# Table Of Contents

1. Overview .................................................................................................................. 1
2. Main Form .................................................................................................................. 3
3. General Operations .................................................................................................. 9
   3.1 Start and Log In to QA Suite .............................................................................. 9
   3.2 Opening A Test Form ....................................................................................... 17
   3.3 Selecting A Form ............................................................................................ 18
   3.4 List View Operations ....................................................................................... 21
   3.5 Print Preview Operations ............................................................................... 22
   3.6 Printing ............................................................................................................ 23
   3.7 Printing To PDF .............................................................................................. 25
   3.8 File Operations ................................................................................................ 29
      3.8.1 File In Use .............................................................................................. 29
      3.8.2 File Recovery .......................................................................................... 30
4. File Menu Operations ............................................................................................... 31
   4.1 Open ............................................................................................................... 31
   4.2 Recent Contracts ............................................................................................. 36
   4.3 Save ............................................................................................................... 38
   4.4 Export To Excel .............................................................................................. 39
   4.5 Change Login .................................................................................................. 41
   4.6 Print .............................................................................................................. 42
   4.7 Print Preview .................................................................................................. 43
   4.8 Exit .............................................................................................................. 44
5. View Menu Operations ............................................................................................ 45
   5.1 HQ Project Data .............................................................................................. 45
   5.2 Project Information ........................................................................................ 47
   5.3 Pay Summary .................................................................................................. 51
   5.4 Plant Mix Incentive Ties ............................................................................... 62
   5.5 Plant Mix Summary ......................................................................................... 71
   5.6 Control Graphs ............................................................................................... 78
6. Specifications Menu Operations ............................................................................. 79
   6.1 Materials Summary Menu Option ................................................................. 79
7. Tests Menu Operations ............................................................................................. 81
   7.1 Test Menu Operations .................................................................................... 81
   7.2 Select Aggregate Gradations Tests .................................................................. 82
   7.3 Select Aggregate Surfacing Density Tests ...................................................... 83
   7.4 Select Concrete Specs Tests ......................................................................... 84
   7.5 Select Daily Plant Mix Report Tests ............................................................... 85
   7.6 Select Marshall Testing Tests ....................................................................... 86
   7.7 Select Plant Mix Density Tests ..................................................................... 87
   7.8 Select Ride Specification Tests ....................................................................... 88
   7.9 Select Volumetrics Tests .............................................................................. 89
8. Tools Menu Operations ........................................................................................... 91
11.1.4  Edit Plant Mix Bit Surf Grade S Material Item ......................................................... 157
11.1.5  Edit Plant Mix Grade D Material Item ................................................................. 181
11.1.6  Edit "Cover Material" Material Item ................................................................. 202
11.1.7  Edit Crushed Base Course Material Item ......................................................... 221
11.1.8  Edit Cement Treated Base Material Item ......................................................... 249
11.1.9  Adding Material Items ......................................................................................... 258
11.1.10 Setting Up Aggregate Sieve Specs ...................................................................... 262
11.1.2  Editing Test Specs ................................................................................................ 267
  11.1.2.1 Select and Edit Test Specs .................................................................................. 267
  11.1.2.2 Mark Test Spec Editing as Complete ............................................................... 268
  11.1.2.3 Edit Aggregate Gradations Test Specs .............................................................. 273
  11.1.2.4 Edit Aggregate Surfacing Density Test Specs .................................................. 278
  11.1.2.5 Edit Concrete Specs Test Specs ........................................................................ 282
  11.1.2.6 Edit Daily Plant Mix Report Test Specs ............................................................ 286
  11.1.2.7 Edit Marshall Testing Test Specs ...................................................................... 298
  11.1.2.8 Edit Plant Mix Density Test Specs .................................................................... 302
  11.1.2.9 Edit Ride Specification Test Specs ..................................................................... 305
  11.1.2.10 Edit Volumetric Testing Test Specs ............................................................... 310
11.1.3  Editing Material Versions ...................................................................................... 317
  11.1.3.1 Edit Material Version Information .................................................................. 317
  11.1.3.2 Mark Material Version Editing as Complete .................................................... 319
  11.1.3.3 Creating New Material Versions ...................................................................... 321
  11.1.3.4 Deleting Material Version ............................................................................... 325
11.1.4  Reviewing and Locking Material Items ................................................................. 328
  11.1.4.1 Review and Lock Material Items ...................................................................... 328
  11.1.4.2 Review and Lock Plant Mix Bit Surf Grade S Material Item .............................. 331
  11.1.4.3 Review and Lock Plant Mix Grade D Material Item ......................................... 335
  11.1.4.4 Review and Lock "Cover Material" Material Item ........................................... 339
  11.1.4.5 Review and Lock Crushed Base Course Material Item ................................... 343
  11.1.4.6 Review and Lock Cement Treated Base Material Item .................................... 347
11.1.5  Reviewing and Locking Test Specs .................................................................... 351
  11.1.5.1 Review and Lock Test Specs ............................................................................ 351
  11.1.5.2 Review and Lock Aggregate Gradations Test Specs ....................................... 353
  11.1.5.3 Review and Lock Aggregate Surfacing Density Test Specs ............................ 357
  11.1.5.4 Review and Lock Concrete Specs Test Specs ................................................. 361
  11.1.5.5 Review and Lock Daily Plant Mix Report Test Specs ....................................... 364
  11.1.5.6 Review and Lock Marshall Testing Test Specs ............................................... 368
  11.1.5.7 Review and Lock Plant Mix Density Test Specs .............................................. 371
  11.1.5.8 Review and Lock Ride Specifications Test Specs ............................................. 373
  11.1.5.9 Review and Lock Volumetric Testing Test Specs ........................................... 376
11.1.6  Reviewing and Locking Material Versions ......................................................... 380
  11.1.6.1 Review and Lock Material Versions ................................................................. 380
11.2  Viewing Material Items and Test Specs ................................................................. 382
  11.2.1 Viewing Material Item Specs .............................................................................. 383
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.2 Setting Up To Split Out Test Types For Data Entry</td>
<td>555</td>
</tr>
<tr>
<td>12.3 Creating Split Files For Data Entry</td>
<td>556</td>
</tr>
<tr>
<td>12.4 Merging Data From Split Files Into Master File</td>
<td>570</td>
</tr>
<tr>
<td>12.5 Updating Test Data in Split File From Master</td>
<td>578</td>
</tr>
<tr>
<td>12.6 Rebuilding Lost Or Damaged Split Files</td>
<td>584</td>
</tr>
<tr>
<td>12.7 Cancelling Split After Merge</td>
<td>587</td>
</tr>
<tr>
<td>13. Working With Test Data</td>
<td>591</td>
</tr>
<tr>
<td>13.1 Editing Test Data</td>
<td>591</td>
</tr>
<tr>
<td>13.1.1 Edit Aggregate Gradations</td>
<td>591</td>
</tr>
<tr>
<td>13.1.1.1 Edit Aggregate Gradations Test Data</td>
<td>591</td>
</tr>
<tr>
<td>13.1.2 Edit Aggregate Surfacing Density Tests</td>
<td>604</td>
</tr>
<tr>
<td>13.1.2.1 Edit Aggregate Surfacing Density Test Data</td>
<td>604</td>
</tr>
<tr>
<td>13.1.3 Edit Concrete Specs Tests</td>
<td>615</td>
</tr>
<tr>
<td>13.1.3.1 Edit Concrete Specs Test Data</td>
<td>615</td>
</tr>
<tr>
<td>13.1.4 Edit Daily Plant Mix Reports</td>
<td>634</td>
</tr>
<tr>
<td>13.1.4.1 Edit Daily Plant Mix Report Test Data</td>
<td>634</td>
</tr>
<tr>
<td>13.1.5 Edit Marshall Tests</td>
<td>671</td>
</tr>
<tr>
<td>13.1.5.1 Edit Marshall Testing Test Data</td>
<td>671</td>
</tr>
<tr>
<td>13.1.6 Edit Plant Mix Density Tests</td>
<td>685</td>
</tr>
<tr>
<td>13.1.6.1 Edit Plant Mix Density Test Data</td>
<td>685</td>
</tr>
<tr>
<td>13.1.7 Edit Ride Specification Tests</td>
<td>707</td>
</tr>
<tr>
<td>13.1.7.1 Edit Ride Specification Test Data</td>
<td>707</td>
</tr>
<tr>
<td>13.1.8 Edit Volumetric Tests</td>
<td>739</td>
</tr>
<tr>
<td>13.1.8.1 Edit Volumetric Test Data</td>
<td>739</td>
</tr>
<tr>
<td>13.2 Evaluation Results</td>
<td>760</td>
</tr>
<tr>
<td>13.2.1 Lot Pay Adjustments</td>
<td>760</td>
</tr>
<tr>
<td>13.2.2 Modifying Pay Adjustments</td>
<td>762</td>
</tr>
<tr>
<td>13.2.3 CP Categories</td>
<td>766</td>
</tr>
<tr>
<td>13.3 Reporting Test Data</td>
<td>769</td>
</tr>
<tr>
<td>13.3.1 Reporting Test Data</td>
<td>769</td>
</tr>
<tr>
<td>13.3.2 Report Aggregate Gradations</td>
<td>770</td>
</tr>
<tr>
<td>13.3.2.1 Report Aggregate Gradations Test Data</td>
<td>770</td>
</tr>
<tr>
<td>13.3.3 Report Aggregate Surfacing Density Tests</td>
<td>777</td>
</tr>
<tr>
<td>13.3.3.1 Report Aggregate Surfacing Density Test Data</td>
<td>777</td>
</tr>
<tr>
<td>13.3.4 Report Concrete Specs Tests</td>
<td>784</td>
</tr>
<tr>
<td>13.3.4.1 Report Concrete Specs Test Data</td>
<td>784</td>
</tr>
<tr>
<td>13.3.5 Report Daily Plant Mix Reports</td>
<td>791</td>
</tr>
<tr>
<td>13.3.5.1 Report Daily Plant Mix Report Test Data</td>
<td>791</td>
</tr>
<tr>
<td>13.3.6 Report Marshall Tests</td>
<td>801</td>
</tr>
<tr>
<td>13.3.6.1 Report Marshall Testing Test Data</td>
<td>801</td>
</tr>
<tr>
<td>13.3.7 Report Plant Mix Density Tests</td>
<td>808</td>
</tr>
<tr>
<td>13.3.7.1 Report Plant Mix Density Test Data</td>
<td>808</td>
</tr>
<tr>
<td>13.3.8 Report Ride Specification Tests</td>
<td>815</td>
</tr>
<tr>
<td>13.3.8.1 Report Ride Specification Test Data</td>
<td>815</td>
</tr>
</tbody>
</table>
13.3.9  Report Volumetric Tests ................................................................. 822
   13.3.9.1 Report Volumetric Test Data ......................................................... 822
   13.3.9.2 Report Volumetric Lot Evaluation Details ........................................... 826
   13.3.9.3 Report Volumetric Pay Adjustment Summary ........................................ 831
   13.3.9.4 Report Volumetric Gmm Rolling Average ............................................ 835
   13.3.9.5 Report Volumetric Gyratory Data ..................................................... 840
   13.3.9.6 Report Volumetric Control Graphs .................................................... 849
   13.3.9.7 View Volumetric Control Graphs ..................................................... 854
   13.3.9.8 Export Volumetric Results To Excel .................................................. 859
   13.3.9.9 Using Volumetric Results Excel Workbook ........................................ 864
13.4  Locking Test Data ........................................................................ 874
   13.4.1 Locking Test Data ........................................................................... 874
   13.4.2 Lock Aggregate Gradations .............................................................. 876
   13.4.2.1 Lock Aggregate Gradations Test Data ............................................... 876
   13.4.3 Lock Aggregate Surfacing Density Tests .............................................. 881
   13.4.3.1 Lock Aggregate Surfacing Density Test Data ...................................... 881
   13.4.4 Lock Concrete Specs Tests ............................................................... 885
   13.4.4.1 Lock Concrete Specs Test Data ........................................................ 885
   13.4.5 Lock Daily Plant Mix Reports ............................................................ 890
   13.4.5.1 Lock Daily Plant Mix Report Test Data .............................................. 890
   13.4.6 Lock Marshall Tests ......................................................................... 893
   13.4.6.1 Lock Marshall Testing Test Data ....................................................... 893
   13.4.7 Lock Plant Mix Density Tests ............................................................ 896
   13.4.7.1 Lock Plant Mix Density Test Data ..................................................... 896
   13.4.8 Lock Ride Specification Tests ............................................................ 900
   13.4.8.1 Lock Ride Specification Test Data ...................................................... 900
   13.4.9 Lock Volumetric Tests ..................................................................... 905
   13.4.9.1 Lock Volumetric Test Data ............................................................. 905
13.5  Unlocking Test Data ........................................................................ 909
   13.5.1 Unlocking Test Data ....................................................................... 909
14.  Transferring Data To Helena ............................................................. 915
   14.1  Setting Up For Transfer To Helena ....................................................... 915
   14.2  Transfer Data To Helena ................................................................. 919
15.  Headquarters Project Data Access ....................................................... 921
   15.1  Starting in View HQ Project Data Mode ............................................... 921
   15.2  Switching Between Local Contract File and View HQ Project Data Modes .... 924
   15.3  Switching to View HQ Project Data Mode During Startup ...................... 926
   15.4  Finding and Selecting an HQ Project ................................................... 928
16.  Working With Local Policies .............................................................. 935
   16.1  Local Policy Definition and Use .......................................................... 935
   16.2  Creating Local Policy ......................................................................... 936
   16.3  Editing Local Policy ......................................................................... 939
   16.4  Applying Local Policy To Contract Files ............................................. 946
17.  Working With Personnel ................................................................... 951
# Table Of Contents

17.1  Step by Step Help for Working With Personnel .......................................................... 951
17.2  Selecting Personnel ......................................................................................................... 953
17.3  Adding Personnel ............................................................................................................ 956
17.4  Removing Personnel ........................................................................................................ 961
17.5  Modifying Personnel Privileges ...................................................................................... 962
17.6  Select Personnel Management Menu Option .................................................................... 965
17.7  Changing Active Status for Personnel ............................................................................ 966
17.8  Viewing Inactive Personnel ............................................................................................ 970
17.9  Adding Person Not In Personnel Database ....................................................................... 972
17.10 Manage Project Personnel ............................................................................................ 977
17.11 Saving Project Personnel Changes ................................................................................ 980

18. Commercial Plant Mix ....................................................................................................... 981
18.1  Overview ........................................................................................................................... 981
18.2  Converting Existing Data ................................................................................................. 982

19. Concrete Aggregate Optimization ..................................................................................... 987
19.1  Overview .......................................................................................................................... 987

20. Plant Mix Incentive Adjustment ......................................................................................... 989
20.1  Overview .......................................................................................................................... 989
20.2  Converting Existing Data ................................................................................................. 991

21. First Lift On CAC Plant Mix Density Evaluation ............................................................... 995
21.1  Overview .......................................................................................................................... 995
21.2  Converting Existing Data ................................................................................................. 996

22. Systems Support ................................................................................................................ 1001

23. Index .................................................................................................................................... 1003
1. **Overview**

Engineers and Technicians have been crunching numbers and measuring quantities and calculating various parameters for various construction and laboratory applications for decades. Over the years, the tools used to perform these calculations have progressed from slide rules to calculators, and now, to the personal computer (PC). There are several advantages to using a PC for Quality Assurance applications, including: complex calculations can be performed quickly and accurately; data can be easily stored, retrieved and transferred to other computers; information can be displayed graphically on screen and/or printed to either a "hard copy" or file format; and equations and methods of calculation can be easily standardized.

The programs described in this document have been designed to utilize these advantages and provide construction and laboratory personnel with a powerful and convenient way to perform the calculations required to evaluate and control the quality of the construction activities and materials that go in to building roads and highways.
2. Main Form

When the program is first started, a "splash screen" is briefly displayed, then after either opening a local QA contract file or starting up in Project Viewer mode, the user is presented with the "main" form. This is where all actions start.

Menus

There are seven main level menus that can be displayed (the Tests menu is only displayed when the material item/test specs and material version for at least one material are locked).

There are numerous options that can be displayed under each menu depending on the startup mode, user's privileges, status of the file, network accessibility and selected form. The following shows all potential menus and all of the potential items for each.

<table>
<thead>
<tr>
<th><strong>File Menu</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open</strong></td>
<td>Allows for selection of an existing data file to be opened.</td>
</tr>
<tr>
<td><strong>Recent Contracts...</strong></td>
<td>Allows for selection of a previously opened data file to be opened.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the current data in a file.</td>
</tr>
<tr>
<td><strong>Export to Excel a</strong></td>
<td>Opens form for selecting options and exporting volumetric results to Excel spreadsheet for sharing with contractors and target adjustment results analyses.</td>
</tr>
<tr>
<td><strong>Change Login</strong></td>
<td>Allows different user to login and work on currently open date file without having to close and restart the application.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Prints the output for the current form to the printer.</td>
</tr>
<tr>
<td><strong>Print Preview</strong></td>
<td>Displays the output for the current form in a print preview form.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Closes the application.</td>
</tr>
</tbody>
</table>

Notes:

a. Only available when the Volumetric Testing form is selected.

View Menu

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HQ Project Data a</strong></td>
<td>Switches QA Suite to Project Viewer mode for viewing HQ project data.</td>
</tr>
<tr>
<td><strong>Project Information</strong></td>
<td>Opens form for viewing, editing or validating and locking project information.</td>
</tr>
<tr>
<td><strong>Pay Summary</strong></td>
<td>Opens form for viewing or printing project pay summary information.</td>
</tr>
<tr>
<td><strong>Plant Mix Incentive Ties b</strong></td>
<td>Opens form for completing designation of all tests entered and evaluating incentive adjustment factor for plant mix incentive</td>
</tr>
</tbody>
</table>
Plant Mix Summary: Opens form for viewing or printing project plant mix summary information.

Control Graphs: Opens form for selecting options and viewing graphs of volumetric results.

Notes:
- Only available when the network is connected.
- Only available when Plant Mix Material Items are included that have the Plant Mix Incentive Ties specification.
- Only available when Plant Mix Material Items are included in the project QA.
- Only available when the Volumetric Testing form is selected.

<table>
<thead>
<tr>
<th>Specifications Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Materials Summary</td>
<td>Opens form for editing, reviewing, locking, viewing or printing material item, test item and material version specification information.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tests Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate Gradations &gt; Material Item(s) a</td>
<td>Opens or selects Aggregate Gradations test user interface form, displaying data for selected material item.</td>
<td></td>
</tr>
<tr>
<td>Aggregate Surfacing Density &gt; Material Item(s)</td>
<td>Opens or selects Aggregate Surfacing Density test user interface form, displaying data for selected material item.</td>
<td></td>
</tr>
<tr>
<td>Daily Plant Mix Report b &gt; Material Item(s)</td>
<td>Opens or selects Daily Plant Mix Report test user interface form, displaying data for selected material item.</td>
<td></td>
</tr>
<tr>
<td>Marshall Testing b &gt; Material Item(s)</td>
<td>Opens or selects Marshall Testing test user interface form, displaying data for selected material item.</td>
<td></td>
</tr>
<tr>
<td>Plant Mix Density b &gt; Material Item(s)</td>
<td>Opens or selects Plant Mix Density test user interface form, displaying data for selected material item.</td>
<td></td>
</tr>
<tr>
<td>Ride Specification b &gt; Material Item(s)</td>
<td>Opens or selects Ride Specification test user interface form, displaying data for selected material item.</td>
<td></td>
</tr>
<tr>
<td>Volumetrics b &gt; Material Item(s)</td>
<td>Opens or selects Volumetrics test user interface form, displaying data for selected material item.</td>
<td></td>
</tr>
</tbody>
</table>

Notes:
- The Material Item is shown as the Material Type (Item Number).
- Only available when Plant Mix Material Items are included in the project QA.

<table>
<thead>
<tr>
<th>Tools Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security/Control &gt;</td>
<td>Opens form for viewing and unlocking, either material ties.</td>
<td></td>
</tr>
</tbody>
</table>
### Specification/Data Locking

<table>
<thead>
<tr>
<th>Specification/Data Locking</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security/Control &gt; Personnel Management</td>
<td>Opens form for adding or removing personnel access to project or editing the privileges of personnel with access to project.</td>
</tr>
<tr>
<td>Security/Control &gt; Edit Local Policy</td>
<td>Opens form for creating or editing local policies for crews or applying the local policy to contract files.</td>
</tr>
<tr>
<td>Project DB Manager &gt; Split</td>
<td>Opens form for splitting testing types out to separate files for distribution to alternate locations for data entry.</td>
</tr>
<tr>
<td>Project DB Manager &gt; Merge</td>
<td>Opens form for merging data from split files back into the master contract file to keep the master file up to date. Split files can also be cancelled after merge when data entry at alternate location is no longer necessary.</td>
</tr>
<tr>
<td>Project DB Manager &gt; Rebuild Split File</td>
<td>Opens form for rebuilding previously created split files to be used for data entry. Should be used as last resort to replace lost or damaged split files since the rebuilt split file will only contain data that has been merged back into the master file.</td>
</tr>
<tr>
<td>Project DB Manager &gt; Update Split From Master</td>
<td>Opens form for updating the test data for all test types that can't be edited in split file. Allows for keeping data for other test types up to date in split file for viewing in alternate locations.</td>
</tr>
<tr>
<td>Project DB Manager &gt; Push Data To HQ</td>
<td>Transfers project data to headquarters for storage in MDT Oracle database where it can be viewed by any user with access to the QA Suite. (Project information must first be validated and locked.)</td>
</tr>
</tbody>
</table>

### Gradation Calculator

Starts the Gradation Calculator tool that allows users to set up sieves and enter gradation test data to calculate gradation results.

### Random Asphalt Mat Sampling

Starts the Random Asphalt Mat Sampling tool that allows users to get random locations for sampling asphalt materials while paving.

### Options

Opens form for editing user's default "Start Mode", "Pavement Course Descriptions" or "Save AutoRecovery" options settings.

## Window Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate Testing a</td>
<td>Selects Aggregate Gradations test user interface form.</td>
</tr>
<tr>
<td>Aggregate Surfacing Density a</td>
<td>Selects Aggregate Surfacing Density test user interface form.</td>
</tr>
<tr>
<td>Daily Plant Mix Report a</td>
<td>Selects Daily Plant Mix Report test user interface form.</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Plant Mix Density</td>
<td>Selects Plant Mix Density test user interface form.</td>
</tr>
<tr>
<td>Ride Specification</td>
<td>Selects Ride Specification test user interface form.</td>
</tr>
<tr>
<td>Volumetric Testing</td>
<td>Selects Volumetrics test user interface form.</td>
</tr>
<tr>
<td>Pay Summary</td>
<td>Selects Pay Summary form.</td>
</tr>
<tr>
<td>Plant Mix Summary</td>
<td>Selects Plant Mix Summary form.</td>
</tr>
</tbody>
</table>

**Notes:**

a. The Window Menu option provides a selection of all open windows to allow the user to bring an open window to the front. These menu options are only displayed when the associated form is already open.

### Help Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Opens the help file with the index displayed</td>
</tr>
<tr>
<td>Contents</td>
<td>Opens the help file with the table of contents displayed</td>
</tr>
<tr>
<td>Search</td>
<td>Opens the help file with the search option displayed</td>
</tr>
<tr>
<td>About QA Suite</td>
<td>Displays the splash screen, which indicates the program name and version</td>
</tr>
</tbody>
</table>

### Toolbar

Several of the more common menu options are also available on the toolbar shown above. The buttons correspond to the following menu options (moving from left to right):

- File > **Open**
- File > **Save**
- File > **Print**
- File > **Print Preview**
- Help > **Index**

### Tests Navigation Panel
The Tests Navigation Panel is initially docked to the left hand edge of the main form and pinned open.

The panel provides a tree structure for locating and selecting tests to view in the test user interface. The tree structure is organized with the Material Item at the top level, the Material Version at the second level, the Test Type(s) for the material item at the third level, and the individual Test Item(s) for the test type at the bottom level.

(Material Item → Material Version → Test Type → Test Item)

Notes:

a. The Material Item is shown as the Material Type (Item Number)

Click on the plus sign + to expand a branch of the tree or the minus sign - to collapse a branch of the tree.

To provide more screen space for the test user interface forms, the Tests Navigation Panel can be unpinned by clicking on the pinned pin at the top right corner of the panel. The unpinned panel is displayed as collapsed as shown below.

Hovering over or clicking on the collapsed panel causes the panel to temporarily expand for the user to make selections.

Click the unpinned pin to pin the panel open.
The status bar at the bottom has three panels. The panels contain the following information (from left to right):

- Current date and time
- Current project data file location and name
- Current project units
3. General Operations

3.1 Start and Log In to QA Suite

Click on the QA Suite shortcut on your desktop (shown below) to start the MDT Quality Assurance Suite program.

The QA Suite information and disclaimer window will be displayed first. Click on the OK button to continue.

The QA Suite splash screen will display as the suite loads, as shown below.
If a recoverable version of a file is available after an abnormal termination, a QA AutoRecover form will be displayed as shown below.
Note: For help with recovering a file see the File Recovery topic.

Otherwise, the program will prompt the user to select the QA Project database file to open, as shown below.
Click on the down arrow next to the **Look in:** dropdown and browse to the project folder (C:\Mdtdata\Contracts\09405\Projects\B377\co\QA in this case) as shown below.
After browsing to the desired folder, select the previously created Project QA database file (09405COQAD001.QDB - which was created using the QA Project File Builder program in this case). Click on the **Open** button to open the file, as shown below.
If the selected file is currently in use by another session of the QA Suite program, a *File In Use* form will be displayed, as shown below.

Note: For help with the file in use option see the *File In Use* topic.

Otherwise, a *QA User Login* window will appear displaying the project manager assigned to this project (set up in the QA Project Builder program). In this case, since Dean Harris' crew (crew 2184 in the Butte district) was running this project, Dean Harris' name is displayed as the Project Manager.
If there are multiple projects in the contract, a dropdown will be displayed next to the Project label. To choose which project to login to and work on, the user clicks on the dropdown arrow as shown below.

The user then clicks on the project in the dropdown list and the project is displayed after the Project label and the selected project's description is shown below the selected project as shown below.
To log in the user enters their user number (MDT UNumber) in the Login (UNumber) text entry box and their computer log-in password in the Password text entry box. Then they click on the OK command button to finish loading the QA Project Database file.

The file will be opened in the QA Suite with the main form displayed (see Main Form).
3.2 Opening A Test Form

To perform operations with test information, the test form containing the information must be the selected form. In order to select the test form, it must be open.

There are two methods that can be used to open a test form:

1. **Use the Tests tree view:** Select a lot under the desired material item/version test type, as shown below.

   ![Tests Tree View](image)

2. **Use the Tests menu option:** Select a test item from the desired Tests->test type->material item->material version, as shown below.

   ![Tests Menu Option](image)

**Notes:**

a. Both methods only work for selecting test user interface forms.

Once a test form is open it can be selected (see Selecting A Form) for access to the associated operations that can be performed for the selected test type.
3.3 Selecting A Form

To process information (such as preview and/or print information or perform additional operations with test information), the form containing the information to be processed must be the selected form. The selected form is the form that is visible (its tab label is highlighted in black and its information is visible on the form).

In the example below, the **Aggregate Testing** form is the selected form (its tab label is highlighted in black and the aggregate test information is visible on the form).

There are four methods that can be used to select an open form:

1. **Select the form's tab label:** Click on the tab label containing the form's title. For example, clicking on the Plant Mix Summary tab makes it the topmost tab, as shown below.

2. **Use the Window menu option:** Select the form from the list of forms under the *Window* menu option, as shown below.
3. **Use the Tests tree view:**  
Select a lot under the desired material item/version test type, as shown below.

4. **Use the Tests menu option:**  
Select a lot from the desired test type->material item->material version, as shown below.

**Notes:**

- Methods 1 and 2 work for all forms, including the test user interface forms.
- Methods 3 and 4 only work for selecting test user interface forms.

After using any of the four options, the desired form will be the selected form as shown below.
Once a form is selected the associated information can be previewed or printed (see Printing).

Additionally, if the form is a test form, the associated operations that can be performed for the selected test type are available for selection (ex., Export to Excel and Control Graphs for Volumetrics test form information (see Export To Excel and Control Graphs)).
3.4 List View Operations

Numerous forms within the QA Suite use lists to hold possible items and selected items. There are buttons that allow movement of items between the possible items list and the selected items list. These operations are completed using the following method:

Add an Item:
- Select the item(s) in the left side list of possible items that you would like to add to the right side list of selected items.
- Press the **Add ->** button to move the selected item(s) from the possible items list to the selected items list (from left to right).

Remove an Item:
- Select the item(s) in the right side list of selected items that you would like to remove from the list of selected items, placing them back in the list of possible items.
- Press the **<- Remove** button to move the selected item(s) from the selected items list to the possible items list (from right to left).

Add All Items:
- Press the **Add All ->>** button to move all of the items from the possible items list to the selected items list (from left to right)

Remove All Items:
- Press the **<<- Remove All** button to move all of the items from the selected items list to the possible items list (from right to left)

Notes:
- Multiple items can be selected for movement by holding down the **Ctrl** key on the keyboard while clicking on the additional items in the list.
3.5 Print Preview Operations

The Print Preview option used throughout the QA Suite opens a standard *Print Preview* window. There are several buttons and dropdown's that allow for printing, changing the size or the items displayed, selecting pages to view and closing the Print preview window. These operations are completed using the following methods.

**Printing:**
- Select the printer button 🖨️
- Note: This print method prints **all pages** to the **default printer**. There is no ability to select pages and there is no ability to select a different printer.

**Change the size of items displayed:**
- Select the dropdown next to the magnifying lens
- Select the desired size from the list of available sizes

**Select pages to view:**
**Method One:**
- Use the up-down arrows next to the Page label to scroll thru the pages

**Method Two:**
- Type the page number in the text box next to the Page label to jump to the page

**Close the Print preview window:**
- Select the **Close** button
3.6 Printing

To preview and/or print information, the form containing the information to be previewed or printed must be the selected form (see Selecting A Form). The selected form is the form that is visible (its tab label is highlighted in black and its information is visible on the form).

To print the data related to the selected form, you have two options:

- Send the data directly to the printer (File->Print or the button on the toolbar)
- Preview the data in a "Print Preview" window before sending it to the printer (File->Print Preview or the button on the toolbar)

It is suggested that the Print Preview option be used, particularly for large reports (e.g., Aggregate Gradations), to verify that the results are reasonable and the data to be printed is what is expected.

When printing from Print Preview (by clicking on the printer button on the preview window), all pages are printed and there is no ability to select pages. However, the print option allows selection of pages. Therefore if you have a large report and only want to print selected pages, the suggested technique is:

1. Select the form containing the information to be printed
2. Select the Print Preview option
3. Make the required selections in the selected form's Print Selections window and click the Print Preview button
4. Determine which pages you would like to print by navigating thru the Print preview window
5. Close the Print preview window
6. Cancel the Print Selections window
7. Select the Print option
8. Make the required selections in the selected form's Print Selections window and click the Print button
9. In the Print window that opens, select the printer (choose the printer from the Name: dropdown in the Printer panel); set the pages to print (choose the Pages option on the Print range panel and enter the start and end pages in the appropriate boxes); and, set the number of copies to print
10. Press OK
11. Cancel the Print Selections window

When printing from Print Preview (by clicking on the printer button on the preview window), all pages are printed to the default printer and there is no ability to select a different printer. However, the print option allows printer selection. Therefore if you want to print to printers other than your default printer, the suggested technique is:

1. Select the form containing the information to be printed
2. Select the Print option
Make the required selections in the selected form's Print Selections window and click the **Print** button.

In the **Print** window that opens, select the printer (choose the printer from the **Name:** dropdown in the **Printer** panel); set the pages to print (choose the **Pages** option on the **Print range** panel and enter the start and end pages in the appropriate boxes); and, set the number of copies to print.

Press **OK**

Cancel the Print Selections window.

**Notes:**

a. The print option can also be used to save the printed information in a PDF document if desired (see **Printing To PDF**).
3.7 Printing To PDF

When printing, the PDF995 printer can be used to create a PDF document containing the printed information.

To do this simply perform the standard Print operations (see Printing), choosing the PDF995 printer as follows.

When the standard windows Print dialog window is displayed, select the PDF995 printer from the dropdown list of available printers next to the Name: label in the Printer panel, as shown below.

After selecting the OK button a Pdf995 Save As window will be displayed, prompting the user to select the location for the PDF document to be saved in and to specify the name for the document to be saved as, as shown below.
After navigating to the desired location for saving the PDF and entering the desired PDF file name, the user simply clicks on the **Save** button to save the PDF as shown below.
The document will be saved as a PDF and then opened in Adobe Acrobat Reader as shown below.
MDT Quality Assurance System

Plant Mix Summary

Contract ID: 00005
Project No.: WH-444120 (03777041000)
Description: US 687 FARE LN S OF TOSTON

Bid Item: PLANT MIX BIT SURF GR 8 - 19 MM
Material Type: PLANT MIX BIT SURF GR 8 - 19 MM
Contract Quantity: 20499 t

Material Version 1

Volumetric Testing Averages (16 Samples)

<table>
<thead>
<tr>
<th>% Voids</th>
<th>WMA</th>
<th>WFA</th>
<th>VFA</th>
<th>V/D Ratio</th>
<th>Density (Lab)</th>
<th>Density (Base)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>14.5</td>
<td>70</td>
<td>3.6</td>
<td>0.9</td>
<td>2.369</td>
<td>2.445</td>
</tr>
</tbody>
</table>

Daily Plant Mix Report Averages (11 Reports)

<table>
<thead>
<tr>
<th>% Asphalt</th>
<th>5.33</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Sample Number</th>
<th>Sample Date</th>
<th>Sample Time</th>
<th>% Voids</th>
<th>Average</th>
<th>Day's Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2/17/2006</td>
<td></td>
<td>2.6</td>
<td>2.8</td>
<td>2.8</td>
</tr>
<tr>
<td>2</td>
<td>2/17/2006</td>
<td></td>
<td>2.8</td>
<td>2.3</td>
<td>2.3</td>
</tr>
<tr>
<td>3</td>
<td>2/17/2006</td>
<td></td>
<td>3.0</td>
<td>2.5</td>
<td>2.5</td>
</tr>
<tr>
<td>4</td>
<td>2/17/2006</td>
<td></td>
<td>3.5</td>
<td>3.2</td>
<td>3.2</td>
</tr>
<tr>
<td>5</td>
<td>2/17/2006</td>
<td></td>
<td>3.6</td>
<td>2.9</td>
<td>2.9</td>
</tr>
<tr>
<td>6</td>
<td>2/17/2006</td>
<td></td>
<td>4.0</td>
<td>3.0</td>
<td>3.0</td>
</tr>
<tr>
<td>7</td>
<td>2/17/2006</td>
<td></td>
<td>3.0</td>
<td>2.5</td>
<td>2.5</td>
</tr>
<tr>
<td>8</td>
<td>2/17/2006</td>
<td></td>
<td>3.5</td>
<td>2.9</td>
<td>2.9</td>
</tr>
<tr>
<td>9</td>
<td>2/17/2006</td>
<td></td>
<td>4.5</td>
<td>3.0</td>
<td>3.0</td>
</tr>
<tr>
<td>10</td>
<td>2/17/2006</td>
<td></td>
<td>3.5</td>
<td>2.5</td>
<td>2.5</td>
</tr>
<tr>
<td>11</td>
<td>2/17/2006</td>
<td></td>
<td>3.0</td>
<td>2.5</td>
<td>2.5</td>
</tr>
<tr>
<td>12</td>
<td>2/17/2006</td>
<td></td>
<td>3.5</td>
<td>3.0</td>
<td>3.0</td>
</tr>
<tr>
<td>13</td>
<td>2/17/2006</td>
<td></td>
<td>4.0</td>
<td>3.5</td>
<td>3.5</td>
</tr>
<tr>
<td>14</td>
<td>2/17/2006</td>
<td></td>
<td>3.5</td>
<td>3.1</td>
<td>3.1</td>
</tr>
<tr>
<td>15</td>
<td>2/17/2006</td>
<td></td>
<td>3.0</td>
<td>3.0</td>
<td>3.0</td>
</tr>
<tr>
<td>16</td>
<td>2/17/2006</td>
<td></td>
<td>3.5</td>
<td>3.1</td>
<td>3.1</td>
</tr>
</tbody>
</table>

QA Version: April 2007

Page 1

11/12/2007
3.8 File Operations

3.8.1 File In Use

When using the QA Suite to work with local contract files (located on the local computer or share drive in the ...\Mdtdata\Contracts\###\contract sub-folder), the program loads the current copy of the file into memory and all operations on the file as done in memory. The changes are only actually saved to the local contract file when a Save operation is performed. Hence, if a file were to be opened and modified by two concurrent sessions of the QA Suite program, the changes made during a given session would be overwritten when the file was saved from the other session.

In order to prevent the loss of information, a file can only be worked in one session of the QA Suite at a time.

If an attempt is made to open a file that is currently in use by another session of the QA Suite program, a File In Use form will be displayed, providing notification that the file is locked for editing, as shown below.

Select the Read Only button to open file in the QA Suite for read only access (the information will be view only).
Select the Notify button to open file in the QA Suite for read only access and receive notification when the file is no longer in use.
Select the Cancel button to cancel the file open process and start the QA Suite in Project Viewer mode (see Starting In View HQ Project Data Mode).
3.8.2 File Recovery

If the QA Suite program encounters a problem and stops responding, you can close the program in a controlled manner. The file being worked on will have a backup copy available to recover if the QA AutoRecovery option is enabled and the file was open for at least the length of the save interval (10 minutes unless changed by the user).

Note: For help with setting up the QA AutoRecovery options see the Save AutoRecovery Options topic.

If a recoverable version of a file is available after an abnormal termination, upon restarting the QA Suite a QA AutoRecover form will be displayed as shown below.

Select the Recover button to recover the backup copy of the file, opening the recovered file in the QA Suite.
Select the Delete button to delete the backup copy of the file and continue with the normal QA Suite startup.
Select the Close button to bypass the recover and continue with the normal QA Suite startup without deleting the backup copy of the file.
4. File Menu Operations

4.1 Open

The open function allows a user to select and open a contract file from within the QA Suite.

To open a QA Contract file select the \textit{Open} option under the \textit{File} menu option as shown below or select the \includegraphics[width=0.2\textwidth]{open_button.png} button on the toolbar.

The program will prompt the user to select the QA Contract database file to open, as shown below.
Click on the down arrow next to the **Look in:** dropdown and browse to the project folder (C:\Mdtdata\Contracts\09405\Projects\B377\co\QA in this case) as shown below.
After browsing to the desired folder, select the previously created Project QA database file (09405COQAD001.QDB - which was created using the QA Project File Builder program in this case). Click on the **Open** button to open the file, as shown below.
If the currently open file has been modified but the changes have not been saved, the user will be prompted to save the changes before the newly selected file is opened, as shown below.

If the **Yes** button is selected, the changes to the currently open QA contract file **will be saved** and the **QA User Login** window will appear*, prompting the user to log in to the newly selected QA contract file (see **Start and Log In to QA Suite**).

If the **No** button is selected, the changes to the currently open QA contract file **will not be saved** and the **QA User Login** window will appear*, prompting the user to log in to the newly selected QA contract file (see **Start and Log In to QA Suite**).

If the **Cancel** button is selected, the open operation will be terminated and the current QA contract file will remain open.
**Note:**

a. If the selected file is currently in use by another session of the QA Suite program, a *File In Use* form will be displayed, as shown below.

![File In Use Form](image)

For help with the file in use option see the *File In Use* topic.
4.2 Recent Contracts...

The recent contracts function allows a user to select and open a recently opened contract file from within the QA Suite.

To open a recently opened QA Contract file select the Recent Contracts... option under the File menu option and click on the desired file in the list of recently opened QA contract files as shown below.

Note:
The Recent Contracts... option will only be displayed when the QA Suite is in the Open Project mode and the current user has previously opened other QA contract files.

If the currently open file has been modified but the changes have not been saved, the user will be prompted to save the changes before the newly selected file is opened, as shown below.

If the Yes button is selected, the changes to the currently open QA contract file will be saved and the QA User Login window will appear®, prompting the user to log in to the newly selected QA contract file (see Start and Log In to QA Suite).

If the No button is selected, the changes to the currently open QA contract file will not be saved and the QA User Login window will appear®, prompting the user to log in to the newly selected QA contract file (see Start and Log In to QA Suite).
If the **Cancel** button is selected, the open recent contacts operation will be terminated and the current QA contract file will remain open.

**Note:**

a. If the selected file is currently in use by another session of the QA Suite program, a *File In Use* form will be displayed, as shown below.

![File In Use Form](image)

For help with the file in use option see the *File In Use* topic.
4.3  Save

While working in the QA Suite, all operations are being performed to the information loaded into memory. The changes resulting from the operations are not saved in the QA Contract file until the save function is performed.

The save function saves all changes to the QA Contract file since the last save has occurred.

When closing a QA contract file or changing login or opening another QA contract file, the user will be prompted to save changes before the operation is performed.

The user can also choose to save changes at any time.

To save changes to the current QA Contract file select the Save option under the File menu option as shown below or select the button on the toolbar.

![Menu with Save option highlighted]
4.4 **Export To Excel**

Volumetric target values can be adjusted by the contractor throughout the course of the project, but the final target values are not set until the end of the project.

In order to change the QA Volumetric target values in the QA Suite, the Volumetric Test item for the Plant Mix Material item must be unlocked, the targets changed, and the Volumetric Test item must then be re-locked by a different user. These operations can only be performed by users with the privileges to Unlock Specifications, Add/Edit Specification and Lock Specifications which generally are an EPM, Field Office Person or Lab Supervisor. There is a need for an easier way for users to be able to analyze the results of proposed changes to target values.

Contractors do not have access to the MDT QA Suite, nor the QA Suite data. There is a need to be able to share the Volumetrics results with the contractor.

The **Export To Excel** option exports the Volumetric results (%Voids, VMF, VFA, D/A Ratio, Gmm, AC Corrected Burn and AC Spot Check) to an Excel workbook.

The Excel workbook is designed to allow for analysis of effects of changes to Target Values on Pay Adjustment calculation results without being able to change the actual data. Sheets in the Excel file are password protected but Proposed Target Values can be modified for each Material Version.

The Excel file can be given to contractors so that they can evaluate the effects of changing Targets on Pay Adjustment calculations. This provides contractors with essentially the same capability as with the MDT Volumetrics program (they were allowed to install the MDT Volumetrics software and were given a copy of the MDT Volumetrics file so that they could see the affects of changing targets).

To export the Volumetric data to Excel, the Volumetrics test form must be open (see Opening A Test Form) and it must be the selected form (see Selecting A Form).

With the Volumetrics test form selected, choose the **Export To Excel** option under the **File** menu option as shown below.
For help with using the *Export to Excel* option see the [Export Volumetric Results To Excel](#) topic.

For help with using the Volumetric results workbook see the [Using Excel Volumetric Results Workbook](#) topic.
4.5 Change Login

The change login function allows a different user to login and work on a QA contract file that is already open in the QA Suite without the current user having to close out of the QA Suite and the new user having to start up the QA Suite and select the file to open.

The change login function can be particularly convenient when switching users to review and lock material items and test specifications after their editing has been completed.

The change login function also makes it more convenient for multiple users to login as themselves when entering test data into the same QA contract file at the same time.

To change login from the current user to a new user select the Change Login option under the File menu option as shown below.

The QA User Login window will appear, prompting the user to log in to the current QA contract file (see Start and Log In to QA Suite).
4.6 Print

The print option is used to print the data related to the selected form (see Printing).
4.7 Print Preview
The print preview option is used to preview the data related to the selected form (see Printing).
4.8 Exit

The exit function allows a user to exit out of the QA Suite.

To exit out of the QA Suite select the **Exit** option under the **File** menu option as shown below or select the red X button at the top right-hand corner of the main form window.

If the currently open file has been modified but the changes have not been saved, the user will be prompted to save the changes before exiting the QA Suite, as shown below.

If the **Yes** button is selected, the **changes** to the currently open QA contract file **will be saved** and the QA Suite program will terminate.

If the **No** button is selected, the **changes** to the currently open QA contract file **will not be saved** and the QA Suite program will terminate.

If the **Cancel** button is selected, the exit operation will be terminated and the QA Suite will continue operating with the current QA contract file will remaining open.
5. **View Menu Operations**

5.1 **HQ Project Data**

Projects that have been transferred in to Helena are available for viewing in the project viewer. The **HQ Project Data** option allows users to switch to the project viewer mode from the open project mode.

To switch to the project viewer mode the user selects the **HQ Project Data** option under the **View** menu option, as shown below.

After choosing the **HQ Project Data** option, the program will switch the **Project Viewer** mode as shown below.
The user can now proceed to find and select the HQ Project to view the data (see Finding And Selecting An HQ Project).
5.2 Project Information

To view project information select the **Project Information** option under the **View** menu item option as shown below.

The Project Information option opens the **View Project Information** form for viewing, editing or validating project information, as shown below.

While the user can edit the project information in this form, it is strongly discouraged. The project information must match the information in the construction contract plans contract information database.

The **Validate Project** button is used to validate the project information (to make sure that the project information matches the information in the construction contract plans contract database).

You will need to validate and lock the project information before you can either:
• Split out test types for data entry or,
• Transfer data in to Helena.

Project information validation and locking only needs to be done once for each contract file.

Project information validation and locking can only be performed by users with one of the following roles:

1. EPM
2. Field Office Person
3. Lab Supervisor

To validate the information simply select each project from the *Project* dropdown and click on the **Validate Project** button, as shown below.

If the project information does not match the information in the contract plans database a window will open with notification of the mismatch, prompting to change the project information to match the contract plans database, as shown below.
Selecting **Yes** changes the project information to match the contract plans database, finishing the validation process. Selecting **No** cancels the validation process.

Once a project's information has been validated the **Validate Project** button will disappear and a **Lock** button will be displayed, as shown below. Select the **Lock** button to lock the project information.

Once the project information for a project has been locked, the **Lock** button will disappear and a **Locked** label will be displayed, as shown below.
If a contract file has multiple projects, you will need to validate all projects under the contract file before the contract file can be transferred to Helena.

To validate another project in the contract file, choose the other project from the Project dropdown and perform the Validate Project and Lock operations discussed above.
5.3 Pay Summary

During the course of the project and at the end of the project in particular, the pay adjustments for each QA material pay item in the project must be computed and reported. This is referred to as Pay Summary information.

The **Pay Summary** option provides a quick and easy mechanism to view and report the project totals for the pay adjustments for each QA material pay item (the Pay Summary information).

To view and/or report the pay summary information, select the **Pay Summary** option under the **View** menu option as shown below.

This will activate the **Pay Summary** tab as shown below.
The pay adjustment values for the QA material pay items are displayed on the Pay Summary tab as shown above.

Double-click on the desired QA material pay item to go to the pay adjustment details for that QA material pay item. For example, double-click on the pay item row for the Plant Mix Bit Surf GR S - 19 MM material, Volumetric test type for Material Version 1, as shown below.

The Volumetric Pay Adjustment Data details form loads, showing the pay adjustment data for the selected material item, material version and material lot, as shown below.
Both the **Pay Summary** print preview and print options export the pay summary data to an Excel workbook using a Pay Summary workbook template.

With the **Pay Summary** form selected, use the Print Preview option to create the workbook with the final workbook set to the Print Preview view mode in Excel or use the Print option to create and save the workbook for viewing, printing or sharing the Pay Summary data.

To create a temporary workbook and preview the Pay Summary information use the *File->Print Preview* menu option or the button on the tool bar.

A temporary Excel workbook is created in the same folder as the QA Contract file and is named "PAY-SUMMARY1.xls".

A *Preparing to Create Temporary Pay Summary Excel Workbook* window will be displayed, informing the user that a temporary Excel workbook will appear and to not interrupt the process of creating the temporary Excel workbook which can take several minutes.
Select the **OK** button to continue the process of creating the temporary Pay Summary Excel workbook for previewing. A temporary Excel workbook is created from the Pay Summary Excel workbook template and the program begins the process of exporting the Pay Summary information to the Excel workbook.

Users should not interrupt the process of creating the Excel workbook. When the workbook creation process is done, the temporary workbook will be displayed in the Excel Print Preview view, as shown below.
Note: For help using the Excel Print Preview window to view and print information see the Microsoft Office Excel Help function.
When done previewing the Pay Summary information, click on the Close button or red X button at the top right-hand corner of the window to close the Excel Print preview window. Excel will automatically close and the temporary Excel file will be deleted.

To create and save a Pay Summary workbook for viewing, printing or sharing the Pay Summary information use the File->Print or the button on the tool bar.

An Excel workbook is created and saved in the same folder as the QA Contract file and is named using the QA Contract file name at the start of the file, and the text "Pay-Summary-Report" included in the file name (ex., "09405COQAD001_Pay-Summary-Results.xls").

A Preparing to Create and Save Pay Summary Excel Workbook window will be displayed, informing the user that an Excel workbook will appear and to not interrupt the process of creating the Excel workbook which can take several minutes.

Select the OK button to continue the process of creating and saving the Pay Summary Excel workbook for viewing, printing or sharing. An Excel workbook is created from the Pay Summary Excel workbook template and the program begins the process of exporting the Pay Summary information to the Excel workbook.

If the Excel file already exists it will automatically be overwritten by the new file with no user notification.

Users should not interrupt the process of creating the Excel workbook. When the workbook creation process is done, the workbook will be displayed in the Excel, as shown below.
Note: For help using the Excel application to view and print information see the Microsoft Office Excel Help function.

The user can now proceed to view, print or share the Pay Summary information from the Excel workbook.
To print or preview the pay summary information out of Excel choose the **File --> Print...** menu option or the button on the Excel tool bar.

The Excel **Print** dialog window will be displayed as shown below.

Click the **OK** button to print the pay summary information worksheet.  
Click the **Cancel** button to cancel the print process.  
Click the **Preview** button to preview the pay summary information worksheet.

When done viewing or printing the Pay Summary information, click on the **File --> Close** menu option or red X button at the top right-hand corner of the window to close the workbook file.  Select the **File --> Exit** menu option to close the Excel application.

**Note the following Pay Summary modifications for Plant Mix Incentive Ties.**

The differences in the Pay Summary UI and Reports are due to the final Adjusted Incentives being based on the results for all Volumetric, Plant Mix Density and Ride Spec tests for the Plant Mix Material Item.  As shown below, the Pay Summary UI and Reports include columns for the Incentive Adjustment Factor and the Adjusted Incentive which is the product of the unadjusted Incentive and the Incentive Adjustment Factor.  The Net Pay Adjustment for the Plant Mix Material Item Plant Mix Density and Volumetric Lot and the Ride Spec Test Run items is the sum of the Adjusted Incentive and the Deduct.
### Pay Summary

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Material Type</th>
<th>Test Type</th>
<th>M</th>
<th>Loc</th>
<th>PVa</th>
<th>Deduct</th>
<th>% Inc</th>
<th>Incentive</th>
<th>Inc Adj Factor</th>
<th>Adj Incentive</th>
<th>Net Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>200</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>0.0</td>
<td>$0.00</td>
<td>0.0%</td>
<td>$0.00</td>
<td>N/A</td>
<td>N/A</td>
<td>$0.00</td>
</tr>
<tr>
<td>2</td>
<td>200</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>0.0</td>
<td>$0.00</td>
<td>0.0%</td>
<td>$0.00</td>
<td>N/A</td>
<td>N/A</td>
<td>$0.00</td>
</tr>
<tr>
<td>3</td>
<td>200</td>
<td>100</td>
<td>7</td>
<td>0</td>
<td>7.7</td>
<td>$(5.42)</td>
<td>0.0%</td>
<td>$0.00</td>
<td>N/A</td>
<td>N/A</td>
<td>$(5.42)</td>
</tr>
</tbody>
</table>

**Item Total**

<table>
<thead>
<tr>
<th>Item Total</th>
<th>Deduct</th>
<th>Incentive</th>
<th>Adj Incentive</th>
<th>Net Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$(5.42)</td>
<td>$0.00</td>
<td>N/A</td>
<td>$(5.42)</td>
</tr>
</tbody>
</table>

**Material**

<table>
<thead>
<tr>
<th>Description</th>
<th>Volume</th>
<th>Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dens Totals</td>
<td>$(119,966)</td>
<td>$0.00</td>
</tr>
<tr>
<td>Volumetric</td>
<td>$(550,025.00)</td>
<td>$(550,025.00)</td>
</tr>
<tr>
<td>Ride Specific</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Vol Totals**

<table>
<thead>
<tr>
<th>Description</th>
<th>Volume</th>
<th>Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ride Totals</td>
<td>$(279,505)</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**For All Material Items**

<table>
<thead>
<tr>
<th>Description</th>
<th>Volume</th>
<th>Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td>$(280,049)</td>
<td>$7.359</td>
</tr>
<tr>
<td>Total</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total</td>
<td>$(280,049)</td>
<td>$7.359</td>
</tr>
</tbody>
</table>

59
### MDI Quality Assurance System

**Pay Summary**

<table>
<thead>
<tr>
<th>Contract ID:</th>
<th>25116</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project No.:</td>
<td>16-1 (9) 10</td>
</tr>
<tr>
<td>[2461020002]</td>
<td></td>
</tr>
<tr>
<td>Description:</td>
<td>ANGELA - N &amp; S</td>
</tr>
</tbody>
</table>

#### Metric

<table>
<thead>
<tr>
<th>Bid Item (Item Number) / Material Type</th>
<th>Test Type</th>
<th>Test Item (Material Number)</th>
<th>Material Type</th>
<th>Lot</th>
<th>R Value</th>
<th>Deduct</th>
<th>% Inc</th>
<th>Inventive Tax Adj Factor</th>
<th>Adjusted Inventive</th>
<th>Set Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>COVER - TYPE 1 (M) (61140010)</td>
<td>Aggregate</td>
<td>1</td>
<td></td>
<td>1</td>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>N/A</td>
<td>N/A</td>
<td>10.00</td>
</tr>
<tr>
<td>COVER MATERIAL GR 16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Item Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>COVER - ASSY COVER 1M (22170005)</td>
<td>Aggregate</td>
<td>1</td>
<td></td>
<td>1</td>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>N/A</td>
<td>N/A</td>
<td>10.00</td>
</tr>
<tr>
<td>COVER - ASSY COVER 1M (22170005)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>COVER - ASSY COVER 1M (22170005)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>COVER - ASSY COVER 1M (22170005)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>COVER - ASSY COVER 1M (22170005)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>COVER - ASSY COVER 1M (22170005)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Item Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>1</td>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>2</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>3</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>4</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>5</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>6</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>7</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>8</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>9</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>10</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>11</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>12</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>13</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>14</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
<tr>
<td>PLAN WSC EST STEP 1B - 0 - 10 MM [6115000000] Phase F3 Inventory</td>
<td>15</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>(24,842.92)</td>
</tr>
</tbody>
</table>

**QA Version:** April 2014

**Page 1 of 2**
NOTE: The Incentive Adjustment Factor will be zero (0.000) until all Volumetric, Density and Ride tests have been entered and the "All Tests Entered" selection has been made for all three test types and the Incentive Adjustment Factor has been computed using the Plant Mix Incentive Ties form which is accessed from the View menu (see Plant Mix Incentive Ties).
5.4 Plant Mix Incentive Ties

The QA Suite was modified to implement the Plant Mix Incentive Adjustment Special Provision (dated 10/10/2013), as summarized in the Plant Mix Incentive Adjustment Overview.

The Plant Mix Incentive Ties option provides a quick and easy mechanism to designate when all of the tests have been entered and compute and view the Plant Mix Incentive Adjustment Factor for the Plant Mix Material Item which is then used to obtain the final Adjusted Incentives for the Plant Mix Material Item.

To designate when all Density, Ride and/or Volumetric tests have been entered and compute the Incentive Adjustment Factor or to view the Incentive Adjustment calculations, select the Plant Mix Incentive Ties option under the View menu option as shown below.

This will activate the Plant Mix Incentive Calculation tab as shown below.
Before the Final Incentive Adjustment Factor can be computed and the Adjusted Incentive amounts for the Density, Ride and Volumetric tests can be calculated:

- All Plant Mix Density test lots must be locked and marked as all density tests being entered for all material versions
- All Volumetric test lots must be locked and marked as all volumetric tests being entered for all material versions
- All Ride Spec test runs must be locked and marked as all ride tests being entered for all material versions

Until all lots or tests have been locked for all material versions, the red notification of one or more lots or tests not being locked is displayed and the All Tests Entered buttons are disabled and the Calculate Final Incentive Factor button is disabled, as shown above.
Once all tests have been entered for Density, Ride and Volumetric test items the lots or runs for all material versions must be locked before the Final Incentive Adjustment Factor can be computed and applied.

The basic process for locking test items is as follows:

1. Open the test form (see Opening A Test Form).
2. Select the test item (lot or run)
3. Lock the test item (lot or run)
   a. To lock the test items
      i. Select the Show Pay Adjustments For This Lot or Show Pay Adjustments For This Test Run button on the form to open the associated evaluation results form.
      ii. Select the Lock button on the evaluation results form.
      iii. Select the OK button on the evaluation results form to complete the locking process.
      iv. Save the changes to the file.

After locking all lots or runs for a test item and saving the changes the Plant Mix Incentive Calculation form will update with the red notification of one or more lots or tests not being locked will no longer be displayed and the All Tests Entered button will be enabled for the user to select and designate that all tests have been entered.

For example, after locking all Density lots and saving the changes, closing and re-opening the Plant Mix Incentive Calculation form will result in the All Density Tests Entered information being updated as shown below with the All Density Tests Entered button enabled for selection to complete the designation of all density tests entered.
Similarly, after locking all Volumetric test lots and saving the changes, closing and re-opening the Plant Mix Incentive Calculation form will result in the All Volumetric Tests Entered information being updated as shown below with the **All Volumetric Tests Entered** button enabled for selection to complete the designation of all volumetric tests entered.
Finally, after locking all Ride test runs and saving the changes, closing and re-opening the Plant Mix Incentive Calculation form will result in the All Ride Tests Entered information being updated as shown below with the All Ride Tests Entered button enabled for selection to complete the designation of all ride tests entered.
Before the Final Incentive Adjustment Factor can be calculated the All Tests Entered buttons must be selected and the changes saved.

To complete the designation of all density tests entered and compute the Density Incentive Factor, select the All Density Tests Entered button and save the changes. The Plant Mix Incentive Calculation form will update to display green notification indicating that the all density tests entered designation has been completed and the Density Incentive Factor will be calculated and displayed in the Density Incentive Factor panel on the form.
To complete the designation of all volumetric tests entered and compute the Volumetric Incentive Factor, select the All Volumetric Tests Entered button and save the changes. The Plant Mix Incentive Calculation form will update to display green notification indicating that the all volumetric tests entered designation has been completed and the Volumetric Incentive Factor will be calculated and displayed in the Volumetric Incentive Factor panel on the form.

To complete the designation of all ride tests entered and compute the Ride Category Incentive Factor(s) and Final Ride Incentive Factor, select the All Ride Tests Entered button and save the changes. The Plant Mix Incentive Calculation form will update to display green notification indicating that the all ride tests entered designation has been completed and the Ride Category Incentive Factor(s) and Ride Final Incentive Factor will be calculated and displayed in the Ride Incentive Factor panels on the form.

Once all three buttons have been selected and the changes saved the Plant Mix Incentive Calculation form will update, enabling the Calculate Final Incentive Factor button, as shown below.
Select the **Calculate Final Incentive Factor** button to calculate and display the final incentive adjustment factor, as shown below.
In this case the Volumetric Incentive Factor was zero because the P value for the Volumetric tests was 35.5 which is $\geq 15$. This results in the Final Incentive Adjustment Factor being zero.

Save the changes before viewing the Adjusted Incentive values for the different test types.
5.5 **Plant Mix Summary**

During the course of the project and at the end of the project in particular, the project averages for plant mix properties must be computed and reported. This is referred to as Plant Mix Summary information.

The *Plant Mix Summary* option provides a quick and easy mechanism to view and report the project averages for the plant mix properties (the Plant Mix Summary information).

To view and/or report the plant mix summary information, select the *Plant Mix Summary* option under the *View* menu option as shown below.

![Plant Mix Summary option](image)

This will activate the *Plant Mix Summary* tab as shown below.

![Plant Mix Summary tab](image)
The project average values for the plant mix properties for the selected material item version are displayed on the Plant Mix Summary tab as shown above.

To view the averages for other plant mix material items and/or versions, the user simply selects the desired material item and version from the list of plant mix material items, as shown below.
Since no Daily Plant Mix Reports have been entered for Material Version 2, the Daily Plant Mix Report plant mix property averages cannot be computed or displayed as shown above.

Double-click on the desired plant mix material item/material version to view details such as the individual sample values and the Day’s Average for the various plant mix properties in the Plant Mix Summary Details window, as shown below.
The Plant Mix Summary information, including details of the plant mix material properties used to generate the averages can also be previewed and printed.
To view and/or print the plant mix summary information, the Plant Mix Summary form must be the selected form.

To select the **Plant Mix Summary** form it must be open (choose the **View -> Plant Mix Summary** menu option to open the form).

Once the form is open, it can be selected (see **Selecting A Form**).

The user can now use the Preview or Print options to either view or print the Plant Mix Summary information (see **Printing**).

To preview the data in a "print preview" window before sending it to the printer, use the **File->Print Preview** menu option or the ![print preview button](button.png) on the toolbar. After selecting the print preview option, the **Plant Mix Summary Print Selection** window will be displayed as shown below.

![Plant Mix Summary Print Selection](screenshot.png)

Select each material item/material version to be previewed. Select the **Include Details** option to have the plant mix summary detail information included in the print preview.

Once the desired options are selected, click the **Print Preview** button to preview the data. The **Print preview** window will be displayed, as shown below.
Note: For help using the Print preview window to view and print information see Print Preview Operations.
When done previewing the printed output, click on the **Close** button to close the *Print preview* window.

Click on the **Cancel** button on the *Plant Mix Summary Print Selection* window to close the window, completing the print preview operation.

To print the data to the printer, select the **File->Print** menu option or the **button on the toolbar. After selecting the print option, the *Plant Mix Summary Print Selection* window will be displayed as shown below.

First, select each material item/material version to be printed. Optionally, select the **Include Details** option to include the details of the plant mix property information used to obtain the averages.

Once the desired options are selected, click the **Print** button to print the data (see *Printing*).

When done printing click on the **Cancel** button on the *Plant Mix Summary Print Selection* window to close the window, completing the print operation.
5.6 Control Graphs

During the course of a project, there is significant benefit in being able to analyze the Volumetric control parameters graphically. These graphs are referred to as Control Graphs.

The Control Graphs option provides a quick and easy mechanism to view and report the graphs of each analysis.

To access the Volumetrics control graphs, the Volumetrics test form must be open (see Opening A Test Form) and it must be the selected form (see Selecting A Form).

With the Volumetrics test form selected, choose the Control Graphs option under the View menu option as shown below.

For help with using the Control Graphs option see the View_Volumetric_Control_Graphs topic.

For help with previewing or printing Control Graphs see the Report_Volumetric_Control_Graphs topic.
6. Specifications Menu Operations

6.1 Materials Summary Menu Option

To set up, manage, edit and/or view materials information select the **Materials Summary** option from the **Specifications** menu dropdown as shown below.

The Materials Summary option opens the **Materials Summary** form for setting up, editing, viewing or reporting materials information, as shown below.

The Materials Summary form provides the tools for setting up, editing, reviewing, locking, viewing or reporting materials information.

For help with setting up and editing materials information see **Select and Edit Material Item**.

For help with reviewing and locking materials information see **Review and Lock Material Item**.

For help with viewing materials information see **Viewing Material Test Specs**.

For help with reporting materials information see Reporting Materials Summary Information.
7. Tests Menu Operations

7.1 Test Menu Operations

The test menu option provides a menu dropdown/popout structure for locating and selecting tests to view in the test user interface. The dropdown/popout structure is organized with the Test Type at the top level, the Material Items requiring the test type at the second level, all Material Versions for the material item at the third level, and the individual Test Item(s) for the selected material item, material version, test type at the bottom level.

(Test Type --> Material Item → Material Version --> Test Item)

Notes:

a. The Material Item is shown as the Material Type (Item Number)
7.2 Select Aggregate Gradations Tests

The *Aggregate Gradations* option under the *Tests* menu can be used to select an aggregate gradations lot for a material version of a material item to open in the *Aggregate Testing* test user interface form.

The *Aggregate Gradations tests selection option is organized as follows:*
*Aggregate Gradations --> Material Type (Item No.) --> Material Version # --> Lot #*

Selecting a lot opens or selects the *Aggregate Tests* test user interface form, displaying data for the selected item.
7.3 Select Aggregate Surfacing Density Tests

The *Aggregate Surfacing Density* option under the *Tests* menu can be used to select an aggregate surfacing density lot for a material version of a material item to open in the *Aggregate Surfacing Density* test user interface form.

The Aggregate Surfacing Density tests selection option is organized as follows:

Aggregate Surfacing Density --> Material Type (Item No.) --> Material Version # --> Lot #

Selecting a lot opens or selects the *Aggregate Surfacing Density* test user interface form, displaying data for the selected item.
7.4 Select Concrete Specs Tests

The *Concrete Specs* option under the *Tests* menu can be used to select a concrete specs lot for a material version of a material item to open in the *Concrete Specs* test user interface form.

The Concrete Specs tests selection option is organized as follows:
Concrete Specs --> Material Type (Item No.) --> Material Version # --> Lot #

Selecting a lot opens or selects the *Concrete Specs* test user interface form, displaying data for the selected item.
7.5 Select Daily Plant Mix Report Tests

The Daily Plant Mix Report option under the Tests menu can be used to select a daily plant mix report for a material version of a material item to open in the Daily Plant Mix Reports test user interface form.

The Daily Plant Mix Report tests selection option is organized as follows:

Daily Plant Mix Report --> Material Type (Item No.) --> Material Version # --> Report Date

Selecting a report opens or selects the Daily Plant Mix Reports test user interface form, displaying data for the selected item.
7.6 Select Marshall Testing Tests

The *Marshall Testing* option under the *Tests* menu can be used to select a marshall test brick for a material version of a material item to open in the *Plant Mix Density* test user interface form.

The Marshall Testing tests selection option is organized as follows:
Marshall Testing --> Material Type (Item No.) --> Material Version # --> Brick #

Selecting a brick opens or selects the *Marshall Testing* test user interface form, displaying data for the selected item.
7.7 Select Plant Mix Density Tests

The *Plant Mix Density* option under the *Tests* menu can be used to select a plant mix density lot for a material version of a material item to open in the *Plant Mix Density* test user interface form.

The Plant Mix Density tests selection option is organized as follows:
Plant Mix Density --> Material Type (Item No.) --> Material Version # --> Lot #

Selecting a lot opens or selects the *Plant Mix Density* test user interface form, displaying data for the selected item.
7.8 Select Ride Specification Tests

The *Ride Specification* option under the *Tests* menu can be used to select a ride specification test run for a material version of a material item to open in the *Ride Specification* test user interface form.

The *Ride Specification* tests selection option is organized as follows:

Ride Specification --> Material Type (Item No.) --> Material Version # --> Test Run

Selecting a test run opens or selects the *Ride Specification* test user interface form, displaying data for the selected item.
7.9 Select Volumetrics Tests

The *Volumetrics* option under the *Tests* menu can be used to select a volumetrics lot for a material version of a material item to open in the *Volumetrics* test user interface form.

The Volumetrics tests selection option is organized as follows:
Volumetrics --> Material Type (Item No.) --> Material Version # --> Lot #

Selecting a lot opens or selects the *Volumetrics* test user interface form, displaying data for the selected item.
8. Tools Menu Operations

8.1 Security/Control Menu

8.1.1 Specification/Data Locking Menu Option

The *Specification/Data Locking* popup from the *Security/Control* option under the *Tools* menu is used to open the *Specification/Data Locking* form for viewing and unlocking either material item/test item/material version specifications (see Unlocking Material/Test Specs) or test data lots/report/test runs (see Unlocking Test Data).

<table>
<thead>
<tr>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security/Control</td>
<td>Specification/Data Locking</td>
<td></td>
</tr>
<tr>
<td>Project DB Manager Options</td>
<td>Personnel Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Edit Local Policy</td>
<td></td>
</tr>
</tbody>
</table>
8.1.2 Personnel Management Menu Option

The Personnel Management popup from the Security/Control option under the Tools menu is used to open the Personnel Management form for adding or removing personnel access to a project or editing the privileges of personnel with access to a project (see Manage Project Personnel).
8.1.3 Edit Local Policy Menu Option

The *Edit Local Policy* popout from the *Security/Control* option under the *Tools* menu is used to access the forms for creating or editing local policies for crews or applying the local policy to contract files (see *Editing Local Policy*).
8.2  Project DB Manager Menu

8.2.1  Split Menu Option

The *Split* popout from the *Project DB Manager* option under the *Tools* menu is used to open the form for splitting testing types out to separate files for distribution to alternate locations for data entry (see *Creating Split Files For Data Entry*).
8.2.2 Merge Menu Option

The Merge popout from the Project DB Manager option under the Tools menu is used to form for merging data from split files back into the master contract file to keep the master file up to date (see Merging Data From Split Files Into Master File). Split files can also be cancelled after merge when data entry at alternate location is no longer necessary (see Cancelling Split After Merge).
8.2.3 Rebuild Split File Menu Option

The Rebuild Split File popup from the Project DB Manager option under the Tools menu is used to open the form for rebuilding previously created split files to be used for data entry (see Rebuilding Lost Or Damaged Split Files). This option should be used as last resort to replace lost or damaged split files since the rebuilt split file will only contain data that has been merged back into the master file.
8.2.4 Update Split From Master Menu Option

The Update Split From Master popout from the Project DB Manager option under the Tools menu is used to open the form for updating the test data for all test types that can’t be edited in split file (see Updating Test Data in Split File From Master). This option allows for keeping data for other test types up to date in the split files for viewing in alternate locations.
8.2.5 Push Data to HQ Menu Option

The *Push Data to HQ* popout from the *Project DB Manager* option under the *Tools* menu is used to transfer project data to headquarters for storage in the MDT Oracle database where it can be viewed by any user with access to the QA Suite (see [Transfer Data To Helena](#)).

Note: Project information must be validated and locked before the first file transfer can occur (see [Setting Up For Transfer To Helena](#)).
8.3 Options Menu

8.3.1 Options Menu Option

The **Options** option under the **Tools** menu is used to open the form for editing a user's default "Start Mode" (see Start Mode Options), "Pavement Course Descriptions" (see Pavement Course Descriptions Options) or "Save AutoRecovery" (see Save AutoRecovery Options) options settings.
8.3.2 Start Mode Options

The QA Suite is used to work with local contract files (located on the local computer or share drive in the ...\Mdtdata\Contracts\##### contract sub-folder) or to view and report information from the contract files that have been transferred in to headquarters.

The Open Project start mode option is the default for new users. In this start mode the QA Suite prompts the user to browse to and select the local QA contract file to open at startup. This is the mode used by Construction and Laboratory field personnel when working with QA data entry and reporting for their projects.

The Project Viewer start mode option is provided for the large number of users that only need to be able to view and report project data that has been transferred in to headquarters. In this start mode the QA Suite opens in the HQ Project View mode at startup.

Users that only need to work with headquarters project data can set their default login mode to start up the QA Suite in the View HQ Project Data mode by changing the start mode option in the Start Mode panel of the User Options form.

To change the default startup option select the Options option under the Tools menu option as shown below.

This will activate the User Options form as shown below.
Next, the user simply selects the **Project Viewer** option in the *Start Mode* panel and clicks on the **OK** button to save the changes as shown below.
Once this operation is completed, the QA Suite will automatically start up in the View HQ Project Data mode whenever the user starts the QA Suite with no prompting for selecting a file to open or for the user to login.

The QA Suite will start up in the Project Viewer mode as shown below.
<table>
<thead>
<tr>
<th>Contract Number</th>
<th>Control Number</th>
<th>Project Name</th>
<th>Project Number</th>
<th>Route</th>
<th>District</th>
<th>Last Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>02307</td>
<td>5795070000</td>
<td>BOULDER INTERCHANGE - N &amp; S</td>
<td>IM 15-3(70).63</td>
<td>I-15</td>
<td>Butte</td>
<td>10/05/2007 11:33</td>
</tr>
<tr>
<td>03C06</td>
<td>5067107000</td>
<td>BLACKFORD INTERCHANGE - EAST</td>
<td>IM 30-2(107).11</td>
<td>I-90</td>
<td>Missoula</td>
<td>01/07/2008 07:31</td>
</tr>
<tr>
<td>02107</td>
<td>1227980000</td>
<td>NORTH OF MANICHE - NORTH</td>
<td>MT-NH 1(108).64</td>
<td>N-1</td>
<td>Missoula</td>
<td>09/13/2007 08:43</td>
</tr>
<tr>
<td>10C06</td>
<td>5973014000</td>
<td>FLATWILLOW CREEK - N &amp; S</td>
<td>NH 61(1)(142).2</td>
<td>N-61</td>
<td>Billings</td>
<td>08/03/2007 13:02</td>
</tr>
<tr>
<td>09N05</td>
<td>03377041000</td>
<td>US 287 PASS LN S OF TOSCON</td>
<td>NH 8(4-1)(19).3</td>
<td>Butte</td>
<td>06/14/2007 13:25</td>
<td></td>
</tr>
<tr>
<td>01C06</td>
<td>5550710000</td>
<td>SOUTH HELENA INTERCHANGE</td>
<td>NH-787(1-1)(178).5</td>
<td>I-15</td>
<td>Great Falls</td>
<td>01/22/2008 04:35</td>
</tr>
<tr>
<td>01C06</td>
<td>5730042000</td>
<td>OILFIELD AVE - PATH - SHELBORNE</td>
<td>STP 5(1-1).8</td>
<td>P-57</td>
<td>Butte</td>
<td>12/04/2007 09:09</td>
</tr>
<tr>
<td>01C06</td>
<td>5020091000</td>
<td>2001 TURN 82 E OF TOWNSEND</td>
<td>STP 14(1-1)(6).2</td>
<td>P-14</td>
<td>Butte</td>
<td>07/05/2007 13:14</td>
</tr>
<tr>
<td>01C06</td>
<td>5959943000</td>
<td>HARRISON - SOUTH</td>
<td>STP 13(1-1)(35).6</td>
<td>P-13</td>
<td>Butte</td>
<td>09/05/2007 13:14</td>
</tr>
<tr>
<td>01C06</td>
<td>1510090000</td>
<td>EAST OF TOWNSEND</td>
<td>STP 14(1-1)(96).2</td>
<td>P-14</td>
<td>Butte</td>
<td>12/04/2007 09:09</td>
</tr>
<tr>
<td>25106</td>
<td>2461009003</td>
<td>ANGELA - N &amp; S</td>
<td>STP 18(1-1)(91).9</td>
<td>P-18</td>
<td>Glendive</td>
<td>10/18/2007 14:29</td>
</tr>
</tbody>
</table>

Monday, January 21, 2008 8:47:42 PM
8.3.3 Pavement Course Descriptions Options

Paving material is placed in courses. The placement of the material is tracked and reported by the course description and lift number on the Placement Summary tab form in the Daily Plant Mix Report.

The QA Suite has a number of default Course Descriptions that are available for use when entering Placement Summary information in Daily Plant Mix Reports.

There are a number of standard course descriptions that can apply for project paving operations. The Pavement Course Descriptions panel on the Options form contains the initial set of course descriptions provided for selection in the Daily Plant Mix Reports Placement Summary tab.

Users can edit this list to add or remove course descriptions to better suit their needs. By making the changes to this list, the course description will be available for selection in the initial set of course descriptions in the Daily Plant Mix Reports Placement Summary tab for all projects the user is working on.

To change the default Pavement Course Descriptions options select the Options option under the Tools menu option as shown below.

This will activate the User Options form as shown below.
When new users log in to the QA Suite the Pavement Course Description panel will contain the default list of course descriptions as shown above.

To add a pavement course description simply select the Add button as shown below.
The pavement course description text box at the bottom of the panel will be enabled and the Add button will be replaced by a Save button.

To add the new pavement course description simply type the new description in the text box and select the **Save** button as shown below.
To cancel the add operation select the **Cancel** button.
The new description will be added to the list of Pavement Course Descriptions and the Save button will be replaced by an Add button, as shown below.
To edit a pavement course description simply select the description in the list and select the **Edit** button, as shown below.
The selected pavement course description will be loaded into the text box at the bottom of the panel and the Add button will be replaced by a Save button.

To change the new pavement course description simply make the changes to the description in the text box and select the **Save** button as shown below. To cancel the edit operation select the **Cancel** button.
The description will be modified in the list of Pavement Course Descriptions and the Save button will be replaced by an Add button, as shown below.
To delete a pavement course description simply select the description in the list and select the **Delete** button, as shown below.
A **Confirm Delete** form will be displayed, prompting for confirmation of the deletion of the selected course description, as shown below.

Select **Yes** to complete the deletion process, returning to the User Options form with the course description removed from the list, as shown below. Select **No** to cancel the deletion process, returning to the User Options form with the course description still in the list.
Select the **OK** button to save the *Pavement Course Description* changes and close the *User Options* form.
Select the **Cancel** button to close the *User Options* form without saving the changes.
8.3.4 Save AutoRecovery Options

When using the QA Suite to work with local contract files (located on the local computer or share drive in the ...\Mdtdata\Contracts##### contract sub-folder), the program loads the current copy of the file into memory and all operations on the file as done in memory. The changes are only actually saved to the local contract file when a Save operation is performed.

Because there is a risk of abnormal termination of the program without changes stored in memory being saved, an AutoRecovery option was added to the QA Suite.

The AutoRecovery option is similar to the auto-recovery option in Microsoft Word. While working on a file, a temporary backup copy of the file loaded in memory (included changes made to the file) is saved at a predetermined time interval to a location on the local computer.

If the QA Suite program terminates abnormally, the last backup copy of the file is still available to be recovered. Hence, the only changes that should be lost would be those that may have been performed within the preset backup time interval of the last backup copy being made.

In other words, if the preset time interval is 10 minutes, then no more than 10 minutes worth of changes should be lost when reverting to a backup copy of a file.

To change the Save AutoRecovery options select the Options option under the Tools menu option as shown below.

This will activate the User Options form as shown below.
When new users log in to the QA Suite the *Save AutoRecovery info every:* option is checked and the save interval is set to 10 minutes, as shown above.

The ability to un-check the *Save AutoRecovery info every:* option has been provided for the unlikely occurrence of a problem arising with the AutoRecovery functioning in the program.

**Unless otherwise directed by your management or technical support staff, DO NOT REMOVE the *Save AutoRecovery info every:* CHECKMARK!!!**

The default save interval is 10 minutes. This interval should be fine for most users' purposes. However, if desired, the interval can be changed by using the up and down arrows in the save interval selection control, as shown below.
Use the up arrow to increase the save interval and the down arrow to decrease the save interval.

The save interval can be set to as little as once every minute. However, this will cause the QA Suite program to pause every minute, potentially interrupting your work, while a backup of the file is saved. This should only be necessary if you are an EXTREMELY fast typist.

Select the OK button to save the Save AutoRecovery options changes and close the User Options form.
Select the Cancel button to close the User Options form without saving the changes.

Note: For help with recovering a file see the File Recovery topic.
8.4 Gradation Calculator
8.4.1 Gradation Calculator
The Gradation Calculator is a tool to perform the math involved in calculating gradation results.

The first step is to select the sieves. There are two options for selecting the sieves. Either click the Select Sieves button to select the sieves, or click the Select Sieves for a Material button to select the sieves. Once the sieves have been selected, enter the Begin Weight as shown below.
Then enter the Cumulative Weight Retained for each sieve above the break sieve as shown below.
Note: The weight passing and percent passing are calculated after each cumulative weight entry is completed.

Then enter the Weight Before Wash and the Weight After Wash as shown below.
Then enter the Cumulative Weight Retained for each sieve below the break sieve as shown below.
8.4.2 Select Sieves

The Select Sieves window is used to select the sieves for the Gradation Calculator.

The Add -, <- Remove, Add All ->> and <<- Remove All buttons are used to move items between the lists (see List View Operations).

Select the sieves that are required, then click the Add button as shown below.

The selected sieves will be added to the Selected Sieves: list as shown below. Next, select the Break Sieve as shown below.
Once the sieves have been selected and the break sieve has been selected, click the OK button as shown below.

The sieves will be transferred to the Gradation Calculator as shown below.
### Gradation Calculator

**Description:**

- **Begin Weight:** 
  - **Sieve:** 5/8” \ 16 mm 
  - **Cum Wt Retained:** 
  - **Wt Passing:** 
  - **Pct Passing:** 

- **Units:**
  - English
  - Metric

**Weight Before Wash:**

- **#8:** 2.360 mm 
- **#40:** 0.425 mm 
- **#90:** 0.180 mm 
- **#200:** 0.075 mm

**Weight After Wash:**

- **g**

**Project Viewer**

- **MDT Quality Assurance Suite - Gradation Calculator**

**File** **View** **Tools** **Window** **Help**

**Close**

**Select Sieves**

**Select Sieves for a Material**

**Clear**

**Thursday, May 07, 2009 11:15:32 AM**
8.4.3 Select Sieves for a Material

The **Gradation Calculator Sieves** window is used to populate the **Gradation Calculator** with the sieves for an aggregate spec from the QA Specification database.

Select the aggregate from the list and then click the OK button as shown below.
The sieves for the selected aggregate will be transferred to the Gradation Calculator as shown below.

![Gradation Calculator Sieves](image)

The sieves for the selected aggregate will be transferred to the Gradation Calculator as shown below.
8.5 Random Asphalt Mat Sampling

8.5.1 Random Asphalt Mat Sampling

The Random Asphalt Mat Sampling tool is designed to generate random sampling locations on an asphalt material when paving. Sampling is based on tonnage. Given the material width and thickness, a random station location is generated for an interval length determined for the given tonnage. Depending on the material width, a random offset is generated from the materials edge. You may generate as many sample locations as needed per run. Sample numbering may begin at any number, and the stationing can start at any station.

The tonnage, material width and thickness are used to determine the sample interval length. The width is also used when generating random offsets. By varying the beginning sample number, station and the number of samples, you have the flexibility in generating the random samples location report. Stationing can also be in reverse.
9. Window Menu Operations

9.1 Aggregate Testing Menu Option

The Aggregate Testing option under the Window menu is used to select the Aggregate Testing test user interface form.

Note: The Window menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see Opening A Test Form.
9.2 Aggregate Surfacing Density Menu Option

The Aggregate Surfacing Density option under the Window menu is used to select the Aggregate Surfacing Density test user interface form.

Note:
The Window menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see Opening A Test Form.
9.3 Concrete Specs Menu Option

The *Concrete Specs* option under the *Window* menu is used to select the *Concrete Specs* test user interface form.

**Note:**
The *Window* menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see [Opening A Test Form](#).
9.4   Daily Plant Mix Reports Menu Option

The *Daily Plant Mix Reports* option under the *Window* menu is used to select the *Daily Plant Mix Reports* test user interface form.

**Note:**
The *Window* menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see [Opening A Test Form](#).
9.5 Marshall Testing Menu Option

The Marshall Testing option under the Window menu is used to select the Marshall Testing test user interface form.

**Note:**
The Window menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see Opening A Test Form.
9.6 Plant Mix Density Menu Option

The *Plant Mix Density* option under the *Window* menu is used to select the *Plant Mix Density* test user interface form.

**Note:**
The *Window* menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see [Opening A Test Form](#).
9.7 Ride Specification Menu Option

The *Ride Specification* option under the *Window* menu is used to select the *Ride Specification* test user interface form.

**Note:**
The *Window* menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see [Opening A Test Form](#).
9.8 Volumetric Testing Menu Option

The *Volumetric Testing* option under the *Window* menu is used to select the *Volumetric Testing* test user interface form.

**Note:**
The *Window* menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening a test form see [Opening A Test Form](#).
9.9 Pay Summary Menu Option

The Pay Summary option under the Window menu is used to select the Pay Summary results form.

Note: The Window menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening the Pay Summary form see Pay Summary.
9.10 Plant Mix Summary Menu Option

The *Plant Mix Summary* option under the *Window* menu is used to select the *Plant Mix Summary* results form.

**Note:**
The *Window* menu option provides a selection of all open forms to allow the user to bring an open form to the front. These menu options are only displayed when the associated form is already open. For information on opening the *Plant Mix Summary* form see *Plant Mix Summary*. 
10. Help Menu Operations

10.1 Index

The **Help Menu --> Index** option opens the help file with the index displayed, as shown below.

![Image of QA Suite Help window with Index tab active]
10.2 Contents

The *Help Menu --> Contents* option opens the help file with the table of contents displayed, as shown below.
10.3 Search

The **Help Menu --> Search** option opens the help file with the search option displayed.
10.4 About QA Suite

The Help Menu --> About QA Suite option displays the splash screen, which indicates the program name and version, as shown below.

When done viewing the information, click on the splash screen to close the screen.
10.5 View Users Manual

The Help Menu --> View Users Manual option opens the PDF version of the QA Suite User's Manual, as shown below.
11. Working With Material Items And Test Specs

11.1 Setting Up Material Items and Test Specs

11.1.1 Editing Material Items

11.1.1.1 Delete Extra Material Items
Since some bid items consist of multiple possible material items, the original contract file created contains all of the possible material items that could be selected by the contractor. As part of the Material Specifications editing, the extra material items that will not be used will need to be deleted.

Material Specs editing can only be performed by users with one of the following roles:
1. EPM
2. Field Office Person
3. Lab Supervisor

To delete extra material items, first open the file in the QA Suite (see Start and Log In to QA Suite).

After logging in, the file will be opened in the QA Suite with the main window displayed as shown below.

The material item test data user interfaces will not be displayed until the material and test specs have been set. Hence, the user must set up the Materials and Test Specs before proceeding with the test data entry. To do this, select the Materials Summary option from the Specifications menu dropdown as shown below.

This will activate the Materials Summary tab as shown below.
To delete a material item first select the material item from the list of Existing Material Items and then click on the **Delete Selected** button. For example, the contractor has chosen to use Crushed Base Course Type A Grade 6 for the Crushed Aggregate Course for this project. Hence, the Crushed Base Course Type A Grade 5 and Crushed Top Surfacing Type A Grade 2 material items can be deleted. To do this, first select the material item to be deleted (Crushed Base Course Type A Grade 5 in this case) and then click the **Delete Selected** button as shown below.

The Material Item will be removed from the Existing Material Items list, as shown below.
Continue selecting and deleting the extra material items until only the material items required for
the project remain in the *Existing Material Items* list, as shown below.

Now that all of the extra material items have been deleted you are ready to continue with editing
the Material and Test Specifications for the remaining material items and associated tests (see
[Select and Edit Material Item](#)).
11.1.1.2 Select and Edit Material Item
After logging in (see Start and Log In to QA Suite), the file will be opened in the QA Suite with the main window displayed as shown below.

The material item test data user interfaces will not be displayed until the material and test specs have been set. Hence, the user must set up the Materials and Test Specs before proceeding with the test data entry. To do this, select the Materials Summary option from the Specifications menu dropdown as shown below.

This will activate the Materials Summary tab as shown below. At this point, the extra Material Items should have been deleted in the previous step (see Delete Extra Material Items) so only the necessary Material Items should be visible in the Existing Material Items list.
The next step is to edit the material item.

To edit a material item, first select the material item from the list of *Existing Material Items* and then click on the **Edit Selected** button as shown below.

To edit the material information for a "COVER MATERIAL" material item, select the "COVER MATERIAL" material item from the list of existing material items and click on the **Edit Selected** button (see [Edit "Cover Material" Material Item](#)).
To edit the material information for a CRUSHED BASE COURSE material item, select the CRUSHED BASE COURSE material item from the list of existing material items and click on the **Edit Selected** button (see [Edit Crushed Base Course Material Item](#)).

To edit the material information for a PLANT MIX BIT SURF GR S material item, select the PLANT MIX BIT SURF GR S material item from the list of existing material items and click on the **Edit Selected** button (see [Edit Plant Mix Bit Surf Grade S Material Item](#)).

To edit the material information for a PLANT MIX GR D material item, select the PLANT MIX GR D material item from the list of existing material items and click on the **Edit Selected** button (see [Edit Plant Mix Grade D Material Item](#)).

After completing Material Item Definition editing the next step is to mark the material item editing as complete (see [Mark Material Item Editing as Complete](#)).

After marking the Material Item Definition editing as complete, the test types list near the bottom of the **Materials Summary** window will be displayed. The list contains all of the test types required for the material item (potential test types are: *Aggregate Gradations, Concrete Specs, Daily Plant Mix Report, Marshall Testing, Plant Mix Density, Ride Specification* and *Volumetric Testing*).

The next step is to edit the Material Information for each test type that is part of the material item (see [Select and Edit Test Specs](#)).
11.1.1.3 Mark Material Item Editing as Complete

When all Material Item Definition edits are complete the next step is to mark the material item editing as complete as described below.

When all of the specification item entries have been completed for a material item, the Validation Errors message section at the bottom of the form is closed and the Edit Complete button is enabled, as shown below.

The Edit Complete button is provided to allow for designating that editing is complete and the material item specifications are ready for review.
When all Material Item Definition edits are complete the next step is to mark the material item editing as complete. To do this, click the **Edit Complete** button, as shown below.

Then click the **OK** button, as shown below.
This completes the marking of the material item editing as complete, changing the status to *Currently awaiting Specification Review* as shown below. Once the Material Item Definition editing is marked as complete, all of the test types associated with the material item are displayed in the list of test types in the lower section of the window, as shown below. In this case, for example, the Aggregate Gradations, Daily Plant Mix Report, Plant Mix Density, Ride Specification and Volumetric Testing test types.
The next step is to edit the Material Information for each test type that is part of the material item (see Select and Edit Test Specs).
11.1.1.4 Edit Plant Mix Bit Surf Grade S Material Item
To edit a Plant Mix Bituminous Surfacing Grade S material item, first select the material item from the list of Existing Material Items and then click on the Edit Selected button as shown below.

The Edit Material Item Definition window will display as shown below.
When editing Plant Mix Grade S material, the **Unit Cost**, **Contract Quantity**, **Sieve Targets**, **VMA**, **VFA**, **VTM**, **Dust/Asphalt Ratio** and **Pit Lab Number** must be set as shown in the **Validation Errors** section at the bottom of the window.

**Note:** The Pit Lab Number must be set for Plant Mix material.

First, enter the Unit Cost, Base Price, Contract Quantity and Pit Lab Number in their appropriate text box entry locations as shown below.
As can be seen in the *Validation Errors* section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For
example, in this case, the Unit Cost and Contract Quantity validation error messages are no longer being displayed since they have been correctly input.

Since the Aggregate Gradation Specs are part of the Material Item definition they must be edited as part of the Material Item editing. To edit the aggregate specification, click the **Edit Aggregate Spec** button as shown below.
The *Add Aggregate Spec* window will display as shown below.
The **Select Sieves** button is used to add or remove sieves as necessary. For example, for this project, the 1" sieve was not used for the gradations so we will remove the 1" sieve. To do this, first click on the **Select Sieves** button as shown below.
The **Select Sieves** window will be displayed.
The Add ->, <- Remove, Add All ->> and <<- Remove All buttons are used to move items between the lists (see List View Operations).

For example, to remove the 1" Sieve, select the 1" \ 25 mm sieve selection from the Selected Sieves: list, then click the <- Remove button as shown below.

The 1" \ 25 mm sieve will be removed from the Selected Sieves: list and returned to the Possible Sieves: list, as shown below.
When the correct sieves have been selected, click the **OK** button to return to the *Add Aggregate Spec* window.

Note: If new sieves are added to the *Selected Sieves:* list, the *Edit Sieve Spec* window will be displayed, prompting the user to set up the sieve spec for each new sieve that has been added (see *Setting Up Aggregate Sieve Specs*) before returning to the *Add Aggregate Spec* window.

Although the desired sieves have been selected, the editing of the sieve specs is not yet complete. As can be seen in the *Validation Errors:* section at the bottom of the form shown below, the targets need to be set for various sieves. Also, since the **1" / 25 mm** sieve was the Break Sieve before it was removed, a new Break Sieve will need to be selected.

To edit the specs for a sieve simply select the sieve from the *Sieves for Gradation Spec:* list. For example, selecting the **3/4" / 19 mm** sieve, as shown below, displays the current specs for the selected sieve are displayed in the *Spec for Selected Sieve* panel.
As shown in the Validation Errors section at the bottom of the window, when editing Sieve Specs the Break Sieve, Target Value, and/or Minimum Value, and/or Maximum Value must be set for each sieve that is not a non-spec sieve. Additionally, the F Factor must be set for each sieve that is a deduct sieve.
As can be seen in the Validation Errors: section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the Break Sieve and 3/4" \ 19 mm Sieve Target Value validation error messages are no longer being displayed since they have been correctly input.
Note that as the Target Value is entered, the input value is validated to confirm that the value is within the range of allowable target values (shown in the parenthesis after the Target input box as shown below). After tabbing out of the target value input text box an *Improper Value* window will be displayed notifying that the entered value should be between the minimum and maximum allowable target values, as shown below.
After choosing the **OK** button on the **Improper Value** form, the form will close and the cursor will be set to the **Target:** text input box for the user to revise the input Target value, as shown below.

Once all of the required spec sieve entries have been completed, the **Validation Errors** message section at the bottom of the form will close and the **OK** button will be enabled to allow for completion of the editing.

To set the Fracture, click the **Related Specifications** tab, then select the **MT217-Fracture** Requirement under the **Requirements for Aggregate** list and set the minimum fracture value in the **Min:** text entry box and select the **Deduct** option and enter the associated **F Factor:**, as shown below.
When the Aggregate Specification editing is completed, click the OK button to return to the Edit Material Item Definition window as shown below.
To set the VMA, VFA, VTM and Dust/Asphalt Ratio, click the *Other Specifications* tab, then select the *MT-322-Gyratory* Specification, and then click the *Edit Selected* button, as shown below.
The **MDT Edit Specification Definition** window will be displayed, as shown below. As shown in the **Validation Errors** section at the bottom of the window, when editing MT332_GyratoryMethod specifications the target values must be set for the **VMA**, **VFA**, **VTM** and **Dust/Asphalt Ratio**.
To set the target values for each item first select the item in the *Specification Items* list and then enter the target value in the *Target:* text entry box. For example, to set the VMA target value, select the VMA item in the *Specification Items* list and enter the VMA target value in the *Target:* text entry box as shown below.
As can be seen in the Validation Errors: section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the VMA and VFA Target Value validation error messages are no longer being displayed since they have been correctly input.
Note that as the Target Value is entered, the input value is validated to confirm that the value is within the range of allowable target values (shown in the parenthesis after the Target input box as shown below). After tabbing out of the target value input text box an **Improper Value** window will be displayed notifying that the entered value should be between the minimum and maximum allowable target values, as shown below.
After choosing the **OK** button on the *Improper Value* form, the form will close and the cursor will be set to the *Target:* text input box for the user to revise the input Target value, as shown below.

Once all of the required MT332_GyratoryMethod specification item entries have been completed, the *Validation Errors* message section at the bottom of the form will close and the **OK** button will be enabled to allow for completion of the editing as shown below.
When the MT332_GyratoryMethod specification definition editing is completed, click the **OK** button to return to the *Edit Material Item Definition* window as shown below.
Notice that since all of the specification item entries have been completed, the Validation Errors message section at the bottom of the form is closed and the Edit Complete button is enabled to allow for designating that editing is complete and the specifications are ready for review, as shown above.

When all Material Item Definition edits are complete the next step is to mark the material item editing as complete (see Mark Material Item Editing as Complete). This is accomplished by clicking the Edit Complete button.

Click the OK button to close the Edit Material Item Definition form.
This completes the editing for the material item, changing the status to *awaiting Specification Review* as shown below. Once the Material Item Definition editing is completed, all of the test types associated with the material item are displayed in the list of test types in the lower section of the window, as shown below. In this case, for example, the Aggregate Gradations, Daily Plant Mix Report, Plant Mix Density, Ride Specification and Volumetric Testing test types are displayed in the list.

Note: As shown above in the test types list near the bottom of the window, when editing Plant Mix Bit Surf GR 2 - 19 MM material items, the material information must be set for the Aggregate Gradations, Daily Plant Mix Report, Plant Mix Density, Ride Specification and Volumetric Testing test types.
After completing Material Item Definition editing, the next step is to edit the Material Information for each test type that is part of the material item (see Select and Edit Test Specs).

To edit the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the Edit button (see Edit Aggregate Gradations Test Specs).

To edit the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the Edit button (see Edit Daily Plant Mix Report Test Specs).

To edit the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the Edit button (see Edit Plant Mix Density Test Specs).

To edit the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the Edit button (see Edit Ride Specification Test Specs).

To edit the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the Edit button (see Edit Volumetric Testing Test Specs).

After marking all of the editing as complete for all of the test types the next step is to edit the material version information and/or mark the material version editing as complete (see Edit Material Version Information and Mark Material Item Editing as Complete).

Once this is done the material item information, test specs and material version are ready for review.
11.1.1.5 Edit Plant Mix Grade D Material Item
To edit a Plant Mix Grade D material item, first select the material item from the list of *Existing Material Items* and then click on the **Edit Selected** button as shown below.

The **Edit Material Item Definition** window will display as shown below.
When editing Grade D Plant Mix material, the Unit Cost, Contract Quantity, Sieve Targets and Pit Lab Number must be set as shown in the Validation Errors section at the bottom of the window.

Note: The Pit Lab Number must be set for Plant Mix material.
First, enter the Unit Cost, Base Price, Contract Quantity and Pit Lab Number in their appropriate text box entry locations as shown below.
As can be seen in the *Validation Errors:* section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the Unit Cost and Contract Quantity validation error messages are no longer being displayed since they have been correctly input.

Since the Aggregate Gradation Specs are part of the Material Item definition they must be edited as part of the Material Item editing. To edit the aggregate specification, click the **Edit Aggregate Spec** button as shown below.
The **Add Aggregate Spec** window will display as shown below.
The **Select Sieves** button is used to add or remove sieves as necessary. For this example, since the default sieves are set correctly for this material item there is no need to add or remove sieves.

To edit the specs for a sieve simply select the sieve from the *Sieves for Gradation Spec:* list. For example, selecting the **1/2" \ 12.5 mm** sieve, as shown below, displays the current specs for the selected sieve are displayed in the *Spec for Selected Sieve* panel.
As shown in the Validation Errors section at the bottom of the window, when editing Sieve Specs the Break Sieve, Target Value, and/or Minimum Value, and/or Maximum Value must be set for each sieve that is not a non-spec sieve. Additionally, the F Factor must be set for each sieve that is a deduct sieve.

As can be seen in the Validation Errors: section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the 1/2" \ 12.5 mm Sieve Target Value validation error messages are no longer being displayed since they have been correctly input.
Once all of the required spec sieve entries have been completed, the Validation Errors message section at the bottom of the form will close and the OK button will be enabled to allow for completion of the editing.
To set the Fracture, click the **Related Specifications** tab, then select the **MT217-Fracture** Requirement under the **Requirements for Aggregate** list and set the minimum fracture value in the **Min:** text entry box and select the **Deduct** option and enter the associated **F Factor:**, as shown below.
When the Aggregate Specification editing is completed, click the **OK** button to return to the *Edit Material Item Definition* window as shown below.
To view the Stability, Flow and Air Voids, click the **Other Specifications** tab, then select the *MT-311-Marshall* Specification. To edit any of the values click the **Edit Selected** button, as shown below.
The **MDT Edit Specification Definition** window will be displayed, as shown below. The Marshall test parameter values are set up as part of the Material Item definition so there should not be a need to edit the Marshall test parameter items. As shown in the list of Specification Items, when editing MT311_MarshallMethod specifications the minimum or range of values are set for the **Stability**, **Flow** and **Air Voids**.
To view or edit the minimum or range values for each item first select the item in the **Specification Items** list. The minimum value will be displayed in the **Min:** text entry box and the maximum value will be displayed in the **Max:** text entry box. For example, to view or edit the Stability minimum value, select the Stability item in the **Specification Items** list and view or edit the Stability minimum value in the **Min:** text entry box as shown below.
Similarly, to view or edit the Flow minimum and maximum values, select the Flow item in the *Specification Items* list and view or edit the Flow minimum value in the *Min:* text entry box or maximum value in the *Max:* text entry box as shown below.
Similarly, to view or edit the Air Voids minimum and maximum values, select the Air Voids item in the *Specification Items* list and view or edit the Air Voids minimum value in the *Min:* text entry box or maximum value in the *Max:* text entry box as shown below.
When the MT311_MarshallMethod specification definition editing is completed, click the **OK** button to return to the *Edit Material Item Definition* window as shown below.
Notice that since all of the specification item entries have been completed, the *Validation Errors* message section at the bottom of the form is closed and the **Edit Complete** button is enabled to allow for designating that editing is complete and the specifications are ready for review, as shown above.

When all Material Item Definition edits are complete the next step is to mark the material item editing as complete (see [Mark Material Item Editing as Complete](#)). This is accomplished by clicking the **Edit Complete** button, as shown below.
Click the **OK** button, as shown below, to close the *Edit Material Item Definition* form.
This completes the editing for the material item, changing the status to *awaiting Specification Review* as shown below. Once the Material Item Definition editing is completed, all of the test types associated with the material item are displayed in the list of test types in the lower section of the window, as shown below. In this case, for example, the Aggregate Gradations, Daily Plant Mix Report, Marshall Testing and Plant Mix Density test types are displayed in the list.
Note: As shown above in the test types list near the bottom of the window, when editing Plant Mix GR D material items, the material information must be set for the **Aggregate Gradations**, **Daily Plant Mix Report**, **Marshall Testing** and **Plant Mix Density** test types.

After completing Material Item Definition editing, the next step is to edit the Material Information for each test type that is part of the material item (see **Select and Edit Test Specs**).

To edit the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the **Edit** button (see **Edit Aggregate Gradations Test Specs**).

To edit the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the **Edit** button (see **Edit Daily Plant Mix Report Test Specs**).
To edit the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the **Edit** button (see [Edit Marshall Testing Test Specs]).

To edit the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the **Edit** button (see [Edit Plant Mix Density Test Specs]).

After completing the editing for all of the test types the next step is to mark the editing as complete for all of the test types (see [Mark Test Spec Editing as Complete]).

After marking all of the editing as complete for all of the test types the next step is to edit the material version information and/or mark the material version editing as complete (see [Edit Material Version Information] and [Mark Material Version Editing as Complete]).

Once this is done the material item information, test specs and material version are ready for review.
11.1.1.6 Edit "Cover Material" Material Item
To edit a "Cover Material" material item, first select the material item from the list of Existing Material Items and then click on the Edit Selected button as shown below.

The Edit Material Item Definition window will display as shown below.
When editing "Cover Material" material, the Unit Cost and Contract Quantity must be set as shown in the Validation Errors section at the bottom of the window.

**Note:** The Pit Lab Number is optional for "Cover Material".
First, enter the Unit Cost, Base Price, Contract Quantity and Pit Lab Number in their appropriate text box entry locations as shown below.

As can be seen in the Validation Errors: section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the Unit Cost and Contract Quantity validation error messages are no longer being displayed since they have been correctly input.
Since the Aggregate Gradation Specs are part of the Material Item definition they must be edited as part of the Material Item editing. To edit the aggregate specification, click the **Edit Aggregate Spec** button as shown below.

The **Add Aggregate Spec** window will display as shown below.
The Select Sieves button is used to add or remove sieves as necessary. In this example, since all of the necessary sieves are already included as part of the default material item definition there is no need to add or remove sieves.

For this "Cover Material" type the #4 \ 4.740 mm and #200 \ 0.075 mm meshes are deduct sieves with F Factors of 2 and 3 respectively.

By selecting the #4 sieve from the list of Sieves for Gradation Spec as shown above, review shows that the sieve is already set as a deduct sieve with an F Factor of 2 and no modifications are necessary for the #4 sieve.

By selecting the #200 sieve from the list of Sieves for Gradation Spec as shown below, review shows that the sieve is already set as a deduct sieve with an F Factor of 3 and no modifications are necessary for the #200 sieve.
To edit the related specifications for the "Cover Material" aggregates item, first select the **Related Specifications** tab as shown below.
The information on the **Related Specifications** tab will be displayed as shown below. As shown in the **Validation Errors:** section at the bottom of the window, F Factor must be set for the Fracture since the specification is set as a deduct item.
Enter the F Factor value in the F Factor text box as shown above. After tabbing out of the F Factor text box the validation error will be corrected and the OK button will be enabled. Click on the OK button to close the Add Aggregate Spec window, returning to the Edit Material Item Definition window as shown below.
Notice that since all of the specification item entries have been completed, the Validation Errors message section at the bottom of the form is closed and the **Edit Complete** button is enabled to allow for designating that editing is complete and the specifications are ready for review, as shown above.

When all Material Item Definition edits are complete the next step is to mark the material item editing as complete (see **Mark Material Item Editing as Complete**). This is accomplished by clicking the **Edit Complete** button, as shown above.

Click the **OK** button, as shown below, to close the **Edit Material Item Definition** form.
This completes the editing for the material item, changing the status to *awaiting Specification Review* as shown below. Once the Material Item Definition editing is completed, all of the test types associated with the material item are displayed in the list of test types in the lower section of the window, as shown below. In this case, for example, only the Aggregate Gradations test type is displayed in the list.
Note: As shown above in the test types list near the bottom of the window, when editing "Cover Material" material items, the material information must be set for the *Aggregate Gradations* test type.

After completing Material Item Definition editing, the next step is to edit the Material Information for each test type that is part of the material item (see *Select and Edit Test Specs*).

To edit the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the **Edit** button as shown below (see *Edit Aggregate Gradations Test Specs*).
The **Add Aggregate Spec** window will be displayed as shown below.
Since the Gradation Specs and the Related Specifications were set up as part of the Material Item editing there is no need to edit these items. However, the default lot size needs to be set (the default size used for new lots when they are added). This is done by entering the default lot size in the text box next to the **Default Lot Size:** label.

The default lot size for "Cover Material" material is 178,500 m². However, in this case there will only be one lot with a lot size of 70,656 m² so the default lot size is entered as 70656 as shown below.
Once the default lot size is entered, click the **Edit Complete** button, as shown below.
Then click the **OK** button, as shown below.
This completes the editing for the Aggregate Gradations test type material information. The Add Aggregate Spec form will close, returning to the main form with the Aggregate Gradations test spec status changed to *Currently in Specification Review Mode* as shown below.
Once the material item information and all of the test types have been placed into Specification Review status (Edit Completed has been selected for the material item and all tests), the material version Edit Complete button will be displayed next to the Edit Material Version button at the top of the Material Version Info for Selected Item panel.

To mark the Material Version ready for specification review click on the Edit Complete button as shown below.
This completes the editing for the Material Item Material Version information, changing the status to *Currently in Specification Review Mode* as shown below.
The material item information, test specs and material version are now ready for review.
11.1.1.7 Edit Crushed Base Course Material Item
To edit a Crushed Base Course material item, first select the material item from the list of *Existing Material Items* and then click on the **Edit Selected** button as shown below.

![Edit Crushed Base Course Material Item](image)

The **Edit Material Item Definition** window will display as shown below.
When editing Crushed Base Course material, the **Unit Cost**, **Contract Quantity** and **Sieve Targets** must be set as shown in the **Validation Errors** section at the bottom of the window.

**Note:** The Pit Lab Number is optional for Crushed Base Course material.
First, enter the Unit Cost, Base Price and Contract Quantity in their appropriate text box entry locations as shown below.

![Edit Material Item Definition](image-url)
As can be seen in the Validation Errors: section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the Unit Cost and Contract Quantity validation error messages are no longer being displayed since they have been correctly input.

Since the Aggregate Gradation Specs are part of the Material Item definition they must be edited as part of the Material Item editing. To edit the aggregate specification, click the Edit Aggregate Spec button as shown above.

The Add Aggregate Spec window will display as shown below.
The **Select Sieves** button is used to add or remove sieves as necessary. For example, for this project, the 2" sieve was not used for the gradations so we will remove the 2" sieve. To do this, first click on the **Select Sieves** button as shown below.

The **Select Sieves** window will be displayed.
The **Add ->**, **< - Remove**, **Add All ->>** and **< - Remove All** buttons are used to move items between the lists (see [List View Operations](#)).

For example, to remove the 2" Sieve, select the **2" \ 50 mm** sieve selection from the *Selected Sieves:* list, then click the **<- Remove** button as shown below.

The **2" \ 50 mm** sieve will be removed from the *Selected Sieves:* list and returned to the *Possible Sieves:* list, as shown below.

For this project, the 1/2" sieve was used for the gradations so we will add the 1/2" sieve. To do this, select the **1/2" \ 12.5 mm** sieve selection from the *Selected Sieves:* list, then click the **Add->** button as shown below.
The **1/2" \ 12.5 mm** sieve will be removed from the *Possible Sieves:* list and added to the *Selected Sieves:* list, as shown below.

When the correct sieves have been selected, click the **OK** button to return to the *Add Aggregate Spec* window.

Since the **1/2" \ 12.5 mm** sieve was added to the *Selected Sieves:* list, the *Edit Sieve Spec* window will be displayed, prompting the user to set up the sieve spec for the new sieve that was added (see [Setting Up Aggregate Sieve Specs](#)) before returning to the *Add Aggregate Spec* window.
As can be seen in the Validation Errors: section at the bottom of the window, when a new spec is added the Spec Type must be set for the sieve. Since the 1/2" sieve is not required as part of the material's aggregate gradation specification, choose the Not a Spec Sieve option as shown below.

Note that all of the other set-up options disappear since they are not required for non-spec sieves. Since there are not more required set-up options, the Validation Errors message section
at the bottom of the form will close and the **OK** button will be enabled to allow for completion of the editing as shown below.

![Edit Sieve Spec](image.png)

Click on the **OK** button to close the *Edit Sieve Spec* form and return to the *Add Aggregate Spec* window as shown below.
Although the desired sieves have been selected, the editing of the sieve specs is not yet complete. As can be seen in the Validation Errors: section at the bottom of the form shown above, the targets need to be set for various sieves.

To edit the specs for a sieve simply select the sieve from the Sieves for Gradation Spec: list. For example, selecting the $3/4" \ 19$ mm sieve, as shown below, displays the current specs for the selected sieve are displayed in the Spec for Selected Sieve panel.

Since the default gradation specs that were set up for this material item are correct for this project the only required input for this sieve is the target value which in this case is "86" which has been entered into the Target: text box as shown below.
As can be seen in the *Validation Errors:* section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the **3/4" \ 19 mm** Sieve Target Value validation error messages are no longer being displayed since they have been correctly input.

![Image of information on adding aggregate spec with validation messages]

Next, the target value for the **3/8" \ 9.5 mm** sieve is entered in the *Target:* value text box as shown below.
For the #4 \ 4/750 mm sieve the material item for this project called for a tolerance of 9. Since the default tolerance for this sieve for this material item was set to 12 the tolerance will need to be changed.

To change the tolerance, click the **Change Spec Type** button as shown below.
The *Edit Sieve Spec* form will be displayed as shown below. To change the tolerance, first select the *Tolerance:* text box as shown below.
Then, enter the desired tolerance value (in this case 9) and click on the **OK** button as shown below.

The *Edit Sieve Spec* form will close, returning to the *Add Aggregate Spec* window with the new tolerance value as shown below.
Next, the target value for the #4 \( 4.750 \text{ mm} \) sieve is entered in the Target: value text box as shown below.
Then, the target value for the $\#40 \ \text{0.425 mm}$ sieve is entered in the Target: value text box as shown below.
Finally, the target value for the \( \#200 \ \ 0.075 \text{ mm} \) sieve is entered in the Target: value text box as shown below.

Since all of the specification item entries have been completed, the Validation Errors message section at the bottom of the form is closed and the OK button is enabled.

Click on the OK button to close the Add Aggregate Spec form as shown below.
The Edit Material Item Definition window will be re-displayed.

Notice that since all of the specification item entries have been completed, the Validation Errors message section at the bottom of the form is closed and the **Edit Complete** button is enabled to allow for designating that editing is complete and the specifications are ready for review, as shown above.

When all Material Item Definition edits are complete the next step is to mark the material item editing as complete (see Mark Material Item Editing as Complete). This is accomplished by clicking the **Edit Complete** button, as shown below.
Click the **OK** button, as shown below, to close the *Edit Material Item Definition* form.
This completes the editing for the material item, changing the status to *awaiting Specification Review* as shown below. Once the Material Item Definition editing is completed, all of the test types associated with the material item are displayed in the list of test types in the lower section of the window, as shown below. In this case, for example, only the Aggregate Gradations test type is displayed in the list.
Note: As shown above in the test types list near the bottom of the window, when editing "Cover Material" material items, the material information must be set for the Aggregate Gradations test type.

After completing Material Item Definition editing, the next step is to edit the Material Information for each test type that is part of the material item (see Select and Edit Test Specs).

To edit the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the Edit button as shown below (see Edit Aggregate Gradations Test Specs).
The **Add Aggregate Spec** window will be displayed as shown below.
Since the Gradation Specs and the Related Specifications were set up as part of the Material Item editing there is no need to edit these items. However, the default lot size needs to be set (the default size used for new lots when they are added). This is done by entering the default lot size in the text box next to the Default Lot Size: label.

The default lot size for Crushed Base Course material is 5,000 m$^3$. However, in this case the default lot size has been specified as 6,250 m$^3$ so the default lot size is entered as 6250 as shown below.

Once the default lot size is entered, click the Edit Complete button, as shown below.
Then click the **OK** button, as shown below.
This completes the editing for the Aggregate Gradations test type material information. The **Add Aggregate Spec** form will close, returning to the main form with the Aggregate Gradations test spec status changed to *Currently in Specification Review Mode* as shown below.
Once the material item information and all of the test types have been placed into Specification Review status (Edit Completed has been selected for the material item and all tests), the material version **Edit Complete** button will be displayed next to the **Edit Material Version** button at the top of the **Material Version Info for Selected Item** panel.

To mark the Material Version ready for specification review click on the **Edit Complete** button as shown below.
This completes the editing for the Material Item Material Version information, changing the status to *Currently in Specification Review Mode* as shown below.
The material item information, test specs and material version are now ready for review.
11.1.1.8 Edit Cement Treated Base Material Item
To edit a Cement Treated Base material item, first select the material item from the list of *Existing Material Items* and then click on the **Edit Selected** button as shown below.

The **Edit Material Item Definition** window will display as shown below.
When editing Cement Treated Base material, the *Unit Cost* and *Contract Quantity* must be set as shown in the *Validation Errors* section at the bottom of the window.
First, enter the Unit Cost, Base Price and Contract Quantity (and optionally the Pit Lab Number) in their appropriate text box entry locations as shown below.

As can be seen in the Validation Errors: section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the Unit Cost and Contract Quantity validation error messages are no longer being displayed since they have been correctly input.
Since the Aggregate Gradation Specs are part of the Material Item definition they must be edited as part of the Material Item editing. To edit the aggregate specification, click the **Edit Aggregate Spec** button as shown below.

![Edit Material Item Definition](image)

The **Add Aggregate Spec** window will display as shown below.
The **Select Sieves** button is used to add or remove sieves as necessary. For this example, since the default sieves are set correctly for this material item there is no need to add or remove sieves.

To set the Fracture, click the **Related Specifications** tab, then select the *MT217-Fracture Requirement* under the *Requirements for Aggregate* list and set the minimum fracture value in the *Min:* text entry box and select the *Deduct* option and enter the associated *F Factor*, as shown below.
For this example, since the default fracture is set correctly for this material item (not an incentive or deduct item there is no need to modify the entries.

When the Aggregate Specification editing is completed, click the OK button to return to the Edit Material Item Definition window as shown below.
Notice that since all of the specification item entries have been completed, the *Validation Errors* message section at the bottom of the form is closed and the **Edit Complete** button is enabled to allow for designating that editing is complete and the specifications are ready for review, as shown above.

When all Material Item Definition edits are complete the next step is to mark the material item editing as complete (see **Mark Material Item Editing as Complete**). This is accomplished by clicking the **Edit Complete** button.

Click the **OK** button to close the **Edit Material Item Definition** form.
This completes the editing for the material item, changing the status to *awaiting Specification Review* as shown below. Once the Material Item Definition editing is completed, all of the test types associated with the material item are displayed in the list of test types in the lower section of the window, as shown below. In this case, for example, the Aggregate Gradations, Aggregate Surfacing Density test types are displayed in the list.

**Note:** As shown above in the test types list near the bottom of the window, when editing Cement Treated Base material items, the material information must be set for the *Aggregate Gradations* and *Aggregate Surfacing Density* test types.

After completing Material Item Definition editing, the next step is to edit the Material Information for each test type that is part of the material item (see [Select and Edit Test Specs](#)).
To edit the material information for the Aggregate Gradations test type, select the *Aggregate Gradations* test type from the list of test types and click on the **Edit** button (see Edit Aggregate Gradations Test Specs).

To edit the material information for the Aggregate Surfacing Density test type, select the *Aggregate Surfacing Density* test type from the list of test types and click on the **Edit** button (see Edit Aggregate Surfacing Density Test Specs).

After marking all of the editing as complete for all of the test types the next step is to edit the material version information and/or mark the material version editing as complete (see Edit Material Version Information and Mark Material Item Editing as Complete).

Once this is done the material item information, test specs and material version are ready for review.
11.1.1.9 Adding Material Items
To add material items, first open the file in the QA Suite (see Start and Log In to QA Suite).

After logging in, the file will be opened in the QA Suite with the main window displayed as shown below.

In order to add material items the Materials Summary form must be open. To do this, select the Materials Summary option from the Specifications menu dropdown as shown below.

This will activate the Materials Summary form as shown below.
To add a material item click on the **Add Material** button, as shown below.

The **Select Project Bid Items** window will be displayed as shown below.

Highlight the bid item and click on the directional arrow button to move the item from the **Available Bid Items** list to the **Bid Item(s) to Add** list. For example, to add Type 2 Cover Material select the COVER - TYPE 2 bid item from the list of **Available Bid Items** and use the **Add ->** button to move the item to the **Bid Item(s) to Add** list as shown below.
The COVER - TYPE 2 bit item will be moved to the *Bid Item(s) to Add* list as shown below.

Once the bid items are selected, click on the **OK** button. The Select Project Bid Items window will close. If a bid item has multiple material types, multiple item numbers, or multiple material versions, the *Select Material Version/Item Number* window will be displayed as shown below.
Select the appropriate material item, item number and/or material version effective date using the combo boxes. Once the desired options are selected, click on the OK button to close the **Select Material Version/Item Number** window and return to the **Materials Summary** form as shown below.

The added material item is displayed in the Existing Material Items list and is now ready for Material Item Editing (see **Select and Edit Material Item**), Test Spec editing (see **Select and Edit Test Specs**) and Material Version editing (see **Edit Material Version Information**).
11.1.1.10 Setting Up Aggregate Sieve Specs

For the various material aggregate gradation specifications, the gradation sieves can be one of several specification (spec) types with associated required inputs as outlined in the following Sieve Spec Type explanation and Sieve Spec Type example tables.

### Explanation of Sieve Spec Types, Their Usage and Required Inputs

<table>
<thead>
<tr>
<th>Sieve Spec Type</th>
<th>Usage</th>
<th>Required Inputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not a Spec Sieve</td>
<td>Used for non-spec sieves (typically included to control the amount of material reaching other sieves)</td>
<td></td>
</tr>
<tr>
<td>Min</td>
<td>Used for sieves that have only a minimum percentage passing specified</td>
<td>X</td>
</tr>
<tr>
<td>Max</td>
<td>Used for sieves that have only a maximum percentage passing specified</td>
<td>X</td>
</tr>
<tr>
<td>Range</td>
<td>Used for sieves that have both a minimum and a maximum percentage passing specified</td>
<td>X X</td>
</tr>
<tr>
<td>Target/Tolerance</td>
<td>Used for sieves that have a target and tolerance for percentage passing specified</td>
<td>X X</td>
</tr>
</tbody>
</table>

### Examples of Spec Book Aggregate Materials Table of Gradations Information

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Sand Surfacing Grade 1 Example</th>
<th>CTS Type &quot;A&quot; Grade 2 Example</th>
<th>CBC Type &quot;A&quot; Example</th>
<th>Grade 6A Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Job Mix Target Limits</td>
<td>Job Mix Tolerance</td>
</tr>
<tr>
<td>1 1/2 inch (37.5 mm)</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>3/4 inch (19.0 mm)</td>
<td>100</td>
<td>82-88</td>
<td>36-48</td>
<td>± 8</td>
</tr>
<tr>
<td>3/8 inch (9.5 mm)</td>
<td>52-64</td>
<td>36-48</td>
<td>36-48</td>
<td>± 12</td>
</tr>
<tr>
<td>No.4 (4.75 mm)</td>
<td>40-70</td>
<td>36-48</td>
<td>36-48</td>
<td>± 12</td>
</tr>
<tr>
<td>No.10 (2.00 mm)</td>
<td>65 min.</td>
<td>25-55</td>
<td>25-55</td>
<td></td>
</tr>
<tr>
<td>No. 40 (0.425)</td>
<td>16-24</td>
<td>16-24</td>
<td>16-24</td>
<td>± 10</td>
</tr>
<tr>
<td>No.200 (0.075)</td>
<td>20 max.</td>
<td>2-8</td>
<td>3-5</td>
<td>± 3</td>
</tr>
</tbody>
</table>
Additionally, some of the sieves are specified for use in determining potential pay adjustments (Deductions with F Factor value specified and/or Incentives).

When adding sieves or editing existing sieve specs, the *Edit Sieve Spec* window will be displayed, prompting the user to set up the sieve spec, as shown below.

![Edit Sieve Spec](image)

If the sieve is not required as part of the material's aggregate gradation specification, choose the **Not a Spec Sieve** option as shown below.

![Not a Spec Sieve](image)

Note that all of the other set-up options disappear since they are not required for non-spec sieves.
Choose the **Min** option if the material's aggregate gradation specification for the sieve requires only a minimum percentage passing the sieve.

![Edit Sieve Spec](image)

Note that the *Min:* option will be enabled for the user to enter the specified minimum percentage passing. The *Deduct* and *Incentive* options will also be enabled. The *F Factor:* entry is visible but disabled unless the *Deduct* option is selected.

Choose the **Max** option if the material's aggregate gradation specification for the sieve requires only a maximum percentage passing the sieve.
Note that the *Max:* option will be enabled for the user to enter the specified maximum percentage passing. The *Deduct* and *Incentive* options will also be enabled. The *F Factor:* entry is visible but disabled unless the *Deduct* option is selected.

Choose the *Range* option if the material's aggregate gradation specification for the sieve requires both a minimum and maximum percentage passing the sieve.

Note that the *Min:* and *Max:* options will be enabled for the user to enter the specified minimum and maximum percentages passing. The *Deduct* and *Incentive* options will also be enabled. The *F Factor:* entry is visible but disabled unless the *Deduct* option is selected.

Choose the **Target/Tolerance** option if the material's aggregate gradation specification for the sieve requires a target and tolerance for percentage passing the sieve.

![Edit Sieve Spec](image)

Note that the *Target Min:*, *Target Max:* and *Tolerance:* options will be enabled for the user to enter the specified target minimum, target maximum and tolerance percentages passing. The *Deduct* and *Incentive* options will also be enabled. The *F Factor:* entry is visible but disabled unless the *Deduct* option is selected.
11.1.2 Editing Test Specs

11.1.2.1 Select and Edit Test Specs

After completing Material Item Definition editing, the next step is to edit the Material Information for each test type that is part of the material item.

After completing Material Item Definition editing, the test types list near the bottom of the Materials Summary window will be displayed. The list contains all of the test types required for the material item (potential test types are: Aggregate Gradations, Concrete Specs, Daily Plant Mix Report, Marshall Testing, Plant Mix Density, Ride Specification and Volumetric Testing).

To edit a test type's material information, first select the test type from the list of test types and then select the **Edit** button in the **Material Info for Selected Test** panel.

To edit the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the **Edit** button (see Edit Aggregate Gradations Test Specs).

To edit the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types and click on the **Edit** button (see Edit Concrete Specs Test Specs).

To edit the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the **Edit** button (see Edit Daily Plant Mix Report Test Specs).

To edit the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the **Edit** button (see Edit Marshall Testing Test Specs).

To edit the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the **Edit** button (see Edit Plant Mix Density Test Specs).

To edit the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the **Edit** button (see Edit Ride Specification Test Specs).

To edit the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the **Edit** button (see Edit Volumetric Testing Test Specs).
11.1.2.2 Mark Test Spec Editing as Complete
When all of the specification item entries have been completed for a material item test type, the Validation Errors message section at the bottom of the form is closed and the Edit Complete button is enabled.

The Edit Complete button is provided to allow for designating that editing is complete and the material item test type specifications are ready for review.

When all Test Type Specification Definition edits are complete for a test type, click the Edit Complete button on that test type form. Examples for each test type are shown below.
After clicking the respective test type form's OK button the form will close, returning to the Materials Summary form.

This completes the editing for the respective test type for the material item, changing the status to Currently awaiting Specification Review.

Once the material item information and all of the test types have been placed into Specification Review status (Edit Completed has been selected for the material item and all tests), the material version Edit Complete button will be displayed next to the Edit Material Version button at the top of the Material Version Info for Selected Item panel.
The next step is to finish any necessary editing of the Material Version and mark the Material Version ready for specification review (see Mark Material Version Editing as Complete).
11.1.2.3 Edit Aggregate Gradations Test Specs
To edit the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the Edit button as shown below.

The Add Aggregate Spec window will be displayed as shown below.
Since the Gradation Specs and the Related Specifications were set up as part of the Material Item editing there is no need to edit these items. However, the default lot size needs to be set (the default size used for new lots when they are added). This is done by entering the default lot size in the text box next to the **Default Lot Size:** label. In this case since the default lot size for the aggregates for this material item is 5000 tons there is no need to change the pre-set value of 5000.

Once the default lot size is entered, the next step is to mark the test spec editing as complete (see [Mark Test Spec Editing as Complete](#)). To do this click the **Edit Complete** button, as shown below.
Then click the **OK** button, as shown below.
This completes the editing for the Aggregate Gradations test type material information. The Add Aggregate Spec form will close, returning to the main form with the Aggregate Gradations test spec status changed to Currently in Specification Review Mode as shown below.
## Working With Material Items And Test Specs

### Materials Summary

<table>
<thead>
<tr>
<th>Existing Material Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>COVER MATERIAL GRADE 4A</td>
</tr>
<tr>
<td>CRUSHED BASE COURSE TYPE A GRADE 6</td>
</tr>
<tr>
<td>PLANT MIX BIT SURF GR 5 - 19 MM</td>
</tr>
</tbody>
</table>

**Information For Selected Item**

- **Bid Item Name:** PLANT MIX BIT SURF GR 5 - 19 MM
- **Material Type:** PLANT MIX BIT SURF GR 5 - 19 MM
- **Effective Date:** 2/15/2005
- **Comment:** Per Special provisions, above date
- **Unit Cost:** 16.75
- **Base Price:** 16.75
- **Contract Quantity:** 20499 t
- **Bid Item Number:** 401080000
- **Pit Lab Number:** 852131
- **Last Modified By:** MCCRAVEN, ARLENE
- **Status:** Currently awaiting Specification Review - Specification Edit Mode marked as complete by MCCRAVEN, ARLENE

### Material Version Info for Selected Item

- **Material Version:** [Dropdown]
- **Comment:**
- **Unit Cost:** 16.75
- **Base Price:** 16.75
- **Last Modified By:** Material Version Creation
- **Status:** Currently in Specification Edit Mode

### Aggregate Gradations

- **Daily Plant Mix Report**
- **Plant Mix Density**
- **Volumetric Testing**

**Material Info for Selected Test**

- **Aggregate Gradations**

**Last Modified By:** MCCRAVEN, ARLENE

**Status:** Currently in Specification Review Mode - Specification Edit Mode marked as complete by MCCRAVEN, ARLENE
11.1.2.4 Edit Aggregate Surfacing Density Test Specs

To edit the material information for the Aggregate Surfacing Density test type, select the Aggregate Surfacing Density test type from the list of test types and click on the Edit button as shown below.

The Aggregate Surfacing Density Material Info window will be displayed as shown below. When editing Aggregate Surfacing Density Material Information values must be set for the Deduct Minimum Percentage, Deduct F Factor and Default Lot Size.
Generally it is not necessary to edit the Aggregate Surfacing Density Material Specifications since they were set up as part of the Material Item definition. However, if the contract specifications call for values different from these default specification values they can be modified here by entering the desired values in the appropriate text entry box. The default lot size also needs to be set here (the default size used for new lots when they are added). This is done by entering the default lot size in the text box next to the Default Lot Size: label. In this case since the default lot size for the aggregate surfacing for this material item is 3750 tons there is no need to change the pre-set value of 3750.

Once the default lot size is entered, click the Edit Complete button, as shown below.
Then click the **OK** button, as shown below.
This completes the editing for the Aggregate Surfacing Density test type material information. The *Aggregate Surfacing Density Material Info* form will close, returning to the main form with the Aggregate Surfacing Density test spec status changed to *Currently in Specification Review Mode* as shown below.
11.1.2.5 Edit Concrete Specs Test Specs
To edit the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types and click on the Edit button as shown below.

The **Concrete Specs Material Info** window will be displayed as shown below. When editing Concrete Specs Material Information, a value of Conventional will be displayed for the Default Gradation Type.
To set a value for the Default Gradation Type to something other than the default value, click on the Default Gradation Type dropdown and make a selection, as shown below.

Once satisfied with the Default Gradation Type selection, click the Edit Complete button, as shown below.
Then click the **OK** button, as shown below.

This completes the editing for the Concrete Specs test type material information. The *Concrete Specs Material Info* form will close, returning to the main form with the Concrete Specs test spec status changed to *Currently in Specification Review Mode* as shown below.
11.1.2.6 Edit Daily Plant Mix Report Test Specs

To edit the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the **Edit** button as shown below.

The **Daily Plant Mix Report Material Info** window will be displayed as shown below. As shown in the **Validation Errors** section at the bottom of the window, when editing Daily Plant Mix Report Material Information values must be set for the **Mix Design Number**, **At Least 2 Bin Splits**, **Number of Lifts**, **Plan Thickness** and **Maximum Mixing Temperature**.
To set the Type of Plant, click on the **Type of Plant** dropdown arrow and select the desired plant type from the list of type of plant options, as shown below.
The mix design number is entered in the text box next to the *Mix Design No.* label as shown below (in this case the mix design number was 1).

The mix design date is entered in the date selection dropdown next to the *Mix Design Date* label as shown below.

There are several methods for entering the date. Clicking on the dropdown arrow opens a calendar that can be navigated to select the desired date as shown below. The default date is set
to the current date which is circled in red on the calendar and noted at the bottom of the calendar.

Click on the black arrow at the left side of the calendar title to navigate backwards thru the calendar one month at a time, as shown below. Once the correct month and year are displayed on the calendar, click on the day on the calendar to select the correct day of the month, as shown below.
After clicking on the day on the calendar the calendar will close displaying the selected date in the dropdown box.

Another way to enter the desired date is to edit each part of the date in the dropdown individually. To do this highlight the item (year, day or month) and then use the Up or Down arrows on the keyboard to move up or down thru the available values or type in the desired value.

In the example below, first the year, then the day and then the month are being edited in this manner.

This results in the desired mix design date being displayed in the date dropdown as shown below.

To set the Mix Type, click on the **Mix Type** dropdown arrow and select the desired mix type from the list of mix type options, as shown below.

Next, a minimum of 2 bin splits must be entered in the Bin Splits section of the form. To start the bin split entry first select the Bin Type by clicking on the **Bin Type** dropdown arrow and select the desired bin type from the list of bin type options, as shown below.
Next, enter the specific gravity and the split percentage for the bin item in the text box under the $Gsb$ (Specific Gravity) and Split % columns as shown below.

As a bin type is added the dropdown for selecting the next bin type is also enabled as shown below.
Continue entering the bin splits until all bin splits have been entered.

To help with validation a split percentage total is displayed at the bottom at the bottom of the Split % column. Once all bin splits have been entered the value in the total split percentage box should be 100 as shown below.
Next the remaining specification items must be entered in the *Specification Items* section of the form.

The Number of Lifts, Average Plan Thickness, Maximum Mixing Temperature, Minimum Mixing Temperature, Design Rice Density and Design VFA are entered in their respective text boxes as shown below.
Notice that as the various required values are entered the items are removed from the *Validation Errors:* list at the bottom of the window as shown below.

Next, the Design % Voids, Design Density, Design % of Asphalt, Design % of Hydrated Lime, Design % of Additive 2 and Max % of Hydrated Lime are entered in their respective text boxes as shown below.
As shown below, once all of the required items have been entered, the Validation Errors: list closes and the **Edit Complete** and **OK** buttons are enabled.

Once all of the Daily Plant Mix Report Material Info has been entered, click the **Edit Complete** button, as shown below.

Then click the **OK** button as shown below.
This completes the editing for the Daily Plant Mix Report test type material information. The *Daily Plant Mix Report Material Info* form will close, returning to the main form with the Daily Plant Mix Report test spec status changed to *Currently in Specification Review Mode* as shown below.
11.1.2.7 Edit Marshall Testing Test Specs
To edit the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the Edit button as shown below.

The Edit Marshall Testing Material Info window will be displayed as shown below. When editing Marshall Testing Material Information values must be set for the Stability Minimum Value, Flow Minimum and Maximum Values and Air Voids Minimum and Maximum Values.
Generally it is not necessary to edit the Plant Mix Density Material Specifications since they were set up as part of the Material Item definition.

Once the specification items are entered, click the **Edit Complete** button, as shown below.

Then click the **OK** button, as shown below.
This completes the editing for the Marshall Testing test type material information. The *Edit Marshall Testing Material Info* form will close, returning to the main form with the Marshall Testing test spec status changed to *Currently in Specification Review Mode* as shown below.
11.1.2.8 Edit Plant Mix Density Test Specs
To edit the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the Edit button as shown below.

The Plant Mix Density Material Info window will be displayed as shown below. When editing Plant Mix Density Material Information values must be set for the Incentive Minimum Percentage, Incentive Maximum Percentage, Deduct Minimum Percentage, Deduct F Factor and Default Lot Size. Additionally, if the project contains mix placed directly on crushed aggregate surfacing (CAC) (see First Lift On CAC Plant Mix Density Evaluation Overview) then the Project Contains Mix Placed Directly on Crushed Aggregate Surfacing (CAC) option must be selected and the Lift on CAC Deduct Minimum Percentage must be set.
Generally it is not necessary to edit the Plant Mix Density Material Specifications since they were set up as part of the Material Item definition. However, if the contract specifications call for values different from these default specification values they can be modified here by entering the desired values in the appropriate text entry box.

If the project contains mix placed directly on crushed aggregate surfacing (CAC) then the Project Contains Mix Placed Directly On Crushed Aggregate Surfacing (CAC) option in the Deduct section should be checked and the Lift on CAC Minimum Percentage text entry box will be displayed, as shown below.

Here again, it is generally not necessary to modify the default value populated in the Lift On CAC Minimum Percentage text box as it was also set up as part of the Material Item definition. However, if the contract specifications call for a value different from this default specification value it can be modified here by entering the desired value in the text entry box.

The default lot size also needs to be set here (the default size used for new lots when they are added). This is done by entering the default lot size in the text box next to the Default Lot Size: label. In this case since the default lot size for the plant mix for this material item is 3000 tons there is no need to change the pre-set value of 3000.

Once the default lot size is entered, click the Edit Complete button, as shown below.

Then click the OK button, as shown below.

This completes the editing for the Plant Mix Density test type material information. The Plant Mix Density Material Info form will close, returning to the main form with the Plant Mix Density test spec status changed to Currently in Specification Review Mode as shown below.
11.1.2.9 Edit Ride Specification Test Specs

To edit the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the **Edit** button as shown below.

The **Edit Ride Spec Material Info** window will be displayed as shown below. When editing Ride Specification Material Information values must be set for the **Spec Effective Date** and **Project Class**.
To set the Spec Effective Date, click on the **Spec Effective Date** dropdown arrow as shown below and select the desired spec effective date from the list of spec effective date options, as shown below.

Depending on the Spec Effective Date selected, either the Project Class dropdown options or the Project Category dropdown options will be displayed. In this case, since the 2/28/2011 spec effective date has been selected, the Project Category dropdown options are displayed.

To set the Project Class or Project Category, click on the **Project Class** or **Project Category** dropdown arrow as shown below and select the desired project class or project category from the list of project class or project category options, as shown below.
Next, for contracts that call for Length Payment Based Ride Specifications (such as the 2/28/2011 option), enter the Unit Cost, which can be obtained from the Ride Specification Special Provision for the contract, as shown below:

Once the Spec Effective Date and Project Class or Project Category have been selected, click the **Edit Complete** button, as shown below.
Then click the **OK** button, as shown below.

This completes the editing for the Ride Specification test type material information. The *Edit Ride Spec Material Info* form will close, returning to the main form with the Ride Specification test spec status changed to *Currently in Specification Review Mode* as shown below.
11.1.2.10 **Edit Volumetric Testing Test Specs**

To edit the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the **Edit** button as shown below.

The **Edit Volumetric Testing Material Info** window will be displayed as shown below. As shown in the **Validation Errors** section at the bottom of the window, when editing Volumetric Testing Material Information values must be set for the **Mix Design Number**, **Mix Design Gmm**, **Asphalt Type**, **Asphalt Supplier** and **Asphalt Specific Gravity**.
The Mix Design Number, Mix Design Gmm, Hyd Lime Bulk Specific Gravity and Default Lot Size are entered in their respective text boxes and the Mix Design Date is set in its respective date dropdown box, as shown below.

![Image of Volumetric Testing Material Info window]

<table>
<thead>
<tr>
<th>Specification Date</th>
<th>% Voids</th>
<th>VMA</th>
<th>VFA</th>
<th>D/A Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/15/2005</td>
<td>3.4</td>
<td>14.6</td>
<td>80.0</td>
<td>0.9</td>
</tr>
</tbody>
</table>

| Incentive Tolerance | N/A | N/A | N/A | N/A |
| Incentive Range     | N/A | N/A | N/A | N/A |
| Job Mix Tolerance   | 1.0  | 0.6 | 5.0 | 0.2 |
| Job Mix Range       | 2.4-4.4 | 14.0-15.2 | 75.0-85.0 | 0.7-1.1 |
| Incentive           | 0.02 | 0.02 | 0.02 | 0.02 |
| F' Factor           | 6    | 6   | 2   | 30  |
Next the specification items can be selected in the *Specifications* section of the form.

The Specification Date controls the Incentive Tolerance, Incentive Range, Job Mix Tolerance, Job Mix Range, Incentive and F' Factor values.

Since the Target Values for the %Voids, VMA, VFA and Dust/Asphalt Ratio were set as part of the Material Item editing they should not need to be edited at this point. However, this is where the values are edited when the contractor chooses to change the target values.

To set the Specification Date, click on the **Specification Date** dropdown arrow and select the desired specification date from the list of specification date options, as shown below.
The asphalt information is entered in the *Asphalt Information* section of the form.

The Asphalt Type, Asphalt Supplier and Asphalt Specific Gravity are entered in their respective text boxes, as shown below.

If desired, comments can be entered in the Notes: text box. This is helpful for documenting information about Target Value changes or Asphalt Information changes.

As shown below, once all of the required items have been entered, the *Validation Errors:* list closes and the *Edit Complete* and *OK* buttons are enabled.
Once all of the Volumetric Testing Material Info has been entered, click the **Edit Complete** button, as shown below.
Then click the **OK** button, as shown below.

This completes the editing for the Volumetric Testing test type material information. The *Edit Volumetric Testing Material Info* form will close, returning to the main form with the Volumetric Testing test spec status changed to *Currently in Specification Review Mode* as shown below.
11.1.3 Editing Material Versions

11.1.3.1 Edit Material Version Information
The Edit Material Version option is provided to allow for editing of the Unit Cost or Base Price for a material item version. The editing process is discussed below.

To edit a the material version for a material item, first select the material item from the list of Existing Material Items and then click on the Edit Material Version button at the top of the Material Version Info for Selected Item panel, as shown below.

The Edit Material Version window will be displayed as shown below.
The *Unit Cost* or *Base Price* can be edited for the current material version by entering the values in the appropriate text entry box. Additionally, the *Comment* text entry box is included to allow for entering information regarding the basis for the editing of the costs.

To close the window without saving changes to the material version click the **Cancel** button.

To close the window and save changes to the material version information click the **OK** button.

Clicking on either button closes the *Edit Material Version* window, returning to the *Materials Summary* form.
11.1.3.2 Mark Material Version Editing as Complete

Once the material item information and all of the test types have been placed into Specification Review status (Edit Completed has been selected for the material item and all tests), the material version **Edit Complete** button will be displayed next to the **Edit Material Version** button at the top of the **Material Version Info for Selected Item** panel.

To mark the Material Version ready for specification review click on the **Edit Complete** button as shown below.

This completes the editing for the Material Item Material Version information, changing the status to **Currently in Specification Review Mode** as shown below.
The material item information, test specs and material version are now ready for review.
11.1.3.3 Creating New Material Versions
To create a new material version for a material item, first open the file in the QA Suite (see Start and Log In to QA Suite).

After logging in, the file will be opened in the QA Suite with the main window displayed as shown below.

In order to create a new material version the Materials Summary form must be open. To do this, select the Materials Summary option from the Specifications menu dropdown as shown below.

This will activate the Materials Summary form as shown below.
To create a new material version for a material item, first select the material item from the list of **Existing Material Items** and then click on the **New Material Version** button at the top of the **Material Version Info for Selected Item** panel, as shown below.
A **New Material Version** window will be displayed.

Information for new material versions is copied from existing material version information. If there is currently only one material version, the new material version information will be copied from the first material version information and the material version to copy option is not displayed, as shown below.

If multiple material versions exist, the **New Material Version** window includes a dropdown to select which existing material version to copy from for creating the new material version, as shown below.
The _Unit Cost_ or _Base Price_ can be edited for the new material version by entering the values in the appropriate text entry box. Additionally, the _Comment_ text entry box is included to allow for entering information regarding the basis for the creating the new material version.

The _Material Version to Copy_ dropdown is used to select which existing material version to copy from.

To close the window without saving changes to the material version click the **Cancel** button.

To close the window and save changes to the material version information click the **OK** button.

Clicking on either button closes the **New Material Version** window, returning to the **Materials Summary** window.
11.1.3.4 Deleting Material Version

Material Specs editing can only be performed by users with one of the following roles:

1. EPM  
2. Field Office Person  
3. Lab Supervisor

To delete a material version, first open the file in the QA Suite (see Start and Log In to QA Suite).

After logging in, the file will be opened in the QA Suite with the main window displayed as shown below.

![Main Window](image)

If the material item for which the material version is to be deleted has been locked, the material item must first be unlocked (see Unlocking Material/Test Specs).

To delete a material version first select the material item from the list of Existing Material Items. Then select the material version to be deleted and then click on the Delete Material Version button.
If the material version has been edited since its creation you will be prompted with a warning that you are about to delete a material version that has already been edited and asked to confirm the deletion, as shown below.

Select **Yes** to continue with the material version deletion, select **No** to cancel the material version deletion.

After completing the material version deletion, the material version will be removed from the *Material Version for Selected Item* list, as shown below.
11.1.4 Reviewing and Locking Material Items

11.1.4.1 Review and Lock Material Items
Once the material item, all test specs, and material version editing have been marked as complete
and placed into *Currently awaiting Specification Review* status, the material item information, test
spec(s) and material version(s) are ready for review. Review of material item information, test spec(s),
and material version(s) cannot be performed by the same user that set up and marked the editing as complete.
A different user will need to start the QA Suite and open the file and log-in (see *Start and Log In to QA Suite*)
or log-in using the change login function (see *Change Login*) to start the review process.
Once logged in, the material item test data user interfaces will not be displayed until the material
and test specs have been reviewed and locked. Hence, the user must review and lock the
Materials and Test Specs before test data entry can begin. To start the review process, select the
**Materials Summary** option from the **Specifications** menu dropdown as shown below.

![Materials Summary](image)

This will activate the **Materials Summary** tab as shown below. At this point, the Material Items
editing should have been marked as complete and the material items in the **Existing Material
Items** list should be in *Currently awaiting Specification Review* status.
The next step is to review and lock the material item. To review and lock a material item, first select the material item from the list of *Existing Material Items* and then click on the **Review Selected** button as shown below.
To review and lock the material information for a "COVER MATERIAL" material item, select the "COVER MATERIAL" material item from the list of existing material items and click on the **Review Selected** button (see **Review and Lock "Cover Material" Material Item**).

To review and lock the material information for a CRUSHED BASE COURSE material item, select the CRUSHED BASE COURSE material item from the list of existing material items and click on the **Review Selected** button (see **Review and Lock Crushed Base Course Material Item**).

To review and lock the material information for a PLANT MIX BIT SURF GR S material item, select the PLANT MIX BIT SURF GR S material item from the list of existing material items and click on the **Review Selected** button (see **Review and Lock Plant Mix Bit Surf Grade S Material Item**).

To review and lock the material information for a PLANT MIX GR D material item, select the PLANT MIX GR D material item from the list of existing material items and click on the **Review Selected** button (see **Review and Lock Plant Mix Grade D Material Item**).

After completing Material Item Definition reviewing and locking, the next step is to review and lock the Material Information for each test type that is part of the material item (see **Review and Lock Test Specs**).
11.1.4.2 Review and Lock Plant Mix Bit Surf Grade S Material Item

To review and lock a Plant Mix Bituminous Surfacing Grade S material item, first select the material item from the list of Existing Material Items and then click on the Review Selected button as shown below.

The Edit Material Item Definition window will display as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the material item definition information are the same as those for editing the material item information (see Edit Plant Mix Bit Surf Grade S Material Item).

When the review of all of the Material Item Definition information is complete the next step is to lock the material item. This is accomplished by clicking the **Lock** button, as shown below.
Then click the **OK** button to close the *Edit Material Item Definition* form. This completes the reviewing and locking for the material item, changing the status to *Locked* as shown below.
The next step is to review and lock the Material Information for each test type that is part of the material item (see Review and Lock Test Specs).

To review and lock the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the Review button (see Review and Lock Aggregate Gradations Test Specs).

To review and lock the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the Review button (see Review and Lock Daily Plant Mix Report Test Specs).

To review and lock the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the Review button (see Review and Lock Plant Mix Density Test Specs).

To review and lock the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the Review button (see Review and Lock Ride Specifications Test Specs).

To review and lock the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the Review button (see Review and Lock Volumetric Testing Test Specs).
11.1.4.3 Review and Lock Plant Mix Grade D Material Item
To review and lock a Plant Mix Grade D material item, first select the material item from the list of Existing Material Items and then click on the Review Selected button as shown below.

The Edit Material Item Definition window will display as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the material item definition information are the same as those for editing the material item information (see Edit Plant Mix Grade D Material Item).

When the review of all of the Material Item Definition information is complete the next step is to lock the material item. This is accomplished by clicking the Lock button, as shown below.
Then click the **OK** button to close the *Edit Material Item Definition* form. This completes the reviewing and locking for the material item, changing the status to **Locked** as shown below.
The next step is to review and lock the Material Information for each test type that is part of the material item (see [Review and Lock Test Specs](#)).

To review and lock the material information for the Aggregate Gradations test type, select the *Aggregate Gradations* test type from the list of test types and click on the **Review** button (see [Review and Lock Aggregate Gradations Test Specs](#)).

To review and lock the material information for the Daily Plant Mix Report test type, select the *Daily Plant Mix Report* test type from the list of test types and click on the **Review** button (see [Review and Lock Daily Plant Mix Report Test Specs](#)).

To review and lock the material information for the Marshall Testing test type, select the *Marshall Testing* test type from the list of test types and click on the **Review** button (see [Review and Lock Marshall Testing Test Specs](#)).

To review and lock the material information for the Plant Mix Density test type, select the *Plant Mix Density* test type from the list of test types and click on the **Review** button (see [Review and Lock Plant Mix Density Test Specs](#)).
11.1.4.4 Review and Lock "Cover Material" Material Item
To review and lock a "Cover Material" material item, first select the material item from the list of Existing Material Items and then click on the Review Selected button as shown below.

The Edit Material Item Definition window will display as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the material item definition information are the same as those for editing the material item information (see Edit "Cover Material" Material Item).

When the review of all of the Material Item Definition information is complete the next step is to lock the material item. This is accomplished by clicking the **Lock** button, as shown below.
Then click the **OK** button to close the *Edit Material Item Definition* form.

This completes the reviewing and locking for the material item, changing the status to *Locked* as shown below.
The next step is to review and lock the Material Information for each test type that is part of the material item (see Review and Lock Test Specs).

To review and lock the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the Review button (see Review and Lock Aggregate Gradations Test Specs).
11.1.4.5 Review and Lock Crushed Base Course Material Item

To review and lock a Crushed Base Course material item, first select the material item from the list of Existing Material Items and then click on the Review Selected button as shown below.

The **Edit Material Item Definition** window will display as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the material item definition information are the same as those for editing the material item information (see Edit Crushed Base Course Material Item).

When the review of all of the Material Item Definition information is complete the next step is to lock the material item. This is accomplished by clicking the Lock button, as shown below.
Then click the **OK** button to close the *Edit Material Item Definition* form. This completes the reviewing and locking for the material item, changing the status to *Locked* as shown below.
The next step is to review and lock the Material Information for each test type that is part of the material item (see Review and Lock Test Specs).

To review and lock the material information for the Aggregate Gradations test type, select the *Aggregate Gradations* test type from the list of test types and click on the **Review** button (see Review and Lock Aggregate Gradations Test Specs).
11.1.4.6 Review and Lock Cement Treated Base Material Item

To review and lock a Cement Treated Base material item, first select the material item from the list of Existing Material Items and then click on the Review Selected button as shown below.

The Edit Material Item Definition window will display as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the material item definition information are the same as those for editing the material item information (see Edit Cement Treated Base Material Item).

When the review of all of the Material Item Definition information is complete the next step is to lock the material item. This is accomplished by clicking the Lock button, as shown below.
Then click the OK button to close the **Edit Material Item Definition** form.

This completes the reviewing and locking for the material item, changing the status to **Locked** as shown below.
The next step is to review and lock the Material Information for each test type that is part of the material item (see Review and Lock Test Specs).

To review and lock the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the Review button (see Review and Lock Aggregate Gradations Test Specs).

To review and lock the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the Review button (see Review and Lock Aggregate Surfacing Density Test Specs).
11.1.5 Reviewing and Locking Test Specs

11.1.5.1 Review and Lock Test Specs
After reviewing and locking the Material Item Definition, the next step is to review and lock the Material Information for each test type that is part of the material item.

The test types list near the bottom of the Materials Summary window contains all of the test types required for the material item (potential test types are: Aggregate Gradations, Concrete Specs, Daily Plant Mix Report, Marshall Testing, Plant Mix Density, Ride Specification and Volumetric Testing).

To review and lock a test type's material information first select the test type from the list of test types and then select the Review button in the Material Info for Selected Test panel, as shown below.
To review and lock the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the Review button (see Review and Lock Aggregate Gradations Test Specs).

To review and lock the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types and click on the Review button (see Review and Lock Concrete Specs Test Specs).

To review and lock the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the Review button (see Review and Lock Daily Plant Mix Report Test Specs).

To review and lock the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the Review button (see Review and Lock Marshall Testing Test Specs).

To review and lock the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the Review button (see Review and Lock Plant Mix Density Test Specs).

To review and lock the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the Review button (see Review and Lock Ride Specifications Test Specs).

To review and lock the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the Review button (see Review and Lock Volumetric Testing Test Specs).
11.1.5.2 Review and Lock Aggregate Gradations Test Specs

To review and lock the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the **Review** button as shown below.

The **Add Aggregate Spec** window will be displayed as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see Edit Aggregate Gradations Test Specs). When the review of all of the Aggregate Gradations test specification information is complete the next step is to lock the test specification. This is accomplished by clicking the Lock button, as shown below.
Then click the **OK** button to close the *Add Aggregate Spec* window. This completes the reviewing and locking for the Aggregate Gradations test spec, changing the status to *Locked* as shown below.
11.1.5.3 Review and Lock Aggregate Surfacing Density Test Specs
To review and lock the material information for the Aggregate Surfacing Density test type, select the Aggregate Surfacing Density test type from the list of test types and click on the **Review** button as shown below.

The **Aggregate Surfacing Density Material Info** window will be displayed as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see Edit Aggregate Surfacing Density Test Specs).

When the review of all of the Aggregate Surfacing Density test specification information is complete the next step is to lock the test specification. This is accomplished by clicking the Lock button, as shown below.
Then click the **OK** button to close the *Aggregate Surfacing Density Material Info* window.

This completes the reviewing and locking for the Aggregate Surfacing Density test spec, changing the status to *Locked* as shown below.
11.1.5.4 Review and Lock Concrete Specs Test Specs

To review and lock the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types and click on the **Review** button as shown below.

The **Concrete Specs Material Info** window will be displayed as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see Edit Concrete Specs Test Specs).

When the review of all of the Concrete Specs test specification information is complete, the next step is to lock the test specification. This is accomplished by clicking the Lock button, as shown below.

Then click the OK button to close the Concrete Specs Material Info window.

This completes the reviewing and locking for the Concrete Specs test spec, changing the status to Locked as shown below.
11.1.5.5 Review and Lock Daily Plant Mix Report Test Specs
To review and lock the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the Review button as shown below.

The *Daily Plant Mix Report Material Info* window will be displayed as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see Edit Daily Plant Mix Report Test Specs).

When the review of all of the Daily Plant Mix Report test specification information is complete the next step is to lock the test specification. This is accomplished by clicking the Lock button, as shown below.
Then click the **OK** button to close the *Daily Plant Mix Report Material Info* window.

This completes the reviewing and locking for the Daily Plant Mix Report test spec, changing the status to *Locked* as shown below.
11.1.5.6 Review and Lock Marshall Testing Test Specs

To review and lock the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the **Review** button as shown below.

The *Edit Marshall Testing Material Info* window will be displayed as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see Edit Marshall Testing Test Specs).

When the review of all of the Marshall Testing test specification information is complete the next step is to lock the test specification. This is accomplished by clicking the Lock button, as shown below.
Then click the **OK** button to close the *Edit Marshall Testing Material Info* window.

This completes the reviewing and locking for the Marshall Testing test spec, changing the status to *Locked* as shown below.
11.1.5.7 Review and Lock Plant Mix Density Test Specs

To review and lock the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the Review button as shown below.

![Image of the Plant Mix Density Material Info window]

The *Plant Mix Density Material Info* window will be displayed as shown below.

During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see Edit Plant Mix Density Test Specs).
When the review of all of the Plant Mix Density test specification information is complete the next step is to lock the test specification. This is accomplished by clicking the **Lock** button, as shown below.

Then click the **OK** button to close the *Plant Mix Density Material Info* window.

This completes the reviewing and locking for the Plant Mix Density test spec, changing the status to **Locked** as shown below.
11.1.5.8 Review and Lock Ride Specifications Test Specs

To review and lock the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the **Review** button as shown below.

The **Edit Ride Spec Material Info** window will be displayed as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see Edit Ride Specification Test Specs).

When the review of all of the Ride Specification test specification information is complete the next step is to lock the test specification. This is accomplished by clicking the Lock button, as shown below.

Then click the OK button to close the Edit Ride Spec Material Info window.

This completes the reviewing and locking for the Ride Specification test spec, changing the status to Locked as shown below.
11.1.5.9 Review and Lock Volumetric Testing Test Specs

To review and lock the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the **Review** button as shown below.

The *Edit Volumetric Testing Material Info* window will be displayed as shown below.
During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the test type specification information are the same as those for editing the test type specification information (see [Edit Volumetric Testing Test Specs](#)).

When the review of all of the Volumetric Testing test specification information is complete the next step is to lock the test specification. This is accomplished by clicking the **Lock** button, as shown below.
Then click the **OK** button to close the *Edit Volumetric Testing Material Info* window.

This completes the reviewing and locking for the Volumetric Testing test spec, changing the status to *Locked* as shown below.
Note: Since the material item information and all of the test types have been placed into Locked status (Locked has been selected for the material item and all tests), the material version Lock button is displayed next to the Edit Material Version button at the top of the Material Version Info for Selected Item panel.

This indicates that the Material Version is ready to be reviewed and locked (see Review and Lock Material Versions).
11.1.6 Reviewing and Locking Material Versions

11.1.6.1 Review and Lock Material Versions

After reviewing and locking the Material Item Definition and reviewing and locking the Material Information for each test type that is part of the material item, the next step is to review and lock the Material Version.

Once the material item information and all of the test types have been reviewed and locked, the material version Lock button will be displayed next to the Edit Material Version button at the top of the Material Version Info for Selected Item panel.

During the review process, the reviewer can edit items if necessary. The steps for reviewing and editing the material version information are the same as those for editing the material version information (see Edit Material Version Information).

When the review of all of the Material Item Material Version information is complete the next step is to lock the material version. This is accomplished by clicking the Lock button, as shown below.

This completes the locking of the Material Item Material Version information, changing the status to Locked as shown below.
Once the Material Item, Material Item Test Specs and Material Item Material Version are all locked, the set-up for this material item is complete. Notice that since the set-up for this material item is complete, the material item and its associated test types are now displayed in the test tree view navigation panel at the left hand side of the main form (see Tests_Navigation_Panel). Test data entry or split for test data entry operations can now be initiated for this material item's test types.
11.2 Viewing Material Items and Test Specs
11.2.1 Viewing Material Item Specs

After logging in (see Start and Log In to QA Suite), the file will be opened in the QA Suite with the main window displayed as shown below.

Since the material and test specs have been set, the user may view and/or report the Materials and Test Specs at any time. To do this, select the Materials Summary option from the Specifications menu dropdown as shown below.

This will activate the Materials Summary tab as shown below.
To view a material item, first select the material item from the list of *Existing Material Items* and then click on the **View Selected** button as shown below.
The **View Material Item Definition** window will display as shown below.
Since the material item is locked, the material item definition information can only be viewed in this window.

The *Aggregate Selection* information tab shows information about the selected aggregate. To view the sieve information for sieves not visible in the *Sieves for Selected Spec:* list, scroll down thru the list as shown below.
Information for Other Specifications can be viewed by selecting the *Other Specifications* tab.
Although the list of existing specifications for the material includes seven items, all but the MT332-Gyrationary specification are procedure only (no embedded specifications).

To view the specification settings for the MT332-Gyrationary specification choose the specification from the list of specifications in the Existing Specifications for This Material: list, as shown below.
Click the Close button to close the View Material Item Definition window and return to the main form Materials Summary tab.
11.2.1.2 View Plant Mix Bit Surf Grade S Material Item Specs

To view a Plant Mix Bit Surf Gr S material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the Plant Mix Bit Surf Gr S material item is locked, the material item definition information can only be viewed in this window.

The *Aggregate Selection* information tab shows information about the selected aggregate. To view the sieve information for sieves not visible in the *Sieves for Selected Spec:* list, scroll down thru the list as shown below.
Information for Other Specifications can be viewed by selecting the *Other Specifications* tab.
Although the list of existing specifications for the material includes seven items, all but the MT332-Gyratory specification are procedure only (no embedded specifications).

To view the specification settings for the MT332-Gyratory specification choose the specification from the list of specifications in the Existing Specifications for This Material: list, as shown below.
Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
**11.2.1.3 View Plant Mix Grade D Material Item**

To view a Plant Mix Grade D material item, first select the material item from the list of *Existing Material Items* and then click on the **View Selected** button as shown below.

The **View Material Item Definition** window will display as shown below.
Since the Plant Mix Grade D material item is locked, the material item definition information can only be viewed in this window.

The Aggregate Selection information tab shows information about the selected aggregate. To view the sieve information for sieves not visible in the Sieves for Selected Spec list, scroll down thru the list as shown below.
Information for Other Specifications can be viewed by selecting the *Other Specifications* tab.
Although the list of existing specifications for the material includes five items, all but the MT311-Marshall specification are procedure only (no embedded specifications).

To view the specification settings for the MT311-Marshall specification choose the specification from the list of specifications in the *Existing Specifications for This Material:* list, as shown below.
Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
11.2.1.4 View "Cover Material" Material Items
To view a "Cover Material" material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the "Cover Material" material item is locked, the material item definition information can only be viewed in this window.

The Aggregate Selection information tab shows information about the selected aggregate. To view the additional requirements for aggregates information not visible in the Additional Requirements for Aggregate: list, scroll down thru the list as shown below.
Information for Other Specifications can be viewed by selecting the *Other Specifications* tab.
Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
11.2.1.5 View Crushed Base Course Material Items

To view a Crushed Base Course material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the Crushed Base Course material item is locked, the material item definition information can only be viewed in this window.

The **Aggregate Selection** information tab shows information about the selected aggregate. To view the sieve information for sieves not visible in the *Sieves for Selected Spec:* list, scroll down thru the list as shown below.
Information for Other Specifications can be viewed by selecting the *Other Specifications* tab.
Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
11.2.1.6 View Cement Treated Base Material Item

To view a Cement Treated Base material item, first select the material item from the list of *Existing Material Items* and then click on the **View Selected** button as shown below.

![View Material Item Definition](image)

The *View Material Item Definition* window will display as shown below.
Since the Cement Treated Base material item is locked, the material item definition information can only be viewed in this window.

The **Aggregate Selection** information tab shows information about the selected aggregate. To view the sieve information for sieves not visible in the **Sieves for Selected Spec** list, scroll down thru the list as shown below.
Information for Other Specifications can be viewed by selecting the Other Specifications tab.
Although the list of existing specifications for the material includes two items, both of the items are procedure only (no embedded specifications).

Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
11.2.1.7 View Concrete Specs Material Item

To view a Concrete Specs material item, first select the material item from the list of *Existing Material Items* and then click on the **View Selected** button as shown below.

![View Material Item Definition window](image)

The **View Material Item Definition** window will display as shown below.
Since the Concrete-Class General material item is locked, the material item definition information can only be viewed in this window.

Information for Other Specifications can be viewed by selecting the Other Specifications tab.
Although the list of existing specifications for the material includes four items, all of the items are procedure only (no embedded specifications).

Click the Close button to close the View Material Item Definition window and return to the main form Materials Summary tab.
11.2.2 Viewing Test Specs

11.2.2.1 Viewing Test Specs

After logging in (see Start and Log In to QA Suite), the file will be opened in the QA Suite with the main window displayed as shown below.

Since the material and test specs have been set, the user may view and/or report the Materials and Test Specs at any time. To do this, select the **Materials Summary** option from the **Specifications** menu dropdown as shown below.

This will activate the **Materials Summary** tab as shown below.
To view material item test specs, first select the material item from the list of *Existing Material Items*, as shown below.
The test types list near the bottom of the Materials Summary window will be displayed. The list contains all of the test types required for the material item (potential test types are: Aggregate Gradations, Concrete Specs, Daily Plant Mix Report, Marshall Testing, Plant Mix Density, Ride Specification and Volumetric Testing).

To view a test type's material information first select the test type from the list of test types and then select the View button in the Material Info for Selected Test panel.

To view the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the View button (see View Aggregate Gradations Test Specs).

To view the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types and click on the View button (see View Concrete Specs Test Specs).
To view the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the View button (see View Daily Plant Mix Report Test Specs).

To view the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the View button (see View Marshall Testing Test Specs).

To view the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the View button (see View Plant Mix Density Test Specs).

To view the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the View button (see View Ride Specification Test Specs).

To view the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the View button (see View Volumetric Testing Test Specs).
11.2.2.2 View Aggregate Gradations Test Specs

To view the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the **View** button as shown below.

The **Add Aggregate Spec** window will be displayed as shown below.
Since the Aggregate Gradation test spec is locked, the Aggregate Spec information can only be viewed in this window.

The *Gradation Spec* information tab shows information about the selected sieves for the gradation spec.

Information for Related Specifications can be viewed by selecting the *Related Specifications* tab.
Click the Close button to close the Add Aggregate Spec window and return to the main form Materials Summary tab.
11.2.2.3 View Aggregate Surfacing Density Test Specs

To view the material information for the Aggregate Surfacing Density test type, select the Aggregate Surfacing Density test type from the list of test types and click on the View button as shown below.

The **Aggregate Surfacing Density Material Info** window will be displayed as shown below.
Since the Aggregate Surfacing Density test spec is locked, the Aggregate Surfacing Density information can only be viewed in this window.

Click the **Close** button to close the **Aggregate Surfacing Density Material Info** window and return to the main form **Materials Summary** tab.
11.2.2.4 View Concrete Specs Test Specs

To view the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types. If there is more than one Material Version, select the desired version first, as shown below.

Once the desired Material Version has been selected, click on the View button as shown below.
The **Concrete Specs Material Info** window will be displayed as shown below. Note the *Line Item Number* that is displayed.
Since there are two Material Versions in this example (with unique Line Item Numbers), selecting Material Version 2 on the Materials Summary tab and then clicking on the View button will display a Concrete Specs Material Info window for the second Line Item Number, as shown below.

Since the Concrete Specs test spec is locked, the Concrete Specs information can only be viewed in this window.

Click the Close button to close the Concrete Specs Material Info window and return to the main form Materials Summary tab.
11.2.2.5 View Daily Plant Mix Report Test Specs
To view the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the **View** button as shown below.

The *Daily Plant Mix Report Material Info* window will be displayed as shown below.
Since the Daily Plant Mix Report test spec is locked, the Daily Plant Mix Report information can only be viewed in this window.

Click the Close button to close the Daily Plant Mix Report Material Info window and return to the main form Materials Summary tab.
11.2.2.6 View Marshall Testing Test Specs
To view the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the View button as shown below.

The View Marshall Testing Material Info window will be displayed as shown below.
Since the Marshall Testing test spec is locked, the Marshall Testing information can only be viewed in this window.

Click the **Close** button to close the **View Marshall Testing Material Info** window and return to the main form **Materials Summary** tab.
11.2.2.7 View Plant Mix Density Test Specs

To view the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the View button as shown below.

The Plant Mix Density Material Info window will be displayed as shown below.

Since the Plant Mix Density test spec is locked, the Plant Mix Density information can only be viewed in this window.

Click the Close button to close the Plant Mix Density Material Info window and return to the main form Materials Summary tab.
11.2.2.8 View Ride Specification Test Specs

to view the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the **View** button as shown below.

The **View Ride Spec Material Info** window will be displayed as shown below.
Since the Ride Specification test spec is locked, the Ride Specification information can only be viewed in this window.

Click the Close button to close the View Ride Spec Material Info window and return to the main form Materials Summary tab.
11.2.2.9 View Volumetric Testing Test Specs

To view the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the View button as shown below.

The View Volumetric Testing Material Info window will be displayed as shown below.
Since the Volumetric Testing test spec is locked, the Volumetric Testing information can only be viewed in this window.

Click the Close button to close the View Volumetric Testing Material Info window and return to the main form Materials Summary tab.
11.3 Reporting Material Items and Test Specs

11.3.1 Reporting Materials Summary Information

To preview and/or print Materials Summary information, the *Materials Summary* form must be the selected form (see Selecting A Form). The selected form is the form that is visible (its tab label is highlighted in black and its information is visible on the form).

Start the process of selecting the Materials Summary form by logging in (see Start and Log In to QA Suite) and opening the file so that it is displayed in the main window as shown below.

![Materials Summary form](image)

To display the Materials Summary form select the *Materials Summary* option from the Specifications menu dropdown as shown below.

![Materials Summary option](image)

This will activate the *Materials Summary* form as shown below.
To preview the Materials Summary information click on the **Print Preview** button on the tool bar as shown below.
The Materials Summary Print Selection form is displayed as shown below.

The print selection form provides a tree structure for locating and selecting material item(s), material version(s) and test type(s) to preview. The tree structure is organized with the material item (designated by Material Type (Item Number)) at the top level, the Material Version(s) at the second level, and the Test Type(s) for the material item at the bottom level.
Click on the plus sign (+) to expand a branch of the tree or the minus sign (−) to collapse a branch of the tree.

All material items, material versions and test types selected in the list of available items are included in the preview. Hence, to exclude items from the preview, un-select the items in the list of items provided.

The Select All button can be used to select all of the items displayed in the available items list. The Clear All button un-selects all of the items displayed in the available items list.

Once the desired options are selected, click the Print Preview button to preview the information.

The Print preview window will be displayed, as shown below.
MDT Quality Assurance System  
Materials Summary

Materials Specifications

Contract ID: 09405  
Project No.: NM 8-4(41)90  
Description: US 287 PASS LN-3 3F TOSTON

Bid Item: COVER - TYPE 1  
Material Type: COVER MATERIAL GRADE 4A  
Contract Quantity: 70656 m^2  
Unit Price: 0.31  
Base Price: 0.28  
Pit Lab Number: 20256

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Spec Min</th>
<th>Spec Max</th>
<th>T Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/8&quot; \ 9.5 mm</td>
<td>100.</td>
<td>0.</td>
<td>10.</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>#4 \ 4.759 mm</td>
<td>0.</td>
<td>0.</td>
<td>15.</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>#8 \ 2.389 mm</td>
<td>0.</td>
<td>0.</td>
<td>20.</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

* denotes incentive sieves

Aggregate Related Specifications
MT108-Plasticity Index
Plasticity Index - Max: 0

MT209-Wear
Wear - Max: 30

MT117-Fracture
Fracture - Min: 70, T Factor: 2

MT126-Cleanness
Cleanness Value Pct - Max: 9.5

Entered by: MCCracken, ARLENE

Checked and Locked by: NELD, TERRY

QA Version: April 2007  
Page 1  
2/15/2006
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window, returning to the Materials Summary Print Selection form.

Click the Cancel button to close the Materials Summary Print Selection form and return to the Materials Summary form.

To print the Materials Summary information click on the Print button on the tool bar as shown below.

The Materials Summary Print Selection form is displayed as shown below.
All material items, material versions and test types selected in the list of available items are included in the printed output. Hence, to exclude items from the print output, un-select the items in the list of items provided.

Once the desired options are selected, click the **Print** button to print the information.

The standard windows printer **Print** dialog window will be displayed as shown below with the default printer selected to print to.
To print to a different printer, select the desired printer from the dropdown list of available printers next to the *Name:* label in the *Printer* panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The windows printer *Print* dialog window will close, returning to the *Materials Summary Print Selection* form.

Click the **Cancel** button to close the *Materials Summary Print Selection* form and return to the *Materials Summary* form.
11.3.2 Reporting Material Item Specs

11.3.2.1 Reporting Material Item Specs
After logging in (see Start and Log In to QA Suite), the file will be opened in the QA Suite with the main window displayed as shown below.

Since the material and test specs have been set, the user may view and/or report the Materials and Test Specs at any time. To do this, select the Materials Summary option from the Specifications menu dropdown as shown below.

This will activate the Materials Summary tab as shown below.
To report a material item, first select the material item from the list of *Existing Material Items* and then click on the **View Selected** button as shown below.
The **View Material Item Definition** window will display as shown below.
Since the material item is locked, the material item definition information can only be viewed in this window.

To preview the material item specification information click on the **Print Preview** button, as shown below.
The Print preview window will be displayed, as shown below.
### MDT Quality Assurance System
#### Materials Summary

<table>
<thead>
<tr>
<th>Contract ID:</th>
<th>09405</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project No.:</td>
<td>NH 6-4(41) 93 [033770410000]</td>
</tr>
<tr>
<td>Description:</td>
<td>US 287 PASS LE-S OF TOSTON</td>
</tr>
<tr>
<td>Bid Item:</td>
<td>PLANT MIX BIT SURF GR 5 - 19 NN</td>
</tr>
<tr>
<td>Material Type:</td>
<td>PLANT MIX BIT SURF GR 5 - 19 NN</td>
</tr>
<tr>
<td>Contract Quantity:</td>
<td>20499 t</td>
</tr>
<tr>
<td>Unit Price:</td>
<td>16.75</td>
</tr>
<tr>
<td>Base Price:</td>
<td>16.75</td>
</tr>
<tr>
<td>Pit Lab Number:</td>
<td>862131</td>
</tr>
<tr>
<td>Item Number:</td>
<td>401080000</td>
</tr>
<tr>
<td>Specification Effective Date:</td>
<td>2/15/2005</td>
</tr>
</tbody>
</table>

#### Sieve Sizes

<table>
<thead>
<tr>
<th>Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Spec</th>
<th>Max</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4&quot; \ 19 mm</td>
<td>100.</td>
<td>7.</td>
<td>93.</td>
<td>107.</td>
<td>1</td>
</tr>
<tr>
<td>1/2&quot; \ 12.5 mm</td>
<td>82.</td>
<td>7.</td>
<td>75.</td>
<td>89.</td>
<td>1</td>
</tr>
<tr>
<td>3/8&quot; \ 9.5 mm</td>
<td>61.</td>
<td>7.</td>
<td>54.</td>
<td>68.</td>
<td>1</td>
</tr>
<tr>
<td>#4 \ 4.750 mm</td>
<td>40.</td>
<td>7.</td>
<td>33.</td>
<td>47.</td>
<td>1</td>
</tr>
<tr>
<td>#8 \ 2.360 mm</td>
<td>27.</td>
<td>6.</td>
<td>21.</td>
<td>33.</td>
<td>3</td>
</tr>
<tr>
<td>#16 \ 1.180 mm</td>
<td>18.</td>
<td>6.</td>
<td>12.</td>
<td>24.</td>
<td>3</td>
</tr>
<tr>
<td>#30 \ 0.600 mm</td>
<td>14.</td>
<td>4.</td>
<td>10.</td>
<td>18.</td>
<td>3</td>
</tr>
<tr>
<td>#50 \ 0.300 mm</td>
<td>11.</td>
<td>4.</td>
<td>7.</td>
<td>15.</td>
<td>3</td>
</tr>
<tr>
<td>#100 \ 0.150 mm</td>
<td>7.</td>
<td>2.</td>
<td>5.</td>
<td>9.</td>
<td>3</td>
</tr>
<tr>
<td>#200 \ 0.075 mm</td>
<td>4.9</td>
<td>1.5</td>
<td>3.4</td>
<td>6.4</td>
<td>6</td>
</tr>
</tbody>
</table>

* denotes incentive sieve

#### Aggregate Related Specifications
- **MT217-Fracture**
  - Fracture: Min: 35, F Factor: 2

#### Other Specifications
- **MT333-Cylindery-3/4"(19MM)**
  - VMA: Target: 14.6, Tolerance: 0.6, Min: 14, Max: 15.2, F Factor: 6
  - VFA: Target: 80, Tolerance: 5, Min: 75, Max: 85, F Factor: 2
  - VIM: Target: 3.4, Tolerance: 1, Min: 2.4, Max: 4.4, F Factor: 6
- Dust/Asphalt Ratio: Target: 0.9, Tolerance: 0.2, Min: 0.7, Max: 1.1, F Factor: 30

#### MT334-HamburgWheelTracking
- Max Rut Depth: Max: 0.5

Entered by: MCCRACKEN, ARLENE

Checked and Locked by: HELD, TERRY

QA Version: April 2007

Page 1 2/14/2008
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the material item specification information, click on the Print button as shown below.
The standard windows printer **Print** dialog window will be displayed as shown below with the default printer selected to print to.

To print to a different printer, select the desired printer from the dropdown list of available printers next to the **Name:** label in the **Printer** panel.

The **Print range** section can be used to select to print a single page or a range of pages.

The **Copies** section can be used to select the Number of copies to print.

Selecting the **Properties...** button opens the printers **Properties** window as shown below.
The properties window provides access to additional printer settings such as finishing, paper and destination options as shown above.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **View Material Item Definition** window will be re-displayed.

Select the **Close** button to close the **View Material Item Definition** window and return to the main form window **Materials Summary** tab.
11.3.2.2 Report Plant Mix Bit Surf Grade S Material Item Specs
To report a Plant Mix Bit Surf Gr S material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the Plant Mix Bit Surf Gr S material item is locked, the Plant Mix Bit Surf Gr S material item definition information can only be viewed in this window.

To preview the Plant Mix Bit Surf Gr S material item specification information click on the Print Preview button, as shown below.
The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Materials Summary

Contract ID: 09405
Project No.: NH 8-4(41)93 [03377041000]
Description: US 287 PASS LB-S OF TOSTON

Bid Item: PLANT MIX BIT SURF GR 5 - 19 MM
Material Type: PLANT MIX BIT SURF GR 5 - 19 MM
Contract Quantity: 20499 t
Unit Price: 16.75
Pit Lab Number: 862131

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Spec Min</th>
<th>Spec Max</th>
<th>F Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4&quot; \ 19 mm</td>
<td>100</td>
<td>7</td>
<td>93</td>
<td>107</td>
<td>1</td>
</tr>
<tr>
<td>1/2&quot; \ 12.5 mm</td>
<td>82</td>
<td>7</td>
<td>75</td>
<td>89</td>
<td>1</td>
</tr>
<tr>
<td>3/8&quot; \ 9.5 mm</td>
<td>61</td>
<td>7</td>
<td>54</td>
<td>68</td>
<td>1</td>
</tr>
<tr>
<td>#4 \ 4.750 mm</td>
<td>40</td>
<td>7</td>
<td>33</td>
<td>47</td>
<td>1</td>
</tr>
<tr>
<td>#8 \ 2.360 mm</td>
<td>27</td>
<td>6</td>
<td>21</td>
<td>33</td>
<td>3</td>
</tr>
<tr>
<td>#10 \ 1.180 mm</td>
<td>18</td>
<td>6</td>
<td>12</td>
<td>24</td>
<td>3</td>
</tr>
<tr>
<td>#30 \ 0.600 mm</td>
<td>14</td>
<td>4</td>
<td>10</td>
<td>18</td>
<td>3</td>
</tr>
<tr>
<td>#50 \ 0.300 mm</td>
<td>11</td>
<td>4</td>
<td>7</td>
<td>15</td>
<td>3</td>
</tr>
<tr>
<td>#100 \ 0.150 mm</td>
<td>7</td>
<td>2</td>
<td>5</td>
<td>9</td>
<td>3</td>
</tr>
<tr>
<td>#600 \ 0.075 mm</td>
<td>4.9</td>
<td>1.5</td>
<td>3.4</td>
<td>6.4</td>
<td>6</td>
</tr>
</tbody>
</table>

* denotes incentive sieve

Aggregate Related Specifications
MT217-Fracture
  Fracture - Min: 35, F Factor: 2

Other Specifications
MT333-Cylindery-3/4"(19MM)
  WDA - Target: 14.6, Tolerance: 0.6, Min: 14, Max: 15.2, F Factor: 6
  VFA - Target: 80, Tolerance: 5, Min: 75, Max: 85, F Factor: 2
  WIM - Target: 3.4, Tolerance: 1, Min: 2.4, Max: 4.4, F Factor: 6
  Dust/Asphalt Ratio - Target: 0.9, Tolerance: 0.2, Min: 0.7, Max: 1.1, F Factor: 30

MT334-HamburgWheelTracking
  Max Rut Depth - Max: 0.5

Entered by: MCCRAKEN, ARLENE

Checked and Locked by: HELD, TERRY

QA Version: April 2007
Page 1 2/14/2008
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Plant Mix Bit Surf Gr S material item specification information, click on the Print button as shown below.
The standard windows printer **Print** dialog window will be displayed as shown below with the default printer selected to print to.

To print to a different printer, select the desired printer from the dropdown list of available printers next to the **Name:** label in the **Printer** panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **View Material Item Definition** window will be re-displayed.

Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
11.3.2.3 Report Plant Mix Grade D Material Item
To report a Plant Mix Grade D material item, first select the material item from the list of *Existing Material Items* and then click on the **View Selected** button as shown below.

![View Material Item Definition window](image)

The **View Material Item Definition** window will display as shown below.
Since the Plant Mix Grade D material item is locked, the Plant Mix Grade D material item definition information can only be viewed in this window.

To preview the Plant Mix Grade D material item specification information click on the Print Preview button, as shown below.
The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Materials Summary

Contract ID: 02903
Project No.: BM 15-1(74).122
Description: ROCKER SCALE SITE

Bid Item: PLANT MIX GR D - COMMERCIAL TESTED
Material Type: PLANT MIX GR D - COMMERCIAL TESTED
Contract Quantity: 4070 cu
Unit Price: 22.50
Base Price: 22.00
Pit Lab Number: 045522

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Min</th>
<th>Spec</th>
<th>Max</th>
<th>F Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4&quot; \ 19 mm</td>
<td>60.</td>
<td>7.</td>
<td>100</td>
<td>76.</td>
<td>90.</td>
<td>1</td>
</tr>
<tr>
<td>1/2&quot; \ 12.5 mm</td>
<td>68.</td>
<td>7.</td>
<td>61.</td>
<td>76.</td>
<td>75.</td>
<td>3</td>
</tr>
<tr>
<td>3/8&quot; \ 9.5 mm</td>
<td>66.</td>
<td>7.</td>
<td>61.</td>
<td>76.</td>
<td>75.</td>
<td>3</td>
</tr>
<tr>
<td>#4 \ 4.75 mm</td>
<td>50.</td>
<td>6.</td>
<td>42.</td>
<td>57.</td>
<td>57.</td>
<td>3</td>
</tr>
<tr>
<td>#10 \ 2.009 mm</td>
<td>30.</td>
<td>6.</td>
<td>24.</td>
<td>36.</td>
<td>36.</td>
<td>3</td>
</tr>
<tr>
<td>#40 \ 0.425 mm</td>
<td>12.</td>
<td>4.</td>
<td>8.</td>
<td>16.</td>
<td>16.</td>
<td>3</td>
</tr>
<tr>
<td>#200 \ 0.075 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* denotes incentive sieve

Aggregate Related Specifications

MT117-Fracture:
  Fracture - Min: 70, F Factor: 2

Other Specifications

MT117-Marshall:
  Stability - Min: 1800
  Flow - Min: 8, Max: 16
  Air Voids - Min: 2, Max: 4

Entered by: STANICH, GEORGE

Checked and Locked by: KARRIS, DEAN

QA Version - April 2007
Page 1
2/17/2008
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Plant Mix Grade D material item specification information, click on the Print button as shown below.
The standard windows printer *Print* dialog window will be displayed as shown below with the default printer selected to print to.

![Print dialog window](image)

To print to a different printer, select the desired printer from the dropdown list of available printers next to the *Name:* label in the *Printer* panel.

Once the desired print selections are made, click on the OK button to print the report.

Select the Cancel button to cancel the printing process with no prints created.

The *View Material Item Definition* window will be re-displayed.

Click the Close button to close the *View Material Item Definition* window and return to the main form *Materials Summary* tab.
11.3.2.4 Report "Cover Material" Material Items
To report a "Cover Material" material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the "Cover Material" material item is locked, the "Cover Material" material item definition information can only be viewed in this window.

To preview the "Cover Material" material item specification information click on the Print Preview button, as shown below.
The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System

Materials Summary

Contract ID: 09405
Project No.: MH 8-4(41)93 [02277941000]
Description: US 287 PAS LNE S 3P TOSTON

Bid Item: COVER - TYPE 1
Material Type: COVER MATERIAL GRADE A
Contract Quantity: 70556 m3
Unit Price: 0.91
Base Price: 0.28
Pit Lab Number: 20266

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Min</th>
<th>Spec</th>
<th>Max</th>
<th>T Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/8&quot; \ 9.5 mm</td>
<td></td>
<td></td>
<td>100</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#4 \ 9.750 mm</td>
<td></td>
<td></td>
<td>0.7</td>
<td>10.0</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>#8 \ 2.560 mm</td>
<td></td>
<td></td>
<td>0.0</td>
<td>15.0</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>#200 \ 0.075 mm</td>
<td></td>
<td></td>
<td>0.0</td>
<td>20.0</td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

* denotes incentive sieve

Aggregate Related Specifications
HT100-Plasticity Index
Plasticity Index - Max: 0

HT109-Wear
Wear - Max: 90

HT17-Triacture
Triacture - Min: 70; T Factor: 2

HT228-Cleaness
Cleaness Value Pct - Max: 3.5

Entered by: MCCracken, Arlene

Checked and Locked by: Held, Terry
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the "Cover Material" material item specification information click on the Print button, as shown below.
The standard Windows printer **Print** dialog window will be displayed as shown below with the default printer selected to print to.

To print to a different printer, select the desired printer from the dropdown list of available printers next to the **Name:** label in the **Printer** panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **View Material Item Definition** window will be re-displayed.

Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
11.3.2.5 Report Crushed Base Course Material Item
To report a Crushed Base Course material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the Crushed Base Course material item is locked, the Crushed Base Course material item definition information can only be viewed in this window.

To preview the Crushed Base Course material item specification information click on the Print Preview button, as shown below.
The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Materials Summary

Contract ID: 02405  
Project No.: NH 8-4(41)93  
Description: US 287 PASS LM-3 8F TOSTON  

Bid Item: CRUSHED AGGREGATE COURSE  
Material Type: CRUSHED BASE COURSE TYPE A GRADE 6A  
Contract Quantity: 22114 m³  
Unit Price: 17.94  
Bass Price: 17.94  

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Min</th>
<th>Spec</th>
<th>Max</th>
<th>F Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 1/2&quot; x 37.5 mm</td>
<td>66.</td>
<td>8.</td>
<td>78.</td>
<td>94.</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3/4&quot; x 19 mm</td>
<td>61.</td>
<td>12.</td>
<td>49.</td>
<td>75.</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>1/2&quot; x 12.5 mm</td>
<td>40.</td>
<td>9.</td>
<td>29.</td>
<td>57.</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3/8&quot; x 8.5 mm</td>
<td>22.</td>
<td>10.</td>
<td>12.</td>
<td>22.</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>#40 x 0.425 mm*</td>
<td>4.5</td>
<td>0.0</td>
<td>1.5</td>
<td>7.5</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>#200 x 0.076 mm</td>
<td>4.5</td>
<td>0.0</td>
<td>1.5</td>
<td>7.5</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

* denotes incentive sieve

Aggregate Related Specifications

HT117-Fracture
Fracture: Min: 25, F Factor: 2

Entered by: MCCracken, ARLENE

Checked and Locked by: Meld, TERREY

QA Version - April 2007  
Page 1  
2/17/2008
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Crushed Base Course material item specification information click on the Print button, as shown below.
The standard windows printer Print dialog window will be displayed as shown below with the default printer selected to print to.

![Print dialog window](image)

To print to a different printer, select the desired printer from the dropdown list of available printers next to the Name: label in the Printer panel.

Once the desired print selections are made, click on the OK button to print the report.

Select the Cancel button to cancel the printing process with no prints created.

The View Material Item Definition window will be re-displayed.

Click the Close button to close the View Material Item Definition window and return to the main form Materials Summary tab.
11.3.2.6 Report Cement Treated Base Material Item

To report a Cement Treated Base material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the Cement Treated Base material item is locked, the material item definition information can only be viewed in this window.

To preview the Cement Treated Base material item specification information click on the **Print Preview** button, as shown below.
The **Print preview** window will be displayed, as shown below.
### MDT Quality Assurance System

**Materials Summary**

**Contract ID:** 07812  
**Project No.:** STPP 54-1(9)0  
**Description:** WYOMING LINE - NORTH

**Bid Item:** BASE-CEMENT TREATED (B)  
**Material Type:** CEMENT TREATED BASE  
**Contract Quantity:** 20621 Cu Yd  
**Unit Price:** 63.13  
**Base Price:** 0.00

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Spec Min</th>
<th>Spec Max</th>
<th>Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1&quot; \ 25 mm</td>
<td></td>
<td></td>
<td>100.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3/4&quot; \ 19 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5/8&quot; \ 16 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/2&quot; \ 12.7 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3/8&quot; \ 9.5 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#4 \ 4.750 mm</td>
<td></td>
<td></td>
<td>40.</td>
<td>70.</td>
<td>3</td>
</tr>
<tr>
<td>#10 \ 2.000 mm</td>
<td></td>
<td></td>
<td>25.</td>
<td>55.</td>
<td>3</td>
</tr>
<tr>
<td>#200 \ 0.075 mm</td>
<td></td>
<td></td>
<td>4.0</td>
<td>12.0</td>
<td>6</td>
</tr>
</tbody>
</table>

* denotes incentive sieve

**Aggregate Related Specifications**

NT217 - Fracture  
Fracture - Min: 0

**Entered by:** BOUCHER, TIM

**Checked and Locked by:** JONES, JAMES ALLEN
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Cement Treated Base material item specification information, click on the Print button as shown below.
The standard windows printer *Print* dialog window will be displayed as shown below with the default printer selected to print to.

To print to a different printer, select the desired printer from the dropdown list of available printers next to the *Name:* label in the *Printer* panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The *View Material Item Definition* window will be re-displayed.

Click the **Close** button to close the *View Material Item Definition* window and return to the main form *Materials Summary* tab.
11.3.2.7 Report Concrete-Class Deck Material Item
To report a Concrete-Class Deck material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the Concrete-Class Deck material item is locked, the material item definition information can only be viewed in this window.

To preview the Concrete-Class Deck material item specification information, click on the **Print Preview** button, as shown below.
The *Print preview* window will be displayed, as shown below.
MDT Quality Assurance System
Materials Summary

Contract ID: 01414
Project No.: NM 22-3(12) 81 [7945012000] English
Description: CILBERTSON-NORTH (MT-16)

Bid Item: CONCRETE-CLASS DECK
Material Type: CONCRETE-CLASS DECK
Contract Quantity: 100 Cu Yd
Unit Price: 1500.00
Base Price: 500.00

Specification Effective Date: 9/11/2014

Bid Item No: 551020107

Entered by: BOUCHER, TIM

Checked and Locked by: HESSLER, JOHN
Note: For help using the Print preview window to view and print information, see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Concrete-Class Deck material item specification information, click on the Print button as shown below.
The standard windows printer *Print* dialog window will be displayed, as shown below, with the default printer selected to print to.

![Print Dialog Window]

To print to a different printer, select the desired printer from the dropdown list of available printers next to the *Name:* label in the *Printer* panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The *View Material Item Definition* window will be re-displayed.

Click the **Close** button to close the *View Material Item Definition* window and return to the main form *Materials Summary* tab.
11.3.2.8 Report Concrete-Class General Material Item

To report a Concrete-Class General material item, first select the material item from the list of Existing Material Items and then click on the View Selected button as shown below.

The View Material Item Definition window will display as shown below.
Since the Concrete-Class General material item is locked, the material item definition information can only be viewed in this window.

To preview the Concrete-Class General material item specification information, click on the **Print Preview** button, as shown below.
The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Materials Summary

Contract ID: 0414
Project No.: NM 22-8/12-01
Description: CILBERTON-NORTH (MT-16)

Bid Item: SIDEWALK-CONCRETE 4 IN
Material Type: CONCRETE-CLASS GENERAL
Contract Quantity: 60 Sq Yd
Unit Price: 100.00
Base Price: 0.00

Bid Item No: 606010020
Specification Effective Date: 9/11/2014

Entered by: BOUCHER, TIM

Checked and Locked by: HESSLER, JOHN
Note: For help using the Print preview window to view and print information, see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Concrete-Class General material item specification information, click on the Print button as shown below.
The standard Windows printer **Print** dialog window will be displayed, as shown below, with the default printer selected to print to.

![Print dialog window](image)

To print to a different printer, select the desired printer from the dropdown list of available printers next to the **Name:** label in the **Printer** panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **View Material Item Definition** window will be re-displayed.

Click the **Close** button to close the **View Material Item Definition** window and return to the main form **Materials Summary** tab.
11.3.3 Reporting Test Specs

11.3.3.1 Reporting Test Specs
After logging in (see Start and Log In to QA Suite), the file will be opened in the QA Suite with the main window displayed as shown below.

Since the material and test specs have been set, the user may view and/or report the Materials and Test Specs at any time. To do this, select the Materials Summary option from the Specifications menu dropdown as shown below.

This will activate the Materials Summary tab as shown below.
To report material item test specs, first select the material item from the list of *Existing Material Items*, as shown below.
The test types list near the bottom of the *Materials Summary* window will be displayed. The list contains all of the test types required for the material item (potential test types are: *Aggregate Gradations*, *Concrete Specs*, *Daily Plant Mix Report*, *Marshall Testing*, *Plant Mix Density*, *Ride Specification* and *Volumetric Testing*).

To report a test type’s material information first select the test type from the list of test types and then select the **View** button in the *Material Info for Selected Test* panel.

To report the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the **View** button (see Report Aggregate Gradations Test Specs).

To report the material information for the Aggregate Surfacing Density test type, select the Aggregate Surfacing Density test type from the list of test types and click on the **View** button (see Report Aggregate Surfacing Density Test Specs).
To report the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types and click on the View button (see Report Concrete Specs Test Specs).

To report the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the View button (see Report Daily Plant Mix Report Test Specs).

To report the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the View button (see Report Marshall Testing Test Specs).

To report the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the View button (see Report Plant Mix Density Test Specs).

To report the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the View button (see Report Ride Specification Test Specs).

To report the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the View button (see Report Volumetric Testing Test Specs).
11.3.3.2 Report Aggregate Gradations Test Specs

To report the material information for the Aggregate Gradations test type, select the Aggregate Gradations test type from the list of test types and click on the **View** button as shown below.

The **Add Aggregate Spec** window will be displayed as shown below.
Since the Aggregate Gradation test spec is locked, the Aggregate Spec information can only be viewed in this window.

To preview the Aggregate Gradations spec information click on the Print Preview button, as shown below.
The *Print preview* window will be displayed, as shown below.
**MDT Quality Assurance System**

**Aggregate Testing Material Info**

**Contract ID:** 69405  
**Project No.:** NH 8-4(41)93  
**Description:** US 287 PASS LN-S OF TOSTON

**Bid Item:** PLANT MIX BIT SURF GR S - 19 MM  
**Material Type:** PLANT MIX BIT SURF GR S - 19 MM  
**Material Version:** 1  
**Default Lot Size:** 5000 t

<table>
<thead>
<tr>
<th>Sieve Size</th>
<th>Job Mix</th>
<th>Tolerance</th>
<th>Spec Min</th>
<th>Spec Max</th>
<th>F Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/4&quot; \ 19 mm</td>
<td>100.</td>
<td>7.</td>
<td>53.</td>
<td>107.</td>
<td>1</td>
</tr>
<tr>
<td>1/2&quot; \ 12.5 mm</td>
<td>82.</td>
<td>7.</td>
<td>75.</td>
<td>89.</td>
<td>1</td>
</tr>
<tr>
<td>3/8&quot; \ 9.5 mm</td>
<td>61.</td>
<td>7.</td>
<td>54.</td>
<td>68.</td>
<td>1</td>
</tr>
<tr>
<td>#4 \ 4.750 mm</td>
<td>40.</td>
<td>7.</td>
<td>35.</td>
<td>47.</td>
<td>1</td>
</tr>
<tr>
<td>#8 \ 2.360 mm</td>
<td>25.</td>
<td>6.</td>
<td>21.</td>
<td>33.</td>
<td>3</td>
</tr>
<tr>
<td>#16 \ 1.180 mm</td>
<td>18.</td>
<td>6.</td>
<td>12.</td>
<td>24.</td>
<td>3</td>
</tr>
<tr>
<td>#30 \ 0.600 mm</td>
<td>14.</td>
<td>4.</td>
<td>10.</td>
<td>18.</td>
<td>3</td>
</tr>
<tr>
<td>#50 \ 0.300 mm</td>
<td>11.</td>
<td>4.</td>
<td>7.</td>
<td>15.</td>
<td>3</td>
</tr>
<tr>
<td>#100 \ 0.150 mm</td>
<td>7.</td>
<td>3.</td>
<td>5.</td>
<td>9.</td>
<td>3</td>
</tr>
<tr>
<td>#200 \ 0.075 mm</td>
<td>4.9</td>
<td>1.5</td>
<td>3.4</td>
<td>6.4</td>
<td>6</td>
</tr>
</tbody>
</table>

* denotes incentive sieve

**Aggregate Related Specifications**

MT217-Fracture  
Fracture - Min: 35, F Factor: 2

Entered by: MCRAVEN, ARLENE

Checked and Locked by: HELD, TERRY

QA Version - April 2007  
Page 1  
2/14/2008
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Aggregate Gradations spec information, click on the Print button as shown below.

The standard windows printer Print dialog window will be displayed as shown below with the default printer selected to print to.
To print to a different printer, select the desired printer from the dropdown list of available printers next to the *Name:* label in the *Printer* panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **Add Aggregate Spec** window will be re-displayed.

Click the **Close** button to close the **Add Aggregate Spec** window and return to the main form **Materials Summary** tab.
11.3.3.3 Report Aggregate Surfacing Density Test Specs

To report the material information for the Aggregate Surfacing Density test type, select the Plant Mix Density test type from the list of test types and click on the View button as shown below.

The **Aggregate Surfacing Density Material Info** window will be displayed as shown below.
Since the Aggregate Surfacing Density test spec is locked, the Aggregate Surfacing Density information can only be viewed in this window.

To preview the Aggregate Surfacing Density spec information click on the **Print Preview** button, as shown below.
The *Print preview* window will be displayed, as shown below.
MDT Quality Assurance System
Aggregate Surfacing Density Testing Material Info

Contract ID: 07812
Project No.: STPP 54-1(3)0 [5744009000] English
Description: WYOMING LINE - NORTH

Bid Item: BASE-CEMENT TREATED (B)
Material Type: CEMENT TREATED BASE
Material Version: 1
Default Lot Size: 3750 Cu Yd

Deduct - Min: 98, F Factor: 6

Entered by: BOUCHER, TIM

Checked and Locked by: JONES, JAMES ALLEN

Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Aggregate Surfacing Density spec information, click on the Print button as shown below.

The standard windows printer Print dialog window will be displayed as shown below with the default printer selected to print to.
To print to a different printer, select the desired printer from the dropdown list of available printers next to the *Name:* label in the *Printer* panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The *Aggregate Surfacing Density Material Info* window will be re-displayed.

Click the **Close** button to close the *Aggregate Surfacing Density Material Info* window and return to the main form *Materials Summary* tab.
11.3.3.4 Report Concrete Specs Test Specs

To report the material information for the Concrete Specs test type, select the Concrete Specs test type from the list of test types and click on the View button as shown below.

The Concrete Specs Material Info window will be displayed as shown below.
Since the Concrete Specs test spec is locked, the Concrete Specs information can only be viewed in this window.

To preview the Concrete Specs spec information, click on the Print Preview button, as shown below.

The Print preview window will be displayed, as shown below.
MDT Quality Assurance System
Concrete Specs Testing Material Info

Contract ID: 01414
Project No.: NH 22-3(12) 51
Description: CILBERTSON-NORTH (MT-16)

Bid Item: CONCRETE-CLASS DECK
Material Type: CONCRETE-CLASS DECK
Contract Quantity: 100 Cu Yd
Unit Price: $1500.00 Base Price: $500.00
Line Item Number: 9021

Specification Items
Default Gradation Type: Optimized

Entered by: BOUCHER, TIM

Checked and Locked by: HESSLER, JOHN

Specification Effective Date: 9/11/2014
Note: For help using the Print preview window to view and print information, see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Concrete Specs spec information, click on the Print button as shown below.

![Concrete Specs Material Info](image)

The standard windows printer Print dialog window will be displayed, as shown below, with the default printer selected to print to.
To print to a different printer, select the desired printer from the dropdown list of available printers next to the *Name:* label in the *Printer* panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The *Concrete Specs Material Info* window will be re-displayed.

Click the **Close** button to close the *Concrete Specs Material Info* window and return to the main form *Materials Summary* tab.
11.3.3.5 Report Daily Plant Mix Report Test Specs

To report the material information for the Daily Plant Mix Report test type, select the Daily Plant Mix Report test type from the list of test types and click on the **View** button as shown below.

The *Daily Plant Mix Report Material Info* window will be displayed as shown below.
Since the Daily Plant Mix Report test spec is locked, the Daily Plant Mix Report information can only be viewed in this window.

To preview the Daily Plant Mix Report spec information click on the **Print Preview** button, as shown below.
The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Daily Plant Mix Report Material Info

Contract ID: 09405
Project No.: NH 8-4(4193) [03377041000]
Description: US 287 PASS LN-S OF TOSTON

Bid Item: PLANT MIX BIT SURF GR S - 19 MM
Material Type: PLANT MIX BIT SURF GR S - 19 MM
Material Version: 1

Item Number: 401080000

Type of Plant: Batch
Mix Design Number: 1
Mix Design Date: 10/11/2005
Mix Type: Grade S

<table>
<thead>
<tr>
<th>Bin Type</th>
<th>Gsb (Specific Gravity)</th>
<th>Split %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coarse</td>
<td>2.637</td>
<td>49.3</td>
</tr>
<tr>
<td>Crushed Pines</td>
<td>2.525</td>
<td>41.9</td>
</tr>
<tr>
<td>Natural Pines</td>
<td>2.504</td>
<td>7.4</td>
</tr>
<tr>
<td>Hyd Lime</td>
<td>2.494</td>
<td>1.4</td>
</tr>
</tbody>
</table>

Number of Lifts: 2
Average Plan Thick: 120
Maximum Mixing Temp: 174
Minimum Mixing Temp: 143
Design Rice Density: 2.459
Design VFA: 80
Design % Void: 3.7
Design Density: 2367
Design % Asphalt: 5.2
Design % Additive 1: 1.4
Design % Additive 2: 0

Entered by: MCCRAVEN, ARLENE

Checked and Locked by: HELD, TERRY
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Daily Plant Mix Report spec information, click on the Print button as shown below.

The standard windows printer Print dialog window will be displayed as shown below with the default printer selected to print to.
To print to a different printer, select the desired printer from the dropdown list of available printers next to the Name: label in the Printer panel.

Once the desired print selections are made, click on the OK button to print the report.

Select the Cancel button to cancel the printing process with no prints created.

The Daily Plant Mix Report Material Info window will be re-displayed.

Click the Close button to close the Daily Plant Mix Report Material Info window and return to the main form Materials Summary tab.
11.3.3.6 Report Marshall Testing Test Specs
To view the material information for the Marshall Testing test type, select the Marshall Testing test type from the list of test types and click on the **View** button as shown below.

![View Marshall Testing Material Info](image)

The **View Marshall Testing Material Info** window will be displayed as shown below.
Since the Marshall Testing test spec is locked, the Marshall Testing information can only be viewed in this window.

To preview the Marshall Testing spec information click on the **Print Preview** button, as shown below.

The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Marshall Testing Material Info

**Contract ID:** 03903
**Project No.:** IM 15-2 (74) 122 [04197074000]
**Description:** ROCKER SCALE SITE

**Bid Item:** PLANT MIX GR D - COMMERCIAL TESTED
**Material Type:** PLANT MIX GR D - COMMERCIAL TESTED
**Material Version:** 1

**Item Number:** 401040500

**Stability - Min:** 1500
**Flow - Min:** 8, **Max:** 16
**Air Voids - Min:** 4, **Max:** 7

**Entered by:** STANICH, GEORGE

**Checked and Locked by:** HARRIS, DEAN

QA Version - April 2007

Page 1

2/15/2008
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Marshall Testing spec information, click on the Print button as shown below.

![View Marshall Testing Material Info - PLANT MIX GR D - COMMERCIAL TESTED]

The standard windows printer Print dialog window will be displayed as shown below with the default printer selected to print to.
To print to a different printer, select the desired printer from the dropdown list of available printers next to the Name: label in the Printer panel.

Once the desired print selections are made, click on the OK button to print the report.

Select the Cancel button to cancel the printing process with no prints created.

The View Marshall Testing Material Info window will be re-displayed.

Click the Close button to close the View Marshall Testing Material Info window and return to the main form Materials Summary tab.
11.3.3.7 Report Plant Mix Density Test Specs
To report the material information for the Plant Mix Density test type, select the Plant Mix Density test type from the list of test types and click on the View button as shown below.

The **Plant Mix Density Material Info** window will be displayed as shown below.

Since the Plant Mix Density test spec is locked, the Plant Mix Density information can only be viewed in this window.

To preview the Plant Mix Density spec information click on the Print Preview button, as shown below.
The **Print preview** window will be displayed, as shown below.

Note: For help using the Print preview window to view and print information see [Print Preview Operations](#).

When done previewing the printed output, click on the **Close** button to close the **Print preview** window.

To print the Plant Mix Density spec information, click on the **Print** button as shown below.

The standard windows printer **Print** dialog window will be displayed as shown below with the default printer selected to print to.

![Print dialog window](image)

To print to a different printer, select the desired printer from the dropdown list of available printers next to the **Name:** label in the **Printer** panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **Plant Mix Density Material Info** window will be re-displayed.
Click the **Close** button to close the *Plant Mix Density Material Info* window and return to the main form *Materials Summary* tab.
11.3.3.8 Report Ride Specification Test Specs
To report the material information for the Ride Specification test type, select the Ride Specification test type from the list of test types and click on the View button as shown below.

The View Ride Spec Material Info window will be displayed as shown below.
Since the Ride Specification test spec is locked, the Ride Specification information can only be viewed in this window.

To preview the Ride Specification spec information click on the Print Preview button, as shown below.

The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Ride Specification Material Info

Contract ID: 09405
Project No.: NH 6-4(41)93 [033770410000] Metric
Description: US 287 PASS LN S OF TOSTON

Bid Item: PLANT MIX BIT SURF GR S - 19 MM
Material Type: PLANT MIX BIT SURF GR S - 19 MM
Material Version: 1

Item Number: 401080000

Specification Date: 8/9/2006
Project Category: I

Entered by: MCCRAKEN, ARLENE

Checked and Locked by: MEID, TERRY

Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Ride Specification spec information, click on the Print button as shown below.

The standard windows printer Print dialog window will be displayed as shown below with the default printer selected to print to.

To print to a different printer, select the desired printer from the dropdown list of available printers next to the Name: label in the Printer panel.
Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **View Ride Spec Material Info** window will be re-displayed.

Click the **Close** button to close the **View Ride Spec Material Info** window and return to the main form **Materials Summary** tab.
11.3.3.9 Report Volumetric Testing Test Specs
To report the material information for the Volumetric Testing test type, select the Volumetric Testing test type from the list of test types and click on the View button as shown below.

The View Volumetric Testing Material Info window will be displayed as shown below.
Since the Volumetric Testing test spec is locked, the Volumetric Testing information can only be viewed in this window.

To preview the Volumetric Testing spec information click on the **Print Preview** button, as shown below.
The *Print preview* window will be displayed, as shown below.
MDT Quality Assurance System
Volumetric Testing Material Info

Contract ID: 09405
Project No.: NH 0-6(41)93
Description: US 287 PASS LN-S OF TOSTON
Bid Item: PLANT MIX BIT SURF GR 5 – 19 MM
Material Type: PLANT MIX BIT SURF GR 5 – 19 MM
Material Version: 1
Default Lot Size: 5000 t

Mix Design Date: 10/11/2005
Mix Design Number: 1
Mix Design Gmm: 2.459
Hyd Lime Bulk Specific Gravity: 2.404
Asphalt Type: F.G. 64-28
Asphalt Supplier: M.R.C.
Asphalt Specific Gravity: 1.028
Specification Date: 2/15/2005

<table>
<thead>
<tr>
<th></th>
<th>% Voids</th>
<th>VMA</th>
<th>VFA</th>
<th>D/A Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Value</td>
<td>3.4</td>
<td>14.6</td>
<td>80</td>
<td>0.9</td>
</tr>
<tr>
<td>Incentive Tolerance</td>
<td>0.3</td>
<td>0.3</td>
<td>3</td>
<td>0.1</td>
</tr>
<tr>
<td>Incentive Range</td>
<td>2.9-3.9</td>
<td>14.3-14.9</td>
<td>77-83</td>
<td>0.8-1</td>
</tr>
<tr>
<td>Job Mix Tolerance</td>
<td>1</td>
<td>0.6</td>
<td>5</td>
<td>0.2</td>
</tr>
<tr>
<td>Job Mix Range</td>
<td>2.4-4.4</td>
<td>14-15.2</td>
<td>75-85</td>
<td>0.7-1.1</td>
</tr>
<tr>
<td>Incentive</td>
<td>0.02</td>
<td>0.02</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>F Factor</td>
<td>6</td>
<td>6</td>
<td>2</td>
<td>30</td>
</tr>
</tbody>
</table>

Entered by: MCCRACKEN, ARLENE

Checked and Locked by: HEID, TERRY

QA Version: April 2007
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

To print the Volumetric Testing spec information, click on the Print button as shown below.

The standard windows printer Print dialog window will be displayed as shown below with the default printer selected to print to.
To print to a different printer, select the desired printer from the dropdown list of available printers next to the **Name** label in the **Printer** panel.

Once the desired print selections are made, click on the **OK** button to print the report.

Select the **Cancel** button to cancel the printing process with no prints created.

The **View Volumetric Testing Material Info** window will be re-displayed.

Click the **Close** button to close the **View Volumetric Testing Material Info** window and return to the main form **Materials Summary** tab.
11.4 Modifying Material Items and Test Specs

11.4.1 Modifying Material/Test Specs

During the course of the project there may be times where material items, test specs and/or material versions specifications may need to be modified.

The process for modifying material/test specs is as follow:\textsuperscript{a,b}
1. Unlock the items to be modified (see Unlocking Material/Test Specs).
2. Make the necessary modifications to the items' specifications.
3. Re-lock all of the items that were unlocked during step 1 (see Re-locking Material/Test Specs).

Things to remember:

a. Unlocking a material item also unlocks all material versions and test specs for the material item. Hence, all material versions and test specs for the material item will also need to be re-locked after the modifications have been made to the material item and the material item has been re-locked.

b. Unlocking a material version also unlocks all test specs for the material version. Hence, all of the test specs for the material version will need to be re-locked before the material version can be re-locked after being modified.
11.4.2 Unlocking Material/Test Specs

Material item, test type and material version specifications will need to be unlocked before they can be modified.

To unlock material item, test type or material version specifications, first open the file in the QA Suite (see Start and Log In to QA Suite).

After logging in, the file will be opened in the QA Suite with the main window displayed as shown below.

To start the process of unlocking material item, test type or material version specifications, select the Specification/Data Locking option under the Tools --> Security/Control option, as shown below.

The QA Specifications and Test Data Locking form opens as shown below.
To view the locked status for specifications and unlock specifications, click the *Material Item Specification Locking* tab, as shown below.
The Material Item Specification Locking tab is organized into two sections.

The locked state for the material type(s) are shown in the Bid Item / Material Type section in the upper part of the tab. As the section heading indicates, the material type(s) are identified by the Bid Item and Material Type separated by a forward slash ("/"). For example, the cover type 1 bid item, cover material grade 4A material type is identified as "COVER - TYPE 1 / COVER MATERIAL GRADE 4A".

For example, the cover type 1 bid item, cover material grade 4A material version 1 material version is identified as "COVER - TYPE 1 / COVER MATERIAL GRADE 4A/Material Ver. 1".

The locked state for the test type(s) for each material type are shown in the Bid Item / Material Type / Material Version / Test Type: section in the lower part of the tab. As the section heading indicates, the test type(s) are identified by the Bid Item, Material Type, Material Version and Test Type separated by forward slashes ("/"). For example, the cover type 1 bid item, cover material grade 4A, material version 1, Aggregate test type is identified as "COVER - TYPE 1 / COVER MATERIAL GRADE 4A/Material Ver. 1/Aggregate".

To unlock a material type un-select the Locked check box next to the material type. As part of the QA process, a reason is required for unlocking an item. Hence, an Unlock Reason window will be displayed, requiring the entry of explanation for the reason for unlocking the item.

After text is entered in the reason entry text box, the OK button will be enabled as shown below.
Click the **OK** button to continue with the material type unlocking. Click the **Cancel** button to cancel the unlocking process.

Because all test types are part of a material version and all material versions are part of a material type, unlocking the material type also unlocks all of the material versions for the material type and all of the test types for each material version, as shown below.

Click the **OK** button to complete the unlocking process. Click the **Cancel** button to cancel the unlocking process.

Since the Plant Mix Bit Surf Gr S - 19MM material is unlocked, all test data editing, viewing and reporting is suspended until the material type is locked again. Hence, the PLANT MIX GR S - 19MM material type is no longer displayed in the tests navigation panel, as shown below.
To unlock a material version, un-select the Locked check box next to the material version. As part of the QA process, a reason is required for unlocking an item. Hence, an Unlock Reason window will be displayed, requiring the entry of explanation for the reason for unlocking the item.

After text is entered in the reason entry text box, the OK button will be enabled as shown below.

Click the OK button to continue with the material type unlocking. Click the Cancel button to cancel the unlocking process.

Because all test types are part of a material version, unlocking the material version also unlocks all of the test types for that material version, as shown below.
Click the **OK** button to complete the unlocking process. Click the **Cancel** button to cancel the unlocking process.

Since the Plant Mix Bit Surf Gr S - 19MM, Material Version 1 is unlocked, all test data editing, viewing and reporting for the material type is suspended until the material version is locked again. Hence, the PLANT MIX GR S - 19MM material type is no longer displayed in the tests navigation panel, as shown below.

To unlock a test type, un-select the Locked check box next to the test type. As part of the QA process, a reason is required for unlocking an item. Hence, an **Unlock Reason** window will be displayed, requiring the entry of explanation for the reason for unlocking the item.
After text is entered in the reason entry text box, the **OK** button will be enabled as shown below.

![Unlock Reason](image)

Click the **OK** button to continue with the material type unlocking. Click the **Cancel** button to cancel the unlocking process.

Because test types are a subset of the material version, they can be unlocked without unlocking the material version. Hence, only the selected test type is unlocked, as shown below.
Click the **OK** button to complete the unlocking process. Click the **Cancel** button to cancel the unlocking process.

Since the Plant Mix Bit Surf Gr S - 19MM, Material Version 1, Volumetric test type is unlocked, test data editing, viewing and reporting for the Material Version 1, Volumetric test type is suspended until the test type is locked again. Hence, the PLANT MIX GR S - 19MM, Material Version 1, Volumetric test type is no longer displayed in the tests navigation panel, as shown below.
Once material item, test type and material version specifications are unlocked they can be edited (see Select and Edit Material Item, Select and Edit Test Specs or Edit Material Version Information).

**Things to remember:**

- a. Unlocking a material item also unlocks all material versions and test specs for the material item. Hence, all material versions and test specs for the material item will also need to be re-locked after the modifications have been made to the material item and the material item has been re-locked.
- b. Unlocking a material version also unlocks all test specs for the material version. Hence, all of the test specs for the material version will need to be re-locked before the material version can be re-locked after being modified.
11.4.3 Re-locking Material/Test Specs

After material item, test type or material version specifications are unlocked and edited, they will need to be re-locked before any further data entry, editing or reporting can be performed.

The process for re-locking material/test specs is the same as the reviewing and locking process used during the materials/test specs setup.

Re-locking a material item requires the following steps: a
1. Review and lock the material item (see Review and Lock Material Items).
2. Lock the test specs for all test types for the material item (see Review and Lock Test Specs).
3. Lock the material version for the material item (see Review and Lock Material Versions).

Re-locking a material version requires the following steps: b
1. Lock the test specs for all test types for the material version (see Review and Lock Test Specs).
2. Review and lock the material version (see Review and Lock Material Versions).

Re-locking test specs requires the following steps:
1. Review and lock the test specs for all test types that were unlocked (see Review and Lock Test Specs).

Things to remember:

a. Unlocking a material item also unlocks all material versions and test specs for the material item. Hence, all material versions and test specs for the material item will also need to be re-locked after the modifications have been made to the material item and the material item has been re-locked.

b. Unlocking a material version also unlocks all test specs for the material version. Hence, all of the test specs for the material version will need to be re-locked before the material version can be re-locked after being modified.
12. Splitting And Merging Test Data

12.1 Split And Merge Function Definition And Use

The master QA Contract file should remain under the control of the EPM's office and there should only be one master file created and maintained for a contract.

The Split/Merge functionality was added to allow the EPM's office to maintain control of the master QA Contract file while allowing other individuals in other locations (ex., test trailers) to perform test data entry at their location.

Since numerous locations have limited or no network connectivity (ex., test trailers) the split function creates a separate QA contract file that only allows for data entry or editing for the types of testing that are defined when the split file is created. All other test information in the split file is view only.

Once a testing type is split out from the master QA Contract file, the information for that test type becomes view only in the master QA Contract file. This is to prevent test data from being entered or edited in two different files at the same time, avoiding obvious potential problems with resolving data inconsistencies between the files.

The EPM's office uses the Split function to create the split file(s) (one split file can be created for each test type, if desired). The split file(s) are created in the same folder as the master QA Contract file using the name(s) defined during the split process.

The EPM's office then copies the file(s) on to a memory stick for other individuals to take to their field location and copy onto their computer or laptop so that they can perform data entry and editing in the QA Suite.

The updated split file(s) are then copied back on to a memory stick and brought back to the EPM's office (preferably once a week if possible) where they are copied back on to the EPM's office machine in the same folder as the master QA Contract file.

The EPM's office then uses the Merge function to merge the data from the split file(s) into the master QA Contract file. This copies the data from the split file(s) into the master QA Contract file. The EPM's office can choose what items to merge back into the master before performing the actual merge.

Once all of the test data has been updated from all split files, the EPM's office uses the Update Split From Master function to update the split file(s) from the master file so that the split file(s) contain all of the current data for all test types.
The updated split file(s) can then be copied back on to a memory stick from the EPM’s office machine and taken back out to the field for copying on to the field computer or laptop for further data entry or editing.

This cycle continues until all of the test data entry and editing at the field location(s) has been completed.

Once the field data entry and editing is completed, the EPM’s office will select the option to cancel the split after merging when performing the last merge.

Once the split is cancelled, the data for the testing types defined for the split file that has been cancelled will no longer be view only in the master QA Contract file.

The cancelled split file is not deleted from the folder containing the master QA Contract file. However, it can no longer be used for data entry or editing (all data is view only) and can no longer be merged back into the master file.

In the off chance that a split file gets lost or damaged, the EPM’s office can use the Rebuild Split function to rebuild the lost or damaged split file from the master QA Contract file.

Note: The rebuild split operations should only be done as a last resort since the rebuilt split file will only contain the data that is in the master QA Contract file. Any data entry or editing that has been performed since the last merge will have been lost.
12.2 Setting Up To Split Out Test Types For Data Entry

You will need to perform the following operations before you can split out test types for data entry:

1. Validate the project information (see Project Information).
2. Delete unnecessary material items (see Delete Extra Material Items)
3. For each necessary material item:
   a. Complete the setup and locking of the material item (see Select and Edit Material Item; Mark Material Item Editing as Complete; and, Review and Lock Material Items)
   b. Complete the setup and locking of the test specifications (see Select and Edit Test Specs; Mark Test Spec Editing as Complete; and, Review and Lock Test Specs)
   c. Complete the setup and locking of the material versions (see Edit Material Version Information; Mark Material Version Editing as Complete; and, Review and Lock Material Versions)

Split operations can only be performed by users with one of the following roles:
   1. Project Manager
   2. Field Office Person
   3. Lab Supervisor

Once these operations have been completed and the file saved, the Split option will become available under the Tools --> Project DB Manager option, as shown below.

Split files can now be created for use for test data entry (see Creating Split Files For Data Entry).
12.3 Creating Split Files For Data Entry

Once you have finished setting up to split out test types for data entry (see Setting Up To Split Out Test Types For Data Entry), split files can be created.

To create a split file, select the **Split** option under the **Tools --> Project DB Manager** option, as shown below.

![Create Project Splits form](image)

The *Create Project Splits* form opens as shown below.

![Define Project Split form](image)

Click the **Add Split** button and the *Define Project Split* form will open as shown below.
First, select the testing to be allowed in the split file by clicking the **Change Testing List** button which will open the *Select Allowed Testing* form as shown below.

Select one or more tests from the **Possible Testing** list and then click the **Add ->** button. The selected test(s) will move to the **Allowed Testing** list as shown below (for help with selecting list items see *List View Operations*).
When the **OK** button is clicked, the selected test(s) will appear in the *Testing Allowed for Split* list in the *Define Project Split* form as shown below.

Next, select the personnel for the split file by clicking the **Change Crew List** button, which will open the *Select Crew Members* form as shown below.
Click the Add All ->> button to add all personnel from the master contract file to the split file. All of the personnel in the Possible Crew Members list will move to the Selected Crew Members list as shown below.

Note: Alternatively, you can select one or more person from the Possible Crew Members list and then click the Add -> button to move the selected person(s) to the Selected Crew Members list (for help with selecting list items see List View Operations).

When the OK button is selected, the selected person(s) will appear in the Crew for Split list in the Define Project Split form as shown below.
Next, name the split file by editing the text in the *Filename for New Split:* text box. The QA Suite program initializes the split file name by appending an underscore (_) to the end of the master file name. In this case, since the split is for Aggregate testing, `AggSplit` was appended to the file name, as shown below.

When the **OK** button is selected, the defined project split will appear in the *Define/View Splits* list in the *Create Project Splits* form as shown below.
To define a separate split file for other test(s), select the **Add Split** button. The *Define Project Split* form will be displayed, allowing for selection of test(s) and crew personnel for the additional split file, as shown below.
When the **OK** button is selected, the new defined project split will also appear in the **Define/View Splits** list in the **Create Project Splits** form as shown below.
As each defined split is selected in the **Define/View Splits** list, the defined split information (file name, testing enabled and crew for split) is displayed in the **Selected Split Info** panel.

To edit a defined split, select the split in the **Define/View Splits** list and select the **Edit Selected Split** button. The **Define Project Split** form will be re-displayed for the user to make changes to the file name, selected test(s) or crew personnel, as shown below.

Once the changes are made, select the **OK** button to save the changes and return to the **Create Project Splits** form.
Once all of the splits have been defined, select the **Create Splits** button to perform the actual file creation. The **Split Results** form will be displayed confirming successful creation of the split file(s), as shown below.

As shown in the **Split Results** form, the newly created split file(s) are created in the same folder as the master QA Contract file using the name(s) defined during the split process.

After selecting the **OK** button, the **Split Complete** information form will be displayed, confirming successful completion of the project split process, as shown below.
Select the **OK** button to complete the split file creation process, returning to the QA Suite main form, as shown below.
Notice that since the Aggregate and Volumetric testing have both been split out for data entry, the Aggregate Gradations and Volumetrics data are now view only in the master contract file. This is indicated by the Lot numbers in italics in the tests tree view navigation panel and the data being grayed out in the test user interface as shown above.
The newly created split file(s) can now be copied to a memory stick for other individuals to take to their field location and copy onto their computer or laptop so that they can perform data entry and editing in the QA Suite.

**Note:**

When a split file is opened for data entry, only the data for the test type enabled for the file can be edited.

For example, after opening the Aggregate test split file, all test data is view only except the Aggregate Gradation data as shown below.
Similarly, after opening the Volumetric test split file, all test data is view only except the Volumetrics data as shown below.
12.4 Merging Data From Split Files Into Master File

The field office staff copy split file(s) from a memory stick onto their computer or laptop so that they can perform data entry and editing in the QA Suite.

During the course of the data entry and editing, the modified information should be merged back into the master contract file in the EPM's office routinely (at least once a week if feasible).

Updated split file(s) are copied back on to a memory stick and brought back to the EPM's office where they are copied back on to the EPM's office machine in the same folder as the master QA Contract file.

The EPM's office then uses the **Merge** function to merge the data from the split file(s) into the master QA Contract file. This copies the data from the split file(s) into the master QA Contract file. The EPM's office can choose what items to merge back into the master before performing the actual merge.

To merge information from a split file(s) into the master contract file, first open the master file. Then select the **Merge** option under the **Tools --> Project DB Manager** option, as shown below.

![Merge QA Project Files form](image)

The **Merge QA Project Files** form opens as shown below.
Note: If a split file is missing from the Master file folder, that file will be disabled in the *Merge QA Project Files* window as shown below.

Select the project files to merge by placing a check mark next to the desired split file name, as shown below.
Click the **Merge Files** button and for each file that has been selected for merge, the *QA Suite Project Merge Reconciliation* form will be displayed as shown below.

The *QA Suite Project Merge Reconciliation* form shows information about the data in the master file on the left side of the window (under the Main (Primary) Project heading). Information about the data in the split file is shown on the right side of the window (under the Project Being Merged heading).
If data for a Lot, Report or Test Run exists in both the Master and the Split file, a Radio Button is displayed for each file. To import data from the Split file into the Master file, check the Radio Button for the Split file. To keep the data from the Master file, check the Radio Button for the master file.

If data exists only in the split file, a Check Box is displayed on the Split file side of the window. To import the data from the Split file into the Master file, check the Check Box.

If the data in the master and split file for a Lot are the same, the label under the Data Match heading will be True. Otherwise it will be False.

If all of the data in the master and the split file are the same, there is nothing to merge and the OK button will not be enabled.

In this case, since the split file has been edited there is a difference between the master and the split file and the OK button is enabled.

As shown below, the Aggregate Gradations data for the CRUSHED BASE COURSE TYPE A GRADE 6A, Material Version 2, Lot 1 has been modified in the split file. Hence, the Data Match is shown as False and the Merge From Split toggle is selected by default. With this option toggled, the data for this lot in the master will be replaced by the data from the split file when the OK button is selected.
If the mouse is hovered over the Last Modified data, a Tool Tip will show the last modification to the Lot, Report or Test Run as shown below.

![Tool Tip Image]

The user can choose to keep data from the master (select the Keep Data From Master radio button) or merge the data in from the split file (select the Merge From Split radio button).

The user selects all of the lots that are to be merged into the master and then clicks the OK button to perform the merge into the master file. The merge progress will be displayed during the merge and a Merge Results form will be displayed when the merge is completed, indicating the success of the merge process, as shown below.

![Merge Results Form]
Select the **OK** button to close the *Merge Results* form, completing the merging of the data from this split file.

After the merge is complete the data in the master file is still read only but it now contains the data from the split file, as shown in the *Comments* field in the form below.
Follow the same steps to merge the data from the other split files into the master file.
Once all of the data from the split files has been updated in the master file you are ready to update the data in the split files from the master file (see Updating Test Data in Split File From Master).
12.5 Updating Test Data in Split File From Master

Once all of the test data has been merged into the master from all split files (see Merging Data From Split Files Into Master File), the EPM’s office uses the Update Split From Master function to update the split file(s) from the master file so that the split file(s) contain all of the current data for all test types.

There are two ways to update information in a split file from the master contract file.

When the master file is open, the master file can be used to update all of the split files at one time. To do this, select the Update Split From Master option under the Tools -> Project DB Manager option, as shown below.

The Update Split Files from Master File form opens as shown below.

Check all of the split files to update by placing a check mark next to the desired split file name, as shown below.
Click the **Update** button and the cursor will change to an hour class while processing and the *Split Files Uploaded* form will open when the update is completed, indicating the success of the update process, as shown below.
Click the OK button to close the Split Files Updated window.

When a Split file is open, the Split file can be updated by selecting the Master file. To do this, select the Update Split From Master option under the Tools --> Project DB Manager option, as shown below.
The *Select Master File* window will open as shown below.

Select the master file, and then click the **OK** button, as shown below.
The Split File Updated window will open, as shown below.

The Split File Updated window will open, as shown below.

Click the **OK** button to close the *Split Files Updated* window.

After the update is complete the read-only data in the split file has been replaced by the data in the master file.

The updated split file(s) can now be copied back on to a memory stick from the EPM’s office machine and taken back out to the field for copying back on to the field computer or laptop for further data entry or editing.
Splitting And Merging Test Data
12.6 Rebuilding Lost Or Damaged Split Files

In the off chance that a split file gets lost or damaged, the EPM's office can use the Rebuild Split function to rebuild the lost or damaged split file from the master QA Contract file.

Note: The rebuild split operations should only be done as a last resort since the rebuilt split file will only contain the data that is in the master QA Contract file. Any data entry or editing that has been performed since the last merge will have been lost.

To rebuild split file(s) from the master contract file, first open the master file. Then select the Rebuild Split File option under the Tools --> Project DB Manager option, as shown below.

![Rebuild Split File Option](image)

The Rebuild Split File form opens as shown below.
As shown above, if the Split file is missing or unreadable, the **Crew For Split:** will be set to **None** and the crew will need to be set by clicking the **Change Crew List** button.

Select the split file(s) to rebuild by placing a check mark next to the desired split file name, as shown below.
Click the **Rebuild Splits** button and the cursor will change to an hour class while processing and the **Split Rebuild Results** form will open when the rebuilding is completed, indicating the success of the rebuilding process, as shown below.

Select the **OK** button to close the **Split Rebuild Results** form, completing the rebuilding the split file(s) from the master file.

The rebuilt split file(s) can now be copied to a memory stick for other individuals to take to their field location and copy onto their computer or laptop so that they can perform data entry and editing in the QA Suite.
12.7 Cancelling Split After Merge

This cycle of adding/editing data in split files, bringing a copy of the split files into the EMP's office, merging the data from the split files into the master file, updating the read-only data in the split files from the master file and returning the updated split file to the field for further data entry and editing continues until all of the test data entry and editing at the field location(s) has been completed.

Once the field data entry and editing is completed, the EPM's office will want to cancel the split file(s) while performing the last merge.

To cancel the split file(s), the user will follow the steps for merging the data from the split file(s) into the master (see Merging Data From Split Files Into Master File).

However, before selecting the OK button on the QA Suite Project Merge Reconciliation form to perform the actual merge, the user will select the Cancel Split After Merge option as shown below.

After selecting the OK button, a Cancel Split form will be displayed, prompting for confirmation of the split cancellation after merge, as shown below.
Select the Yes button to continue the merge with the split cancelled after the merge.

The merge progress will be displayed during the merge and a Merge Results form will be displayed when the merge is completed, indicating the success of the merge process, as shown below.

Select the OK button to close the Merge Results form, completing the merging of the data from this split file and the cancellation of the split file. This will return the focus to the QA Suite main form, as shown below.
Once the split is cancelled, the data for the testing types defined for the split file that has been cancelled will no longer be view only in the master QA Contract file.
Notice that since the Volumetric testing split has been cancelled, the Volumetrics data can now be edited in the master file. This is indicated by the Volumetrics Lot numbers no longer being in italics in the tests tree view navigation panel and the data not being grayed out in the Volumetrics test user interface as shown above. However, since all of the other testing is still split out for data entry, the data for all of the other tests are still view only in the master contract file. This is indicated by the Lot numbers, Report Dates and Test Runs in italics in the tests tree view navigation panel and the data being grayed out in the test user interfaces.

The cancelled split file is not deleted from the folder containing the master QA Contract file. However, it can no longer be used for data entry or editing (all data is view only) and can no longer be merged back into the master file.
13. Working With Test Data

13.1 Editing Test Data

13.1.1 Edit Aggregate Gradations

13.1.1.1 Edit Aggregate Gradations Test Data

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To edit Aggregate Gradations test data the **Aggregate Testing** test form must be opened and selected (see Selecting A Form).

When the **Aggregate Testing** test data form is opened and selected it looks like the one below:

![Aggregate Testing Form]

The basic procedure for entering Aggregate Gradations lot data is:
1. Add a new lot (select the **Add New QA Lot** button to add QA lot; select the **Add New Non-QA Lot** button to add Non-QA lot - see [Add a new Lot](#)).
2. Enter the lot size (see [Input the Aggregate lot size](#))
3. Add a new Sub Lot (select **Start Test** button to add new sub lot - see [Add a new Aggregate Sub Lot](#)).
4. For each sample enter and save the data (see [Enter Aggregate Sub Lot Sample Data](#)).
   - Date Sampled
   - Time Sampled
   - Date Tested
   - Time Tested
   - Beginning Weight
   - Cumulative Weight Retained for each sieve above the break sieve
   - Weight Before Wash
   - Weight After Wash
   - Cumulative Weight Retained for each sieve below break sieve
   - Stockpile Moisture
   - % Used Aggregate
   - % Used Filler
   - Percent of Fracture
   - Tester
   - Comments
5. Add another Sub Lot and enter and save the sample data (see [Add another Aggregate Sub Lot](#)).
6. Continue adding sub lots and entering and saving sample data until all sub lots have been entered for the lot.
7. Review the pay adjustments for the current lot, (select the **Show Pay Adjustment Results For This Lot** button - see [Review Aggregate Lot Pay Adjustment Results](#)).
8. Add another lot and enter and save the sub lot data.
9. Continue adding lots and sub lots and entering and saving sample data until all QA data has been entered for the material item Aggregate Gradations testing.

Add a new lot (select the **Add New QA Lot** button to add a QA lot; select the **Add New Non-QA Lot** button to add a Non-QA lot).

A new lot will be added with the lot number populated with the next available lot number.
Input the lot size (input the desired value if it is different from the default lot size).

Add a new Sub Lot (select the Start Test button to add a new Sub Lot).

The Test Number will be populated with the next available test number.

For each sample (e.g., Sub Lot 1), input the data.

- Date Sampled [Month/Day/Year in MM/DD/YYYY format (ex., 10/26/2005 for Oct. 26, 2005)]
- Time Sampled [Military time - Hours:Minutes in HH:MM format (ex., 08:00 for 8:00 AM)]
- Date Tested [Month/Day/Year in MM/DD/YYYY format (ex., 10/26/2005 for Oct. 26, 2005)]
- Time Tested [Military time - Hours:Minutes in HH:MM format (ex., 10:35 for 10:35 AM)]
Note: Warning is provided to prompt for correction if the testing is shown occurring before sampling.

- **Beginning Weight**  [Must be input before Cum. Wt. Retained by sieves can be input]

- **Cumulative Weight Retained for each sieve above the break sieve**
Note: The weight passing and percent passing are calculated after each cumulative weight retained entry is completed and warning is provided if the percent passing is out of spec.

- Weight Before Wash
- Weight After Wash
- Cumulative Weight Retained for each sieve below break sieve

- Stockpile Moisture
- % Used Aggregate
- % Used Filler
- Percent of Fracture

Note: As shown above, warning is provided if the percent of fracture is out of spec.

- Tester (select tester's name from Tester Dropdown)
• Comments (select the Comments text box and enter the comments)
Working With Test Data

Note: The Comments text box expands for easier data entry, as shown above.

When all data entry is completed the form will look as follows.
This is a good time to save the data using the **Save** button on the tool bar (see **Toolbar**) or the **File Menu --> Save** option (see **Save**).

To enter test data for additional tests in the lot, click on the next **Sub Lot** tab as shown below and then repeat sample data entry as shown above.
Note: The Sampled and Tested Dates and the Tester will carry forward from the previous sub lot as shown below.

To review the pay adjustments for the current lot, press the Show Pay Adjustment Results For This Lot button at the top of the form. The Aggregate Results for: form is displayed with the Aggregate Results tab selected.

If less than 3 samples have been entered for the lot, a warning is displayed that a minimum of 3 samples are required to compute pay adjustments as shown below.
Once at least 3 samples have been entered, the pay adjustment results for the lot are displayed as shown below.

To view the pay adjustment results for related specs click the **Results for Related Specs** tab as shown below.
Things to remember:

All calculated values (Weight Passing and Percent Passing) are automatically generated as soon as all of the inputs are provided.

Each sub lot tab represents a sample within the lot. For example, sub lot 1 is the first sample in the lot and sub lot 7 is the seventh sample in the lot.

A minimum of 3 samples are required to compute pay adjustments.
13.1.2 Edit Aggregate Surfacing Density Tests

13.1.2.1 Edit Aggregate Surfacing Density Test Data
To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To edit Aggregate Surfacing Density test data the **Aggregate Surfacing Density** test form must be opened and selected (see Selecting A Form).

When the **Aggregate Surfacing Density** test data form is opened and selected it looks like the one below:

![Aggregate Surfacing Density Test Form](image)

The basic procedure for entering Aggregate Surfacing Density lot data is:
1. Add a new lot (select the **Add New QA Lot** button to add QA lot; select the **Add New Non-QA Lot** button to add Non-QA lot - see Add_a_new_lot).
2. Enter the lot size (see Input the lot size)
3. Add a new Sub Lot (select **Start Test** button to add new sub lot - see [Add_a_new_sub_lot]).
4. For each sample enter and save the data (see [Enter_Aggregate_Surfacing_Density_sub_lot_data]).
   - Date Sampled
   - Time Sampled
   - Date Tested
   - Time Tested
   - Device
   - Lift Number
   - Station
   - Offset Distance
   - Offset Direction
   - Target Density
   - Test % Moisture
   - Test Density
   - Comments
   - Tester
5. Add another Sub Lot and enter and save the sample data (see [Add another sub lot]).
6. Continue adding sub lots and entering and saving sample data until all sub lots have been entered for the lot.
7. Review the pay adjustments for the current lot, (select the **Show Pay Adjustment Results For This Lot** button - see [Review_Aggregate_Surfacint_Density_lot_pay_adjustment_results]).
8. Add another lot and enter and save the sub lot data.
9. Continue adding lots and sub lots and entering and saving sample data until all QA data has been entered for the material item Aggregate Surfacing Density testing.

Add a new lot (select the **Add New QA Lot** button to add a QA lot; select the **Add New Non-QA Lot** button to add a Non-QA lot).
A new lot will be added with the lot number populated with the next available lot number.

Input the lot size (input the desired value if it is different from the default lot size).

Add a new Sub Lot (select the **Start Test** button to add a new Sub Lot).

The Test Number will be populated with the next available test number.

For each sample (e.g., Sub Lot 1), input the data.

- **Date Sampled** [Month/Day/Year in MM/DD/YYYY format (ex., 5/13/2013 for May 13, 2013)]
- **Time Sampled** [Military time - Hours:Minutes in HH:MM format (ex., 08:00 for 8:00 AM)]
- **Date Tested** [Month/Day/Year in MM/DD/YYYY format (ex., 5/13/2013 for May 13, 2013)]
- **Time Tested** [Military time - Hours:Minutes in HH:MM format (ex., 08:00 for 8:00 AM)]
Working With Test Data

Note: Warning is provided to prompt for correction if the testing is shown occurring before sampling.

- Device  [enter the device number for the Nuclear Gauge device used (integer number)]
- Lift Number  [enter the lift number for this sample test (integer number)]
- Station  [enter the station where the sample was taken to the nearest hundredth]
- Offset Distance  [enter the centerline offset distance where the sample was taken to the nearest tenth]
- Offset Direction  [select the centerline offset direction where the sample was taken (Left or Right)]
- Target Density  [enter the target density (maximum dry density) (to the nearest tenth)]
- Test % Moisture  [enter the test percent moisture (to the nearest tenth)]
- Test Density  [enter the test density (to the nearest tenth)]
The % of Target is computed when both the Target Density and the Test Density values have been entered.

Notification is provided if the calculated % of Target is less than or equal to the minimum allowed for a single test, prompting that the average of 3 tests is required, as shown below.

To compute the average of 3 tests first select the **Compute Avg of 3 Tests** button next to the Target Density text box as shown below.

The **Compute Average Aggregate Surfacing Density** form will be displayed as shown below.
For each of the 3 tests, input the data.

- Test Density  [enter the test density (to the nearest tenth)]
- Test % Moisture  [enter the test percent moisture (to the nearest tenth)]

After the test density has been input for a test, the % of target density for the test is computed and displayed. After the test density and test % moisture have been entered for all three tests, the average test density, average test % moisture and average % of target density are computed and displayed, as shown above. Select the OK button to close the **Compute Average Aggregate Surfacing Density** form and transfer the computed average Test Density and average Test %
Moisture values to the *Aggregate Surfacing Mix Density* test data form, as shown below.

<table>
<thead>
<tr>
<th>Target Density</th>
<th>134.8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg. % Moisture</td>
<td>5</td>
</tr>
<tr>
<td>Avg. Density</td>
<td>128.2</td>
</tr>
<tr>
<td>% of Target</td>
<td>95.1</td>
</tr>
</tbody>
</table>

The Test Density and Test % Moisture text boxes will be disabled, so that the computed values cannot be changed. If at a later time, the Test Density needs to be input, instead of computed, click the **Compute Avg of 3 Tests** button to open the *Compute Average Aggregate Surfacing Density* form and clear the text boxes for the Test Density and Test % Moisture for all three tests on the *Compute Average Aggregate Surfacing Density* form and close the form. The Test Density and Test % Moisture text boxes will be enabled to allow input of the Test Density and Test % Moisture values.

- Comments (select the Comments text box and enter the comments)
- Tester (select tester's name from Tester Dropdown)
When all data entry is completed the form will look as follows.
This is a good time to save the data using the **Save** button on the tool bar (see **Toolbar**) or the **File Menu --> Save** option (see **Save**).

To enter test data for additional tests in the lot, click on the next **Sub Lot** tab as shown below and then repeat sample data entry as shown above.

Note: The Sampled and Tested Dates and the Device Number, Lift Number, Target Density and Tester will carry forward from the previous sub lot as shown below.
To review the pay adjustments for the current lot, press the **Show Pay Adjustment Results For This Lot** button at the top of the form. The **Aggregate Surfacing Density Pay Adjustment Data For:** form is displayed.

If less than 3 samples have been entered for the lot, a warning is displayed that a minimum of 3 samples are required to compute pay adjustments as shown below.
Once at least 3 samples have been entered, the pay adjustment results for the lot are displayed as shown below.

**Things to remember:**

All calculated values (% of Target) are automatically generated as soon as all of the inputs are provided.

Each sub lot tab represents a sample within the lot. For example, sub lot 1 is the first sample in the lot and sub lot 7 is the seventh sample in the lot.

A minimum of 3 samples are required to compute pay adjustments.
13.1.3 Edit Concrete Specs Tests

13.1.3.1 Edit Concrete Specs Test Data

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To edit Concrete Specs test data the **Concrete Specs** test form must be opened and selected (see Selecting A Form).

When the **Concrete Specs** test data form is opened and selected it looks like the one below:
This example shows Lot 1 for Material Version 1. Test data for other material versions can be selected from either the tree view structure along the left-hand side, or can be selected from the **Material Version** dropdown as shown below:

![Screenshot of Material Version dropdown]

Test data for a particular lot within a material version may also be selected from either the tree view structure along the left-hand side, or can be selected from the **Lot Number** dropdown as shown below:
The gradation type can be selected from the **Gradation Type** dropdown as shown below:

If the **Gradation Type** dropdown selected is **Conventional**, the form will be displayed as shown below:
If the Gradation Type dropdown selected is **Optimized**, the form will be displayed as shown below:
The **Concrete Specs Material Info** form can be viewed from the **Concrete Specs** test data form by selecting the **View Material Info** button as shown below:
The Concrete Specs Material Info form can be viewed by selecting the Show Pay Adjustment Results For This Lot button as shown below:
which results in the following **Concrete Specs Results for:** form being displayed:
Data can be retrieved and updated from SiteManager by selecting the **Update Data From SiteManager** button as shown below:

Contract Payment (CP) Categories can be displayed by selecting the **CP Categories** button as shown below:
which results in the following **CP Categories** form being displayed:

Comments can be entered for each of the test type results. Click in the **Comments** text box and enter the comments as shown below:
Comments may also be viewed for each of the test type results by selecting the View Comments button as shown below:
which results in the following **Concrete Specs Strength Test Comments** form being displayed:

To view the Strength test results, select the **Strength** tab, which results in the display as shown below:
To view the Air Content test results, select the **Air Content** tab, which results in the display as shown below:
To view the T277 Permeability test results, select the **T277 Permeability** tab, which results in the display as shown below:
To view the Conventional Gradation Results test results, first select *Conventional* from the **Gradation Type** dropdown as shown below:
and then select the **Conventional Gradation Results** tab, which results in the display as shown below:

To view the Conventional Gradation Results test results for a particular Coarse Aggregates Test, use the **Coarse Aggregates Tests for Lot** dropdown to select a test as shown below:
To view the Conventional Gradation Results test results for a particular Fine Aggregates Test, use the **Fine Aggregates Tests for Lot** dropdown to select a test as shown below:
To view the Optimized Gradation Results test results, first select **Optimized** from the **Gradation Type** dropdown as shown below:
and then select the **Optimized Gradation Results** tab, which results in the display as shown below:

![View of Optimized Gradation Results](image1)

To view the Optimized Gradation Results test results for a particular Optimized Aggregates Test, use the **Optimized Aggregates Tests for Lot** dropdown to select a test as shown below:

![View of Optimized Aggregates Tests for Lot](image2)
13.1.4 Edit Daily Plant Mix Reports

13.1.4.1 Edit Daily Plant Mix Report Test Data
To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To edit Daily Plant Mix Report test data the Daily Plant Mix Reports test form must be opened and selected (see Selecting A Form).

When the Daily Plant Mix Reports test data form is opened and selected it looks like the one below:

![Daily Plant Mix Reports Form](image)

The basic procedure for entering Daily Plant Mix Report data is:
1. Add a new report (select Add Report button to add a report - see Add a new report).
2. Enter report information on the Report Information tab: (see Enter report information)
   - Spec Number
Working With Test Data

- Morning Weather Condition
- Afternoon Weather Condition
- Morning Temperature
- Afternoon Temperature
- Percentage of Bag House Fines (Optional)
- Start/Stop/Delays - OR - Multiple Start/Stop times
- Plant Tons Per Hour (Optional)
- Inspector

3. Enter spot check information on Spot Checks tab: (see Enter spot check information)
   For each spot check performed on the report date enter:
   - Time
   - % of Asphalt
   - % of Hydrated Lime (Optional)
   - Discharge Temperature

4. Enter placement summary information on Placement Summary tab: (see Enter placement summary information)
   For each course/lift placed on the report date enter:
   - Course
   - Lift
   - Amount of material placed
   - Amount of waste material

5. Enter gyratory summary information on Gyratory Summary tab: (see Enter gyratory summary information)
   - Average Rice Density
   - Average VFA
   - Average % of Voids
   - Average Density
   - Date of last Gyratory Average
   - Bin Split Percentages

6. Enter asphalt and additive summary information on Asphalt & Additive Summary tab: (see Enter asphalt and additive summary information)
   - Amount of Asphalt Used
   - Amount of Hydrated Lime Used
   - Amount of 2nd Additive Used
   - Percent Asphalt for Job Mix
   - Percent Hydrated Lime for Job Mix
   - Percent 2nd Additive for Job Mix
   - Asphalt Type
   - Asphalt Supplier
   - Hydrated Lime Type
   - Hydrated Lime Supplier
   - 2nd Additive Type
   - 2nd Additive Supplier
   - Comments
7. Enter material storage information on Material Storage tab: (see Enter material storage information)
   - Asphalt Invoice data
   - Hydrated Lime Invoice data
   - Additive 2 Invoice data

To add a new report select the Add Report button as shown below.

A New Daily Report form is displayed with the report date set to the current day's date.

Note: Warning is provided to prompt for correction if the report date occurs in the future.

Use the date dropdown control to enter the report date [Month/Day/Year in MM/DD/YYYY format (ex., 11/11/2005 for Nov. 11, 2005)].

Click the OK button to close the form and return to the Daily Plant Mix Reports test data form.
A new report will be created with the report number populated with the next available lot number and the report date set to the specified date. The Pit Lab No., Mix Type, Contract Quantity, Mix Design, Mix Design Date, Number of Lifts, Plan Thickness, Type of Plant, Contractor and Viscosity Temperature Range Max and Min Mixing Temperatures that were set up as part of the Daily Plant Mix Report testing specification setup are also displayed on the form.

To enter report information go to the Report Information tab form and enter the data as described below:

- Spec Number
- Morning Weather Condition [Select from options available in Weather Conditions AM dropdown list]
- Afternoon Weather Condition [Select from options available in Weather Conditions PM dropdown list]
- Morning Temperature  [Enter in degrees Fahrenheit for Metric and English (to nearest whole value)]
- Afternoon Temperature  [Enter in degrees Fahrenheit for Metric and English (to nearest whole value)]
- Percentage of Bag House Fines (Optional)

- Start/Stop/Delays  - OR -  Multiple Start/Stop times
Note: All times, including delays, are entered in military time [Military time - Hours:Minutes in HH:MM format (ex., 09:45 for 9:45 AM ; 00:30 for 1/2 hour or 30 minutes of delays)]. The Gross time and the Net time are calculated after all Start and Stop times are entered.

- **Plant Tons Per Hour (Optional)**

  The Plant Tons Per Hour input is provided to capture the current plant production settings. The Average Hourly Production is calculated based on the daily plant mix placement amount entered on the Placement Summary tab divided by the net time.

- **Inspector (select inspector's name from Inspector Dropdown)**

  When all report information data entry is completed the Report Information tab form will look as follows.
This is a good time to save the data using the **Save** button on the tool bar (see **Toolbar**) or the **File Menu --> Save** option (see **Save**).

To enter spot check information go to the **Spot Checks** tab form and enter the data as described below:

Select the Spot Checks tab to display the **Spot Checks** tab form.
For each spot check performed on the report date:

Select the **Add Spot Checks** button to add the text entry boxes for entering spot check data and enter the data:

- **Time** [Military time - Hours:Minutes in HH:MM format (ex., 10:15 for 10:15 AM)]
- **% of Asphalt** [enter the % of asphalt to the nearest hundredth]
- **% of Hydrated Lime (Optional)** [enter the % of hydrated lime to the nearest hundredth]
- **Discharge Temperature** [enter the discharge temperature to the nearest degree (Metric °C : English °F)]

Continue selecting the **Add Spot Check** button and entering the data. Once at least three entries have been made the average temperature begins to be automatically calculated and displayed.
Continue selecting the **Add Spot Check** button and entering the data until all spot checks have been entered.

When all spot check information data entry is completed the *Spot Checks* tab form will look as follows.
This is a good time to save the data using the **Save** button on the tool bar (see *Toolbar*) or the *File Menu* --> *Save* option (see *Save*).

To enter the placement summary information go to the *Placement Summary* tab form and enter the data as described below:

Select the *Placement Summary* tab to display the *Placement Summary* tab form.

For each course lift placed on the report date:
- **Course**
- **Lift**

Select the **Add/Update Course/Lift** button to set up the Course(s) and Lift(s) placed. The **Select/Edit Course/Lift** form will be displayed as shown below:
The existing course/lift combinations for the project are displayed in the Possible Course/Lifts list on the left. This list is initially populated from the user's Pavement Course Descriptions defined as part of the user's options (see Pavement Course Descriptions Options).

To add a course to the Possible Course/Lifts list, type the desired new course description in the text box under the Course label and enter a value of "1" in the text box under the Lift label. Then select the Add button to add the Course/Lift combination to the Possible Course/Lifts list, as shown below.

The new Course/Lift combination is added to the Possible Course/Lifts list with the new combination selected in the list, as shown below.
To add a lift to an existing course, select the desired course in the *Possible Course/Lifts* list. The selected item’s course description will be loaded in the text box under the *Course* label and its lift number will be loaded in the text box under the *Lift* label. Enter the new lift number value in the text box under the *Lift* label. Then select the **Add** button to add the new Course/Lift combination to the *Possible Course/Lifts* list, as shown below.

The new Course/Lift combination is added to the *Possible Course/Lifts* list, as shown below.
To change the course description or lift number for an existing course/lift combination, select the desired course in the Possible Course/Lifts list. The selected item's course description and lift number will be loaded in the text boxes under the list. Modify the course description or lift number value in the appropriate text box. Then select the Change button to change the selected Course/Lift combination in the Possible Course/Lifts list, as shown below.

The selected Course/Lift combination is modified to the Possible Course/Lifts list, as shown below.
The Add ->, <- Remove, Add All ->> and << Remove All buttons are used to move items between the lists (see List View Operations).
To select an existing Course/Lift combination, click the combination in the Possible Course/Lifts list and use the Add -> button to move the combination to the Selected Course/Lifts list on the right, as shown below.

In this case, the Roadbed/1 combination was selected and added to the Selected Course/Lifts list as shown below.
Once the desired Course/Lift combinations have been selected, click the **OK** button to close the form and add the Course and Lift combinations to the **Placement Summary** tab form as shown below.
Amount of material produced  [enter the amount of material produced to the nearest thousandth (Metric tonnes ; English tons) in the text box under the Today (Gross) column label]
After tabbing out of the amount placed text box the To Date and Total amounts are automatically calculated and displayed as shown below.
Note: A suggested number of cores to be sampled based on the amount of material placed is also computed and displayed under the *Suggested Number of Cores* column. The Number of Cores Taken and Tested (Today and Cumulative) are computed from the Plant Mix Density tests.

- Amount of waste material  
  [enter the amount of waste material to the nearest thousandth (Metric tonnes; English tons) in the text box under the *Waste* column label]
After tabbing out of the waste amount box the *Today (Net)*, *To Date (Net)* and *Totals* amounts are automatically calculated and displayed as shown below.
After completing the entry of the placement summary daily totals, the *Average Hourly Production* amount is calculated and displayed on the *Report Information* tab form, as shown below:
This is a good time to save the data using the **Save** button on the tool bar (see Toolbar) or the **File Menu --> Save** option (see Save).

To enter Plant Mix Tickets, click the Plant Mix Tickets button, as shown below.
The Plant Mix Tickets form will be displayed as shown below.
Enter the ticket number and amount. Optionally, select the Course/Lift as shown below.
If the ticket is split across multiple course/lifts, select Split from the Course/Lift Dropdown as shown below.
and then click the Split button. The Plant Mix Ticket Split form will be displayed as shown below.

You can either enter the amount for each split and the program will compute the percentage as shown below.
or enter the percentage for each split and the program will compute the amount as shown below.

To enter additional tickets, click the Add Ticket button as shown below.
If there are multiple Course/Lifts, you can view the totals for each Course/Lift by clicking the Details button as shown below.
The Plant Mix Ticket Total Details window will appear as shown below.

Once all of the tickets have been entered, click the OK button, as shown below.
To enter the gyratory summary information go to the *Gyratory Summary* tab form and enter the data as described below:

Select the Gyratory Summary tab to display the *Gyratory Summary* tab form.
Enter Gyratory Comparisons data in *Gyratory Comparisons* panel:

- **Average Rice Density**  
  [enter the average rice density for the day to the nearest thousandth]
- **Average VFA**  
  [enter the average VFA for the day to the nearest whole number]
- **Average % of Voids**  
  [enter the average % of voids for the day to the nearest tenth]
- **Average Density**  
  [enter the average density for the day to the nearest whole number]
- **Date of last Gyratory Average**  
  [Use the date dropdown control to enter the last Gyratory Average date (Month/Day/Year in MM/DD/YYYY format (ex., 11/11/2005 for Nov. 11, 2005))]
- **Daily Bin Split Percentage**  
  [enter the bin split percentage to the nearest tenth]

<table>
<thead>
<tr>
<th>Bin</th>
<th>Design</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coarse</td>
<td>49.3</td>
<td>49</td>
</tr>
<tr>
<td>Crushed Fines</td>
<td>41.9</td>
<td>42</td>
</tr>
<tr>
<td>Natural Fines</td>
<td>7.4</td>
<td>7.4</td>
</tr>
<tr>
<td>Hyd Lime</td>
<td>1.4</td>
<td>1.4</td>
</tr>
</tbody>
</table>

When all gyratory summary data entry is completed the *Gyratory Summary* tab form will look as follows.
This is a good time to save the data using the **Save** button  on the tool bar (see **Toolbar**) or the **File Menu**  >  **Save** option (see **Save**).

To enter the asphalt and additive summary information go to the **Asphalt & Additive Summary** tab form and enter the data as described below:

Select the **Asphalt & Additive Summary** tab to display the **Asphalt & Additive Summary** tab form.

**Enter Amount Used data in Amount Used panel:**

- **Amount of Asphalt Used**  
  [enter daily amount of asphalt used to nearest thousandth]
- **Amount of Hyd. Lime Used**  
  [enter daily amount of hyd. lime used to nearest thousandth]
- **Amount of 2nd Additive Used**  
  [enter daily amount of 2nd additive used to nearest thousandth]
After tabbing out of the amount used today text box the *To Date*, *Waste* and *Net* amounts as well as the Hydrated Lime *Pay* amount are automatically calculated and displayed as shown above and the *Percent Mix Today* amounts are automatically calculated and displayed as shown below.

*Note:* The Hydrated Lime Pay Amount may be less than the Net amount if the Net amount exceeds the Max % Hyd. Lime multiplied by the Total Mix Net.

Enter Percent Mix data in *Percent Mix* panel:

- Percent Asphalt for Job Mix  [enter daily percent of asphalt for the job mix to nearest tenth]
- Percent Hyd. Lime for Job Mix  [enter daily percent of hyd. lime for the job mix to nearest tenth]
- Percent 2nd Additive for Job Mix  [enter daily percent of 2nd additive for the job mix to nearest tenth]

Enter Asphalt & Additive type and supplier information in Type/Supplier section of form

- Asphalt Type  [enter description of asphalt type]
- Asphalt Supplier  [enter name of asphalt supplier]
- Hydrated Lime Type  [enter description of hydrated lime]
- Hydrated Lime Supplier  [enter name of hydrated lime supplier]
- 2nd Additive Type  [enter name of 2nd additive type]
- 2nd Additive Supplier  [enter name of 2nd additive supplier]
Comments (select the Comments text box and enter the comments)

When all asphalt & additive summary data entry is completed the Asphalt & Additive Summary tab form will look as follows.

This is a good time to save the data using the Save button on the tool bar (see Toolbar) or the File Menu --> Save option (see Save).

To enter the material storage information go to the Material Storage tab form and enter the data as described below:
Select the Material Storage tab to display the *Material Storage* tab form.

Enter Invoice data in the panel for each item:
- Asphalt Invoice data [enter asphalt invoice number and quantity to nearest thousandth]

Select the **Add Invoice** button in the Asphalt panel and enter the *Invoice Number* and associated *Quantity* as shown below.
After tabbing out of the *Quantity* text box the amount of Asphalt material in storage at day's end is calculated and displayed in the *In storage at day's end* text box as shown below.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Add Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>110.000</td>
</tr>
</tbody>
</table>

In storage at day's end: 3.320

- **Hydrated Lime Invoice data** [enter hyd. lime invoice number and quantity to nearest thousandth]

Select the **Add Invoice** button in the *Hyd. Lime* panel and enter the *Invoice Number* and associated *Quantity* as shown below.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Add Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30.5</td>
</tr>
</tbody>
</table>

In storage at day's end: -29.030

After tabbing out of the *Quantity* text box the amount of Hydrated Lime material in storage at day's end is calculated and displayed in the *In storage at day's end* text box as shown below.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Add Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>30.500</td>
</tr>
</tbody>
</table>

In storage at day's end: 1.470
- Additive 2 Invoice data [enter additive 2 invoice number and quantity to nearest thousandth]

Select the **Add Invoice** button in the *Additive 2* panel and enter the *Invoice Number* and associated *Quantity*. After tabbing out of the *Quantity* text box the amount of Additive 2 material in storage at day's end is calculated and displayed in the *In storage at day's end* text box.

When all material storage data entry is completed the *Material Storage Summary* tab form will look as follows.

This is a good time to save the data using the **Save** button on the tool bar (see Toolbar) or the *File Menu --> Save* option (see Save).
13.1.5 Edit Marshall Tests

13.1.5.1 Edit Marshall Testing Test Data

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To edit Marshall Testing test data the *Marshall Testing* test form must be opened and selected (see Selecting A Form).

When the *Marshall Testing* test data form is opened and selected it looks like the one below:

![Marshall Testing Test Form](image)

The basic procedure for entering Marshall Testing brick data is:

1. Add a new brick (select the **Add New Brick** button - see Add_a_new_Marshall_brick).
2. For each sample enter and save the data.
   i. Enter the sample test information (see Enter_the_sample_test_information).
      - Date Sampled
ii. For each sample either enter or compute the Gcm (see Enter_or_compute_the_Gcm).
   - Enter Rice/Actual (Gcm)
   - OR-
   - Enter Gcm Calculation Data
     - Weight of Flask
     - Weight of Water
     - Weight of Water + Material
     - Weight After Saturation

iii. Enter Gmb Calculation data for each brick sample (see Enter_the_Gmb_Calculation_data).
   - Weight in Air
   - Weight in Water
   - Weight of Surface Dry Sample in Air

iv. Enter Stability/Flow data for each brick sample (see Enter_the_Stability_and_Flow_data).
   - Ring Reading
   - Stability Graph
   - Flow
   - Appearance

v. For each brick select the tester and enter any comments (see Enter_the_tester_and_comments).
   - Tester
   - Comments

vi. Save the brick data (see Save_the_brick_data).

3. Optionally, view the Gmb Rolling Average history (select the Rolling Average button - see View_Gmb_Rolling_Average_history).

4. Add another brick and enter and save the sample data.

5. Continue adding bricks and entering and saving sample data until all QA data has been entered for the material item Marshall testing.

Add a new brick (select the Add New Brick button to add a brick).
A new brick will be added with the brick number populated with the next available brick number.

For each brick (e.g., Brick Number 1), input the data.

Enter the sample test information.

- **Date Sampled** [Month/Day/Year in MM/DD/YYYY format]
- **Time Sampled** [Military - Hours:Minutes in HH:MM format]
- **Date Tested** [Month/Day/Year in MM/DD/YYYY format]
- **Time Tested** [Military - Hours:Minutes in HH:MM format]
- **Asphalt Grade** [enter the asphalt grade description]
- **Refinery Name** [enter the name of the refinery]
- **Station tested** [enter to nearest tenth (.1)]

- **% Asphalt** [enter to nearest hundredth (.01)]
- **% Asphalt NAC** [enter to nearest hundredth (.01)]
- **Temperature Molded** [enter to nearest tenth (.1)]
- **#4 Mesh** [enter to nearest tenth (.1)]

* - Optional

Either enter or compute the Gcm.
- Enter the Gcm.
  - Rice/Actual (Gcm) [enter to nearest thousandth (.001)]

If the Gcm is input by the user, the *Gcm Calculation* panel and text boxes for the individual weights is disabled and hidden.

If at a later time, the Gcm needs to be computed, clear the text in the Gcm text box, and the *Gcm Calculation* panel and text boxes for the individual weights will be made visible and enabled to allow input of the individual weights and computation of the Gcm.

- OR -

- Compute the Gcm (enter the Gcm Calculation data).
  - Weight of Flask [enter to nearest tenth (.1)]
  - Weight of Water [enter to nearest tenth (.1)]
  - Weight of Water + Material [enter to nearest tenth (.1)]
  - Weight After Saturation [enter to nearest tenth (.1)]
After the individual weights have been input, the Gcm will be computed and displayed in the Rice/Actual (Gcm) text box.

The Rice/Actual (Gcm) text box will be disabled, so that the computed value cannot be changed. If at a later time, the Gcm needs to be input, instead of computed, clear the text in the text boxes for the individual weights, and the Rice/Actual (Gcm) text box will be enabled to allow input of the Gcm value.

Enter the Gmb Calculation data for each brick sample.
- Compute the Gmb for each brick (enter the Gmb Calculation data for each brick).
  - Weight in Air [enter to nearest tenth (.1)]
  - Weight in Water [enter to nearest tenth (.1)]
  - Weight of Surface Dry Sample in Air [enter to nearest tenth (.1)]

After the individual weights have been input, the Displacement, Gmb, % Voids and Correlation Ratio will be computed and displayed below the Brick sample column.
Once the data for both brick samples have been entered, the brick average Gmb and % Voids are also calculated and displayed under the Average column, as shown below.

<table>
<thead>
<tr>
<th>Gmb Calculation</th>
<th>Brick A</th>
<th>Brick B</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight in Air</td>
<td>1194.0</td>
<td>1217.9</td>
<td></td>
</tr>
<tr>
<td>Weight in Water</td>
<td>685.0</td>
<td>698.2</td>
<td></td>
</tr>
<tr>
<td>Weight of SSD Sample</td>
<td>195.5</td>
<td>1219.0</td>
<td></td>
</tr>
<tr>
<td>Displacement</td>
<td>510.5</td>
<td>520.8</td>
<td></td>
</tr>
<tr>
<td>Gmb</td>
<td>2.339</td>
<td>2.339</td>
<td>2.339</td>
</tr>
<tr>
<td>% Voids</td>
<td>2.4</td>
<td>2.4</td>
<td>2.4</td>
</tr>
<tr>
<td>Corr. Ratio</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Enter the Stability/Flow data for each brick sample.
- Compute the Stability and Flow for each brick.
  - Ring Reading [enter to nearest whole (1)]
  - Stability Graph [enter to nearest whole (1)]
  - Flow [enter to nearest whole (1)]
  - Appearance [select from dropdown]

<table>
<thead>
<tr>
<th>Stability Graph Calculation</th>
<th>Brick A</th>
<th>Brick B</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ring Reading</td>
<td>175</td>
<td>185</td>
<td></td>
</tr>
<tr>
<td>Stability Graph</td>
<td>2424</td>
<td>2563</td>
<td></td>
</tr>
<tr>
<td>Corrected Stability</td>
<td>2424</td>
<td>2563</td>
<td></td>
</tr>
<tr>
<td>Flow</td>
<td>15</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Appearance</td>
<td>Normal</td>
<td>Normal</td>
<td></td>
</tr>
</tbody>
</table>

After the Ring Reading and Stability Graph values have been input, the Corrected Stability will be computed and displayed below the Brick sample column.

Once the data for both brick samples have been entered, the brick average Corrected Stability and Flow are also calculated and displayed under the Average column, as shown below.
For each brick select the tester and enter any comments.

- Tester (select tester's name from Tester Dropdown)

<table>
<thead>
<tr>
<th></th>
<th>Brick A</th>
<th>Brick B</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight in Air</td>
<td>194.0</td>
<td>1217.9</td>
<td></td>
</tr>
<tr>
<td>Weight in Water</td>
<td>685.0</td>
<td>698.2</td>
<td></td>
</tr>
<tr>
<td>Weight of SSD Sample</td>
<td>195.5</td>
<td>1219.0</td>
<td></td>
</tr>
<tr>
<td>Displacement</td>
<td>510.5</td>
<td>520.8</td>
<td></td>
</tr>
<tr>
<td>Gmb</td>
<td>2.339</td>
<td>2.339</td>
<td>2.339</td>
</tr>
<tr>
<td>% Voids</td>
<td>2.4</td>
<td>2.4</td>
<td>2.4</td>
</tr>
<tr>
<td>Corr. Ratio</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Ring Reading</td>
<td>175</td>
<td>185</td>
<td></td>
</tr>
<tr>
<td>Stability Graph</td>
<td>2424</td>
<td>2563</td>
<td></td>
</tr>
<tr>
<td>Corrected Stability</td>
<td>2424</td>
<td>2563</td>
<td>2494</td>
</tr>
<tr>
<td>Flow</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Appearance</td>
<td>Normal</td>
<td>Normal</td>
<td></td>
</tr>
</tbody>
</table>
• Comments (select the Comments text box and enter the comments)
When all data entry is completed the form will look as follows.
This is a good time to save the data using the **Save** button on the tool bar (see **Toolbar**) or the **File Menu** --> **Save** option (see **Save**).

To view the Gmb Rolling Average history, select the **Rolling Average** button in the middle right section of the Gmb Calculation panel

The *Marshall Gmb Rolling Average* form is displayed. Once at least four bricks have been entered, the calculation of the Gmb rolling average value is started. The calculation is performed for all bricks based on the date and time sampled.
Things to remember:

All calculated values (Displacement, Gmb, % Voids, Correlation Ratio, Corrected Stability, Average Gmb, Average % Voids, Average Corrected Stability, Average Flow) are automatically generated as soon as all of the inputs are provided.

A minimum of 4 bricks are required to compute the Gmb Rolling Average.

Note the following Marshall Testing UI modifications for Commercial Plant Mix

The differences in the UI are due to the Commercial Plant Mix being test base instead of lot based.
The Aggregate Testing form is shown below. For each Marshall test added, an Aggregate test will be added.
To review the pay adjustments for the current test, press the **Show Pay Adjustment Results For This Test** button at the top of the form. The **Commercial Plant Mix Pay Adjustment Data For** form is displayed.

Commercial Plant Mix Pay Adjustment Data For: PLANT MIX GR D - COMMERCIAL TESTED - Mtl. Ver. 1 - Test 1

<table>
<thead>
<tr>
<th>Test/Sieve</th>
<th>Min</th>
<th>Max</th>
<th>Result</th>
<th>Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voids</td>
<td>2</td>
<td>4</td>
<td>4.8</td>
<td>Fail</td>
</tr>
<tr>
<td>Stability</td>
<td>1800</td>
<td>2270</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flow</td>
<td>8</td>
<td>16</td>
<td>17</td>
<td>Fail</td>
</tr>
<tr>
<td>Aggregate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3/4&quot;</td>
<td>100</td>
<td></td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>1/2&quot;</td>
<td>76</td>
<td>90</td>
<td>84.5</td>
<td></td>
</tr>
<tr>
<td>3/8&quot;</td>
<td>62</td>
<td>76</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>#4</td>
<td>39</td>
<td>53</td>
<td>49.2</td>
<td></td>
</tr>
<tr>
<td>#10</td>
<td>22</td>
<td>34</td>
<td>29.7</td>
<td></td>
</tr>
<tr>
<td>#40</td>
<td>6</td>
<td>16</td>
<td>11.8</td>
<td></td>
</tr>
<tr>
<td>#200</td>
<td>3.2</td>
<td>6.2</td>
<td>5.17</td>
<td></td>
</tr>
</tbody>
</table>

Price Reduction

<table>
<thead>
<tr>
<th>Test Quantity</th>
<th>Contract Price</th>
<th>Percent</th>
<th>Net Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1793</td>
<td>$85.00</td>
<td>10</td>
<td>($15,236.25)</td>
</tr>
</tbody>
</table>

Net Pay Adjustment ($15,236.25)
13.1.6 Edit Plant Mix Density Tests

13.1.6.1 Edit Plant Mix Density Test Data

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see "Opening A Test Form").

To edit Plant Mix Density test data the Plant Mix Density test form must be opened and selected (see "Selecting A Form").

When the Plant Mix Density test data form is opened and selected it looks like the one below:

![Plant Mix Density Test Form]

The basic procedure for entering Plant Mix Density lot data is:

1. Add a new lot (select the Add New QA Lot button to add QA lot; select the Add New Non-QA Lot button to add Non-QA lot - see "Add_a_new_lot").
2. Enter the lot size (see "Input the lot size").
3. Add a new Sub Lot (select **Start Test** button to add new sub lot - see [Add a new sub lot]).

4. For each sample enter and save the data (see [Enter Plant Mix Density sub lot data]).
   - Date Sampled
   - Time Sampled
   - Date Tested
   - Time Tested
   - Lift Number
   - Station
   - Offset Distance
   - Offset Direction
   - Target Density
   - Gmb (Density)
   - Comments
   - Tester

5. Add another Sub Lot and enter and save the sample data (see [Add another sub lot]).

6. Continue adding sub lots and entering and saving sample data until all sub lots have been entered for the lot.

7. Review the pay adjustments for the current lot, (select the **Show Pay Adjustment Results For This Lot** button - see [Review Plant Mix Density lot pay adjustment results]).

8. Add another lot and enter and save the sub lot data.

9. Continue adding lots and sub lots and entering and saving sample data until all QA data has been entered for the material item Plant Mix Density testing.

Add a new lot (select the **Add New QA Lot** button to add a QA lot; select the **Add New Non-QA Lot** button to add a Non-QA lot).

A new lot will be added with the lot number populated with the next available lot number.

Input the lot size (input the desired value if it is different from the default lot size).
Add a new Sub Lot (select the **Start Test** button to add a new Sub Lot).

The Test Number will be populated with the next available test number.

For each sample (e.g., Sub Lot 1), input the data.

- **Date Sampled**  
  [Month/Day/Year in MM/DD/YYYY format (ex., 11/11/2005 for Nov. 11, 2005)]

- **Time Sampled**  
  [Military time - Hours:Minutes in HH:MM format (ex., 16:45 for 4:45 PM)]

- **Date Tested**  
  [Month/Day/Year in MM/DD/YYYY format (ex., 11/12/2005 for Nov. 12, 2005)]

- **Time Tested**  
  [Military time - Hours:Minutes in HH:MM format (ex., 14:45 for 2:45 PM)]
Note: Warning is provided to prompt for correction if the testing is shown occurring before sampling.

- Lift Number  [enter the lift number for this sample test (integer number)]
- Station      [enter the station where the sample was taken to the nearest hundredth]
- Offset Distance [enter the centerline offset distance where the sample was taken to the nearest tenth]
- Offset Direction  [select the centerline offset direction where the sample was taken (Left or Right)]
- Target Density   [enter the target rice density (to the nearest ten-thousandth) or target density (to the nearest tenth)]

- Gmb (Density)
The Gmb can either be input by the user, as shown above, or computed as described below.

To compute the Gmb first select the button next to the Gmb (Density) text box as shown below.

The Compute Density form will be displayed as shown below.

The Gmb is computed by input of:
- Weight of Sample in Air
- Weight of Sample in Water
- Weight of Surface Dry Sample in Air
After the individual weights have been input for a sample, the Displacement and Gmb for the sample are computed and displayed. After the Gmb has been computed for both samples, the average Gmb value is computed and displayed, as shown above. Select the OK button to close the **Compute Density** form and transfer the computed Gmb value to the **Plant Mix Density** test data form, as shown below.

![Compute Density form](image)

The Gmb text box will be disabled, so that the computed value cannot be changed. If at a later time, the Gmb needs to be input, instead of computed, click the **...** button to open the **Compute Density** form and clear the text boxes for the individual weights on the **Compute Density** form and close the form. The Gmb text box will be enabled to allow input of the Gmb value.

- Comments (select the Comments text box and enter the comments)
Note: The Comments text box vertical scroll bar is displayed for easier data entry and viewing, as shown above.

- Tester (select tester's name from Tester Dropdown)
When all data entry is completed the form will look as follows.
This is a good time to save the data using the Save button on the tool bar (see Toolbar) or the File Menu --> Save option (see Save).

To enter test data for additional tests in the lot, click on the next Sub Lot tab as shown below and then repeat sample data entry as shown above.

Note: The Sampled and Tested Dates and the Lift Number, Target Density and Tester will carry forward from the previous sub lot as shown below.
To review the pay adjustments for the current lot, press the **Show Pay Adjustment Results For This Lot** button at the top of the form. The **Plant Mix Density Pay Adjustment Data For:** form is displayed.

If less than 3 samples have been entered for the lot, a warning is displayed that a minimum of 3 samples are required to compute pay adjustments as shown below.
Once at least 3 samples have been entered, the pay adjustment results for the lot are displayed as shown below.

Things to remember:

All calculated values (% of Target, Gmb Compute Density) are automatically generated as soon as all of the inputs are provided.

Each sub lot tab represents a sample within the lot. For example, sub lot 1 is the first sample in the lot and sub lot 7 is the seventh sample in the lot.

A minimum of 3 samples are required to compute pay adjustments.

Density tests that should not be included in the ride spec calculations may be excluded by clicking the Exclude Sample from Ride Calculations check box as shown below.

NOTE: The Exclude Sample from Ride Calculations selection should only be made with the knowledge and consent of the Project Manager.
Note the following Plant Mix Density Pay Adjustment UI modifications for Plant Mix Incentive Ties.

The differences in the UI are due to the final Adjusted Incentives being based on the results for all Volumetric, Plant Mix Density and Ride Spec tests for the Plant Mix Material Item. As shown below, the UI displays the unadjusted Lot Incentive amount for the current lot along with the Plant Mix Incentive Tie Incentive Adjustment Factor (IAF) and the corresponding Adjusted Incentive amount which is the product of the unadjusted Lot Incentive and the Incentive Adjustment Factor. The Net Pay Adjustment for the lot is the sum of the Adjusted Incentive and the Deduct.
NOTE: The Incentive Adjustment Factor will be zero (0.000) until all Volumetric, Density and Ride tests have been entered and the "All Tests Entered" selection has been made for all three test types and the Incentive Adjustment Factor has been computed using the Plant Mix Incentive Ties form which is accessed from the View menu (see [Plant Mix Incentive Ties](#)).

*Note the following Plant Mix Density UI modifications for Projects with First Lift Directly On Crushed Top Surfacing (CAC)*

The differences in the UI are due to the fact that the Minimum Compaction for mix placed directly on crushed aggregate surfacing (CAC) is different from the Minimum Compaction allowed for mix that is not placed directly on CAC (92% versus 93%) and must therefore be evaluated separately. In order to allow for this the lot with First Lift On CAC tests must be identified and must be verified to contain only tests for the first lift and evaluated appropriately. As shown below, the UI includes an option to identify the Lot as a First Lift On CAC Lot.
To identify a Lot as a First Lift on CAC Lot, select the *First Lift On CAC Lot* option, as shown below.
After making the selection a note will be displayed prompting that "All Sub Lots For The Current Lot Must Contain First Lift on CAC Tests", and the Minimum Compaction value for will be displayed as 92%, as shown below.

Data entry is performed in the normal manner, as shown below. Note that the Lift Value for all Sub Lots in the Lot must be 1 (one).
If the Percent of Target result for the Sub Lot (Test) is less than the minimum compaction an "Out" label will be displayed, as shown below.

Selecting the Show Pay Adjustment Results For This Lot button causes the Plant Mix Density Pay Adjustment Data form, as shown below. The form includes a label showing that the lot is a First Lift On CAC Lot and prompting the user to Verify That All Tests are for First Lift on CAC.
The Print and Print Preview results also include notes showing that the lot is a First Lift On CAC Lot and prompting the user to Verify That All Tests are for First Lift on CAC, as shown below.
MDT Quality Assurance System
Plant Mix Density

Contract ID: 05112
Project No.: MI 13-4(128)196 [7623125000]
Description: ELLENA - NORTH

Bid Item: PLANT MIX BIT SURF GR S - 3/4 IN (E)
Material Type: PLANT MIX BIT SURF GR S - 3/4 IN
Contract Quantity: 2000 Ton

Specification Effective Date: 6/1/2004

Material Version: 1
Lot: 1

Evaluation Results Details for Material Version 1 - Lot 1
(First Lift On CMC Lot - Verify That All Tests are for First Lift On CMC)

Quantity This Lot: 2000 Ton
Accumulated Quantity: 0000 Ton

Plant Mix Density Test Results (Percentage of Target Density)

<table>
<thead>
<tr>
<th>Test No.</th>
<th>Date Sampled</th>
<th>Time Sampled</th>
<th>Date Tested</th>
<th>Time Tested</th>
<th>Density No.</th>
<th>Station</th>
<th>Lift</th>
<th>Distance</th>
<th>Density</th>
<th>GML</th>
<th>% of Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5/9/2004</td>
<td>05:00:00</td>
<td>5/11/2004</td>
<td>05:00:00</td>
<td>19012.00</td>
<td>3</td>
<td>3.5</td>
<td>2.00</td>
<td>9.4</td>
<td>8.7</td>
<td>95.4</td>
</tr>
<tr>
<td>2</td>
<td>5/9/2004</td>
<td>06:00:00</td>
<td>5/11/2004</td>
<td>06:00:00</td>
<td>19012.00</td>
<td>3</td>
<td>3.5</td>
<td>2.00</td>
<td>9.4</td>
<td>8.7</td>
<td>95.4</td>
</tr>
<tr>
<td>3</td>
<td>5/9/2004</td>
<td>07:00:00</td>
<td>5/11/2004</td>
<td>07:00:00</td>
<td>19012.00</td>
<td>3</td>
<td>3.5</td>
<td>2.00</td>
<td>9.4</td>
<td>8.7</td>
<td>95.4</td>
</tr>
<tr>
<td>4</td>
<td>5/9/2004</td>
<td>08:00:00</td>
<td>5/11/2004</td>
<td>08:00:00</td>
<td>19012.00</td>
<td>3</td>
<td>3.5</td>
<td>2.00</td>
<td>9.4</td>
<td>8.7</td>
<td>95.4</td>
</tr>
</tbody>
</table>

Incentive Range: 95.0 to 97.0
Mix Composition: 0%

Total Value: $3.33
Incentive: 3.3%
Lot Pay Adjustment: $3.33

P Value Calculation:

Lot Does Not Qualify For Incentive Allowance

Comments:
Test 1 - Stationing in mile post
If a Lift value other than 1 (one) is entered, the Lift label is shown in red, a yellow note will be displayed, notifying that the first lift on CAC lot tests must be for the first lift on CAC (Lift 1), and a red warning is displayed indicating that "At Least Once CAC Test is Not Lift 1!", as shown below.

If any of the Sub Lot Lift values are not 1 (one), a red warning is displayed indicating that "At Least Once CAC Test is Not Lift 1!", as shown below.
After selecting the Show Pay Adjustment Results For This Lot button a message box will be displayed prompting the user that at least one of the tests is not for the First Lift On CAC (Lift 1) and advising to check the tests for the lot and remove tests that are not for the first lift on CAC or correct the Lift Number for the tests and warning that results for P values will not be correct until this is done, as shown below.

After selecting **OK**, the Plant Mix Density Pay Adjustment Data form will be displayed with prompts and messages warning to correct any tests that are not Lift 1 in order to correct results for P values, as shown below.

The Print and Print Preview results also include notes and messages warning to correct any tests that are not Lift 1 in order to correct results for P values, as shown below.
Working With Test Data

MDT Quality Assurance System
Plant Mix Density

Contract ID: 05113
Project No.: NM-45-22120061
Description: HELENA - NORTH

Bid Item: PLANT MIX BIT SURF GR S - 3/4 IN (E)
Material Type: PLANT MIX BIT SURF GR S - 3/4 IN
Contract Quantity: 2000 Ton

Evaluation Results Details for Material Version 1 - Lot 1
(First Lift on CAC Lot - Verify that All Tests are for First Lift on CAC)

Quantity This Lot: 2000 Ton
Accumulated Quantity: 2000 Ton

Material Version: 1

Plant Mix Density Test Results (Percentage of Target Density)

<table>
<thead>
<tr>
<th>Test No.</th>
<th>Test Date</th>
<th>Time Sampled</th>
<th>Time Tested</th>
<th>Time Tested</th>
<th>Test Results</th>
<th>Test Results</th>
<th>Lift</th>
<th>Target Density</th>
<th>% of Target Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>REMAIN, REMAIN</td>
<td>8/7/20</td>
<td>8:00</td>
<td>8:00</td>
<td>8:00</td>
<td>80.0</td>
<td>80.0</td>
<td>1</td>
<td>80.0</td>
</tr>
<tr>
<td>2</td>
<td>REMAIN, REMAIN</td>
<td>8/7/20</td>
<td>8:00</td>
<td>8:00</td>
<td>8:00</td>
<td>80.0</td>
<td>80.0</td>
<td>1</td>
<td>80.0</td>
</tr>
<tr>
<td>3</td>
<td>REMAIN, REMAIN</td>
<td>8/7/20</td>
<td>8:00</td>
<td>8:00</td>
<td>8:00</td>
<td>80.0</td>
<td>80.0</td>
<td>1</td>
<td>80.0</td>
</tr>
<tr>
<td>4</td>
<td>REMAIN, REMAIN</td>
<td>8/7/20</td>
<td>8:00</td>
<td>8:00</td>
<td>8:00</td>
<td>80.0</td>
<td>80.0</td>
<td>1</td>
<td>80.0</td>
</tr>
<tr>
<td>5</td>
<td>REMAIN, REMAIN</td>
<td>8/7/20</td>
<td>8:00</td>
<td>8:00</td>
<td>8:00</td>
<td>80.0</td>
<td>80.0</td>
<td>1</td>
<td>80.0</td>
</tr>
<tr>
<td>6</td>
<td>REMAIN, REMAIN</td>
<td>8/7/20</td>
<td>8:00</td>
<td>8:00</td>
<td>8:00</td>
<td>80.0</td>
<td>80.0</td>
<td>1</td>
<td>80.0</td>
</tr>
</tbody>
</table>

Incentive Range: 94.0 - 105.0
Min Compaction: 92
Average Min: 95.0
High Low Limit: 3

P Value:
- Total: $3.13
- Incentive: $3.13
- Lot Pay Adjustment: $3.13

First Lift on CAC Lot Tests Must All Be for First Lift On CAC (Lift 1).
Please check the tests for this lot and remove tests that are not for the first lift on CAC or correct the lift number for the tests.
Results for P values will not be correct until this is done.

P Value Calculation
(80 + 3.13 * 3.6) * F = P
(F = 80 + 3.13 * 3.6) * 10 = 80.0

Comments:
Test 1 - stationing in mile post

QA Version - April 2014
Page 1
10/24/2014
13.1.7 Edit Ride Specification Tests

13.1.7.1 Edit Ride Specification Test Data
To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To edit Ride Specification test data the *Ride Specification* test form must be opened and selected (see Selecting A Form).

When the *Ride Specification* test data form is opened and selected it looks like the one below:

![Ride Specification test data form](image)

The basic procedure for entering Ride Specification test data is:
1. Add a new test run (select the Add New Test Run button - see Add a new test run).
2. Select whether to import test run data or input test run data (see Select to import or input test run data).
3. Select the Courtesy Test Run option if applicable (see Set courtesy test run option).
4. For each test run enter the default data for all ride sections in the test run (see Set_default_data_for_ride_sections_in_test_run).
   - Lane (only required for User Input option - populated during import for IRI Import File option)
   - Depth*
   - Width*
   - Unit Weight* [either input, calculated from Core Method (Rice Gravity) or calculated from Nuclear Gauge (Density)]
   **NOTE:** Items with asterisk (*) are only required for Volume Payment Based Ride Specifications.

5. For each test run either import (see Importing_test_run_data_from_ride_data_files) or enter (see Entering_test_run_data_manually) and save the data.
   - From Distance
   - To Distance
   - Average IRI (always input as inches/mile)
   **NOTE:** Average IRI values are always input as inches/mile (in/mi) regardless of the units selected.

6. Review the pay adjustments for the current test run, (select the Show Pay Adjustment Results For This Test Run button - see Review_Ride_Specification_test_run_pay_adjustment_results).

7. Add another test run and enter and save the test run data.

8. Continue adding test runs and entering and saving test run data until all QA data has been entered for the material item Ride Specification testing.

Add a new test run (select the Add New Test Run button).

A **New Test Run** form will be displayed as shown below:
Working With Test Data

Note: The Project Class/Project Category and Unit Cost text boxes are disabled since their values have been set and locked as part of the Material Item and Ride Specification Test Specifications.

Select whether to import test run data or input test run data.

- To import test run data select the **IRI Import File** option in the Data Source panel (the default).

- To input test run data select the **User Input** option in the Data Source panel.

Select the **Courtesy Test Run** option if the test run was performed as a courtesy rather than for QA assessment. Pay adjustments are not computed for courtesy test runs.

For each test run input the default data for the ride sections in the test run:
• **Lane** [if the *User Input* data source option is selected, enter the lane description in the *Lane* text box; the lane description is read from the test run file when importing data]

```
New Test Run
Data Source
   - IRI Import File
   - User Input

   □ Courtesy Test Run

Lane          SB Slow
```

• **Depth** [enter the depth of the pavement]
  [enter meters to the nearest hundredth (.01) for Metric units]
  [enter feet to the nearest tenth (.1) for English units]

• **Width** [enter the width of the lane being tested]
  [enter meters to the nearest hundredth (.01) for Metric units]
  [enter feet to the nearest tenth (.1) for English units]

```
New Test Run
Data Source
   - IRI Import File
   - User Input

   □ Courtesy Test Run

Lane
Depth       0.12       m
Width       3.60       m

Unit Weight From  User Calculated and Input

Unit Weight (Input)     tonne/m3
Unit Cost           16.75       $/tonne
```

• **Unit Weight** [select method for Unit Weight input and enter associated data as described below]
  - **User Calculated and Input**
1. User calculates Unit Weight [rounded to the nearest thousandth (.001)] and enters it directly into the Unit Weight text box.

**NOTE:** The user is encouraged to use one of the other two methods since they perform all of the necessary calculations. However, if the user chooses to perform their own calculations and enter the value they desire, this option provides them with that capability.

**When calculating Unit Weight the user should be aware of the following:**

- **Users should not just enter the Mix Design Rice Gravity value as Unit Weight.**

  The Unit Weight represents the density of the material being placed (which includes voids) on a tonnage basis. The Mix Design Rice Gravity represents the specific gravity of the material with no voids, so the voids need to be accounted for. Assuming 7% voids, the density of the material being placed is approximated to be 93% of the density obtained from the Mix Design Rice Gravity. Also, because the Mix Design Rice Gravity represents a specific gravity, the correct Water Density must be used to determine the actual density represented by the Mix Design Rice Gravity.

  The equations to use to obtain Unit Weight from Mix Design Rice Gravity for English and Metric units are as follows:

  **English units:** (ton/yd³)
  \[
  \text{Unit Weight} = \frac{0.93 \times \text{Mix Design Gmm} \times \text{Water Density (lbm/ft}^3\text{)} \times 27 (\text{ft}^3)}{2000 (\text{lbm/ton}) \times 1 (\text{yd}^3)}
  \]

  **Metric units:** (tonne/m³)
  \[
  \text{Unit Weight} = \frac{0.93 \times \text{Mix Design Gmm} \times \text{Water Density (kg/m}^3\text{)}}{1000 (\text{kg/tonne})}
  \]

  Where:
  Gmm = Rice Gravity
  Water Density = 62.4 lbm/ft³ (English units); 1000 kg/m³ (Metric units)

- **Users should not just enter the Nuclear Gauge readout Bulk Density value as Unit Weight.**

  The Unit Weight represents the density of the material being on a tonnage basis. The density of the material being placed is about 98% of the bulk density reading obtained from the Nuclear Gauge.
Also, the default Nuclear Gauge bulk density readout is in English units. A conversion factor for converting from English to Metric units will need to be applied to convert the bulk density to Metric units.

The equations to use to obtain Unit Weight from the Nuclear Gauge bulk density readout for English and Metric units are as follows:

**English units:** (ton/yd³)

\[
\text{Unit Weight} = 0.98 \times \text{Bulk Density (lbm/ft}^3\text{)} \times \frac{27 \text{ (ft}^3\text{)}}{2000 \text{ (lbm/ton)} \times 1 \text{ (yd}^3\text{)}}
\]

**Metric units:** (tonne/m³)

\[
\text{Unit Weight} = 0.98 \times \text{Bulk Density (lbm/ft}^3\text{)} \times \frac{16.01846 \text{ (kg/m}^3\text{)}}{1000 \text{ (kg/tonne)} \times 1 \text{ (lbm/ft}^3\text{)}}
\]

- **Core Method (Rice Gravity)**

  Used for Density Acceptance from Rice Gravity obtained from Core Method

  **User enters Mix Design Rice Gravity** [rounded to the nearest thousandth (.001)] and Unit Weight is calculated when user tabs out of Rice Gravity text box
  - The Unit Weight is calculated per Special Provision 401-12 (Item C. Basis of Payment)
  
  Unit Weight = 93 percent of density obtained using Rice Gravity from the Mix Design for each type of bituminous surfacing. (When accepting density by core method.)
  
  Density is calculated from Mix Design Rice Gravity using Water Density of 62.4 lbm/ft³ (1000 kg/m³)

- **Nuclear Gauge (Density)**

  Used for Density Acceptance using Nuclear Gauge Density Method

  **User enters Mix Design Bulk Density** (always input as lbm/ft³) [rounded to the nearest tenth (.1)] and Unit Weight is calculated when user tabs out of Bulk Density text box
  - The Unit Weight is calculated per Special Provision 401-12 (Item C. Basis of Payment)
  
  Unit Weight = 98 percent of Mix Design Bulk Density for each type of bituminous surfacing. (When accepting density with a nuclear gauge.)
Bulk Density is always input in lbm/ft$^3$ regardless of units (matches default Nuclear Gauge readout). Bulk Density is converted for metric using 16.01846 kg/m$^3$ per lbm/ft$^3$ conversion factor.

**NOTE:** Mix Design Bulk Density values are always input as lbm/ft$^3$ regardless of units selected.

**Importing Test Run data from ride data files:**

After all of the required common test run data items have been entered, make sure that the **IRI Import File** option is selected on the **Data Source** panel and click the **OK** button, as shown below.

A **Select the File to Load** form will be displayed, prompting the user to choose the ride data file (obtained from the profiler testing) to import the distances and IRI values from.

For importing ride data from the **old RP090L Profiler** select the appropriate data file with the ***.3** file extension, as shown below:
For importing ride data from the **newer SSI Profiler select** the appropriate data file with the *txt file extension*, as shown below:
Use the **Look in:** dropdown to browse and locate the desired ride data file to import. Once the file is selected, click the **Open** button to import the ride data file.

**Note:** The SSI Profiler software will only produce IRI values in inches/mile if the results are created in English Units. This means that all data in the results data file are in English Units, including the lengths and distances. Hence, when importing SSI Profiler results ride data into a Metric QA Suite project a **Converting Imported Lengths** informational form will be displayed, as shown below:

Select the **OK** button to continue importing the data.

When importing ride data, the QA Suite attempts to use the Lane description information from the ride data file as the Test Run identifier. For SSI Profiler ride data files, the Lane may be "undefined" in the ride results file. If this occurs, a **Lane Missing** form will be displayed, prompting the user to enter the Lane description, as shown below:
If this occurs, enter the appropriate Lane/Test Run description in the text box next to the Lane label and select the OK button, as shown below.

![Lane Missing dialog box](image1)

When importing or entering Ride Specification data, each test run must have a unique name. If the ride data file Lane description information or the user input Lane description matches an existing Test Run name, a Rename Test Run form will be displayed, prompting for a new Test Run name, as shown below.

![Rename Test Run dialog box](image2)

If this occurs, enter a new name for the Lane/Test Run description in the text box next to the Lane label and select the OK button, as shown below.
The ride data will be imported and displayed on the *Ride Specification* test data form, as shown below.

The following information is imported and displayed on the form:

- **Lane** - used to identify the Test Run (in this case, "SB Slow")
- **Date Tested** [Month/Day/Year in MM/DD/YYYY format (ex., 6/2/2006 for June 2, 2006)]
- **Time Tested** [Military time - Hours:Minutes in HH:MM format (ex., 08:54 for 8:54 AM)]
- **Operator**
- **Witness**
- **Test section data**
The following information is calculated from the input data and displayed on the form:

- **Rough Distance**: (feet (English units); meters (Metric units))
  \[ \text{Rough Distance} = \text{To distance} - \text{From distance} \]
- **Volume**: (yd\(^3\) (English units); m\(^3\) (Metric units))
  \[ \text{Volume} = (\text{Rough Distance} \times \text{Depth} \times \text{Width}) / \text{Volume Conversion Factor} \]
  Where:
  \[ \text{Volume Conversion Factor} = 27 \text{ ft}^3/\text{yd}^3 \text{ (English units)}; 1 \text{ m}^3/\text{m}^3 \text{ (Metric units)} \]

The following common test run data (from the **New Test Run** form) are displayed on the form:

- **Depth**: (feet (English units); meters (Metric units))
- **Width**: (feet (English units); meters (Metric units))
- **Project Class or Category**: (set as part of the material item test specification)
- **Unit Weight**: From selection
- **Rice Gravity or Bulk Density**: used in Unit Weight calculation if unit weight is calculated
- **Unit Weight**: (tons/\text{yd}^3 \text{ (English units)}; tonne/\text{m}^3 \text{ (Metric units))}
- **Unit Cost**: (set as part of the material item specification)

This is a good time to save the data using the **Save** button on the tool bar (see **Toolbar**) or the **File Menu --> Save** option (see **Save**). **Entering Test Run data manually:**

After all of the required common test run data items have been entered, make sure that the **User Input** option is selected on the **Data Source** panel and click the **OK** button, as shown below.
A new test run is created on the **Ride Specification** test data form with the Test Run named using the Lane information from the New Test Run form, as shown below.
Enter the test run data collection information:

- Date Tested  [Month/Day/Year in MM/DD/YYYY format (ex., 6/2/2006 for June 2, 2006)]
- Time Tested  [Military time - Hours:Minutes in HH:MM format (ex., 08:54 for 8:54 AM)]
- Operator
- Witness

The following common test run data (from the **New Test Run** form) are displayed on the form:

- Depth (feet (English units); meters (Metric units))
- Width (feet (English units); meters (Metric units))
- Project Class or Category (set as part of the material item test specification)
Working With Test Data

- Unit Weight From selection
- Mix Design Rice Gravity or Bulk Density used in Unit Weight calculation if unit weight is calculated
- Unit Weight (tons/yd$^3$ (English units) ; tonne/m$^3$ (Metric units))
- Unit Cost (set as part of the material item specification)

<table>
<thead>
<tr>
<th>Depth</th>
<th>0.12 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>3.6 m</td>
</tr>
<tr>
<td>Project Category</td>
<td>1</td>
</tr>
<tr>
<td>Unit Weight From</td>
<td>Core Method (Rice Gravity)</td>
</tr>
<tr>
<td>Mix Design Rice Gravity</td>
<td>2.459</td>
</tr>
<tr>
<td>Unit Weight (Calc.)</td>
<td>2.287 tonne/m$^3$</td>
</tr>
<tr>
<td>Unit Cost</td>
<td>16.75 $/tonne</td>
</tr>
</tbody>
</table>

For each section of road analyzed, input the values as follows:

Click the Add button.

Enter the test section data:
- From distance
- To distance
- Average IRI

<table>
<thead>
<tr>
<th>From</th>
<th>45 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>345 m</td>
</tr>
<tr>
<td>Rough Distance</td>
<td>300.00 m</td>
</tr>
<tr>
<td>Avg IRI</td>
<td>46 in/1000 mi</td>
</tr>
</tbody>
</table>

Note: The Rough Distance is calculated after the From and To distances have been entered.

Click the Save button to save the test section data to the table of values and calculate the associated test section Volume, as shown below.
Continue using the Add button and entering test section values until all of the test section data has been entered as shown below.

This is a good time to save the data using the Save button on the tool bar (see Toolbar) or the File Menu --> Save option (see Save).

To review the pay adjustments for the current test run, press the Show Pay Adjustment Results For This Test Run button at the top of the form. The Ride Spec Pay Adjustment Data form is displayed.

Because the Ride Specification evaluation is tied to the Plant Mix Density Test Results, a warning is displayed that not all of the density tests have been entered, as shown below. The warning is provided to indicate that the results are preliminary until all of the Plant Mix Density test results evaluations for the project have been marked as completed.
Once the Plant Mix Density test results evaluations for the project have been marked as completed, the pay adjustment results for the test run are displayed as shown below.
Buttons:

Clear All - Pressing this button will clear the list of station data and all station entry values.

Add - Pressing this button enables the test section input boxes below the table for test section data entry for adding a new test section to the table.

Save - Pressing this button saves the test section data entered in the test section input boxes to the table.

Edit - Pressing this button will load the selected station's data from the table to the text boxes below the table for editing and saving.
**Update All Entries** - Pressing this button will update all values in the table with the depth, width, and/or unit weight values that are input in the boxes. If no value is input, the value in the table will be used.

**Update Selected Entries** - Pressing this button will update the selected rows in the table with the depth, width, and/or unit weight values that are input in the boxes. If no value is input, the value in the table will be used.

*Note the following Ride Spec Testing User Interface (UI) modifications for Length Payment Based Ride Specifications.*

The differences in the UI are due to the Length Payment Based Ride Spec evaluations being based on the average IRI for the entire test run and the total length of the entire run, rather than being based on the average IRI and mass for each individual ride segment.

As shown below, the Depth, Width, Unit Weight and Volumes do not appear as they do not apply for Length Based Ride Specifications.
Additionally, since the Length Based Ride Spec evaluation does not involve pay adjustment calculations of individual ride sections, the Pay Adjustment data form does not include a Pay column for the individual ride sections or a summary of Ride Sections with Pay Reductions. Instead the IRI Pay Adjustment Results are calculated based on the average IRI and total length for the entire test run and displayed, as shown below:
Note that the Plant Mix Density test results are still included in the evaluation and all density tests must still be entered before the pay adjustment results can be locked, as shown below.
Note the following Ride Spec Pay Adjustment UI modifications for Plant Mix Incentive Ties.

The differences in the UI are due to the final Adjusted Incentives being based on the results for all Volumetric, Plant Mix Density and Ride Spec tests for the Plant Mix Material Item. As shown below, the UI displays the unadjusted Lot Incentive amount for the current lot along with the Plant Mix Incentive Tie Incentive Adjustment Factor (IAF) and the corresponding Adjusted Incentive amount which is the product of the unadjusted Lot Incentive and the Incentive Adjustment Factor. The Net Pay Adjustment for the lot is the sum of the Adjusted Incentive and the Deduct.
NOTE: The Incentive Adjustment Factor will be zero (0.000) until all Volumetric, Density and Ride tests have been entered and the "All Tests Entered" selection has been made for all three test types and the Incentive Adjustment Factor has been computed using the Plant Mix Incentive Ties form which is accessed from the View menu (see Plant Mix Incentive Ties).

Creating QA Suite Compatible SSI Ride Data Results Import Files

Starting with Version 2.6, the SSI Profiler Analysis software provides functionality for creating QA Suite compatible SSI ride data results files for use in importing ride data into the MDT QA Suite. The basic steps for using this functionality are described below.
The Lane description required for importing ride data into the QA Suite can either be input during the QA Suite import process or can be set up to be included in the ride data file. In order to have the desired Lane description included in the ride data file a User Defined Project Parameter must be added to the Project Details and saved before running the QA Suite Report Print Option.

To add the Lane description to the SSI Profiler relative height data project information, first select the **Analyze Data** command button on the SSI Profiler application main form, as shown below:

Next, select the **Project Details** tab, as shown below:

Then, select the **User Defined** tab in the **Project Parameters** panel, as shown below.

Next, select the **Add Parameter** button on the **User Defined** tab, as shown below.
An Add Parameter form will be displayed, as shown below:

Next, select the Lane Identification item from the Parameter dropdown list, as shown below.

Then, enter the desired Lane description ("NB Driving" in this example) in the Value text box and select the Add command button, as shown below.
The **User Defined** tab will update to show the Lane Identification Parameter with its Value set to the desired Lane description ("NB Driving"), as shown below.

Finally, select the **Save Project** command button to save the User Defined Lane Identification parameter to the ride height data project file, as shown below.
The Lane description contained in the Lane Identification parameter value will be included in the ride data file created with the QA Suite Report command.

To start the process of creating a SSI ride data results file for use in importing ride data into the QA Suite, go to the **Print Options** tab in the SSI Profiler application, as shown below.
Next, select the **QA Suite Report** command button in the **Addition Print Formats** panel on the tab, as shown below.

![Screenshot of SSI Profiler interface](image)

An **Save as...** form will be displayed with the **Save in:** location set to the same location as the currently loaded SSI Profiler Ride Height Data project file and the **File name:** set to match the SSI Profiler Ride Height Data project file name with a text (*.txt) file extension, as shown below:
Next, navigate to the desired location using the **Save in:** dropdown and enter the desired name for the file to be saved with in the **File name:** text box. The file must be saved with a .txt file extension in order to be recognized as a valid file type for importing to the QA Suite. Once the desired location and name for the file are set select the **Save** command button to create the file, as shown below:
The SSI Profiler software will generate the QA Suite compatible SSI ride data results text file and an SSI Profiler file created form will be displayed, indicating that the file was created successfully, as shown below:

Next, select the **Close** command button to simply close the form and complete the QA Suite Report generation process.

Alternatively, select the **Open File** command button which will close the form and open the QA Suite compatible SSI ride data results text file in Notepad for viewing (as shown below) completing the QA Suite Report generation process.
NOTE: In this case since the Lane description ("NB Driving") was added to the SSI Ride Height Data project file as a User Defined Lane Identification Project Parameter prior to running the QA Suite Report generation, the "NB Driving" Lane description information is included after the LANE identifier in the text file (as highlighted above). The QA Suite will read the "NB Driving" Lane description from this file during the import process to identify the Test Run.

If the User Defined Lane Identification Project Parameter has not been added to the SSI Ride Height Data project file prior to running the QA Suite Report generation, the text "undefined" is included after the LANE identifier in the text file (as shown highlighted below). The QA Suite will read the "undefined" Lane description from this file during the import process and prompt the user to enter a Lane/Test Run description prior to completing the import process.

The SSI ride data results text file created by the QA Suite Report generation process is now ready to be imported into the QA Suite (see Importing_test_run_data_from_ride_data_files).
13.1.8 Edit Volumetric Tests

13.1.8.1 Edit Volumetric Test Data
To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To edit Volumetrics test data the Volumetric Testing test form must be opened and selected (see Selecting A Form).

When the Volumetric Testing test data form is opened and selected it looks like the one below:

Although there is a lot of information on the form, it is broken down into several smaller pieces (such as the Aggregate Gravity Information, Gmm Calculation, Gmb Calculation and Results sections) within the form.

The basic procedure for entering Volumetric Testing lot data is:
1. Add a new lot (select the **Add New QA Lot** button to add QA lot; select the **Add New Non-QA Lot** button to add Non-QA lot - see **Add a new lot**)
2. Enter the lot size (see **Input the Volumetric lot size**)
3. Add a new Sub Lot (select **Start Test** button to add new sub lot - see **Add a new Volumetric sub lot**).
4. For each sample enter and save the sample data.
   i. Enter the sample test information (see **Enter the Volumetric sample test information**).
      - Date Sampled
      - Time Sampled
      - Date Tested
      - Time Tested (Optional)
      - Sample Tonnage (Optional)
      - % AC Corrected Burn
      - % AC Spot Check (Optional)
      - Plant Temperature (Optional)
      - Temperature Tested (Optional)
      - Minus 200M (Burn MT 320)
      - Sample Data for Both Bricks
         - Mass
         - Initial Height
         - Design Height
   ii. For each sample enter the Aggregate Gravity information (see **Enter the Volumetric Aggregate Gravity information**).
      - Bulk Specific Gravity
      - Bin %
   iii. For each sample either calculate or enter the Gmm (see **Compute or enter Volumetric Gmm**).
      - Enter Gmm Calculation Data
         - Weight of Flask
         - Weight of Water
         - Weight of Water + Material
         - Weight After Saturation
         -OR-
         - Enter Gmm
   iv. For each brick either calculate or enter the Gmb (see **Compute or enter Volumetric Gmb**).
      - Enter Gmb Calculation Data for Each Brick
         - Weight in Air
         - Weight in Water
         - Weight of Weight of Surface Dry Sample in Air
         -OR-
1.

- Enter Gmb
  v. For each sample enter any comments and select the tester (see [Enter comments and select tester](#)).
  - Comments
  - Tester
  vi. Save the sub lot data (see [Save the sub lot data](#)).

5. Add another Sub Lot and enter and save the sample data (see [Add another Volumetric sub lot](#)).

6. Continue adding sub lots and entering and saving sample data until all sub lots have been entered for the lot.

7. Optionally, review the results of the Outlier Analysis (select the [Analyze for Outliers](#) button - see [Review results of Outlier Analysis](#)).

8. Optionally, review the Gmm Rolling Average history (select the [Show History](#) button - see [Review Gmm Rolling Average history](#)).

9. Review the pay adjustments for the current lot, (select the [Show Pay Adjustment Results For This Lot](#) button - see [Review Volumetric lot pay adjustment results](#)).

10. Add another lot and enter and save the sub lot data.

11. Continue adding lots and sub lots and entering and saving sample data until all QA data has been entered for the material item Volumetrics testing.

Add a new lot (select the [Add New QA Lot](#) button to add a QA lot; select the [Add New Non-QA Lot](#) button to add a Non-QA lot).

A new lot will be added with the lot number populated with the next available lot number.

Input the lot size (input the desired value if it is different from the default lot size).
Add a new Sub Lot (select the **Start Test** button to add a new Sub Lot).

The Test Number will be populated with the next available test number.

For each sample (e.g., Sub Lot 1), input the data.

Enter the sample test information.

- **Date Sampled**: [Month/Day/Year in MM/DD/YYYY format]
- **Time Sampled**: [Military - Hours:Minutes in HH:MM format]
- **Date Tested**: [Month/Day/Year in MM/DD/YYYY format]
- **Time Tested**: [Military - Hours:Minutes in HH:MM format]
- **Sample Tonnage**: [enter to nearest tenth (.1)]
- **% AC Corrected Burn**: [enter to nearest hundredth (.01)]
- **% AC Spot Check**: [enter to nearest hundredth (.01)]
- **Plant Temperature**: [enter to nearest tenth (.1)]
- **Temperature Tested**: [enter to nearest tenth (.1)]
- **Minus 200M (Burn MT 320)**: [enter to nearest tenth (.1)]
- **Sample Data for Both Bricks**
  - **Mass**: [enter to nearest tenth (.1)]
  - **Initial Height**: [enter to nearest tenth (.1)]
• Design Height [enter to nearest tenth (.1)]

Enter the Aggregate Gravity information for each bin.
• Specific Gravity [enter to nearest thousandth (.001)]
• Bin % [enter to nearest tenth (.1)]

Note: The bin descriptions are loaded from the Volumetrics test specifications.
The adjusted bin percentages and blend values are computed from the input specific gravities and bin percentages once the values are input for all of the bins.

Either compute or enter the Gmm.

- **Compute the Gmm** (enter the Gmm Calculation data).
  - Weight of Flask [enter to nearest tenth (.1)]
  - Weight of Water [enter to nearest tenth (.1)]
  - Weight of Water + Material [enter to nearest tenth (.1)]
  - Weight After Saturation [enter to nearest tenth (.1)]

After the individual weights have been input, the Gmm will be computed and displayed and the Gmm label will indicate that the Gmm is computed”.

The Gmm text box will be disabled, so that the computed value cannot be changed. If at a later time, the Gmm needs to be input, instead of computed, clear the text in the text boxes for the individual weights, and the Gmm text box will be enabled to allow input of the Gmm value.

- OR -

- **Enter the Gmm.**
  - Gmm [enter to nearest thousandth (.001)]

If the Gmm is input by the user, the text boxes for the individual weights will be disabled, and the Gmm label will indicate that the Gmm is input.

If at a later time, the Gmm needs to be computed, clear the text in the Gmm text box, and the text boxes for the individual weights will be enabled to allow input of the individual weights and computation of the Gmm.
Either compute or enter the Gmb for each brick.

- Compute the Gmb for each brick (enter the Gmb Calculation data for each brick).
  - Weight in Air  [enter to nearest tenth (.1)]
  - Weight in Water [enter to nearest tenth (.1)]
  - Weight of Surface Dry Sample in Air [enter to nearest tenth (.1)]

<table>
<thead>
<tr>
<th>Gmb Calculation</th>
<th>Data Set 1</th>
<th>Data Set 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight in Air</td>
<td>4664.0</td>
<td>4666.3</td>
</tr>
<tr>
<td>Weight in Water</td>
<td>2707.4</td>
<td>2711.0</td>
</tr>
<tr>
<td>Weight of SSD Sample</td>
<td>4667.9</td>
<td>4669.9</td>
</tr>
<tr>
<td>Gmb</td>
<td>2.379</td>
<td>2.382</td>
</tr>
</tbody>
</table>

Computed Computed

After the individual weights have been input, the Gmb will be computed and displayed and a "Computed" label will be displayed below the Data Set column.

The Gmb text box will be disabled, so that the computed value cannot be changed. If at a later time, the Gmb needs to be input, instead of computed, clear the text in the text boxes for the individual weights, and the Gmb text box will be enabled to allow input of the Gmb value.

- OR -

- Enter the Gmb.
  - Gmb  [enter to nearest thousandth (.001)]

<table>
<thead>
<tr>
<th>Gmb Calculation</th>
<th>Data Set 1</th>
<th>Data Set 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight in Air</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weight in Water</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weight of SSD Sample</td>
<td>2.379</td>
<td>2.382</td>
</tr>
<tr>
<td>Gmb</td>
<td>2.379</td>
<td>2.382</td>
</tr>
</tbody>
</table>

Input Input

If the Gmb is input by the user, the text boxes for the individual weights will be disabled, and a "Input" label will be displayed below the Data Set column.

If at a later time, the Gmb needs to be computed, clear the text in the Gmb text box, and the text boxes for the individual weights will be enabled to allow input of the individual weights and computation of the Gmb.
Enter any comments and select the tester.

- Comments (select the Comments text box and enter the comments)

Note: The Comments text box expands for easier data entry, as shown above.

- Tester (select tester's name from Tester Dropdown)
When all data entry is completed the form will look as follows.
This is a good time to save the data using the Save button on the tool bar (see Toolbar) or the File Menu --> Save option (see Save).

To enter test data for additional tests in the lot, click on the next Sub Lot tab as shown below and then repeat sample data entry as shown above.
Note: The Sampled and Tested Dates, Aggregate Gravity Information, and Tester will carry forward from the previous sub lot as shown below. When a different Hyd Lime Bulk Specific Gravity value is entered, the new value will be used for all subsequent samples.

To review the results of the Outlier Analysis, select the Analyze for Outliers button in the upper right section of the form. The Potential Outliers form is displayed.

Below the outlier analysis is a check box to exclude the sample from QA and incentive calculations. This box should be checked to exclude outliers. The first two lots can be used to help set the targets. These lots are designated as non-QA lots. By default, all samples for non-QA lots are checked for exclusion from QA and Incentive Calculations.

By default, the Exclude Sample from QA and Incentive Calculations option should be unchecked for all QA lot samples. This is necessary in order to properly calculate the pay adjustments.
If a sample in a QA lot fails the Outlier Analysis, the *Outlier Analysis Result:* label will display the word "Fail" in red. If this occurs the user will need to review the results of the Outlier Analysis. The Outlier Analysis can be viewed by selecting the *Analyze for Outliers* button. The *Potential Outliers* form will be displayed as shown below.

To go to a sample to view the data and the calculated results, select the sample from the list and click on the *Go to Sample* button, as shown below.

The selected sample will be opened in the *Volumetric Testing* tab form.

After verifying the validity of the sample and the testing performed and verifying the numbers input for the test results, a determination can be made as to whether a sample is a true outlier. If the sample is a true outlier it can be excluded from the QA and Incentive
Calculations by checking the *Exclude Samples from QA and Incentive Calculations* option, as shown below.

To review the Gmm Rolling Average history, select the **Show History** button in the upper right section of the form. The **Gmm Rolling Average** form is displayed.

Once at least two samples have been entered, the calculation of the Gmm rolling average value is started. The calculation is performed for all lots (QA and non-QA) based on the date and time sampled and the current Gmm rolling average value is displayed in the upper right section of the **Volumetric Testing** form tab below the **Gmm Rolling Average** label.

The Gmm rolling average value is compared to the target value. Notification is provided to check the target if the Gmm rolling average value falls outside the acceptable tolerance (0.5 pounds per cubic foot) of the current target value, as shown below.

The target Gmm value is set on the **Gmm Rolling Average** form. The target is set by first entering the target value into the **Target** text box and then selecting the **Set** button next to the desired target value. When a target is set, the text in the associated Target text box is highlighted in bold and green. Once a target value is set, it remains the target value until a new target value is set. In the case shown below, the target value was set to 2.45 starting with Lot A, Sample 2 and then re-set to 2.437 starting at Lot B, Sample 10.
If the Gmm value for a sample is questionable, the sample can be excluded from the rolling average calculation by checking the *Exclude* option, as shown below.

<table>
<thead>
<tr>
<th>Lot Number</th>
<th>Sample Number</th>
<th>Sample Date</th>
<th>Time Sampled</th>
<th>Gmm</th>
<th>Average</th>
<th>Target</th>
<th>Set</th>
<th>Exclude</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>6</td>
<td>10/12/2005</td>
<td>13:15</td>
<td>2.452</td>
<td>2.449</td>
<td>2.453</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>4</td>
<td>11/11/2005</td>
<td>16:05</td>
<td>2.464</td>
<td>2.452</td>
<td>2.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>5</td>
<td>11/12/2005</td>
<td>10:35</td>
<td>2.434</td>
<td>2.449</td>
<td>2.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>7</td>
<td>11/12/2005</td>
<td>13:55</td>
<td>2.455</td>
<td>2.449</td>
<td>2.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>8</td>
<td>11/16/2005</td>
<td>11:10</td>
<td>2.439</td>
<td>2.448</td>
<td>2.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>9</td>
<td>11/16/2005</td>
<td>12:55</td>
<td>2.438</td>
<td>2.442</td>
<td>2.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>11/17/2005</td>
<td>08:00</td>
<td>2.414</td>
<td>2.437</td>
<td>2.437</td>
<td>Set</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>11/17/2005</td>
<td>12:35</td>
<td>2.449</td>
<td>2.435</td>
<td>2.437</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>5/15/2006</td>
<td>13:10</td>
<td>2.418</td>
<td>2.430</td>
<td>2.437</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5/16/2006</td>
<td>15:50</td>
<td>2.444</td>
<td>2.431</td>
<td>2.437</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>5/16/2006</td>
<td>10:05</td>
<td>2.458</td>
<td>2.442</td>
<td>2.437</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>5/16/2006</td>
<td>14:20</td>
<td>2.442</td>
<td>2.441</td>
<td>2.437</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*To set a new target, enter new target in text box, then click the Set button.*
To review the pay adjustments for the current lot, press the **Show Pay Adjustment Results For This Lot** button at the top of the form. The **Volumetric Pay Adjustment Data For:** form is displayed.

If less than 3 samples have been entered for the lot, a warning is displayed that a minimum of 3 samples are required to compute pay adjustments as shown below.

![Gmm Rolling Average Table](image)

**To set a new target, enter new target in text box, then click the Set button.**
Once at least 3 samples have been entered, the pay adjustment results for the lot are displayed as shown below.
Things to remember:

All calculated values (Adjusted Bin %, Blend Specific Gravity, Blend Bin %, Gmm, Gmb, % Voids, VMA, VFA, Dust/Asphalt Ratio, Average % Voids, Average VMA, Average VFA, Gmm Rolling Average, Outlier Analysis Result) are automatically generated as soon as all of the inputs are provided.

Each sub lot tab represents a sample within the lot. For example, sub lot 1 is the first sample in the lot and sub lot 7 is the seventh sample in the lot.

A minimum of 3 samples are required to compute pay adjustments.

**Note the following Volumetric Testing UI modifications for Commercial Plant Mix.**

The differences in the UI are due to the Commercial Plant Mix being test base instead of lot based.
The Aggregate Testing form is shown below. For each Volumetric test added, an Aggregate test will be added.
To review the pay adjustments for the current test, press the **Show Pay Adjustment Results For This Test** button at the top of the form. The **Commercial Plant Mix Pay Adjustment Data For** form is displayed.
Note the following Volumetric Pay Adjustment UI modifications for Plant Mix Incentive Ties.

The differences in the UI are due to the final Adjusted Incentives being based on the results for all Volumetric, Plant Mix Density and Ride Spec tests for the Plant Mix Material Item. As shown below, the UI displays the unadjusted Lot Incentive amount for the current lot along with the Plant Mix Incentive Tie Incentive Adjustment Factor (IAF) and the corresponding Adjusted Incentive amount which is the product of the unadjusted Lot Incentive and the Incentive Adjustment Factor. The Net Pay Adjustment for the lot is the sum of the Adjusted Incentive and the Deduct.
NOTE: The Incentive Adjustment Factor will be zero (0.000) until all Volumetric, Density and Ride tests have been entered and the "All Tests Entered" selection has been made for all three test types and the Incentive Adjustment Factor has been computed using the Plant Mix Incentive Ties form which is accessed from the View menu (see Plant Mix Incentive Ties).
13.2 Evaluation Results

13.2.1 Lot Pay Adjustments

Part of the QA process is to perform analysis using QA formulas to determine if the product is acceptable, and if an incentive or price reduction should be applied. Incentives or price reductions are also known as lot pay adjustments.

Lot pay adjustments are calculated and displayed when the "Show Pay Adjustment For This Lot" button is selected on the test data form.

After pressing the "Show Pay Adjustment For This Lot" button, a new form will open showing the details of the pay adjustment calculations such as the following:

<table>
<thead>
<tr>
<th>Test #</th>
<th>Voids</th>
<th>VMA</th>
<th>VFA</th>
<th>D/A Ratio</th>
<th>Gnm</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.8</td>
<td>14.4</td>
<td>81</td>
<td>0.8</td>
<td>2.449</td>
</tr>
<tr>
<td>2</td>
<td>2.5</td>
<td>15.1</td>
<td>83</td>
<td>1.0</td>
<td>2.418</td>
</tr>
<tr>
<td>3</td>
<td>2.1</td>
<td>13.8</td>
<td>85</td>
<td>0.9</td>
<td>2.444</td>
</tr>
<tr>
<td>4</td>
<td>4.7</td>
<td>15.4</td>
<td>70</td>
<td>0.9</td>
<td>2.458</td>
</tr>
<tr>
<td>5</td>
<td>3.0</td>
<td>14.3</td>
<td>79</td>
<td>1.0</td>
<td>2.442</td>
</tr>
</tbody>
</table>

Xn is the average value of all samples.

R is the range (maximum value - minimum value) of all samples.

P value is the maximum of the following two formulas:

\[ P = (Xn + aR - Tu) \times F \]
\[ P = (TL + aR - Xn) \times F \]
where $a$ is a factor based on the number of samples in the lot, the $T$ values are upper and lower target values and $F$ is the $F'$ Factor for the analysis.

Incentive % is the percentage incentive for each analysis and total incentive for the lot as a whole potentially including a bonus.

Bonus is an additional incentive % determined based on the incentive % for all of the parameters.

The value of the deduct and incentive are calculated by the following:

$$\text{Value} = \text{Lot Size} \times \text{Price} \times (P \text{ or Incentive}) / 100$$

The net pay adjustment is the sum of the deduct value and the incentive.

The calculated pay adjustment can be modified at the project manager's discretion. For help with making modifications to calculated pay adjustments see the Modifying Pay Adjustments topic.
13.2.2 Modifying Pay Adjustments

Occasionally a project manager may need to make modifications to calculated pay adjustments.

The project manager can document any necessary calculated pay adjustment modifications on the appropriate lot pay adjustment calculation form.

To modify calculated pay adjustments the EPM first opens the appropriate lot pay adjustment form, as shown below.

Next, check the Modify Adjustment check box. A text box for entering the modified amount and a text box for entering the reason for the adjustment will be displayed, as shown below.
Next, enter the modified amount in the text box next to the *Modify Adjustment* check box and an explanation of the reason for the modification in the *Reason* text box, as shown below.
Note: A reason for the modification must be entered. The **OK** and **Lock** buttons will be disabled until a reason is entered in the *Reason* text box.
Finally, select the OK button to complete the calculated pay adjustments modification process and close the lot pay adjustment form.
13.2.3 CP Categories

Occasionally there is a need to partition project costs to certain categories for financial purposes. For example, projects that span multiple counties may need to have the portion of the project costs that are associated with the work performed in each county identified, tracked and entered separately into the estimates. This is one example of where contract payment (CP) categories can come into play.

During the course of placing material items on a project, the material from a given lot can be placed with a certain portion being placed in one county and the remaining portion placed in the another county.

Since, for QA purposes, the material in question is all part of the same lot, all of the sub-lot samples should be evaluated together as part of the lot.

The contract payment (CP) categories option was added to the QA system to allow for determining the amount of pay adjustment that should be applied to each category based on the relative amount of material placed in each category.

To set up CP categories for a lot simply click on the CP Categories button on the test data form, as shown below.

A CP Categories form will be displayed as shown below.
Use the up and down arrows next to the Number of CP Categories selection control to select the number of categories. One set of CPCategory description and Percent text boxes will appear for each CP Category. Enter the CP Category description in the CPCategory text box and the associated percent of the lot material to be associated with the category in the Percent text box.

For example, if the material in question crossed a county boundary with 70% of the lot material being placed in Silver Bow County and 30% of the lot material being placed in Jefferson County, the user might use the CP Categories form to set up the county categories as follow.

![CP Categories Form]

Note: The sum of the percentages should add up to 100%.

Select the OK button to complete the CP Categories definition process, returning to the test data form.

The CP Categories are then used to compute and display the category amounts on the lot pay adjustments form, as shown below.
The CP Category adjustments are also displayed in the Pay Summary (see Pay Summary).
13.3 Reporting Test Data

13.3.1 Reporting Test Data

Throughout the course of a project, there is a need to view and/or print test data and associated analysis results.

The basic process for reporting test data and analysis results is as follows:

1. Open the file in the QA Suite (see Start and Log In to QA Suite).
2. Open the test form (see Opening A Test Form).
3. View the information:
   i. Select the File->Print Preview or the button on the toolbar.
   ii. Make the required selections in the selected form's Print Selections window and click the Print Preview button.

   OR

4. Print the information:
   i. To print the information select the File->Print or the button on the toolbar.
   ii. Make the required selections in the selected form's Print Selections window and click the Print button.
13.3.2 Report Aggregate Gradations

13.3.2.1 Report Aggregate Gradations Test Data
With the Aggregate Testing test form selected, use the Preview or Print options to either preview or print the Aggregate Gradations test data and/or evaluation results (see Printing).

To preview the Aggregate Gradations test data and/or evaluation results in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Aggregate Gradations Print Selection window will be displayed as shown below.

The Check the Lots and/or Tests that you would like to print list provides a tree structure for locating and selecting the lots and/or tests to include in the print preview results. The tree structure is organized with the Material Version at the top level, the Lot(s) for each material version at the second level, and the individual Test(s) for each lot at the bottom level.

Click on the plus sign to expand a branch of the tree or the minus sign to collapse a branch of the tree.
Items in the list with a check mark are selected. Click on the individual Lot or Test Number item on the tree to select or un-select the item.

Selecting a Lot automatically selects all Tests under that lot.

Un-selecting a lot automatically un-selects all Tests under that lot.

There are three types of information that can be included in the print preview results (Pay Adjustment Details, Pay Adjustment Summary and/or Individual Test data). At least one of the options must be selected in order to perform the print preview operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected lots in the print preview results. If no lots are selected, no pay adjustment details are included in the print preview results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the print preview results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot or test selections.

Select the **Include Individual Tests** option to include the test data for selected tests in the print preview results. If no tests are selected, no test data information is included in the print preview results.

The **Select All** button can be used to select all of the lots and tests displayed in the *Check the Lots and/or Tests that you would like to print* list. The **Clear All** button un-selects all of the lots and tests displayed in the *Check the Lots and/or Tests that you would like to print* list.

All lots and tests selected in the *Check the Lots and/or Tests that you would like to print* list are included in the print preview results. Hence, to exclude lots or tests from the print preview results, un-select the lots or tests in the *Check the Lots and/or Tests that you would like to print* list.

For example, with the selections shown below,
The print preview results will include:
  The pay adjustment summary.
  The pay adjustment details for Material Version 1 --> Lot 1.

Once the desired selections are made, click the **Preview** button to preview the information for the selected options. The **Print preview** window will be displayed, as shown below.
## MDT Quality Assurance System
### Aggregate Gradations

**Contract ID:** 09405  
**Project No.:** NH 8-4(41) 93  
**Description:** US 297 PASS LN-S OF TOSTON

**Bid Item:** CRUSHED AGGREGATE COURSE  
**Material Type:** CRUSHED BASE COURSE TYPE A GRADE 6A  
**Contract Quantity:** 22,114 m³  
**Item Number:** 01270000  
**Specification Effective Date:** 2/1/2004

### Pay Adjustment Summary by Lot

<table>
<thead>
<tr>
<th>Lot No.</th>
<th>Lot Size</th>
<th>Deduction Value</th>
<th>Incentive Value</th>
<th>Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6250</td>
<td>$0.00</td>
<td>$25,606.25</td>
<td>$25,606.25</td>
</tr>
<tr>
<td>2</td>
<td>6250</td>
<td>$0.00</td>
<td>$25,606.25</td>
<td>$25,606.25</td>
</tr>
<tr>
<td>3</td>
<td>6613</td>
<td>($56,910.88)</td>
<td>$0.00</td>
<td>($56,910.88)</td>
</tr>
<tr>
<td>Total</td>
<td>28,463 m³</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Net Pay Adjustment:** ($46,698.28)  
(For this project item)

N/A indicates insufficient number of samples for lot pay adjustment calculations.  
(A Minimum of 3 samples are required to compute Pay Adjustments.)

QA Version: April 2007  
Page 1  
3/26/2008
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Aggregate Gradations Print Selection window to close the window, completing the print preview operation.

To print the Aggregate Gradations test data and/or evaluation results use the File->Print or the button on the toolbar. After selecting the print option, the Aggregate Gradations Print Selection window will be displayed as shown below.

![Aggregate Gradations Print Selection window](image)

The Check the Lots and/or Tests that you would like to print list provides a tree structure for locating and selecting the lots and/or tests to include in the printed results. The tree structure is organized with the Material Version at the top level, the Lot(s) for each material version at the second level, and the individual Test(s) for each lot at the bottom level.

(✓ Material Version #
  ✓ Lot #
    ✓ Test Number #
  ✓ Non-QA Lot #)

774
Test Number #)

Click on the plus sign to expand a branch of the tree or the minus sign to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Lot or Test Number item on the tree to select or un-select the item.

Selecting a Lot automatically selects all Tests under that lot.

Un-selecting a lot automatically un-selects all Tests under that lot.

There are three types of information that can be included in the printed results (Pay Adjustment Details, Pay Adjustment Summary and/or Individual Test data). At least one of the options must be selected in order to perform the print operation.

Select the Pay Adjustment Details option to include the pay adjustment details for selected lots in the printed results. If no lots are selected, no pay adjustment details are included in the printed results.

Select the Pay Adjustment Summary option to include the pay adjustment summary information in the printed results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot or test selections.

Select the Include Individual Tests option to include the test data for selected tests in the printed results. If no tests are selected, no test data information is included in the printed results.

The Select All button can be used to select all of the lots and tests displayed in the Check the Lots and/or Tests that you would like to print list. The Clear All button un-selects all of the lots and tests displayed in the Check the Lots and/or Tests that you would like to print list.

All lots and tests selected in the Check the Lots and/or Tests that you would like to print list are included in the printed results. Hence, to exclude lots or tests from the printed results, un-select the lots or tests in the Check the Lots and/or Tests that you would like to print list.

For example, with the selections shown below,
The printed results will include:
- The pay adjustment summary.
- The pay adjustment details for Material Version 1 --> Lot 1.
- The pay adjustment details for Material Version 1 --> Lot 2 --> Test Number 10.

Once the desired selections are made, click the **Print** button to print the data (see **Printing**).

When done printing click on the **Cancel** button on the **Aggregate Gradations Print Selection** window to close the window, completing the print operation.
13.3.3 Report Aggregate Surfacing Density Tests

13.3.3.1 Report Aggregate Surfacing Density Test Data
With the *Aggregate Surfacing Density* test form selected, use the Preview or Print options to either preview or print the Aggregate Surfacing Density test data and/or evaluation results (see *Printing*).

To preview the Aggregate Surfacing Density test data and/or evaluation results in a "print preview" window before sending it to the printer use the *File->Print Preview* menu option or the button on the toolbar. After selecting the print preview option, the *Aggregate Surfacing Density Print Selection* window will be displayed as shown below.

![Aggregate Surfacing Density Print Selection](image)

The *Check the Lots that you would like to print:* list provides a tree structure for locating and selecting the lots to include in the print preview results. The tree structure is organized with the Material Version at the top level, and the Lot(s) for each material version at the bottom level.

(☑️ Material Version #
  ☑️ Lot #
  ☑️ Non-QA Lot #)

Click on the plus sign ☐ to expand a branch of the tree or the minus sign ☐ to collapse a branch of the tree.
Items in the list with a check mark are selected. Click on the individual Lot item on the tree to select or un-select the item.

There are two types of information that can be included in the print preview results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print preview operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected lots in the print preview results. If no lots are selected, no pay adjustment details are included in the print preview results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the print preview results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot selections.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots that you would like to print:* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots that you would like to print:* list.

All lots selected in the *Check the Lots that you would like to print:* list are included in the print preview results. Hence, to exclude lots from the print preview results, un-select the lots in the *Check the Lots that you would like to print:* list.

For example, with the selections shown below,
The print preview results will include:
   The pay adjustment summary.
   The pay adjustment details for Material Version 1 --> Lot 1.

Once the desired selections are made, click the **Preview** button to preview the information for the selected options. The *Print preview* window will be displayed, as shown below.
MDT Quality Assurance System
Aggregate Surfacing Density

Contract ID: 07812
Project No.: STPP 54-1(5)0
Description: WYOMING LINK - NORTH

Bid Item: BASE-CEMENT TREATED (R)
Material Type: CEMENT TREATED BASE
Contract Quantity: 20625 Cu Yd

Specification Effective Date: 1/1/1995

<table>
<thead>
<tr>
<th>Lot No.</th>
<th>Lot Size</th>
<th>Reduction Value</th>
<th>Incentive Value</th>
<th>Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3750</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>3750</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>3750</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>3750</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>3750</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>3750</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Total Quantity: 26250 Cu Yd
Net Pay Adjustment: ($20,596.16)
(For this project item)

N/A indicates insufficient number of samples for lot pay adjustment calculations. (A Minimum of 3 samples are required to compute Pay Adjustments.)
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Aggregate Surfacing Density Print Selection window to close the window, completing the print preview operation.

To print the Plant Mix Density test data and/or evaluation results use the File->Print or the button on the toolbar. After selecting the print option, the Aggregate Surfacing Density Print Selection window will be displayed as shown below.

The Check the Lots that you would like to print: list provides a tree structure for locating and selecting the lots to include in the printed results. The tree structure is organized with the Material Version at the top level, and the Lot(s) for each material version at the bottom level.

(☑ ☑ Material Version #  
   ☑ Lot #  
   ☑ Non-QA Lot #)
Click on the plus sign \( \text{+} \) to expand a branch of the tree or the minus sign \( \text{-} \) to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Lot item on the tree to select or un-select the item.

There are two types of information that can be included in the printed results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected lots in the printed results. If no lots are selected, no pay adjustment details are included in the printed results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the printed results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot selections.

The **Select All** button can be used to select all of the lots displayed in the **Check the Lots that you would like to print:** list. The **Clear All** button un-selects all of the lots displayed in the **Check the Lots that you would like to print:** list.

All lots selected in the **Check the Lots that you would like to print:** list are included in the printed results. Hence, to exclude lots from the printed results, un-select the lots in the **Check the Lots that you would like to print:** list.

For example, with the selections shown below,
The printed results will include:
  The pay adjustment summary.
  The pay adjustment details for Material Version 1 --> Lot 1.

Once the desired selections are made, click the **Print** button to print the data (see **Printing**).

When done printing click on the **Cancel** button on the **Aggregate Surfacing Density Print Selection** window to close the window, completing the print operation.
13.3.4 Report Concrete Specs Tests
13.3.4.1 Report Concrete Specs Test Data
With the Concrete Specs test form selected, use the Preview or Print options to either preview or print the Concrete Specs test data and/or evaluation results (see Printing).

To preview the Concrete Specs test data and/or evaluation results in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Concrete Specs Print Selection window will be displayed as shown below.

The Check the Lots that you would like to print: list provides a tree structure for locating and selecting the lots to include in the print preview results. The tree structure is organized with the Material Version at the top level, and the Lot(s) for each material version at the bottom level.

(☑ Material Version #
  ☑ Lot #
  ☑ Non-QA Lot #)

Click on the plus sign ☐ to expand a branch of the tree or the minus sign ☐ to collapse a branch of the tree.
Items in the list with a check mark are selected. Click on the individual Lot item on the tree to select or un-select the item.

There are two types of information that can be included in the print preview results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print preview operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected lots in the print preview results. If no lots are selected, no pay adjustment details are included in the print preview results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the print preview results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot selections.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots that you would like to print:* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots that you would like to print:* list.

All lots selected in the *Check the Lots that you would like to print:* list are included in the print preview results. Hence, to exclude lots from the print preview results, un-select the lots in the *Check the Lots that you would like to print:* list.

For example, with the selections shown below,
The print preview results will include:
- The pay adjustment summary.
- The pay adjustment details for Material Version 1 --> Lot 1.

Once the desired selections are made, click the **Print Preview** button to preview the information for the selected options. The **Print preview** window will be displayed, as shown below.
MDT Quality Assurance System
Concrete Specs

Contract ID: 01414
Project No.: 08 22-3(12) 81  [79450120000]  English
Description: CULBERTSON-NORTH (MT-14)

Bid Item: SIDEWALK-CONCRETE 4 IN  Bid Item No: 6080010020
Material Type: CONCRETE-CLASS GENERAL
Contract Quantity: 60 Sq Yd  Specification Effective Date: 9/11/2014

Pay Adjustment Summary by Lot

<table>
<thead>
<tr>
<th>Lot No</th>
<th>Lot Size</th>
<th>Incentive Value</th>
<th>Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>2</td>
<td>25</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>3</td>
<td>6</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total</td>
<td>42 Sq Yd</td>
<td></td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Net Pay Adjustment: $0.00
(For this project item)
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Concrete Specs Print Selection window to close the window, completing the print preview operation.

To print the Concrete Specs test data and/or evaluation results use the File->Print or the button on the toolbar. After selecting the print option, the Concrete Specs Print Selection window will be displayed as shown below.

The Check the Lots that you would like to print: list provides a tree structure for locating and selecting the lots to include in the printed results. The tree structure is organized with the Material Version at the top level, and the Lot(s) for each material version at the bottom level.

(☑ Material Version #
   ☑ Lot #
   ☑ Non-QA Lot #)
Click on the plus sign ☰ to expand a branch of the tree or the minus sign ☯ to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Lot item on the tree to select or un-select the item.

There are two types of information that can be included in the printed results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected lots in the printed results. If no lots are selected, no pay adjustment details are included in the printed results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the printed results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot selections.

The **Select All** button can be used to select all of the lots displayed in the **Check the Lots that you would like to print:** list. The **Clear All** button un-selects all of the lots displayed in the **Check the Lots that you would like to print:** list.

All lots selected in the **Check the Lots that you would like to print:** list are included in the printed results. Hence, to exclude lots from the printed results, un-select the lots in the **Check the Lots that you would like to print:** list.

For example, with the selections shown below,
The printed results will include:
  The pay adjustment summary.
  The pay adjustment details for Material Version 1 --> Lot 1.

Once the desired selections are made, click the **Print** button to print the data (see **Printing**).

When done printing click on the **Cancel** button on the **Concrete Specs Print Selection** window to close the window, completing the print operation.
13.3.5 Report Daily Plant Mix Reports

13.3.5.1 Report Daily Plant Mix Report Test Data
Both the **Daily Plant Mix Reports** print preview and print options export the Daily Plant Mix Report data to an Excel workbook using a Daily Plant Mix Report workbook template.

With the **Daily Plant Mix Reports** test form selected, use the Print Preview option to create the workbook with the final workbook set to the Print Preview view mode in Excel or use the Print option to create and save the workbook for viewing, printing or sharing the Daily Plant Mix Report data.

To preview the Daily Plant Mix Reports test data in a "print preview" window before sending it to the printer use the **File->Print Preview** menu option or the button on the toolbar. After selecting the print preview option, the **Daily Plant Mix Report Print Selection** window will be displayed as shown below.

The **Check the Reports that you would like to print:** list provides a tree structure for locating and selecting the reports to include in the print preview results. The tree structure is organized with the Material Version at the top level, and the Report(s) for each material version at the bottom level.

(☑️ **Material Version #
☑️ Report # - MM/DD/YYYY)**
Click on the plus sign to expand a branch of the tree or the minus sign to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Report item on the tree to select or un-select the item.

All reports selected in the Check the Reports that you would like to print: list are included in the print preview results. Hence, to exclude reports from the print preview results, un-select the reports in the Check the Reports that you would like to print: list.

For example, with the selections shown below,

The print preview results will include the Daily Plant Mix Report test data for all of the Material Version 1 reports except Report 1 and Report 9.

Once the desired selections are made, click the Print Preview button to create the temporary workbook and preview the Daily Plant Mix Report information.

The temporary Excel workbook is created in the same folder as the QA Contract file and is named "CB-31_GYRATORY-MARSHALL1.xls".

A Preparing to Create Temporary Daily Plant Mix Report Excel Workbook window will be displayed, informing the user that a temporary Excel workbook will appear and to not interrupt the process of creating the temporary Excel workbook which can take several minutes.
Select the **OK** button to continue the process of creating the temporary Daily Plant Mix Report Excel workbook for previewing. A temporary Excel workbook is created from the Daily Plant Mix Report Excel workbook template and the program begins the process of exporting the Daily Plant Mix Report data to the Excel workbook.

Users should not interrupt the process of creating the Excel workbook. When the workbook creation process is done, the temporary workbook will be displayed in the Excel Print Preview view, as shown below.
Montana Department of Transportation

Plant Mix Report Form

Contract ID: 08405  Ml Item & Vers.: 401080000 - 1  Spec Effective Date: 2/15/2005
Project No: NH 8-4(1)(9)  [03377041003]  Report No: 12
Designation: US 287 PASS LN-S OF TOSTON  Date: 9/26/2006
Type of Mix: Grade S-Vo, Contract Tons: 28499 t
Type of Plant: Batch
Contractor: JIM GILMAN EXCAVATING INC.

Plant Data

<table>
<thead>
<tr>
<th>Time Start</th>
<th>9:45</th>
<th>Time Stop</th>
<th>16:30</th>
<th>Gross Time</th>
<th>8:45</th>
<th>Delay</th>
<th>0:30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Time</td>
<td>6:15</td>
<td>Average Hourly Production</td>
<td>24 t/hr</td>
<td>Tons per hour: 300 t/hr</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spot Checks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>10:15</td>
<td>11:05</td>
<td>12:30</td>
<td>13:45</td>
<td>15:15</td>
<td>16:00</td>
<td></td>
</tr>
<tr>
<td>Asphalt %</td>
<td>5.12</td>
<td>5.13</td>
<td>5.21</td>
<td>5.31</td>
<td>5.18</td>
<td>5.21</td>
<td></td>
</tr>
<tr>
<td>Bums</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hym. Lime %</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mx Discharge Temp</td>
<td>170</td>
<td>171</td>
<td>168</td>
<td>172</td>
<td>172</td>
<td>170</td>
<td></td>
</tr>
<tr>
<td>Avg Mx Discharge Temp</td>
<td>170</td>
<td>170</td>
<td>171</td>
<td>171</td>
<td>171</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viscosity Temperature Range: From</td>
<td>143</td>
<td>To</td>
<td>174</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Placement Summary (Report to the nearest thousandth)

<table>
<thead>
<tr>
<th>Course-Lift</th>
<th>Gross Tons Today</th>
<th>Waste Tons Today</th>
<th>Today</th>
<th>Previous</th>
<th>Net Tons Placed</th>
<th>To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadbed-1</td>
<td>18,359.630</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roadbed-2</td>
<td>9,687.560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approach-1</td>
<td>135.430</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approach-2-1</td>
<td>150.000</td>
<td>5.000</td>
<td>145.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Totals:</td>
<td>150.000</td>
<td>5.000</td>
<td>145.000</td>
<td></td>
<td>20,192.620</td>
<td>20,337.620</td>
</tr>
</tbody>
</table>

Gyratory Comparisons (Field averages at current job mix)

<table>
<thead>
<tr>
<th>Design</th>
<th>VMA</th>
<th>VFA</th>
<th>% Void</th>
<th>Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.459</td>
<td>90</td>
<td>3.7</td>
<td>2367</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>VMA</th>
<th>VFA</th>
<th>% Void</th>
<th>Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.452</td>
<td>71</td>
<td>4.5</td>
<td>2341</td>
<td></td>
</tr>
</tbody>
</table>

Bin Split Percentages

<table>
<thead>
<tr>
<th>Course</th>
<th>C. Fines</th>
<th>H. Fines</th>
<th>Blend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design</td>
<td>49.3</td>
<td>41.9</td>
<td>7.4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Current</th>
<th>49.4</th>
<th>42</th>
<th>7.4</th>
<th>1.4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydrated Lime Pay Tons</td>
<td>Today</td>
<td>Previous</td>
<td>To Date</td>
<td></td>
</tr>
<tr>
<td>2.320</td>
<td>277.582</td>
<td>278.902</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Date of last field testing avg: 5/26/2006

Asphalt & Additive Summary

<table>
<thead>
<tr>
<th>Tons Used (Report to the nearest thousandth)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asphalt</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>7.930</td>
</tr>
</tbody>
</table>

Hydrated Lime | Gross Today | Waste Today | Today | Previous | To Date | Percent of Mix | Today | Job Mix | Design |
| 2.630 | 0.068 | 2.562 | 777.582 | 780.124 | 1.75 | 1.4 | 1.4 |

2nd Additive

<table>
<thead>
<tr>
<th>Asphalt Type</th>
<th>64-29</th>
<th>Supplier: Montana refining Co.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydrated Lime Type</td>
<td>Hyd Lime</td>
<td>Supplier: Gravmont</td>
</tr>
</tbody>
</table>

2nd Additive Type | Supplier: |

Remarks

Inspector: RICHARDS, WILLIAM
Note: For help using the Excel Print Preview window to view and print information see the Microsoft Office Excel Help function.

When done previewing the Daily Plant Mix Reports, click on the Close button or red X button at the top right-hand corner of the window to close the Excel Print preview window. Excel will automatically close and the temporary Excel file will be deleted.

Next, click on the Cancel button on the Daily Plant Mix Report Print Selection window to close the window, completing the print preview operation.

To create and save the Daily Plant Mix Report Excel workbook use the File->Print or the button on the toolbar. After selecting the print option, the Daily Plant Mix Report Print Selection window will be displayed as shown below.

The Check the Reports that you would like to print: list provides a tree structure for locating and selecting the reports to include in the print preview results. The tree structure is organized with the Material Version at the top level, and the Report(s) for each material version at the bottom level.

(Material Version #
  Report # - MM/DD/YYYY)
Click on the plus sign + to expand a branch of the tree or the minus sign - to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Report item on the tree to select or un-select the item.

All reports selected in the Check the Reports that you would like to print: list are included in the Excel workbook that is created.

Generally it is best to include all of the reports in the Excel workbook. However, to exclude reports from the Excel workbook, un-select the reports in the Check the Reports that you would like to print: list.

For example, with the selections shown below,

The Excel workbook would include the Daily Plant Mix Report test data for all of the Material Version 1 reports except Report 1 and Report 9.

Once the desired selections are made, click the Print button to create the workbook and view, print or share the Daily Plant Mix Report information.

The Excel workbook is created and saved in the same folder as the QA Contract file and is named using the QA Contract file name at the start of the file, the mix type (ex., PMS-Grade-S-Vol for Grade S volumetric plant mix), and the text "Daily_Plan_t_Mix_Reports" included in the file name (ex., "09405COQAD001_PMS-Grade-S-Vol_Daily-Plant-Mix-Reports.xls").
A *Preparing to Create and Save Daily Plant Mix Report Excel Workbook* window will be displayed, informing the user that an Excel workbook will appear and to not interrupt the process of creating the Excel workbook which can take several minutes.

Select the **OK** button to continue the process of creating and saving the Daily Plant Mix Report Excel workbook for viewing, printing or sharing. An Excel workbook is created from the Daily Plant Mix Report Excel workbook template and the program begins the process of exporting the Daily Plant Mix Report data to the Excel workbook.

If the Excel file already exists it will automatically be overwritten by the new file with no user notification.

Users should not interrupt the process of creating the Excel workbook. When the workbook creation process is done, the workbook will be displayed in the Excel, as shown below.
### Montana Department of Transportation
#### Plant Mix Report Form

**Contract ID:** 09405  
**MIL Item & Ver.:** 401080000 - 1  
**Spec Effective Date:** 3/15/2005  
**Metric**  
**Project No.:** NH 8-44(1)93  
**Report No.:** 12  
**Date:** 5/26/2006  
**Designation:** US 287 P.S. LNS OF TOSTON  
**Weather Condition:** Partly Cloudy/Cloudy  
**Type of Mix:** Grade S Vol Contract Tons: 20499 t  
**Temperatures:** AM: 35 PM: 45  
**Plan Thickness:** 120 mm  
**No. of Lifts:** 2  
**Mix Design No. & Date:** 1 - 10/11/2005  
**Contractor:** JIM GILMAN EXCAVATING INC  
**Type of Plant:** Batch

#### Plant Data
- **Time Start:** 9:45  
- **Time Stop:** 16:30  
- **Gross Time:** 6:45  
- **Delay:** 0:30

- **Spot Time:** 10:15  
- **Burns:** 11:05  
- **Asphalt %:** 6.15  
- **Hyd. Lime %:** 6.21  
- **Waste %:** 5.31  
- **Net Hourly Production:** 5.18  
- **Tons per hour:** 5.21  
- **380 t/hr**

#### Mix Discharge Temp
- **Mix Discharge Temp:** 170  
- **Avg Mix Discharge Temp:** 170  
- **Viscosity Temperature Range:** From: 143  
- **To:** 174

#### Placement Summary
(Report to the nearest thousandth)

<table>
<thead>
<tr>
<th>Course-Lift</th>
<th>Gross Tons Today</th>
<th>Waste Tons Today</th>
<th>Net Tons Placed</th>
<th>Today</th>
<th>Previous</th>
<th>To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roadbed-1</td>
<td>10,359.630</td>
<td></td>
<td>10,359.630</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roadbed-2</td>
<td>9,897.560</td>
<td></td>
<td>9,897.560</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approach-1</td>
<td>135,430</td>
<td></td>
<td>135,430</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approach-2-1</td>
<td>150,000</td>
<td>5,000</td>
<td>145,000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Totals:</strong></td>
<td><strong>150,000</strong></td>
<td><strong>5,000</strong></td>
<td><strong>145,000</strong></td>
<td><strong>20,192,620</strong></td>
<td><strong>20,337,620</strong></td>
<td></td>
</tr>
</tbody>
</table>

#### Gyratory Comparisons
(Field averages at current job mix)

<table>
<thead>
<tr>
<th>VMA</th>
<th>VFA</th>
<th>% Void</th>
<th>Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.459</td>
<td>80</td>
<td>3.7</td>
<td>23.67</td>
</tr>
<tr>
<td>2.459</td>
<td>71</td>
<td>4.5</td>
<td>234.1</td>
</tr>
</tbody>
</table>

#### Bin Split Percentages

<table>
<thead>
<tr>
<th>Bin Split Percentages</th>
<th>Design</th>
<th>Coarse</th>
<th>C Fin</th>
<th>N Fin</th>
<th>Blend</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design</strong></td>
<td>49.3</td>
<td>41.9</td>
<td>7.4</td>
<td>1.4</td>
<td></td>
</tr>
<tr>
<td><strong>Current</strong></td>
<td>49</td>
<td>42</td>
<td>7.4</td>
<td>1.4</td>
<td></td>
</tr>
<tr>
<td><strong>Hydrated Lime Pay Tons</strong></td>
<td>Today</td>
<td>Previous</td>
<td>To Date</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.320</td>
<td>277,582</td>
<td>279,902</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Date of last field testing avg.

5/26/2006

#### Asphalt & Additive Summary

<table>
<thead>
<tr>
<th>Tons Used (Report to the nearest thousandth)</th>
<th>Percent of Mix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Today</td>
<td>Waste Today</td>
</tr>
<tr>
<td>Asphalt</td>
<td>7.930</td>
</tr>
<tr>
<td>Hydrated Lime</td>
<td>2.630</td>
</tr>
<tr>
<td>[2nd Additive Type]</td>
<td>64-28</td>
</tr>
<tr>
<td>[Hydrated Lime Type]</td>
<td>Hyd. Lime</td>
</tr>
<tr>
<td>[2nd Additive Type]</td>
<td>Supplier:</td>
</tr>
</tbody>
</table>
As shown above, each daily plant mix report is a separate sheet in the workbook. To select a different report click on the worksheet tab with the desired report number and date. For example, to view or print the daily plant mix report for November 16, 2005 select the tab labeled "Report #3 (11-16-2005)".

Note: For help using the Excel application to view and print information see the Microsoft Office Excel Help function.

The user can now proceed to view, print or share the Daily Plant Mix Reports data from the Excel workbook.

To print or preview the daily plant mix reports out of Excel choose the File --> Print... menu option or the button on the Excel toolbar.

The Excel Print dialog window will be displayed as shown below.

![Print dialog window]

The print or preview all of the daily plant mix report worksheets at one time, select the Entire workbook option in the "Print what" section, as shown below.
Click the **OK** button to print the daily plant mix report worksheets.  
Click the **Cancel** button to cancel the print process.  
Click the **Preview** button to preview the daily plant mix report worksheets.

When done viewing or printing the Daily Plant Mix Reports, click on the **File --> Close** menu option or red X button at the top right-hand corner of the window to close the workbook file. Select the **File --> Exit** menu option to close the Excel application.

Select the **Cancel** button on the **Daily Plant Mix Report Print Selection** window to close the window, completing the print operation.
13.3.6 Report Marshall Tests

13.3.6.1 Report Marshall Testing Test Data

With the Marshall Testing test form selected, use the Preview or Print options to either preview or print the Marshall Testing test data (see Printing).

To preview the Marshall Testing test data in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Marshall Tests Report Print Selection window will be displayed as shown below.

The Check the Sample Dates and/or Bricks that you would like to print: list provides a tree structure for locating and selecting the sample dates and/or bricks to include in the print preview results. The tree structure is organized with the Material Version at the top level, the Sample Date(s) for each material version at the second level, and the individual Brick(s) for each sample date at the bottom level.

Click on the plus sign to expand a branch of the tree or the minus sign to collapse a branch of the tree.
Items in the list with a check mark are selected. Click on the individual Sample Date or Brick item on the tree to select or un-select the item.

Selecting a Sample Date automatically selects all Bricks under that sample date.

Un-selecting a Sample Date automatically un-selects all Bricks under that sample date.

The **Select All** button can be used to select all of the sample dates and bricks displayed in the **Check the Sample Dates and/or Bricks that you would like to print:** list. The **Clear All** button un-selects all of the sample dates and bricks displayed in the **Check the Sample Dates and/or Bricks that you would like to print:** list.

All sample dates and bricks selected in the **Check the Sample Dates and/or Bricks that you would like to print:** list are included in the print preview results. Hence, to exclude sample dates and/or bricks from the print preview results, un-select the sample dates and/or bricks in the **Check the Sample Dates and/or Bricks that you would like to print:** list.

The Series Average is calculated for all selected bricks with the same sample date.

If a sample date is selected then all bricks with that sample date will be included in the results and in the series average calculation.

To exclude bricks from the series average calculation, un-select the sample date and select only those bricks under the sample date that should be included in the series average.

For example, with the selections shown below,
The print preview results will include:

Test data and averages for Material Version 1 --> 7/5/2005 sample date --> Bricks 12, 13 and 14.

Once the desired selections are made, click the Preview button to preview the information for the selected options. The Print preview window will be displayed, as shown below.
MDT Quality Assurance System
Marshall Tests

Contract ID: 03903
Project No.: IN 15-1(74)122 [04197074000] Metric
Description: ROCK SCALING SITE

Bid Item: Item Number: 401040000
Material Type: PLANT MIX OR D - COMMERCIAL TESTED
Contract Quantity: 4375 t

Specification Effective Date: 1/1/1995
Asphalt Grade: 70-28
Material Version: 1

Refinery: M.R.C.
Pit Lab No.: 045623
Sample Date: 6/28/2005
Daily Plant Mix Report No.: 2

<table>
<thead>
<tr>
<th>BRICK NUMBER</th>
<th>2</th>
<th>2A</th>
<th>4</th>
<th>4A</th>
</tr>
</thead>
<tbody>
<tr>
<td>STATION</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>% ASPHALT</td>
<td>6.90</td>
<td>6.90</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEMP. MOLDED</td>
<td>143</td>
<td>143</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RICE/ACTUAL</td>
<td>2.375</td>
<td>2.375</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIME</td>
<td>12:55</td>
<td>16:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#4 MESH</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTER</td>
<td>SHOW, MARK</td>
<td>SHOW, MARK</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WT. IN AIR (A)</td>
<td>1290.6</td>
<td>1294.1</td>
<td>1229.0</td>
<td>1228.0</td>
</tr>
<tr>
<td>WT. SURF. DRY (B)</td>
<td>1291.2</td>
<td>1294.7</td>
<td>1204.2</td>
<td>1229.2</td>
</tr>
<tr>
<td>WT. IN WATER (C)</td>
<td>747.3</td>
<td>747.6</td>
<td>697.4</td>
<td>698.6</td>
</tr>
<tr>
<td>DISPLACEMENT (B-C)</td>
<td>540.9</td>
<td>547.1</td>
<td>516.8</td>
<td>530.6</td>
</tr>
<tr>
<td>DENSITY D=A/(B-C)</td>
<td>2.373</td>
<td>2.365</td>
<td>2.376</td>
<td>2.314</td>
</tr>
<tr>
<td>% Voids = (R-D)/R</td>
<td>0.0</td>
<td>0.3</td>
<td>0.0</td>
<td>2.6</td>
</tr>
<tr>
<td>CORR. RATIO</td>
<td>0.93</td>
<td>0.89</td>
<td>1.00</td>
<td>0.96</td>
</tr>
<tr>
<td>RING READING</td>
<td>225</td>
<td>230</td>
<td>176</td>
<td>178</td>
</tr>
<tr>
<td>STABILITY GRAPH</td>
<td>3130</td>
<td>3189</td>
<td>2430</td>
<td>2466</td>
</tr>
<tr>
<td>CORRECTED STAB.</td>
<td>2902</td>
<td>2838</td>
<td>2438</td>
<td>2367</td>
</tr>
<tr>
<td>FLOW</td>
<td>17</td>
<td>18</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>APPEARANCE</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Bricks 2,2A</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bricks 4,4A</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Series Average

| DENSITY | 2.357 | 1357.0 kg/m3 |
| % Voids | 0.7   |     |
| CORRECT STAB. | 2536 |     |
| FLOW    | 16    |     |

Comments:
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Marshall Tests Report Print Selection window to close the window, completing the print preview operation.

To print the Marshall Testing test data use the File->Print or the button on the toolbar. After selecting the print option, the Marshall Tests Report Print Selection window will be displayed as shown below.

The Check the Sample Dates and/or Bricks that you would like to print: list provides a tree structure for locating and selecting the sample dates and/or bricks to include in the printed results. The tree structure is organized with the Material Version at the top level, the Sample Date(s) for each material version at the second level, and the individual Brick(s) for each sample date at the bottom level.

(Material Version #)
  (MM/DD/YYYY Bricks)
    (Brick #)

The v is used to indicate selection and the x to unselect.
Click on the plus sign + to expand a branch of the tree or the minus sign − to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Sample Date or Brick item on the tree to select or un-select the item.

Selecting a Sample Date automatically selects all Bricks under that sample date.

Un-selecting a Sample Date automatically un-selects all Bricks under that sample date.

The Select All button can be used to select all of the sample dates and bricks displayed in the Check the Sample Dates and/or Bricks that you would like to print: list. The Clear All button un-selects all of the sample dates and bricks displayed in the Check the Sample Dates and/or Bricks that you would like to print: list.

All sample dates and bricks selected in the Check the Sample Dates and/or Bricks that you would like to print: list are included in the printed results. Hence, to exclude sample dates and/or bricks from the printed results, un-select the sample dates and/or bricks in the Check the Sample Dates and/or Bricks that you would like to print: list.

The Series Average is calculated for all selected bricks with the same sample date.

If a sample date is selected then all bricks with that sample date will be included in the results and in the series average calculation.

To exclude bricks from the series average calculation, un-select the sample date and select only those bricks under the sample date that should be included in the series average.

For example, with the selections shown below,
The printed results will include:


Once the desired selections are made, click the **Print** button to print the data (see **Printing**).

When done printing click on the **Cancel** button on the **Marshall Tests Report Print Selection** window to close the window, completing the print operation.
13.3.7 Report Plant Mix Density Tests

13.3.7.1 Report Plant Mix Density Test Data

With the Plant Mix Density test form selected, use the Preview or Print options to either preview or print the Plant Mix Density test data and/or evaluation results (see Printing).

To preview the Plant Mix Density test data and/or evaluation results in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Plant Mix Density Print Selection window will be displayed as shown below.

The Check the Lots that you would like to print: list provides a tree structure for locating and selecting the lots to include in the print preview results. The tree structure is organized with the Material Version at the top level, and the Lot(s) for each material version at the bottom level.

(✔️ Material Version #
- Lot #
- Non-QA Lot #)

Click on the plus sign 📦 to expand a branch of the tree or the minus sign 📦 to collapse a branch of the tree.
Items in the list with a check mark are selected. Click on the individual Lot item on the tree to select or un-select the item.

There are two types of information that can be included in the print preview results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print preview operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected lots in the print preview results. If no lots are selected, no pay adjustment details are included in the print preview results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the print preview results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot selections.

The **Select All** button can be used to select all of the lots displayed in the **Check the Lots that you would like to print:** list. The **Clear All** button un-selects all of the lots displayed in the **Check the Lots that you would like to print:** list.

All lots selected in the **Check the Lots that you would like to print:** list are included in the print preview results. Hence, to exclude lots from the print preview results, un-select the lots in the **Check the Lots that you would like to print:** list.

For example, with the selections shown below,
The print preview results will include:
- The pay adjustment summary.
- The pay adjustment details for Material Version 1 --> Lot 1.

Once the desired selections are made, click the Preview button to preview the information for the selected options. The Print preview window will be displayed, as shown below.
Working With Test Data

MDT Quality Assurance System
Plant Mix Density

Contract ID: 09405
Project No.: NH 8-4(41)93  [03377041000]  Metric
Description: US 287 PASS LN-S OF TOSTON

Bid Item: PLANT MIX BIT SURF GR S - 19 MM  Item Number: 401080000
Material Type: PLANT MIX BIT SURF GR S - 19 MM  Specification Effective Date: 6/1/2004
Contract Quantity: 20499 t

Pay Adjustment Summary by Lot

<table>
<thead>
<tr>
<th>Mtl Ver</th>
<th>Lot No.</th>
<th>Lot Size</th>
<th>Deduction Value</th>
<th>Incentive Value</th>
<th>Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>3000</td>
<td>$0.00</td>
<td>$2,512.50</td>
<td>$2,512.50</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3000</td>
<td>$0.00</td>
<td>$2,512.50</td>
<td>$2,512.50</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>3000</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>3000</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>3000</td>
<td>$0.00</td>
<td>$2,512.50</td>
<td>$2,512.50</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>3000</td>
<td>$0.00</td>
<td>$2,512.50</td>
<td>$2,512.50</td>
</tr>
<tr>
<td>1</td>
<td>7</td>
<td>2193</td>
<td>$0.00</td>
<td>$1,836.64</td>
<td>$1,836.64</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>3000</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>3000</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Total Quantity: 26193 t  Net Pay Adjustment: $11,886.64
(For this project item)

N/A indicates insufficient number of samples for lot pay adjustment calculations.
(A Minimum of 3 samples are required to compute Pay Adjustments.)
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Plant Mix Density Print Selection window to close the window, completing the print preview operation.

To print the Plant Mix Density test data and/or evaluation results use the File->Print or the button on the toolbar. After selecting the print option, the Plant Mix Density Print Selection window will be displayed as shown below.

The Check the Lots that you would like to print: list provides a tree structure for locating and selecting the lots to include in the printed results. The tree structure is organized with the Material Version at the top level, and the Lot(s) for each material version at the bottom level.

( ☑ Material Version #
  ☑ Lot #
  ☑ Non-QA Lot #)
Click on the plus sign to expand a branch of the tree or the minus sign to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Lot item on the tree to select or un-select the item.

There are two types of information that can be included in the printed results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected lots in the printed results. If no lots are selected, no pay adjustment details are included in the printed results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the printed results. Because the pay adjustment summary is a summary for all lots, all lots are included in the pay summary results regardless of lot selections.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots that you would like to print:* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots that you would like to print:* list.

All lots selected in the *Check the Lots that you would like to print:* list are included in the printed results. Hence, to exclude lots from the printed results, un-select the lots in the *Check the Lots that you would like to print:* list.

For example, with the selections shown below,
The printed results will include:
The pay adjustment summary.
The pay adjustment details for Material Version 1 --> Lot 1.

Once the desired selections are made, click the **Print** button to print the data (see Printing).

When done printing click on the **Cancel** button on the *Plant Mix Density Print Selection* window to close the window, completing the print operation.
13.3.8 Report Ride Specification Tests

13.3.8.1 Report Ride Specification Test Data
With the *Ride Specification* test form selected, use the Preview or Print options to either preview or print the Ride Specification test data and/or evaluation results (see Printing).

To preview the Ride Specification test data and/or evaluation results in a "print preview" window before sending it to the printer use the *File -> Print Preview* menu option or the button on the toolbar. After selecting the print preview option, the *Print Selection* window will be displayed as shown below.

```
Bid Item: PLANT MIX BIT SURF GR 5 - 19 MM
Material: PLANT MIX BIT SURF GR 5 - 19 MM

Check the Test Runs that you would like to print:

[ ] Material Version 1
  [ ] Test Run - SB Slow
  [ ] Test Run - SB Driving
  [ ] Test Run - NB Slow
  [ ] Test Run - NB Driving

[ ] Print Preview
[ ] Select All
[ ] Clear All
[ ] Cancel

[ ] Pay Adjustment Details
[ ] Pay Adjustment Summary
```

The *Check the Test Runs that you would like to print:* list provides a tree structure for locating and selecting the test runs to include in the print preview results. The tree structure is organized with the Material Version at the top level, and the Test Run(s) for each material version at the bottom level.

( [ ] Material Version #
    [ ] Test Run - #######)

Click on the plus sign to expand a branch of the tree or the minus sign to collapse a branch of the tree.

Items in the list with a check mark are selected. Click on the individual Test Run item on the tree to select or un-select the item.
There are two types of information that can be included in the print preview results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print preview operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected test runs in the print preview results. If no test runs are selected, no pay adjustment details are included in the print preview results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the print preview results. Because the pay adjustment summary is a summary for all test runs, all test runs are included in the pay summary results regardless of test run selections.

The **Select All** button can be used to select all of the test runs displayed in the **Check the Test Runs that you would like to print** list. The **Clear All** button un-selects all of the test runs displayed in the **Check the Test Runs that you would like to print** list.

All test runs selected in the **Check the Test Runs that you would like to print** list are included in the print preview results. Hence, to exclude test runs from the print preview results, un-select the test runs in the **Check the Test Runs that you would like to print** list.

For example, with the selections shown below,

```
The print preview results will include:
- The pay adjustment summary.
- The pay adjustment details for Material Version 1 --> Test Run - SB Slow.
```
Once the desired selections are made, click the **Preview** button to preview the information for the selected options. The *Print preview* window will be displayed, as shown below.
MDT Quality Assurance System
Ride Specification Report

Contract ID: 09405
Project No.: NM 8-4(41)93 [03377341000]
Description: US 297 PASS LN-S OF TOSTON

Bid Item: PLANT MIX BIT SURF GR S – 19 MM
Material Type: PLANT MIX BIT SURF GR S – 19 MM
Contract Quantity: 20499 t

Specify Effective Date: 8/9/2006

Pay Adjustment Summary by Test Run

<table>
<thead>
<tr>
<th>Mtl Ver</th>
<th>Test Run</th>
<th>No. Runs</th>
<th>Deduction Value</th>
<th>Incentive Value</th>
<th>Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SB Slow</td>
<td>5</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>SB Driving</td>
<td>14</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>1</td>
<td>NB Slow</td>
<td>5</td>
<td>($99.29)</td>
<td>$0.00</td>
<td>($99.29)</td>
</tr>
<tr>
<td>1</td>
<td>NB Driving</td>
<td>14</td>
<td>($1,874.15)</td>
<td>$0.00</td>
<td>($1,874.15)</td>
</tr>
</tbody>
</table>

Total No. Runs: 18
Net Pay Adjustment: ($1,973.44)

Not All Density Tests Have Been Entered
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Print Selection window to close the window, completing the print preview operation.

To print the Ride Specification test data and/or evaluation results use the File->Print or the button on the toolbar. After selecting the print option, the Print Selection window will be displayed as shown below.

The Check the Test Runs that you would like to print: list provides a tree structure for locating and selecting the test runs to include in the printed results. The tree structure is organized with the Material Version at the top level, and the Test Run(s) for each material version at the bottom level.

( □ Material Version #
  □ Test Run - ####### )

Click on the plus sign to expand a branch of the tree or the minus sign to collapse a branch of the tree.
Items in the list with a check mark are selected. Click on the individual Test Run item on the tree to select or un-select the item.

There are two types of information that can be included in the printed results (Pay Adjustment Details, and/or Pay Adjustment Summary). At least one of the options must be selected in order to perform the print operation.

Select the **Pay Adjustment Details** option to include the pay adjustment details for selected test runs in the printed results. If no test runs are selected, no pay adjustment details are included in the printed results.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information in the printed results. Because the pay adjustment summary is a summary for all test runs, all test runs are included in the pay summary results regardless of test run selections.

The **Select All** button can be used to select all of the test runs displayed in the **Check the Test Runs that you would like to print:** list. The **Clear All** button un-selects all of the test runs displayed in the **Check the Test Runs that you would like to print:** list.

All test runs selected in the **Check the Test Runs that you would like to print:** list are included in the printed results. Hence, to exclude test runs from the printed results, un-select the test runs in the **Check the Test Runs that you would like to print:** list.

For example, with the selections shown below,

![Print Selection](image)

The printed results will include:

- The pay adjustment summary.
The pay adjustment details for Material Version 1 --> Test Run - SB Slow.

Once the desired selections are made, click the **Print** button to print the data (see **Printing**).

When done printing click on the **Cancel** button on the **Print Selection** window to close the window, completing the print operation.
13.3.9 Report Volumetric Tests

13.3.9.1 Report Volumetric Test Data
With the *Volumetrics* test form selected, use the Preview or Print options to either preview or print any or all of the Volumetric information (see Printing).

To preview any or all of the Volumetric information in a "print preview" window before sending it to the printer use the *File->Print Preview* menu option or the button on the toolbar. After selecting the print preview option, the *Volumetrics Print Selection* window will be displayed as shown below.

To preview an individual Volumetric item, select only the options that pertain to that item before selecting the *Preview* button.

For help with previewing the lot evaluations details information see the *Report_Volumetric_Lot_Evaluation_Details* topic.
For help with previewing the pay adjustment summary information see the Report_Volumetric_Pay_Adjustment_Summary topic.

For help with previewing the Gmm rolling average information see the Report_Volumetric_Gmm_Rolling_Average topic.

For help with previewing the gyratory data form information see the Report_Volumetric_Gyratory_Data topic.

For help with previewing the control graph information see the Report_Volumetric_Control_Graphs topic.

Alternatively, all of the Volumetric information items can be previewed at one time by selecting all of the options for all of the items before selecting the Preview button, as shown below.
For help with the options for each item see the topic for that item, as shown above.

To print any or all of the Volumetric information use the File->Print or the button on the toolbar. After selecting the print option, the **Volumetrics Print Selection** window will be displayed as shown below.

![Volumetrics Print Selection Window](image)

To print an individual Volumetric item, select only the options that pertain to that item before selecting the **Print** button.

For help with printing the lot evaluations details information see the [Report_Volumetric_Lot_Evaluation_Details](#) topic.

For help with printing the pay adjustment summary information see the [Report_Volumetric_Pay_Adjustment_Summary](#) topic.
For help with printing the Gmm rolling average information see the Report_Volumetric_Gmm_Rolling_Average topic.

For help with printing the gyratory data form information see the Report_Volumetric_Gyratory_Data topic.

For help with printing the control graph information see the Report_Volumetric_Control_Graphs topic.

Alternatively, all of the Volumetric information items can be printed at one time by selecting all of the options for all of the items before selecting the Print button, as shown below.

For help with the options for each item see the topic for that item, as shown above.
13.3.9.2 Report Volumetric Lot Evaluation Details

With the Volumetrics test form selected, use the Preview or Print options to either preview or print the Lot Evaluation Details (see Printing).

To preview the lot evaluation details in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Volumetrics Print Selection window will be displayed as shown below.

To preview the lot evaluation details, select the Include Evaluation Details option in the Lot Evaluation Details panel as shown above.

Select the Pay Adjustment Summary option to include the pay adjustment summary information with the lot evaluation details.
Initially, all samples not excluded from QA and incentive calculations are displayed in the *Check the Lots to be Detailed* list. Select the **Include samples marked for exclusion from QA** option to include all lots in the list.

All lots selected in the *Check the Lots to be Detailed* list are included in the lot evaluation details. Hence, to exclude lots from the lot evaluation details, un-select the lots in the *Check the Lots to be Detailed* list.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots to be Detailed* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots to be Detailed* list.

Once the desired selections are made, click the **Preview** button to preview the lot evaluation details. The **Print preview** window will be displayed, as shown below.

### MDT Quality Assurance System

#### Volumetrics Report

**Contract ID:** 09405  
**Project No.:** NH 8-4 (41) 93  
**Description:** US 287 PASS LN-S OF TOSTOW  
**Bid Item:** PLANT MIX BIT SURF GR S - 19 MM  
**Material Type:** PLANT MIX BIT SURF GR S - 19 MM  
**Contract Quantity:** 20499 t  
**Specify Effective Date:** 2/15/2005  
**Item Number:** 401080000

#### Pay Adjustment Results Details for Material Version 1 - Lot 1

<table>
<thead>
<tr>
<th>Test No.</th>
<th>Voids</th>
<th>VMA</th>
<th>VF1</th>
<th>D/A</th>
<th>Rice</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.0</td>
<td>14.4</td>
<td>81</td>
<td>0.8</td>
<td>2.449</td>
</tr>
<tr>
<td>2</td>
<td>2.5</td>
<td>15.1</td>
<td>83</td>
<td>1.0</td>
<td>2.418</td>
</tr>
<tr>
<td>3</td>
<td>2.1</td>
<td>13.8</td>
<td>85</td>
<td>0.9</td>
<td>2.444</td>
</tr>
<tr>
<td>4</td>
<td>4.7</td>
<td>15.4</td>
<td>70</td>
<td>0.9</td>
<td>2.458</td>
</tr>
<tr>
<td>5</td>
<td>3.0</td>
<td>14.3</td>
<td>79</td>
<td>1.0</td>
<td>2.442</td>
</tr>
</tbody>
</table>

| Xn | 3.0 | 14.6 | 80 | 0.9 | N/A |
| R  | 2.6 | 1.6  | 15 | 0.2 | N/A |
| P  | 1.55 | -0.43 | -0.10 | 0.00 | N/A |
| Inc| 1.5 | 2.0  | 2.0 | 2.0 | N/A |

| Total F Value | 1.6 |
| Total Lot Deduction | $0.00 |
| Percent Incentive | 11.5% |
| Total Lot Incentive | $9,611.25 |
| Net Lot Pay Adjustment | $9,611.25 |
| Modified Lot Pay Adjustment | $0.00 |

(Adjustment Reason - TVB - Test of Payment Modification)

**Adjustment CP Categories**

- **Silver Bow County:** $0.00
- **Deer Lodge County:** $0.00
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Volumetrics Print Selection window to close the window, completing the print preview operation.

To print the lot evaluation details use the File->Print or the button on the toolbar. After selecting the print option, the Volumetrics Print Selection window will be displayed as shown below.
To print the lot evaluation details, select the **Include Evaluation Details** option in the *Lot Evaluation Details* panel as shown above.

Select the **Pay Adjustment Summary** option to include the pay adjustment summary information with the lot evaluation details.

Initially, all samples not excluded from QA and incentive calculations are displayed in the *Check the Lots to be Detailed* list. Select the **Include samples marked for exclusion from QA** option to include all lots in the list.

All lots selected in the *Check the Lots to be Detailed* list are included in the lot evaluation details. Hence, to exclude lots from the lot evaluation details, un-select the lots in the *Check the Lots to be Detailed* list.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots to be Detailed* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots to be Detailed* list.

Once the desired selections are made, click the **Print** button to print the data (see **Printing**).

When done printing click on the **Cancel** button on the *Volumetrics Print Selection* window to close the window, completing the print operation.
13.3.9.3 Report Volumetric Pay Adjustment Summary
With the Volumetrics test form selected, use the Preview or Print options to either preview or print the Pay Adjustment Summary (see Printing).

To preview the pay adjustment summary in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Volumetrics Print Selection window will be displayed as shown below.

To preview the pay adjustment summary, select the Pay Adjustment Summary option.

Next, click the Preview button to preview the pay adjustment summary. The Print preview window will be displayed, as shown below.
## MDT Quality Assurance System
### Volumetrics Report

**Contract ID:** 09405  
**Project No.:** NH 8-4(41) 93  
**Description:** US 297 PASS LN-S OF TOSTON  
**Bid Item:** PLANT MIX BIT SURF GR S - 19 MM  
**Material Type:** PLANT MIX BIT SURF GR S - 19 MM  
**Contract Quantity:** 20499 t  
**Item Number:** 4010860000  
**Specification Effective Date:** 2/15/2005

### Pay Adjustment Summary by Lot

<table>
<thead>
<tr>
<th>Lot No.</th>
<th>Lot Size</th>
<th>Deduction Value</th>
<th>Incentive Value</th>
<th>Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5000</td>
<td>$0.00</td>
<td>$9,631.25</td>
<td>$0.00**</td>
</tr>
<tr>
<td>1</td>
<td>5000</td>
<td>$0.00</td>
<td>$10,050.00</td>
<td>$10,050.00</td>
</tr>
<tr>
<td>1</td>
<td>193</td>
<td>$0.00</td>
<td>$10,437.93</td>
<td>$10,437.93</td>
</tr>
<tr>
<td>2</td>
<td>5000</td>
<td>$0.00</td>
<td>$9,715.00</td>
<td>$9,715.00</td>
</tr>
</tbody>
</table>

**Total QA Quantity:** 30193 t  
**Total Non-QA Quantity:** 10000 t  
**Total Quantity:** 30193 t

Double asterisk (**) indicates modified pay adjustment for lot.
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Volumetrics Print Selection window to close the window, completing the print preview operation.

To print the pay adjustment summary use the File->Print or the button on the toolbar. After selecting the print option, the Volumetrics Print Selection window will be displayed as shown below.

To print the pay adjustment summary, select the Pay Adjustment Summary option.
Next, click the Print button to print the data (see Printing).

When done printing click on the Cancel button on the Volumetrics Print Selection window to close the window, completing the print operation.
13.3.9.4 Report Volumetric Gmm Rolling Average
With the Volumetrics test form selected, use the Preview or Print options to either preview or print the Gmm Rolling Average information (see Printing).

To preview the Gmm rolling average information in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Volumetrics Print Selection window will be displayed as shown below.

![Volumetrics Print Selection Window]

To preview the Gmm rolling average information, select the Gmm Rolling Average option in the Gmm Rolling Average panel as shown above.

All material versions selected in the Check Mtl Version to Average list are included in the Gmm rolling average information. Hence, to exclude material versions from the Gmm rolling average information, un-select the material version in the Check Mtl Version to Average list.
Once the desired selections are made, click the **Preview** button to preview the graphs. The *Print preview* window will be displayed, as shown below.
## MDT Quality Assurance System
### Volumetrics Report

**Contract ID:** 09405  
**Project No.:** NH 8-4(41)93  
**Description:** US 297 PASS LN-S OF TOSTON  
**Bid Item:** PLANT MIX BIT SURF GR S = 19 MM  
**Material Type:** PLANT MIX BIT SURF GR S = 19 MM  
**Contract Quantity:** 20499 t  
**Item Number:** 401080000  
**Metric:**  
**Specification Effective Date:** 2/15/2005  

### Gmm Rolling Average for Material Version 1

<table>
<thead>
<tr>
<th>Lot Number</th>
<th>Sample Number</th>
<th>Sample Date</th>
<th>Time Sampled</th>
<th>Gmm</th>
<th>Average</th>
<th>Target</th>
<th>Exclude</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>5</td>
<td>10/12/2005</td>
<td>13:15</td>
<td>2.452</td>
<td>N/A</td>
<td>2.459</td>
<td>False</td>
</tr>
<tr>
<td>A</td>
<td>4</td>
<td>11/11/2005</td>
<td>16:05</td>
<td>2.464</td>
<td>2.462</td>
<td>2.450</td>
<td>False</td>
</tr>
<tr>
<td>A</td>
<td>5</td>
<td>11/12/2005</td>
<td>10:35</td>
<td>2.434</td>
<td>2.449</td>
<td>2.450</td>
<td>False</td>
</tr>
<tr>
<td>B</td>
<td>7</td>
<td>11/12/2005</td>
<td>13:55</td>
<td>2.455</td>
<td>2.449</td>
<td>2.450</td>
<td>False</td>
</tr>
<tr>
<td>B</td>
<td>9</td>
<td>11/16/2005</td>
<td>11:10</td>
<td>2.439</td>
<td>2.446</td>
<td>2.450</td>
<td>False</td>
</tr>
<tr>
<td>B</td>
<td>9</td>
<td>11/16/2005</td>
<td>12:55</td>
<td>2.438</td>
<td>2.442</td>
<td>2.450</td>
<td>False</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>11/17/2005</td>
<td>08:00</td>
<td>2.414</td>
<td>2.437</td>
<td>2.437</td>
<td>False</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>11/17/2005</td>
<td>12:35</td>
<td>2.449</td>
<td>2.455</td>
<td>2.457</td>
<td>False</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>5/15/2006</td>
<td>15:10</td>
<td>2.418</td>
<td>2.430</td>
<td>2.437</td>
<td>False</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5/15/2006</td>
<td>15:50</td>
<td>2.444</td>
<td>2.431</td>
<td>2.437</td>
<td>False</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>5/16/2006</td>
<td>10:05</td>
<td>2.458</td>
<td>2.442</td>
<td>2.437</td>
<td>False</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>5/16/2006</td>
<td>14:20</td>
<td>2.442</td>
<td>2.441</td>
<td>2.437</td>
<td>False</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>5/10/2006</td>
<td>10:40</td>
<td>2.442</td>
<td>2.447</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>5/18/2006</td>
<td>14:40</td>
<td>2.448</td>
<td>2.448</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>5/18/2006</td>
<td>17:05</td>
<td>2.445</td>
<td>2.444</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>2</td>
<td>9</td>
<td>5/22/2006</td>
<td>11:30</td>
<td>2.438</td>
<td>2.443</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>5/22/2006</td>
<td>14:30</td>
<td>2.445</td>
<td>2.444</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>11</td>
<td>5/22/2006</td>
<td>15:35</td>
<td>2.444</td>
<td>2.443</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>12</td>
<td>5/23/2006</td>
<td>12:35</td>
<td>2.446</td>
<td>2.443</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>13</td>
<td>5/23/2006</td>
<td>16:10</td>
<td>2.453</td>
<td>2.447</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>5/24/2006</td>
<td>10:00</td>
<td>2.438</td>
<td>2.445</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>15</td>
<td>5/24/2006</td>
<td>11:15</td>
<td>2.453</td>
<td>2.448</td>
<td>2.447</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>16</td>
<td>5/24/2006</td>
<td>12:40</td>
<td>2.454</td>
<td>2.450</td>
<td>2.447</td>
<td>False</td>
</tr>
</tbody>
</table>

* - Rolling Average out of range of +/- 0.5 lbs  
^ - Target set by user
Note: For help using the Print preview window to view and print information see Print Preview Operations.

When done previewing the printed output, click on the Close button to close the Print preview window.

Next, click on the Cancel button on the Volumetrics Print Selection window to close the window, completing the print preview operation.

To print the Gmm rolling average information use the File->Print or the button on the toolbar. After selecting the print option, the Volumetrics Print Selection window will be displayed as shown below.
To print the Gmm rolling average information, select the **Gmm Rolling Average** option in the *Gmm Rolling Average* panel as shown above.

All material versions selected in the *Check Mtl Version to Average* list are included in the Gmm rolling average information. Hence, to exclude material versions from the Gmm rolling average information, un-select the material version in the *Check Mtl Version to Average* list.

Once the desired selections are made, click the **Print** button to print the data (see Printing).

When done printing click on the **Cancel** button on the *Volumetrics Print Selection* window to close the window, completing the print operation.
13.3.9.5 Report Volumetric Gyratory Data

The *Gyratory Data Form* option exports the Volumetric Gyratory data to a Word document using a Gyratory Data Entry Form template.

With the *Volumetrics* test form selected, use the Preview option to create the document with the final document set to the Print Preview view mode in Word or use the Print option to create and save the document for viewing, printing or sharing the Gyratory data.

To preview the gyratory data in a "print preview" window before sending it to the printer use the *File->Print Preview* menu option or the [ ] button on the toolbar. After selecting the print preview option, the *Volumetrics Print Selection* window will be displayed as shown below.

![Volumetrics Print Selection](image)

To preview the gyratory data, select the *Gyratory Data Form* option in the *Gyratory Data Form* panel as shown above.
If the **Blank Form** option is checked, the lot information is ignored and a blank form is previewed.

Initially, all samples not excluded from QA and incentive calculations are displayed in the *Check the Lots to be Detailed* list. Select the **Include samples marked for exclusion from QA** option to include all lots in the list.

All lots selected in the *Check the Lots for the Forms* list are included in the lot evaluation details. Hence, to exclude lots from the lot evaluation details, un-select the lots in the *Check the Lots for the Forms* list.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots for the Forms* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots for the Forms* list.

Once the desired selections are made, click the **Preview** button to create the temporary document and preview the gyratory data forms.

The temporary Word document is created in the same folder as the QA Contract file and is named using the QA Contract file name at the start of the file, the mix type (ex., PMS-Grade-S for Grade S plant mix), and the text "Vol_Gyratory-Data-Form" included in the file name (ex., "09405COQAD001_PMS-Grade-S_Vol-Gyratory-Data-Form.doc").

A **Preparing to Create Word Document** window will be displayed, informing the user that a Word document will appear and to not interrupt the process of creating the Word document which can take several minutes.

Select the **OK** button to continue the process of creating the Word Gyratory Data forms document for previewing. A temporary Word document is created from the Gyratory Data Form template and the program begins the process of exporting the gyratory data to the Word document, as shown below.
Users should not interrupt the process of creating the Word document. When the document creation process is done, the temporary document will be displayed in the Word Print Preview view, as shown below.
**GYRATORY DATA ENTRY FORM**

Form No. F408 Q:\R-TD\F408.doc

<table>
<thead>
<tr>
<th>Project Number:</th>
<th>NH 8-414193</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date:</td>
<td>3/15/2006</td>
</tr>
<tr>
<td>Project Name:</td>
<td>US 277 PASS LN S OF TOSTON</td>
</tr>
<tr>
<td>Operator:</td>
<td>MCCRAY, ARLIN</td>
</tr>
<tr>
<td>Mix Design No.:</td>
<td>604313</td>
</tr>
<tr>
<td>Mix Design Date:</td>
<td>10/4/2002</td>
</tr>
<tr>
<td>Bin %:</td>
<td>Coarse 49.3</td>
</tr>
<tr>
<td></td>
<td>Intermediate 7.4</td>
</tr>
<tr>
<td></td>
<td>Fine 41.9</td>
</tr>
<tr>
<td>Hid Line:</td>
<td>1.4</td>
</tr>
<tr>
<td>Bulk Gravity:</td>
<td>Coarse 2.637</td>
</tr>
<tr>
<td></td>
<td>Intermediate 2.604</td>
</tr>
<tr>
<td></td>
<td>Fine 2.625</td>
</tr>
<tr>
<td>Source of AC:</td>
<td>M.R.C.</td>
</tr>
<tr>
<td>Grade of AC:</td>
<td>P.G. 64.28</td>
</tr>
<tr>
<td>Gravity of AC:</td>
<td>1038</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot # - Sample Tag(s)</td>
<td>1 - 5657</td>
<td>1 - 6998</td>
<td>1 - 7395</td>
</tr>
<tr>
<td>Sample No.</td>
<td>1</td>
<td>1A AVG</td>
<td>2</td>
</tr>
<tr>
<td>% AC Corrected Burn</td>
<td>5.57</td>
<td>5.44</td>
<td>5.37</td>
</tr>
<tr>
<td>% AC spot check (optional):</td>
<td>12.35</td>
<td>15.10</td>
<td>15.50</td>
</tr>
<tr>
<td>Plant Temperature</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Time Sampled</td>
<td>12:35</td>
<td>13:10</td>
<td>13:50</td>
</tr>
<tr>
<td>Temperature tested</td>
<td>12:55</td>
<td>12:20</td>
<td>16:10</td>
</tr>
<tr>
<td>Time Tested</td>
<td>12:55</td>
<td>12:20</td>
<td>16:10</td>
</tr>
<tr>
<td>Minus 2000 (burn MT)</td>
<td>4.2</td>
<td>5.3</td>
<td>5.1</td>
</tr>
<tr>
<td>Mass Before Compaction</td>
<td>4675.0</td>
<td>4675.0</td>
<td>4675.0</td>
</tr>
<tr>
<td>Height Int. (Hd)</td>
<td>114.2</td>
<td>114.1</td>
<td>114.2</td>
</tr>
<tr>
<td>Height Des. (Hd)</td>
<td>114.2</td>
<td>114.1</td>
<td>114.2</td>
</tr>
<tr>
<td>wt. In Air (a)</td>
<td>4664.0</td>
<td>4666.3</td>
<td>4666.2</td>
</tr>
<tr>
<td>wt. In Water (c)</td>
<td>2707.4</td>
<td>2711.0</td>
<td>2709.2</td>
</tr>
<tr>
<td>SSD Wt. In Air (b)</td>
<td>4667.9</td>
<td>4669.9</td>
<td>4668.9</td>
</tr>
<tr>
<td>Gravities:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rice (Gmm.)</td>
<td>2.449</td>
<td>2.418</td>
<td>2.444</td>
</tr>
<tr>
<td>Design Bulk (Gmb) =</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Densities:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Des. % Den. =</td>
<td>97.2</td>
<td>97.5</td>
<td>97.9</td>
</tr>
<tr>
<td>Voids:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Des. Voids (Ya) = 100 - (Gmb*(Gmm**100)</td>
<td>2.86</td>
<td>2.74</td>
<td>2.8</td>
</tr>
<tr>
<td>Rolling Average:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMA = 100 - (Gmb% Agg) / blend bulk gravity</td>
<td>14.45</td>
<td>14.34</td>
<td>14.4</td>
</tr>
<tr>
<td>FFA = 100 - (CMA - Ya) / MFA * 100</td>
<td>80.2</td>
<td>80.9</td>
<td>81</td>
</tr>
<tr>
<td>Dust Ratio =</td>
<td>0.8</td>
<td>1.0</td>
<td>0.9</td>
</tr>
</tbody>
</table>

**Notes:**

Constr. File: ______________

Form No. F408 Q:\R-TD\F408.doc
Note: For help using the Word Print Preview window to view and print information see the Microsoft Office Word Help function.

When done previewing the gyratory data forms, click on the red X button at the top right-hand corner of the window to close the Word Print preview window. Then close Word.

To create and save the gyratory data forms document use the File->Print or the button on the toolbar. After selecting the print option, the Volumetrics Print Selection window will be displayed as shown below.

To create and save the gyratory data forms document, select the Gyratory Data Form option in the Gyratory Data Form panel as shown above.

If the Blank Form option is checked, the lot information is ignored and a blank form is printed.
Initially, all samples not excluded from QA and incentive calculations are displayed in the Check the Lots to be Detailed list. Select the Include samples marked for exclusion from QA option to include all lots in the list.

All lots selected in the Check the Lots for the Forms list are included in the lot evaluation details. Hence, to exclude lots from the lot evaluation details, un-select the lots in the Check the Lots for the Forms list.

The Select All button can be used to select all of the lots displayed in the Check the Lots for the Forms list. The Clear All button un-selects all of the lots displayed in the Check the Lots for the Forms list.

Once the desired selections are made, click the Print button to create and save the Gyratory Data Forms document for viewing, printing or sharing.

The Word document is created and saved in the same folder as the QA Contract file and is named using the QA Contract file name at the start of the file, the mix type (ex., PMS-Grade-S for Grade S plant mix), and the text "Vol_Gyratory-Data-Form" included in the file name (ex., "09405COQAD001_PMS-Grade-S_Vol-Gyratory-Data-Form.doc").

A Preparing to Create Word Document window will be displayed, informing the user that a Word document will appear and to not interrupt the process of creating the Word document which can take several minutes.

Select the OK button to continue the process of creating the Word Gyratory Data forms document for printing. A Word document is created from the Gyratory Data Form template and the program begins the process of exporting the gyratory data to the Word document, as shown below.
Users should not interrupt the process of creating the Word document. When the document creation process is done, the document will be displayed in Word, as shown below.
GYRATORY DATA ENTRY FORM

<table>
<thead>
<tr>
<th>Date</th>
<th>Lot # - Sample Tonnage</th>
<th>Sample No.</th>
<th>% AC Corrected Burn</th>
<th>% AC spot check (optional)</th>
<th>Plant Temperature</th>
<th>Time Sampled</th>
<th>Temperature-tested</th>
<th>Time Tested</th>
<th>Minus 200m (burn MT DP)</th>
<th>Mass Before Compaction</th>
<th>Height Inv. (ft)</th>
<th>Height Des. (ft)</th>
<th>Wt. In Air (a)</th>
<th>Wt. In Water (c)</th>
<th>SSD Wt. In Air (b)</th>
<th>Gravities</th>
<th>Densities</th>
<th>Voids</th>
<th>Rolling Average</th>
<th>Dust Ratio</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/17/2005</td>
<td>1 - 5657</td>
<td>1</td>
<td>5.57</td>
<td>0.00</td>
<td>12.35</td>
<td>143.0</td>
<td>12:55</td>
<td>16:10</td>
<td>4675.0</td>
<td>4675.0</td>
<td>114.2</td>
<td>114.2</td>
<td>4664.0</td>
<td>2707.4</td>
<td>4667.9</td>
<td>2.449</td>
<td>2.379</td>
<td>97.2</td>
<td>2.86</td>
<td>0.8</td>
<td></td>
</tr>
<tr>
<td>5/15/2006</td>
<td>1 - 6998</td>
<td>1A</td>
<td>5.44</td>
<td>0.00</td>
<td>12:10</td>
<td>143.0</td>
<td>12:20</td>
<td>16:10</td>
<td>4675.0</td>
<td>4675.0</td>
<td>114.1</td>
<td>114.2</td>
<td>4664.6</td>
<td>2711.0</td>
<td>4666.9</td>
<td>2.419</td>
<td>2.382</td>
<td>97.5</td>
<td>2.74</td>
<td>2.8</td>
<td></td>
</tr>
<tr>
<td>5/15/2006</td>
<td>1 - 7395</td>
<td>2</td>
<td>5.3</td>
<td>0.00</td>
<td>15:50</td>
<td>143.0</td>
<td>12:20</td>
<td>16:10</td>
<td>4675.0</td>
<td>4675.0</td>
<td>114.2</td>
<td>114.2</td>
<td>4664.6</td>
<td>2709.2</td>
<td>4668.9</td>
<td>2.444</td>
<td>2.365</td>
<td>97.9</td>
<td>2.81</td>
<td>2.4</td>
<td></td>
</tr>
</tbody>
</table>

Gravities:
- <0.5 mm: 2.449
- 0.5-1.0 mm: 2.419
- >1.0 mm: 2.444

Densities:
- Des. % Den. = (Des. Bulk/Smq/mm) * 100
- Voids: Des. Voids (Va) = 100 - Gravities(mm) / 100
- Rolling Average:
  - VMA = 100 - (VMA/Smq/mm) * 100
  - VFA = 100 - (VMA/Smq/mm) * 100
  - Dust Ratio = (0.1% % AC Burn)

Notes: [Blank]

Form No. F4000 Q:\MT-STD\F400.doc
The user can now proceed to view, print or share the Volumetric Gyratory data from the Word document.
13.3.9.6 Report Volumetric Control Graphs

With the Volumetrics test form selected, use the Preview or Print options to either preview or print the Control Graphs (see Printing).

To preview the graphs in a "print preview" window before sending it to the printer use the File->Print Preview menu option or the button on the toolbar. After selecting the print preview option, the Volumetrics Print Selection window will be displayed as shown below.

![Volumetrics Print Selection Window]

To preview the control graphs, select the Graphs option in the Control Graphs panel as shown above.

Initially, all samples not excluded from QA and incentive calculations are displayed in the Check the Lots to be Graphed list. Select the Include samples marked for exclusion from QA option to include all lots in the list.
All lots selected in the *Check the Lots to be Graphed* list are included in the control graphs. Hence, to exclude lots from the control graphs, un-select the lots in the *Check the Lots to be Graphed* list.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots to be Graphed* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots to be Graphed* list.

Once the desired selections are made, click the **Preview** button to preview the graphs. The *Print preview* window will be displayed, as shown below.
Note: For help using the Print preview window to view and print information see Print Preview Operations.
When done previewing the printed output, click on the **Close** button to close the **Print preview** window.

Next, click on the **Cancel** button on the **Volumetrics Print Selection** window to close the window, completing the print preview operation.

To print the graphs use the **File->Print** or the button on the toolbar. After selecting the print option, the **Volumetrics Print Selection** window will be displayed as shown below.

To print the control graphs, select the **Graphs** option in the **Control Graphs** panel as shown above.

Initially, all samples not excluded from QA and incentive calculations are displayed in the **Check the Lots to be Graphed** list. Select the **Include samples marked for exclusion from QA** option to include all lots in the list.
All lots selected in the *Check the Lots to be Graphed* list are included in the control graphs. Hence, to exclude lots from the control graphs, un-select the lots in the *Check the Lots to be Graphed* list.

The **Select All** button can be used to select all of the lots displayed in the *Check the Lots to be Graphed* list. The **Clear All** button un-selects all of the lots displayed in the *Check the Lots to be Graphed* list.

Once the desired selections are made, click the **Print** button to print the data (see **Printing**).

When done printing click on the **Cancel** button on the *Volumetrics Print Selection* window to close the window, completing the print operation.
13.3.9.7 View Volumetric Control Graphs

During the course of a project, there is significant benefit in being able to analyze the Volumetric control parameters graphically. These graphs are referred to as Control Graphs.

The **Control Graphs** option provides a quick and easy mechanism to view the graphs of each analysis.

To access the Volumetrics control graphs, the Volumetrics test form must be open (see Opening A Test Form) and it must be the selected form (see Selecting A Form).

With the Volumetrics test form selected, choose the **Control Graphs** option under the **View** menu option as shown below.

![Control Graphs option highlighted in the menu]

This will activate the **Volumetric Control Graphs** window as shown below.
The samples are divided into lots on the graphs with the vertical dotted lines.

Control graphs are provided for all of the Volumetric results parameters (% Voids, VMA, VFA, Dust/Asphalt Ratio, Gmm, AC Corrected Burn and AC Spot Check).

Initially, the % Voids control graph tab is displayed. To view the control graph for any of the other parameters simply click on the tab for the desired parameter. For example, to view the control graph for the VMA, click on the VMA tab, as shown below.
The Select All button can be used to select all of the lots displayed in the available lots list. The Clear All button un-selects all of the lots displayed in the available lots list.

Initially, all samples not excluded from QA and incentive calculations are displayed in the list of available lots. Select the Include samples marked for exclusion from QA option to include all lots in the list of available lots and in the control graphs, as shown below.
All lots selected in the list of available lots are included in the control graphs. Hence, to remove valid lots from the control graphs, un-select the lots in the list of valid lots provided. For example, un-selecting Lot 1 removes it from the control graphs, as shown below.
For help with previewing or printing Control Graphs see the Report Volumetric Control Graphs topic.
13.3.9.8 Export Volumetric Results To Excel

Volumetric target values can be adjusted by the contractor throughout the course of the project, but the final target values are not set until the end of the project.

In order to change the QA Volumetric target values in the QA Suite, the Volumetric Test item for the Plant Mix Material item must be unlocked, the targets changed, and the Volumetric Test item must then be re-locked by a different user. These operations can only be performed by users with the privileges to Unlock Specifications, Add/Edit Specification and Lock Specifications which generally are an EPM, Field Office Person or Lab Supervisor. There is a need for an easier way for users to be able to analyze the results of proposed changes to target values.

Contractors do not have access to the MDT QA Suite, nor the QA Suite data. There is a need to be able to share the Volumetrics results with the contractor.

The **Export To Excel** option exports the Volumetric results (%Voids, VMF, VFA, D/A Ratio, Gmm, AC Corrected Burn and AC Spot Check) to an Excel workbook.

The Excel workbook is designed to allow for analysis of effects of changes to Target Values on Pay Adjustment calculation results without being able to change the actual data. Sheets in the Excel file are password protected but Proposed Target Values can be modified for each Material Version.

The Excel file can be given to contractors so that they can evaluate the effects of changing Targets on Pay Adjustment calculations. This provides contractors with essentially the same capability as with the MDT Volumetrics program (they were allowed to install the MDT Volumetrics software and were given a copy of the MDT Volumetrics file so that they could see the affects of changing targets).

To export the Volumetric data to Excel, the Volumetrics test form must be open (see [Opening A Test Form](#)) and it must be the selected form (see [Selecting A Form](#)).

With the Volumetrics test form selected, choose the **Export To Excel** option under the **File** menu option as shown below.
This will activate the Export to Excel window as shown below.

Initially, all samples not excluded from QA and incentive calculations are displayed in the list of available lots. Select the Include samples marked for exclusion from QA option to include all lots in the list of available lots.

All lots selected in the list of available lots are exported to the Excel workbook. Hence, to exclude lots from the Excel workbook, un-select the lots in the list of lots provided.

The Select All button can be used to select all of the lots displayed in the available lots list. The Clear All button un-selects all of the lots displayed in the available lots list.

Once the desired options are selected, click the OK button to export the data to an Excel workbook.
Working With Test Data

The Excel workbook file is created in the same folder as the QA Contract file and is named using the QA Contract file name at the start of the file, the mix type (ex., PMS for Grade S plant mix), and the text "Volumetric-Data-Export" included in the file name (ex., "09405COQAD001_PMS_Volumetric-Data-Export.xls").

If the Excel file already exists, a **File Exists** window will be displayed, prompting the user to overwrite the file, change the file name for the file to be created as, or cancel, as shown below.

Selecting **Yes** continues the export process, overwriting the existing file. Selecting **Cancel** cancels the export process. Selecting **No** loads a **Select File Name and Destination** window, prompting for the file name as shown below.
Enter the desired file name in the *File name:* text box and select the **Save** button to continue. Selecting the **Cancel** button cancels the export process.

A *Preparing to Create Excel Workbook* window will be displayed, informing the user to wait and not interrupt the Excel workbook creation process, as shown below.

Select the **OK** button to continue with the export to Excel process.

When the export to Excel process is done, the newly created Excel file will be opened. When the Excel file opens, the user will be prompted with the Excel Security Warning window, prompting the user to select whether or not to enable macros, as shown below.

Click on the **Enable Macros** button to complete the Excel file open process.

The Excel application window will be displayed with the newly created Excel file open, as shown below.
The user can now proceed to view the Volumetric results and analyze the effects of modifying the Volumetric targets (see Using Excel Volumetric Results Workbook).
13.3.9.9 Using Volumetric Results Excel Workbook

The volumetric results Excel workbook is designed to allow for analysis of effects of changes to Target Values on Pay Adjustment calculation results without being able to change the actual data. The sheets in the Excel file are password protected but Proposed Target Values can be modified for each Material Version.

The Excel file can be given to contractors so that they can evaluate the effects of changing Targets on Pay Adjustment calculations. This provides contractors with essentially the same capability as with the MDT Volumetrics program (they were allowed to install the MDT Volumetrics software and were given a copy of the MDT Volumetrics file so that they could see the affects of changing targets).

To help with organizing and analyzing results, the volumetric results Excel workbook has multiple sheets, as shown below.

The Excel workbook consists of five different types of sheets as follows:
- A pay adjustment summary worksheet (one per workbook)
  - One per workbook
  - Named "Pay-Adjustment-Summary"
• Contains the pay adjustment summary information for all lots included in the workbook

• Volumetric data worksheets
  • One for each Material Version
  • Named "MV #_Volumetric-Data"; where # is the Material Version number
  • Contains the volumetric data for Lots in the Material Version

• Control graphs worksheets
  • One for each Material Version
  • Named "MV #_Control-Graphs"; where # is the Material Version number
  • Contains the control graphs for the Material Version volumetric results

• Target values worksheets
  • One for each Material Version
  • Named "MV #_Target-Values"; where # is the Material Version number
  • Contains the target values for the Material Version volumetric results

• Lot evaluation results worksheets (one for each lot (Non-QA or QA) in the Material Version)
  • One for each Lot in the Material Version
  • Named "MV #_Lot ###_Eval Results";
    where # is the Material Version number and ## is the QA Lot number or Non-QA Lot letter
  • Contains the lot data and evaluation results

The workbook sheets are organized as follows:
1. "Pay-Adjustment-Summary" sheet
2. Material Version 1 sheets: (one set for each Material Version)
   i. "MV 1_Volumetric-Data" sheet
   ii. "MV 1_Control-Graphs" sheet
   iii. "MV 1_Target-Values" sheet
   iv. Material Version 1 Lot evaluation results sheets:
     a. Non-QA Lots (one for each Non-QA Lot)
        i. "MV 1-Lot A-Eval Results"
        ii. "MV 1-Lot B-Eval Results"
        iii. etc.
     b. QA Lots (one for each QA Lot)
        i. "MV 1-Lot 1-Eval Results"
        ii. "MV 1-Lot 2-Eval Results"
        iii. "MV 1-Lot 3-Eval Results"
        iv. etc.
3. Material Version 2 sheets: (one set for each Material Version)
   i. "MV 2_Volumetric-Data" sheet
   ii. "MV 2_Control-Graphs" sheet
   iii. "MV 2_Target-Values" sheet
   iv. Material Version 2 Lot evaluation results sheets:
     a. QA Lots (one for each QA Lot)
        i. "MV 2-Lot 1-Eval Results"
The user can iteratively update the proposed target values for Volumetric parameters and view the pay adjustment summary to determine the impact of the proposed target values on the pay adjustment results.

The process for viewing and/or setting the volumetric target values for a material version is as follows:

1. Select the target values sheet for the material version (for example, "MV 1_Target-Values" sheet)

2. Select the cell in the Proposed Target row under the desired Volumetric Parameter column. For example, to change the proposed target for the VMA, select the cell under the VMA parameter column in the Proposed Target row, as shown below.
3. Enter a new Proposed Target value to be used for the lot evaluations. The Evaluation Target value will automatically be updated to the Proposed Target value, but not outside of the Allowable Target Range.

For example, to change the VMA proposed target value to 16.0, enter 16.0 in the VMA proposed target cell and tab out of the cell, as shown below.
The proposed target value for the Volumetric parameter is evaluated against the Allowable Target Range for the parameter.

- If the proposed target value is within the allowable target range, the Evaluation Target value for the parameter is set equal to the Proposed Target value.
- If the proposed target value is less than the minimum allowable target value, the Evaluation Target value is set equal to the minimum Allowable Target Range value.
- If the proposed target value is greater than the maximum allowable target value, the Evaluation Target value is set equal to the maximum Allowable Target Range value.

4. Since the lot evaluation results calculations are based on the Evaluation Target values, the evaluation results for all lots in the material version are automatically recalculated when Evaluation Target values change, as shown below.
5. Since the pay adjustment summary calculations are based on the lot evaluation results, the pay adjustment summary results are automatically recalculated when Evaluation Target values change, as shown below.
<table>
<thead>
<tr>
<th>Mtl Ver</th>
<th>Lot No.</th>
<th>Lot Size</th>
<th>Deduction Value</th>
<th>Incentive Value</th>
<th>Pay Adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>5000</td>
<td>($7,968.25)</td>
<td>$4,808.25</td>
<td>($3,140.00)</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>5000</td>
<td>($6,532.50)</td>
<td>$8,375.00</td>
<td>$1,842.50</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5193</td>
<td>($6,810.69)</td>
<td>$9,898.28</td>
<td>$2,087.59</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>5000</td>
<td>$0.00</td>
<td>$9,715.00</td>
<td>$9,715.00</td>
</tr>
</tbody>
</table>

Total QA Quantity: 20,193 t  
Net Pay Adjustment: $10,295.09

Total Non-QA Quantity: 10,000 t  
(For this project item)

Total Quantity: 30,193 t
6. The control graphs for the Material Version are also automatically updated to show the modified job mix range bands resulting from the Evaluation Target values change, as shown below.
Working With Test Data
13.4 Locking Test Data

13.4.1 Locking Test Data

Once all test data has been entered and the test values have been reviewed and verified and the pay adjustment evaluation results have been reviewed for a test item (brick, lot, report, run), the test item should be locked to prevent further editing and to designate the completion of the test data entry and evaluation of results for the test item.

In fact, in some instances test items must be locked in order for evaluations of other test items to be completed. For example, because the Ride Specification evaluation is tied to the Plant Mix Density Test Results, all Plant Mix Density test lots must be locked and the Plant Mix Density test results evaluations for the project must be marked as completed before the Ride Specification evaluations can be completed and the test runs can be locked.

The basic process for locking test items is as follows:

1. Open the test form (see Opening A Test Form).
2. Select the test item (brick, lot, report or run)
3. Lock the test item (brick, lot, report or run)
   a. For test items that include Pay Adjustment Evaluations (Aggregates, Concrete Specs, Plant Mix Density, Ride Specification or Volumetrics)
      i. Select the Show Pay Adjustments For This Lot or Show Pay Adjustments For This Test Run button on the form to open the associated evaluation results form.
      ii. Select the Lock button on the evaluation results form.
      iii. Select the OK button on the evaluation results form to complete the locking process.
   b. For test items that do not include Pay Adjustment Evaluations (Daily Plant Mix Report or Marshall)
      i. Select the Lock button on the test form.

The basic process for marking test results evaluations as complete for Plant Mix Density tests is as follows:

1. Lock all of the Plant Mix Density test lots for a material version using the steps outlined above.
2. Select the last Plant Mix Density Test lot for the material version.
3. Select the Show Pay Adjustments For This Lot button on the form to open the associated evaluation results form.
4. Select the All Density Test Entered button on the test form and select the OK button on the test form to complete the process.
5. Repeat these steps for all Plant Mix Density material versions.

NOTE: Before the Ride Specification results evaluations can be completed and the Ride Specification test runs can be locked, all Plant Mix Density test lots must be locked and
marked as all density tests being entered for all material versions (per the processes discussed above).
13.4.2 Lock Aggregate Gradations

13.4.2.1 Lock Aggregate Gradations Test Data
Once all test data has been entered and the test values have been reviewed and verified and the pay adjustment evaluation results have been reviewed for an Aggregate Gradation lot, the lot should be locked to prevent further editing and to designate the completion of the test data entry and evaluation of results for the lot.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Aggregate Gradations test data lots the **Aggregate Testing** test form must be opened and selected (see Selecting A Form).

When the **Aggregate Testing** test data form is opened and selected it looks like the one below:

![Aggregate Testing Form]

The basic procedure for locking Aggregate Gradations lots is:
1. Open the **Aggregate Testing** test form (see Opening A Test Form).
2. Select the Aggregate Gradations lot for the desired material item and material version (see Selecting A Form).
3. Open the pay adjustments results form for the current lot, (select the **Show Pay Adjustment Results For This Lot** button - see [Open the pay adjustments results form](#)).
4. Lock the lot (select the **Lock** button - see [Lock the Aggregate lot](#)).
5. Close the pay adjustment results form.
6. Select another lot and lock the lot.
7. Continue selecting and locking lots until all Aggregate Gradations test data lots have been locked for all material versions of the material item.

To open the pay adjustments results form, press the **Show Pay Adjustment Results For This Lot** button at the top of the *Aggregate Testing* form, as shown below.

![Aggregate Testing Form](image)

The **Aggregate Results for:** form is displayed with the **Aggregate Results** tab selected.

To lock the Aggregate Gradation test lot select the **Lock** button on the **Aggregate Results for:** form, as shown below.
The **Lock** button is replaced with a "Locked" label and the **OK** and **Cancel** buttons are displayed, as shown below.
Click the **OK** button to complete the locking process. Click the **Cancel** button to cancel the locking process.

After selecting the **OK** button the **Aggregate Results for:** form will close, returning to the **Aggregate Testing** test form where the material item, material version, Aggregate Gradations Lot test item is now locked (the locked status indicator is displayed on the **Aggregate Testing** user interface and the test data items are disabled and cannot be edited), as shown below.
13.4.3 Lock Aggregate Surfacing Density Tests

13.4.3.1 Lock Aggregate Surfacing Density Test Data

Once all test data has been entered and the test values have been reviewed and verified and the pay adjustment evaluation results have been reviewed for an Aggregate Surfacing Density lot, the lot should be locked to prevent further editing and to designate the completion of the test data entry and evaluation of results for the lot.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Aggregate Surfacing Density test data lots the Aggregate Surfacing Density test form must be opened and selected (see Selecting A Form).

When the Aggregate Surfacing Density test data form is opened and selected it looks like the one below:

The basic procedure for locking Aggregate Surfacing Density lots is:
1. Open the Aggregate Surfacing Density test form (see Opening A Test Form).
2. Select the Aggregate Surfacing Density lot for the desired material item and material version (see Selecting A Form).
3. Open the pay adjustments results form for the current lot, (select the Show Pay Adjustment Results For This Lot button - see Open the pay adjustments results form).
4. Lock the lot (select the Lock button - see Lock the Aggregate Surfacing Density Lot).
5. Close the pay adjustment results form.
6. Select another lot and lock the lot.
7. Continue selecting and locking lots until all Aggregate Surfacing Density test data lots have been locked for all material versions of the material item.
To open the pay adjustments results form, press the **Show Pay Adjustment Results For This Lot** button at the top of the **Aggregate Surfacing Density** form, as shown below.

The **Aggregate Surfacing Density Pay Adjustment Data For:** form is displayed.

To lock the Aggregate Surfacing Density test lot select the **Lock** button on the **Aggregate Surfacing Density Pay Adjustment Data For:** form.

The **Lock** button is replaced with a "Locked" label and the **OK** and **Cancel** buttons are displayed, as shown below.
Click the **OK** button to complete the locking process. Click the **Cancel** button to cancel the locking process.

After selecting the **OK** button the **Aggregate Surfacing Density Pay Adjustment Data For:** form will close, returning to the **Aggregate Surfacing Density** test form where the material item, material version, Aggregate Surfacing Density Lot test item is now locked (the locked status indicator is displayed on the **Aggregate Surfacing Density** user interface and the test data items are disabled and cannot be edited), as shown below.
13.4.4 Lock Concrete Specs Tests

13.4.4.1 Lock Concrete Specs Test Data
Once all test data has been entered and the test values have been reviewed and verified and the pay adjustment evaluation results have been reviewed for a Concrete Specs lot, the lot should be locked to prevent further editing and to designate the completion of the test data entry and evaluation of results for the lot.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Concrete Specs test data lots, the Concrete Specs test form must be opened and selected (see Selecting A Form).

When the Concrete Specs test data form is opened and selected, it looks like the one below:

![Concrete Specs Test Form]

The basic procedure for locking Concrete Specs lots is:

1. Open the Concrete Specs test form (see Opening A Test Form).
2. Select the Concrete Specs lot for the desired material item and material version (see Selecting A Form).
3. Open the pay adjustments results form for the current lot, (select the Show Pay Adjustment Results For This Lot button - see Open_the_pay_adjustments_results_form).
4. Lock the lot (select the **Lock** button - see *Lock the Concrete Specs lot*).
5. Close the pay adjustment results form.
6. Select another lot and lock the lot.
7. Continue selecting and locking lots until all Concrete Specs test data lots have been locked for all material versions of the material item.

To open the pay adjustments results form, press the **Show Pay Adjustment Results For This Lot** button at the top of the *Concrete Specs* form, as shown below.

The *Concrete Specs Results for:* form is displayed.

To lock the Concrete Specs test lot, select the **Lock** button on the *Concrete Specs Results for:* form.
The Lock button is replaced with a "Locked" label and the OK and Cancel buttons are displayed, as shown below.
Click the **OK** button to complete the locking process. Click the **Cancel** button to cancel the locking process.

After selecting the **OK** button, the *Concrete Specs Results for:* form will close, returning to the *Concrete Specs* test form where the material item, material version, and Concrete Specs Lot test item is now locked (the locked status indicator is displayed on the *Concrete Specs* user interface and the test data items are disabled and cannot be edited), as shown below.
Working With Test Data
13.4.5 Lock Daily Plant Mix Reports

13.4.5.1 Lock Daily Plant Mix Report Test Data

Once all test data has been entered and the test values have been reviewed and verified for an Daily Plant Mix Report, the report should be locked to prevent further editing and to designate the completion of the test data entry for the report.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Daily Plant Mix Report test data reports the *Daily Plant Mix Reports* test form must be opened and selected (see Selecting A Form).

When the *Daily Plant Mix Reports* test data form is opened and selected it looks like the one below:

![Daily Plant Mix Reports Form](image)

The basic procedure for locking Daily Plant Mix Report test reports is:

1. Open the *Daily Plant Mix Reports* test form (see Opening A Test Form).
2. Select the Daily Plant Mix Report test report for the desired material item and material version (see Selecting A Form).
3. Lock the test report (select the Lock button - see Lock_the_Daily_Plant_Mix_Report_test_report).
4. Select another test report and lock the test report.
5. Continue selecting and locking test reports until all Daily Plant Mix Report test data test reports have been locked for all material versions of the material item.

To lock the Daily Plant Mix Report test report select the Lock button on the *Daily Plant Mix Reports* form.
The Lock button disappears and a "Locked" label is displayed next to the Report Number label, as shown below.

After selecting the Lock button the material item, material version, Daily Plant Mix Report Test Report test item is now locked (the locked status indicator is displayed on the Daily Plant Mix
Report user interface and the test data items are disabled and cannot be edited), as shown above.
13.4.6 Lock Marshall Tests

13.4.6.1 Lock Marshall Testing Test Data

Once all test data has been entered and the test values have been reviewed and verified for an Marshall Testing brick, the brick should be locked to prevent further editing and to designate the completion of the test data entry for the brick.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Marshall Testing test data brick the Marshall Testing test form must be opened and selected (see Selecting A Form).

When the Marshall Testing test data form is opened and selected it looks like the one below:

The basic procedure for locking Marshall Testing test bricks is:
1. Open the Marshall Testing test form (see Opening A Test Form).
2. Select the Marshall Testing test brick for the desired material item and material version (see Selecting A Form).
3. Lock the test brick (select the Lock button - see Lock_the_Marshall_Testing_test_brick).
4. Select another test brick and lock the test brick.
5. Continue selecting and locking test bricks until all Marshall Testing test data test bricks have been locked for all material versions of the material item.

To lock the Marshall Testing test brick select the Lock button on the Marshall Testing form.
The **Lock** button disappears and a "Locked" label is displayed next to the *Brick Number* label, as shown below.

After selecting the **Lock** button the material item, material version, Marshall Testing test item is now locked (the locked status indicator is displayed on the *Marshall Testing* user interface and the test data items are disabled and cannot be edited), as shown above.
13.4.7 Lock Plant Mix Density Tests

13.4.7.1 Lock Plant Mix Density Test Data
Once all test data has been entered and the test values have been reviewed and verified and the pay adjustment evaluation results have been reviewed for an Plant Mix Density lot, the lot should be locked to prevent further editing and to designate the completion of the test data entry and evaluation of results for the lot.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Plant Mix Density test data lots the **Plant Mix Density** test form must be opened and selected (see Selecting A Form).

When the **Plant Mix Density** test data form is opened and selected it looks like the one below:

The basic procedure for locking Plant Mix Density lots is:
1. Open the **Plant Mix Density** test form (see Opening A Test Form).
2. Select the Plant Mix Density lot for the desired material item and material version (see Selecting A Form).
3. Open the pay adjustments results form for the current lot, (select the **Show Pay Adjustment Results For This Lot** button - see Open_the_pay_adjustments_results_form).
4. Lock the lot (select the **Lock** button - see Lock_the_Plant_Mix_Density_lot).
5. Close the pay adjustment results form.
6. Select another lot and lock the lot.
7. Continue selecting and locking lots until all Plant Mix Density test data lots have been locked for all material versions of the material item.
To open the pay adjustments results form, press the **Show Pay Adjustment Results For This Lot** button at the top of the **Plant Mix Density** form, as shown below.

The **Plant Mix Density Pay Adjustment Data For:** form is displayed.

To lock the Plant Mix Density test lot select the **Lock** button on the **Plant Mix Density Pay Adjustment Data For:** form.

The **Lock** button is replaced with a "Locked" label and the **OK** and **Cancel** buttons are displayed, as shown below.
Click the **OK** button to complete the locking process. Click the **Cancel** button to cancel the locking process.

After selecting the **OK** button the *Plant Mix Density Pay Adjustment Data For:* form will close, returning to the *Plant Mix Density* test form where the material item, material version, Plant Mix Density Lot test item is now locked (the locked status indicator is displayed on the *Plant Mix Density* user interface and the test data items are disabled and cannot be edited), as shown below.
13.4.8 Lock Ride Specification Tests

13.4.8.1 Lock Ride Specification Test Data
Once all test data has been entered and the test values have been reviewed and verified and the pay adjustment evaluation results have been reviewed for an Ride Specification test run, the test run should be locked to prevent further editing and to designate the completion of the test data entry and evaluation of results for the test run.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Ride Specification test data lots the Ride Specification test form must be opened and selected (see Selecting A Form).

When the Ride Specification test data form is opened and selected it looks like the one below:

![Ride Specification Test Form](image)

The basic procedure for locking Ride Specification test runs is:
1. Open the Ride Specification test form (see Opening A Test Form).
2. Select the Ride Specification test run for the desired material item and material version (see Selecting A Form).
3. Open the pay adjustments results form for the current test run, (select the Show Pay Adjustment Results For This Test Run button - see Open_the_pay_adjustments_results_form).
4. Lock the test run (select the Lock button - see Lock_the_Ride_Specification_test_run).
5. Close the pay adjustment results form.
6. Select another test run and lock the test run.
7. Continue selecting and locking test runs until all Ride Specification test data test runs have been locked for all material versions of the material item.

To open the pay adjustments results form, press the Show Pay Adjustment Results For This Test Run button at the top of the Ride Specification form, as shown below.
The *Ride Spec Pay Adjustment Data For:* form is displayed.

To lock the Ride Specification test run select the **Lock** button on the *Ride Spec Pay Adjustment Data For:* form.
The **Lock** button is replaced with a "Locked" label and the **OK** and **Cancel** buttons are displayed, as shown below.
Click the **OK** button to complete the locking process. Click the **Cancel** button to cancel the locking process.

After selecting the **OK** button the **Ride Spec Pay Adjustment Data For** form will close, returning to the **Ride Specification** test form where the material item, material version, Ride Specification Test Run test item is now locked (the locked status indicator is displayed on the **Ride Specification** user interface and the test data items are disabled and cannot be edited), as shown below.
**QA Suite User's Manual**

![Image of QA Suite User Interface](image.jpg)

**Table of Specifications**

<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Material Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>598</td>
<td>698</td>
<td>9100000</td>
<td>Plant Mix Bit Surf Gr 5 - 19 mm</td>
</tr>
</tbody>
</table>

**Test Results**

<table>
<thead>
<tr>
<th>Depth</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5</td>
<td>4.5</td>
</tr>
</tbody>
</table>

**Project Category**

1

**Unit Weight**

- **Unit Weight (Input):** 1.59 tonne
- **Unit Weight (Input):** 1.59 tonne

**Unit Cost**

1.59 tonne

**NOTE:** If Courtesy is True, the Pay column is calculated, but is not included in Total Net Payment.
13.4.9 Lock Volumetric Tests

13.4.9.1 Lock Volumetric Test Data
Once all test data has been entered and the test values have been reviewed and verified and the pay adjustment evaluation results have been reviewed for a Volumetric lot, the lot should be locked to prevent further editing and to designate the completion of the test data entry and evaluation of results for the lot.

To perform operations with test information, the test form for the information must be the selected form. In order to select the test form, it must be open. The test form can be opened from either the Tests tree view or the Tests menu options (see Opening A Test Form).

To lock Volumetric test data lots the Volumetric Testing test form must be opened and selected (see Selecting A Form).

When the Volumetric Testing test data form is opened and selected it looks like the one below:

The basic procedure for locking Volumetric lots is:
1. Open the Volumetric Testing test form (see Opening A Test Form).
2. Select the Volumetric lot for the desired material item and material version (see Selecting A Form).
3. Open the pay adjustments results form for the current lot, (select the Show Pay Adjustment Results For This Lot button - see Open_the_pay_adjustments_results_form).
4. Lock the lot (select the Lock button - see Lock_the_Volumetric_lot).
5. Close the pay adjustment results form.
6. Select another lot and lock the lot.
7. Continue selecting and locking lots until all Volumetric test data lots have been locked for all material versions of the material item.
To open the pay adjustments results form, press the **Show Pay Adjustment Results For This Lot** button at the top of the **Volumetric Testing** form, as shown below.

The **Volumetric Pay Adjustment Data For** form is displayed.

To lock the Volumetric test lot select the **Lock** button on the **Volumetric Pay Adjustment Data For** form, as shown below.
The **Lock** button is replaced with a "Locked" label, as shown below.

<table>
<thead>
<tr>
<th>Test #</th>
<th>Voids</th>
<th>VMA</th>
<th>VFA</th>
<th>D/A Ratio</th>
<th>Grn</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.8</td>
<td>14.4</td>
<td>81</td>
<td>0.8</td>
<td>2.449</td>
</tr>
<tr>
<td>2</td>
<td>2.5</td>
<td>15.1</td>
<td>83</td>
<td>1.0</td>
<td>2.418</td>
</tr>
<tr>
<td>3</td>
<td>2.1</td>
<td>13.8</td>
<td>85</td>
<td>0.9</td>
<td>2.444</td>
</tr>
<tr>
<td>4</td>
<td>1.7</td>
<td>15.4</td>
<td>70</td>
<td>0.9</td>
<td>2.458</td>
</tr>
<tr>
<td>5</td>
<td>3.0</td>
<td>14.3</td>
<td>79</td>
<td>1.0</td>
<td>2.442</td>
</tr>
</tbody>
</table>

Click the **OK** button to complete the locking process. Click the **Cancel** button to cancel the locking process.

After selecting the **OK** button the **Volumetric Pay Adjustment Data For:** form will close, returning to the **Volumetric Testing** test form where the material item, material version, Volumetric Lot test item is now locked (the locked status indicator is displayed on the **Volumetric Testing** user interface and the test data items are disabled and cannot be edited), as shown below.
13.5 Unlocking Test Data

13.5.1 Unlocking Test Data

Test data items (bricks, lots, reports or runs) will need to be unlocked before they can be modified.

To unlock test data items (test data bricks, test data lots, test data reports or test data runs), first open the file in the QA Suite (see Start and Log In to QA Suite).

After logging in, the file will be opened in the QA Suite with the main window displayed as shown below.

![Image of QA Suite main window]

To start the process of unlocking test data item(s) (bricks, lots, reports or runs), select the Specification/Data Locking option under the Tools --> Security/Control option, as shown below.

![Image of Specification/Data Locking form]

The QA Specifications and Test Data Locking form opens as shown below.
The locked state for the test data for each test type brick, lot, report or run are shown in the *Bid Item / Material Type / Material Version / Test Type / Lot* section on the *Test Data Locking* tab. As the section heading indicates, the test data item(s) (bricks, lots, reports or runs) are identified by the Bid Item, Material Type, Material Version, Test Type and test data item (brick, lot, report or run) separated by forward slashes ("/").

For example:
The cover type 1 bid item, cover material grade 4A material type, material version 1, Aggregate test type, Lot 1 is identified as "COVER - TYPE 1 / COVER MATERIAL GRADE 4A/Material Ver. 1/Aggregate/Lot 1".

The plant mix bit surf gr S - 19 mm bid item, plant mix bit surf gr S - 19 mm material type, material version 1, Aggregate test type, Lot 1 is identified as "PLANT MIX BIT SURF GR S - 19 MM / PLANT MIX BIT SURF GR S - 19 MM / Material Ver. 1/Aggregate/Lot 1".


The plant mix gr D - commercial tested bid item, plant mix gr D - commercial tested material type, material version 1, Marshall test type, Brick 1 is identified as "PLANT MIX GR D - COMMERCIAL TESTED / PLANT MIX GR D - COMMERCIAL TESTED / Material Ver. 1/Marshall/Lot 1".
The plant mix bit surf gr S - 19 mm bid item, plant mix bit surf gr S - 19 mm material type, material version 1, Plant Mix Density test type, Lot 1 is identified as "PLANT MIX BIT SURF GR S - 19 MM / PLANT MIX BIT SURF GR S - 19 MM / Material Ver. 1/ PlantMixDensity/Lot 1".

The plant mix bit surf gr S - 19 mm bid item, plant mix bit surf gr S - 19 mm material type, material version 1, Ride Specification test type, run SB Slow is identified as "PLANT MIX BIT SURF GR S - 19 MM / PLANT MIX BIT SURF GR S - 19 MM / Material Ver. 1/ RideSpec/Lane: SB Slow".

The plant mix bit surf gr S - 19 mm bid item, plant mix bit surf gr S - 19 mm material type, material version 1, Volumetric test type, Lot 1 is identified as "PLANT MIX BIT SURF GR S - 19 MM / PLANT MIX BIT SURF GR S - 19 MM / Material Ver. 1/Volumetric/Lot 1".

To unlock a test data item (brick, lot, report or run), un-select the Locked check box next to the test data item. As part of the QA process, a reason is required for unlocking an item. Hence, an Unlock Reason window will be displayed, requiring the entry of explanation for the reason for unlocking the item.

For example, the COVER - TYPE 1, COVER MATERIAL GRADE 4A - Material Version 1 - Aggregate Lot 1 test item is locked (the locked status indicator is displayed on the Aggregate Test user interface and the test data items are disabled and cannot be edited), as shown below.
To modify the lot size for the COVER - TYPE 1, COVER MATERIAL GRADE 4A - Material Version 1 - Aggregate Lot 1, the test item will need to be unlocked. To unlock the test item, the check mark is removed from the Locked check box next to the test item. After removing the check from the Locked check box for the test item the Unlock Reason window is displayed as shown below.

![Unlock Reason Window](image)

After text is entered in the reason entry text box, the OK button will be enabled as shown below.

![Unlock Reason Window with Reason](image)

Click the OK button to complete the unlocking process. Click the Cancel button to cancel the unlocking process.

Since the COVER - TYPE 1, COVER MATERIAL GRADE 4A - Material Version 1 - Aggregate Lot 1 is now unlocked, the locked status indicator is removed from the Aggregate Test user interface and the test data items are enabled and can be edited, as shown below.
Working With Test Data
14. Transferring Data To Helena

14.1 Setting Up For Transfer To Helena

You will need to validate and lock the project information before the first transfer to Helena can occur. This only needs to be done once for each contract file.

Project information validation and locking can only be performed by users with one of the following roles:

1. EPM
2. Field Office Person
3. Lab Supervisor

To validate and lock project information, first open the file in the QA Suite (see Start and Log In to QA Suite). Then, select the Project Information option under the View menu option, as shown below.

This will bring up the View Project Information window. Simply select each project from the Project dropdown and click on the Validate Project button, as shown below.
If the project information does not match the information in the contract plans database a window will open with notification of the mismatch, prompting to change the project information to match the contract plans database, as shown below.

Selecting **Yes** changes the project information to match the contract plans database, finishing the validation process. Selecting **No** cancels the validation process.

Once a project information has been validated the **Validate Project** button will disappear and a **Lock** button will be displayed, as shown below. Select the **Lock** button to lock the project information.
Once the project information for a project has been locked, the **Lock** button will disappear and a **Locked** label will be displayed, as shown below.
If a contract file has multiple projects, you will need to validate all projects under the contract file before the contract file can be transferred to Helena.

To validate another project in the contract file, choose the other project from the *Project* dropdown and perform the Validate Project and Lock operations discussed above.

The contract file is now ready to be transferred in to Helena (see [Transfer Data To Helena](#)).
14.2 Transfer Data To Helena

Once you have validated the project information (see Setting Up For Transfer To Helena) the file can be transferred to Helena.

File transfer can only be performed by users with one of the following roles:

1. EPM
2. Field Office Person
3. Lab Supervisor

To transfer a file to Helena, first open the file in the QA Suite (see Start and Log In to QA Suite). Then, select the **Push Data to HQ** option from the **Project DB Manager** option under the **Tools** menu option, as shown below.

**Note:**
If the **Push Data to HQ** option is not displayed, check to make sure that the project information has been validated for all projects in the Contract file (see Setting Up For Transfer To Helena).

File transfer is immediate, with e-mail notification to the individual transferring the file as well as the EPM and HQ distribution.
15. Headquarters Project Data Access

15.1 Starting in View HQ Project Data Mode

A large number of users only need to be able to view and report project data that has been transferred in to headquarters.

Since these users only need to work with headquarters project data, they can set their default login mode to start up the QA Suite in the View HQ Project Data mode.

To set their default startup mode for the QA Suite user's will first need to start up the QA Suite.

To set your default startup mode for the QA Suite, first start up the QA Suite, switching to the View HQ Project Data mode during startup (see Switching To View HQ Project Data Mode During Startup).

After starting the QA Suite in the View HQ Project Data mode, the program will start up in the Project Viewer mode as shown below.

To set the default startup option select the Options option under the Tools menu option as shown below.
This will activate the **User Options** form as shown below.

Next, the user simply selects the **Project Viewer** option in the **Start Mode** panel and clicks on the **OK** button to save the changes as shown below.

Once this operation is completed, the QA Suite will automatically start up in the View HQ Project Data mode whenever the user starts the QA Suite with no prompting for selecting a file to open or for the user to login.

The QA Suite will start up in the Project Viewer mode as shown below.
The user can now proceed to find and select the HQ Project to view the data (see Finding And Selecting An HQ Project).

<table>
<thead>
<tr>
<th>Contract Number</th>
<th>Control Number</th>
<th>Project Name</th>
<th>Project Number</th>
<th>Route</th>
<th>District</th>
<th>Last Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>039D3</td>
<td>04970704000</td>
<td>ROCKER SCALE SITE</td>
<td>IM 25-2(74)22</td>
<td></td>
<td>Butte</td>
<td>08/24/2007 14:14</td>
</tr>
<tr>
<td>023D7</td>
<td>52950700000</td>
<td>BOULDER INTERCHANGE- N &amp; S</td>
<td>IM 15-3(70)163</td>
<td>I-15</td>
<td>Butte</td>
<td>10/05/2007 11:33</td>
</tr>
<tr>
<td>065D7</td>
<td>57951140000</td>
<td>CASCADE - ULM</td>
<td>IM 15-5(114)257</td>
<td>I-15</td>
<td>Great Falls</td>
<td>12/14/2007 07:22</td>
</tr>
<tr>
<td>091D7</td>
<td>54840937000</td>
<td>BRADY - N &amp; S (NB)</td>
<td>IM 15-6(37)223</td>
<td>I-15</td>
<td>Great Falls</td>
<td>10/29/2007 07:11</td>
</tr>
<tr>
<td>071D7</td>
<td>57606900000</td>
<td>SUNBURST - SOUTH</td>
<td>IM 15-6(62)380</td>
<td></td>
<td>Butte</td>
<td>10/29/2007 10:50</td>
</tr>
<tr>
<td>03C06</td>
<td>50470700000</td>
<td>BONNER INTERCHANGE - EAST</td>
<td>IM 15-2(101)110</td>
<td>I-90</td>
<td>Missoula</td>
<td>01/07/2008 07:31</td>
</tr>
<tr>
<td>082D7</td>
<td>61590730000</td>
<td>CIVERT-NE OF MILES CITY</td>
<td>IM 14-7(3)143</td>
<td>I-94</td>
<td>Glendive</td>
<td>11/27/2007 13:41</td>
</tr>
<tr>
<td>021D7</td>
<td>10279800000</td>
<td>NORTH OF MANCICK - NORTH</td>
<td>MT-41-1(100)54</td>
<td>N-1</td>
<td>Missoula</td>
<td>02/12/2007 08:43</td>
</tr>
<tr>
<td>07H07</td>
<td>57650220000</td>
<td>SHELBY EAST</td>
<td>NH-1-108-303</td>
<td>N-1</td>
<td>Great Falls</td>
<td>10/29/2007 10:50</td>
</tr>
<tr>
<td>01C06</td>
<td>59691140000</td>
<td>ROLLINS - NORTH &amp; SOUTH</td>
<td>NH-1-92-4352</td>
<td>N-5</td>
<td>Butte</td>
<td>02/14/2008 15:15</td>
</tr>
<tr>
<td>10C06</td>
<td>59730140000</td>
<td>FLATWILLOW CREEK - NB &amp; S</td>
<td>NH-1-11(312)</td>
<td>N-51</td>
<td>Billings</td>
<td>08/31/2007 13:02</td>
</tr>
<tr>
<td>09405</td>
<td>03377041000</td>
<td>US 287 PASS LN-S OF TOSTON</td>
<td>NH-8-14-4030</td>
<td></td>
<td>Butte</td>
<td>06/14/2008 13:35</td>
</tr>
<tr>
<td>01605</td>
<td>55550100000</td>
<td>SOUTH HELENA - INTERCHANGE</td>
<td>NH-MPH-401-1</td>
<td>I-15</td>
<td>Great Falls</td>
<td>01/10/2008 09:25</td>
</tr>
<tr>
<td>071D7</td>
<td>59700420000</td>
<td>OILFIELD AVE. PATH - SHELBY</td>
<td>STRE 51(45)</td>
<td>P-67</td>
<td>Butte</td>
<td>10/29/2007 10:50</td>
</tr>
<tr>
<td>01C06</td>
<td>50200190000</td>
<td>2001-PASS BAYE OF TOWNSEND</td>
<td>STPHS 14-1(192)</td>
<td>P-14</td>
<td>Butte</td>
<td>12/04/2007 00:00</td>
</tr>
<tr>
<td>06107</td>
<td>59599420000</td>
<td>HARRISON-SOUTH</td>
<td>STPP 13-14356</td>
<td>P-13</td>
<td>Butte</td>
<td>09/05/2007 13:14</td>
</tr>
<tr>
<td>01C06</td>
<td>15100010000</td>
<td>EAST OF TOWNSEND</td>
<td>STTP 14-1(96)</td>
<td>P-14</td>
<td>Butte</td>
<td>12/04/2007 00:00</td>
</tr>
<tr>
<td>25106</td>
<td>24601090000</td>
<td>ANGELA - N &amp; S</td>
<td>STTP 16-1(918)</td>
<td>P-18</td>
<td>Glendive</td>
<td>07/10/2007 14:29</td>
</tr>
</tbody>
</table>
15.2 Switching Between Local Contract File and View HQ Project Data Modes

After opening a file a user can access the Project Viewer function by selecting the `HQ Project Data` option under the `View` menu option, as shown below.

After choosing the HQ Project Data option, the program will switch the `Project Viewer` mode as shown below.

A user can switch back to working with a local contract file by simply select the `Open` option under the `File` menu option as shown below.
The user will be prompted to select the file to open and to login (see Start and Log In to QA Suite).
15.3 Switching to View HQ Project Data Mode During Startup

The default startup mode for the QA Suite is the Open Project mode.

Users that only need to view HQ project data can change the startup mode option to have the QA Suite start in the Project Viewer mode (see Starting In View HQ Project Data Mode). However, in order to get the QA Suite started up so that they can change the startup mode they will need to start the QA Suite in the View HQ Project Data mode.

Additionally, users that normally work in the Open Project mode can switch to the Project Viewer mode during startup. This provides a convenient means of changing the QA Suite startup mode without having to keep changing the default startup mode option.

To switch to the View HQ Project Data mode during startup, first start the QA Suite in the normal manner (see Start and Log In to QA Suite).

When the QA Suite starts up, the *Open* window will be displayed for the user to select the file to open. At this point, the user can click on the **Cancel** button as shown below.

After choosing the **Cancel** button, the program will start in the **Project Viewer** mode as shown below.
Headquarters Project Data Access

The user can now proceed to find and select the HQ Project to view the data (see Finding And Selecting An HQ Project).

If the user has access to local contract files, they can open the local contract file, switching back to the Open Project mode (see Switching Between Local Contract File and View HQ Project Data Modes).
15.4 Finding and Selecting an HQ Project

Projects that have been transferred in to Helena are available for viewing in the project viewer.

After starting up in or switching to the View HQ Project Data mode, the program will display the **Project Viewer** screen as shown below.

Projects that have been transferred in to Helena will be displayed in the list as shown above.

The projects are sorted by the field that is represented by the column heading. By default they are sorted by Project Number as indicated by the carrot symbol (^) appearing after the Project Number column heading and the label next to the text entry box reading Project Name.

If a user needs to sort and find projects by one of the other fields they can click on the column heading for the information that they know. For example, if a user knew the Control Number they would click on the Column Number column heading and the carrot symbol (^) would appear after the Control Number column heading (Control Number^). The information would be sorted by Control Number, the label next to the text entry box would change to read Control Number and they could start entering the Control Number into the text entry box, as shown below.
By default, all projects for all districts are displayed in the list. To limit the projects displayed to those for a certain district the user simply chooses the desired district from the dropdown list next to the District label as shown below.
After setting the district filter, the list of projects will be updated to display only those projects for the selected district as shown below.
In this case, we know the Project Number is STPS 210-1(9)0 so we leave the Project Number column heading selected and start entering this Project Number in the text entry box. As we enter the letters the list starts scrolling down to the Project Number matching the text being entered as shown below.
To open a project file for viewing and reporting the user selects the desired project from the list so that it is highlighted and then clicks on the View Selected button as shown below.
The file will be opened in *View Only* mode in the QA Suite as shown below.
16. Working With Local Policies

16.1 Local Policy Definition and Use

Each project manager will want to create a local policy for his crew. Once created and configured, the local policy will be used to apply the EPM’s desired default Role/Privileges configuration and Personnel configuration (with associated individual Privileges) to the contract files for the projects he/she will be managing.

The local policy only needs to be created once by the EPM or their designee (Field Office Person). Once it is created it remains under the control of the EPM’s office on their local computer. It does not need to be (and should not be) copied out to other computers. It is a tool to be used by the EPM’s office to control the personnel and roles and privileges to be applied to the contract files being created in their office. It is also a tool to be used to apply the crew’s personnel and roles and privileges to contract files which have been created elsewhere.

Generally the EPM’s office will only have one local policy file on their office machine (the local policy for their crew). However, in those instances where an EPM may be managing multiple crews at one time, a local policy for each crew being managed is allowed by the software and is recommended.

By creating and maintaining this local policy file, the EPM’s office can quickly and easily create and apply personnel and role and privilege settings to a contract file without having to go thru the process of adding personnel and setting roles and privileges individually on every project in every contract file they create or are given.
16.2 Creating Local Policy

To create a local policy, select the *Edit Local Policy* option from the *Tools-*Security/Control* menu dropdown as shown below.

This will display the *Select Local Policy File to Edit* form as shown below. Existing local policies will be displayed in the *Crew* list (i.e., local policies already exist for crews 3181 and 3182 in the example below).

To create a local policy for a new crew, choose the district from the *District* dropdown list, select the crew from the *Available Crews* list and then click the *Add Crew* button, as shown below.
After adding the new crew, the QA Local Policy window will be displayed as shown below.
The *QA Local Policy* form allows users to edit the local policy (see *Editing Local Policy*) or apply the local policy to a contract file (see *Applying Local Policy To Contract Files*).
16.3 Editing Local Policy

To edit a Local Policy, select the *Edit Local Policy* option from the *Tools->Security/Control* menu dropdown as shown below.

This will display the *Select Local Policy File to Edit* form as shown below. Existing local policies will be displayed in the *Crew* list (i.e., local policies already exist for crews 3181 and 3182 in the example below).

To edit an existing local policy, select the local policy from the *Crew* list, then select the *OK* button, as shown below.
After choosing an existing local policy and selecting OK, the *QA Local Policy* window will be displayed as shown below.
The *QA Local Policy* form allows users to edit the local policy.

For each Role/Privilege, if the Corporate Policy allows the Local Policy to override, the *Override* check box will be enabled. To override the Corporate Policy, check the *Override* check box.

The *Roles and Privileges* section allows the EPM to modify the privileges assigned to a role for the personnel on his or her crew, provided the Corporate Policy allows them to be overridden.

For example, the Field Office Person role is set up under the Corporate Policy to have all privileges by default except the Modify Pay Adjustment privilege. Since the Corporate Policy allows this default setting to be overridden, the EPM can give all Field Office Person’s the privilege to Make Pay Adjustments. To do this, the EPM would click on the Field Office Person role, click on the
Modify Pay Adjustment privilege, and place a check box in the Assigned by Default check box, as shown below.

![QA Local Policy](image)

After saving this change to the Local Policy (by clicking on the **Save** button), all personnel on the crew that have been assigned the Field Office Person role will now also have the Modify Pay Adjustment privilege by default.

If you have created a new local policy, the Personnel are based on the Personnel Database for the crew that you selected. To edit the personnel for the local policy, click the **Edit** button. The *Personnel Management* window will be displayed as shown below.
To modify the role for a person already assigned to the project, select the person’s name in the "People assigned to Project" list and select the desired role from the Role dropdown list, as shown below.
The privileges that are assigned to that role by default are shown in bold and blue in the Privileges list. There is no need to place a check mark next to these privileges since they are already assigned to this role. However, to give the person additional privileges beyond those provided by default, place a check mark next to any of the privileges in the Privileges list that are not already allowed for that role by default (any of the privileges items that are not shown Bold/Blue in the Privileges list).

For example, to give a particular Testing Technician the ability to Lock Lots, select the person from the “People assigned to Project” list and select the Lock Data privilege (click in the check box next to the Lock Data privilege, placing a check mark in the check box) as shown below.
This will give the currently selected user the added privilege to Lock Data in addition to the default privilege of being able to Add/Edit Data.

Select the **OK** button to keep the changes and return to the QA Local Policy form.

Select the **Cancel** button to return to the QA Local Policy form with no changes saved.

This is the method used to manage personnel and their roles and privileges controlled thru the local policy.
To apply the Local Policy to contract files, select the contract files by clicking the Add Files button as shown below.

Browse to the location of the desired contract file and select the contract file and choose the Open button to complete selecting the desired file as shown below.
The selected file will then be displayed in the “Apply to Contract Files – Files” list as shown below.
To apply only the Roles/Privileges changes without Personnel changes click on the **Apply** button without selecting the **Apply Personnel Changes** option.

To apply personnel changes as well as Roles and Privileges changes to the Contract file, check the **Apply Personnel Changes** check box. Then click the **Apply** button, as shown below.
The Roles and Privileges and Personnel settings in the Local Policy file will be applied to the selected Contract file(s) and the file(s) will be saved.
17. Working With Personnel

17.1 Step by Step Help for Working With Personnel

How Do I Manage Project Personnel?

1. Start up and log in to the QA Suite program (see Start and Log In to QA Suite).
2. Select the Personnel Management menu option (see Select Personnel Management menu option).
3. Manage the project personnel information (see Manage Project Personnel).
4. Save the changes to the Project Personnel information (see Saving Project Personnel Changes).
5. Exit out of the QA Suite program (see Exit).

How Do I Handle Personnel That Leave the Department or Are No Longer Working on the Project?

When personnel leave the project they are not be deleted from the project personnel information. Instead, they are marked as inactive.

To do this, perform the following steps:

1. Start up and log in to the QA Suite program (see Start and Log In to QA Suite).
2. Select the Personnel Management menu option (see Select Personnel Management menu option).
3. Change the person's active status to inactive (see Changing Active Status for Personnel).
4. Save the changes to the Project Personnel information (see Saving Project Personnel Changes).
5. Exit out of the QA Suite program (see Exit).

How Do I Handle Personnel That Return to the Department or Return To Work on the Project?

When personnel return to the project they do not need to be added to the project personnel information. Instead, they are made active.

To do this, perform the following steps:

1. Start up and log in to the QA Suite program (see Start and Log In to QA Suite).
2. Select the Personnel Management menu option (see Select Personnel Management menu option).
3. Change the person's inactive status to active (see Changing Active Status for Personnel).
4. Save the changes to the Project Personnel information (see Saving Project Personnel Changes).
5. Exit out of the QA Suite program (see Exit).

How Do I Add a New User That Has Not Yet Been Added to The QA Suite Personnel Database?

Even though a new user may not yet have been added to the QA Suite personnel database, they can still be added to the personnel for the project.

To do this, perform the following steps:

1. Start up and log in to the QA Suite program (see Start and Log In to QA Suite).
2. Select the Personnel Management menu option (see Select Personnel Management menu option).
3. Add the new user to the Project Personnel information (see Adding Person Not In Personnel Database).
4. Save the changes to the Project Personnel information (see Saving Project Personnel Changes).
5. Exit out of the QA Suite program (see Exit).
17.2 Selecting Personnel

After opening the **Personnel Management** form (see Select Personnel Management menu option), the user selects the desired person to view and/or edit the person’s role, privileges or active status. The instructions for selecting personnel are discussed below.

When the form opens, all **active** personnel assigned to the project are displayed in the "**People assigned to Project**" list, as shown below.

The user scrolls down through the "**People assigned to Project**" list until the desired person is displayed in the list.

The list is sorted alphabetically but a user can enter the first letter of the last name for the person assigned to the project to quickly move to the section of the list for people whose last name start with that letter.

For example, to edit personnel information for William Richards, the user would click anywhere on the list and then enter an "R", moving the list to the section with last names that start with an "R", as shown below.
The user then scrolls to find the desired person's name and then clicks on the desired person's name as shown below.
Once the desired person has been selected in the list, the user can either modify the selected person's role and/or privileges (see [Modifying Personnel Privileges](#)) or change the selected person's active status (see [Changing Active Status for Personnel](#)).
17.3 Adding Personnel

To add personnel to the project select the **Add New Personnel** button as shown below.

The **Select Additional Personnel** form will be displayed as shown below.
The **Crew Type** dropdown is provided to allow the user to filter the types of crews that are displayed in the "Crews" list. To use the filter simply click on the **Crew Type** dropdown arrow as shown below and select the desired crew type from the list of crew type options.

The **District** dropdown is provided to allow the user to filter the district crews that are displayed in the "Crews" list. To use the filter simply click on the **District** dropdown arrow as shown below and select the desired district from the list of district options. This option would be used if a person from a different district needed to be added to the personnel for the project.
To add people to a project the user first selects the crew that the person is assigned to in the "Crews" list. All personnel currently assigned to the selected crew that have not already been added to the project are shown in the "Available People" list, as shown below.

NOTE: If the desired person is not displayed in the "Available People" list when the correct crew has been selected and the person has not already been assigned to the project then it is possible that the user has not yet been added to the QA personnel database. (Occasionally a new user will be added to a crew but won't yet have been added to the QA personnel database.) In this case the person can be added using the Add New Person button (see Adding Person Not In Personnel Database).

Once the desired people are displayed in the "Available People" list the user can select the desired users and use the Add -> button to add them to the "People to Add" list (see List View Operations). In the example below, two of the three available people have been selected to be added to the "People to Add" list.
After clicking the **Add ->** button, the people have been moved to the "People to Add" list as shown below.

Once the desired people have been added to the "People to Add" list, the user selects the OK button, as shown below, to complete the process of adding the people to the project personnel.
The **Select Additional Personnel** form will close, returning to the **Personnel Management** form with the additional people displayed in the "People assigned to Project" list, as shown below.
17.4 Removing Personnel

When personnel leave the project they are not be removed from the project personnel information. Instead, they are marked as inactive.

The Active/Inactive status provides a method for controlling the personnel assigned to work on projects without having to actually remove the users from the personnel assigned to the project. This ability is necessary because personnel may have performed work on a project and therefore need to remain associated with the project even though they may not be doing any further work on the project (they are no longer active on this project (i.e., they are inactive)).

See Changing Active Status for Personnel for instructions on how to mark a user as inactive.
17.5 Modifying Personnel Privileges

After selecting a user's name in the "People assigned to Project" list (see Selecting Personnel), the user's privileges can be modified using the Role and Privileges options in the Personnel Management form as discussed below.

To change a person's role on a crew first select the user's name in the "People assigned to Project" list. Next, select the black arrow at the right end of the Role dropdown and scroll through the dropdown list to find the new role and then select that role, as shown below.

After making the selection, the new role will be shown in the Role dropdown and the new privileges will be displayed in the "Privileges" list, as shown below.
The privileges that are assigned to that role by default are shown in bold and blue in the Privileges list. There is no need to place a check mark next to these privileges since they are already assigned to this role. However, to give the person additional privileges beyond those provided by default, place a check mark next to any of the privileges in the Privileges list that are not already allowed for that role by default (any of the privileges items that are not shown Bold/Blue in the Privileges list).

For example, to give a particular Testing Technician the ability to Lock Lots, select the person from the “People assigned to Project” list and select the Lock Data privilege (click in the check box next to the Lock Data privilege, placing a check mark in the check box) as shown below.
This will give the currently selected user the added privilege to Lock Data in addition to the default privilege of being able to Add/Edit Data.
17.6 Select Personnel Management Menu Option

After starting the QA Suite program the QA User Login window will appear, prompting the user to log in to the current QA contract file (see Start and Log In to QA Suite).

To start the process of managing personnel choose the Tools -> Security/Control --> Personnel Management menu option, as shown below.

The Personnel Management form will be displayed as shown below.

![Personnel Management Form]

The user can now proceed to manage personnel information (see Manage Project Personnel).
17.7 Changing Active Status for Personnel

The Active/Inactive status provides a method for controlling the personnel assigned to work on projects without having to actually remove the users from the personnel assigned to the project. This ability is necessary because personnel may have performed work on a project and therefore need to remain associated with the project even though they may not be doing any further work on the project (they are no longer active on this project (i.e., they are inactive)).

During the course of a project, personnel changes will occur. For example, personnel can change crews or be assigned to different projects. When personnel will no longer be active on a project they can be marked as inactive. This maintains the history of personnel assigned to a project while removing the individual's ability to do further work on the project.

To mark a person as inactive, simply select their name in the “People assigned to Project” list and click on the Mark Inactive button, as shown below.

A confirmation window will be displayed, prompting the user to verify the action to mark the selected user as inactive, as shown below.
Select the **Yes** button to complete the mark inactive operation and make the user inactive. The **Personnel Management** form will be updated with the selected user made inactive and no longer shown in the "People assigned to Project" list, as shown below.

Select the **No** button to cancel the mark inactive operation and leave the user active.

To view inactive as well as active people assigned to the project use the **Show Inactive** option (see **Viewing Inactive Personnel**).

To make a person active, first select the **Show Inactive** option so that the inactive person's name is displayed. Then choose the inactive person's name from the list and select the **Make Active** button as shown below.
The Personnel Management form will be updated with the selected user made active and the "(I)" indicator removed from their name in the "People assigned to Project" list, as shown below.
## Working With Personnel

![Personnel Management](image)

### People assigned to Project

<table>
<thead>
<tr>
<th>Name</th>
<th>Role</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOHNSON, SHANE</td>
<td></td>
<td>Add/Edit Data, Add/Edit Specification, Lock Data, Lock Specifications, Modify Pay Adjustment, Modify Privileges, Unlock Data, Unlock Specifications</td>
</tr>
<tr>
<td>MACMILLAN, JOHN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MALONEY, WILLIAM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAYNARD, RONALD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MCCracken, Arlene</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MORELAND, JAMIE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phelps, Riley</td>
<td></td>
<td></td>
</tr>
<tr>
<td>POWERS, VICKI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REIFFERN, DAVID</td>
<td>Testing Technician</td>
<td>Add/Edit Data, Add/Edit Specification, Lock Data, Lock Specifications, Modify Pay Adjustment, Modify Privileges, Unlock Data, Unlock Specifications</td>
</tr>
<tr>
<td>Richards, William</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snow, Mark</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sturm, James</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Mark Inactive**
- **Add New Personnel**
- **Show Inactive**

- **OK**
- **Cancel**
17.8 Viewing Inactive Personnel

When the Personnel Management form opens, all active personnel assigned to the project are displayed in the “People assigned to Project” list.

To view inactive as well as active personnel assigned to the project select the Show Inactive option as shown below.

After selecting the Show Inactive option, the Personnel Management form will update with inactive users included in the "People assigned to Project" list. The inactive personnel will be included in list with the "(I)" designation after their name, as shown below.
17.9 Adding Person Not In Personnel Database

Occasionally a new user will be added to a crew but won't yet have been added to the QA personnel database. In this case the person can be added using the Add New Person button provided on the Select Additional Personnel form as discussed below.

To add a new crew member to the project select the Add New Personnel button as shown below.

![Select Additional Personnel Form]

The Select Additional Personnel form will be displayed. Simply click the Add New Person button as shown below.
An **Add New Person** form will be displayed as shown below.

When adding new persons, the **UNumber (User's User Number)**, **First Name**, **Last Name**, **District**, **Crew** and **Role** must be set as shown in the **Validation Errors** section at the bottom of the window.
First, enter the UNumber, First Name and Last Name in their appropriate text box entry locations as shown below.

![Add New Person](image)

**Note:** The UNumber must be the user's correct user number or they will not be able to log in to the QA Suite. Also, the names should be entered in ALL CAPITAL LETTERS in order to be consistent with the names stored in the QA Personnel database.

As can be seen in the *Validation Errors:* section at the bottom of the form, as the various inputs are entered, the validation messages are updated to reflect the validation of the inputs. For example, in this case, the UNumber, First Name and Last Name validation error messages are no longer being displayed since they have been correctly input.

Next, select the District, Crew and Role from the appropriate dropdown list, as shown below.
Finally, click the OK button to complete the new person data entry, returning to the Select Additional Personnel form with the new person’s name displayed in the "People to Add" list as shown below.

Once the new person has been added to the "People to Add" list, the user selects the OK button, as shown above, to complete the process of adding the people to the project personnel.

The Select Additional Personnel form will close, returning to the Personnel Management form with the new person displayed in the "People assigned to Project" list, as shown below.
Select the **OK** button to keep the changes and return to the QA Suite main form.
17.10 Manage Project Personnel

After opening the **Personnel Management** form (see Select Personnel Management menu option), the user can view and edit the personnel information for the project as follows.

When the form opens, all **active** personnel assigned to the project are displayed in the "People assigned to Project" list.

The user scrolls down through the "People assigned to Project" list until the desired person is displayed in the list.

The list is sorted alphabetically but a user can enter the first letter of the last name for the person assigned to the project to quickly move to the section of the list for people whose last name start with that letter.

For example, to edit personnel information for William Richards, the user would click anywhere on the list and then enter an "R", moving the list to the section with last names that start with an "R", as shown below.
The user then scrolls to find the desired person's name and then clicks on the desired person's name as shown below.
Once the desired person has been selected in the list, the user can either modify the selected person's role and/or privileges (see Modifying Personnel Privileges) or change the selected person's active status (see Changing Active Status for Personnel).

Once the personnel changes have been completed the changes can be saved and the user can return to the main QA Suite as shown below.

Select the OK button to keep the changes and return to the QA Suite main form.

Select the Cancel button to return to the QA Suite main form with no changes saved.

This is the method used to manage personnel and their roles and privileges for current project.
17.11 Saving Project Personnel Changes

Once the personnel changes have been completed the changes can be saved and the user can return to the main QA Suite as shown below.

Select the **OK** button to keep the changes and return to the QA Suite main form.

Select the **Cancel** button to return to the QA Suite main form with no changes saved.
18. Commercial Plant Mix

18.1 Overview

The QA Suite was modified to handle the following paragraph of the Commercial Plant Mix Special Provision (4/7/2008):

A 5 percent price reduction (15 percent maximum), in the unit bid price for Commercial Plant Mix Surfacing will be applied for each test not meeting the VMA, VFA, VTM, D/A, Stability, Flow or Aggregate Requirements specified. Price reductions will be assessed on the quantity of material represented by each failing sample. The quantity of material represented by each sample is the total tons of material produced divided by the total number of samples representing the material.

QA Contract files created after the update will have the Commercial Plant Mix material items modified to meet the Commercial Plant Mix Special Provision. Contract files created prior to the update will need to have the Commercial Plant Mix material items modified according to the instructions at Converting Existing Data.

Marshall Testing for Commercial Plant Mix

Volumetric Testing for Commercial Plant Mix
18.2 Converting Existing Data

The following operations will need to be performed on QA Contract files that were created before the changes were made to the QA Suite for Commercial Plant Mix.

1. Unlock the Material Item (see Unlocking Material/Test Specs).
2. Select the material Item in Materials Summary (see Review and Lock Material Items).
3. Click on the Review Selected button as shown below.

4. The Edit Material Item Definition window will display as shown below. Select the Other Specifications tab and then click the Choose Specifications button as shown below.
5. The **Select Specifications** window will appear as shown below. Select the specification **Commercial_Plant_Mix** in the **Possible Specifications** list and then click the **Add** button as shown below.
6. Then, click the **OK** button as shown below.

7. Set the target value for the Asphalt Content

8. Click the **Lock** button and then the **OK** button as shown below.
8. Re-lock the material test specs and the material versions (see Re-locking Material/Test Specs).
19. Concrete Aggregate Optimization

19.1 Overview

The QA Suite was modified to generate the following charts for Class SD-L, Class DD-Bridge, CLASS AD, Class SD and Drilled Shaft Concrete:

- Coarseness Factor Chart
- 0.45 Power Factor Chart
- Percent Retained Chart

For each Bid Item, up to 5 Material Items will be added to the project, for example for the Class SD-L Bid Item, the following Material Items will be added to the project:

- CLASS SD-L CONCRETE AGGREGATE NO. 1
- CLASS SD-L CONCRETE AGGREGATE NO. 2
- CLASS SD-L CONCRETE AGGREGATE NO. 3
- CLASS SD-L CONCRETE AGGREGATE NO. 4
- CLASS SD-L CONCRETE AGGREGATE NO. 5

Aggregate gradations may be entered for any or all of the Material Items.

The following additional entries are required:

- Mix Design Cementatious Content - lbs / cu yd
- Aggregate Content - lbs / cu yd for each aggregate

To generate the charts, either select the menu item File->Combined Aggregate Optimization Charts or click the button Generate Aggregate Optimization Charts and the Aggregate Optimization Chart Selection will be displayed as shown below:
The **Select All** button can be used to select all of the tests displayed in the *Check the Tests that you would like to chart* list. The **Clear All** button un-selects all of the tests displayed in the *Check the Lots and/or Tests that you would like to chart* list.

Once the desired selections are made, click the **Generate** button to generate the charts for the selected options.

When the charts have been generated click on the **Cancel** button on the *Aggregate Optimization Chart Selection* window to close the window, completing the generation operation.
20. Plant Mix Incentive Adjustment

20.1 Overview

The QA Suite was modified to implement the Plant Mix Incentive Adjustment Special Provision (dated 10/10/2013), as summarized below:

Plant mix incentives are paid based on an anticipated increased service life due to high quality plant mix volumetric properties, compaction, and ride. Adjustments to the incentives will be made according to the Incentive Adjustment Table when the anticipated increased service life is not expected to be realized due to poor results in one or more of the other plant mix properties. Ride specification incentives will not be reduced based on density tests as stated in Subsection 105.03.3(C). Table 105-5 in Subsection 105.03.3 does not apply.

<table>
<thead>
<tr>
<th>Incentive Adjustment Table</th>
<th>No Incentive Adjustment</th>
<th>Adjustment Factor (Cannot be greater than 1)</th>
<th>No Incentive Allowed (Adjustment Factor = 0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOLUMETRICS</td>
<td>≤7</td>
<td>( F_v = -0.125P_v+1.875 )</td>
<td>( ≥15 )</td>
</tr>
<tr>
<td>COMPAC garn</td>
<td>≤7</td>
<td>( F_c = -0.125P_c+1.875 )</td>
<td>( ≥15 )</td>
</tr>
<tr>
<td>RIDE SPECIFICATION (IRI)</td>
<td>( ≤65 ) ( ≤80 )</td>
<td>( F_r = -0.1( IRI )+7.5 )( F_r = -0.1( IRI )+9 )</td>
<td>( ≥75 ) ( ≥90 )</td>
</tr>
</tbody>
</table>

Where:

- \( P_v \) = Average of all positive P value for all the plant mix volumetric properties (VMA, VFA, VTM, and D/A) evaluated under Section 105.03.2 on the project.
- \( P_c \) = Average of all positive P value for the compaction evaluated under Section 105.03.2 on the project.
- IRI = Weighted average International Roughness Index (IRI) for all travel lanes evaluated for surface smoothness on the project. When multiple ride categories are included on a project, adjustment factors will be determined for each. A weighted average of all adjustment factors will then be determined for use in the overall incentive adjustment equation below.

The Department will evaluate plant mix surfacing in accordance with all applicable contract requirements. Total incentives for plant mix volumetric properties, compaction, and ride will be adjusted based on the overall quality of all the plant mix paving properties. The overall incentive adjustment will be calculated as follows:

\[ I_a = I (F_v)(F_c)(F_r) \]
$I_a = \text{Total adjusted incentive amount}$
$I = \text{Total unadjusted incentive amount}$
$F_v = \text{Adjustment Factor resulting from plant mix volumetric properties}$
$F_c = \text{Adjustment Factor resulting from plant mix compaction}$
$F_r = \text{Adjustment Factor resulting from ride}$

Quality incentive allowances will be adjusted in accordance with this provision and then used to offset any price reductions. Any quality incentive allowance remaining after all price reductions have been deducted will be paid for as a lump sum when all work on the item is complete.

QA Contract files created after the update will have the Plant Mix Incentive Ties specification added to the Plant Mix Grade S Volumetric material items Spec Version 10/10/2013 to implement the Plant Mix Incentive Adjustment Special Provision. Contract files created prior to the update will need to have the Plant Mix Grade S Volumetric material items modified according to the instructions at Converting Existing Data.
20.2 Converting Existing Data

The following operations will need to be performed on QA Contract files that were created before the changes were made to the QA Suite for Plant Mix Incentive Adjustments.

1. Unlock the Material Item (see Unlocking Material/Test Specs).
2. Select the material Item in Materials Summary (see Review and Lock Material Items).
3. Click on the Review Selected button as shown below.

![Image of Materials Summary]

4. The Edit Material Item Definition window will display as shown below. Select the Other Specifications tab and then click the Choose Specifications button as shown below.
5. The **Select Specifications** window will appear as shown below. Select the specification **Plant_Mix_Incentive_Ties** in the **Possible Specifications** list and then click the **Add** button as shown below.
6. Then, click the **OK** button as shown below.

8. Click the **Lock** button and then the **OK** button as shown below.
8. Re-lock the material test specs and the material versions (see Re-locking Material/Test Specs).
21. First Lift On CAC Plant Mix Density Evaluation

21.1 Overview

The QA Suite was modified to handle the Section 401.03.21 Supplemental Change allowing 92% Minimum Compaction for mix placed directly on crushed aggregate surfacing (CAC) (dated 9/26/2013), summarized as follows:

Once the plant mix is spread, struck off, and surface irregularities are corrected, compact to the plant mix to at least 93.0% percent of target Maximum Specific Gravity as determined using MT 328 with the following exceptions:

- 92.0% - any mix placed directly on a crushed aggregate surfacing

QA Contract files created after the update will have the Plant Mix Density Test setup options for users to designate that the Plant Mix Item for the project includes a First Lift on CAC and to define the associated minimum target density (the default will be the 92.0% value defined above).

Contract files created prior to the update will need to have the Plant Mix Density Test setup options modified according to the instructions at Converting Existing Data.
21.2 Converting Existing Data

The following operations will need to be performed on QA Contract files that were created before the changes were made to the QA Suite for First Lift On CAC Plant Mix Density Evaluation Adjustments.

1. Unlock the Material Item/ Material Version / Plant Mix Density Test Type (see Unlocking Material/Test Specs).
2. Select the Material Item from the list of Existing Material Items in the Materials Summary then select the Material Version in the Material Version Info for Selected Item section and then select the Plant Mix Density test type from the list of test types (see Review and Lock Plant Mix Density Test Specs).
3. Click on the Material Info For Plant Mix Density Test Review button as shown below.
4. The **Plant Mix Density Material Info** form will be displayed as shown below. Note that the Deduct section contains an option designating that the project contains mix placed directly on crushed aggregate surfacing (CAC).

![Plant Mix Density Material Info form]

5. Select the **Project Contains Mix Placed Directly On Crushed Aggregate Surfacing (CAC)** option in the **Deduct** section and the **Lift on CAC Minimum Percentage** text entry box will be displayed as shown below.
6. Enter the Lift On CAC Minimum Percentage value (92) in the *Lift On CAC Minimum Percentage* text box and then select the **Lock** button and then the **OK** button to re-lock the Plant Mix Density Test Setup as shown below.
The *Plant Mix Density Material Info* form will close, returning to the main form with the Plant Mix Density test spec status changed to *Locked* as shown below.
Finally, save the changes using the Save button on the tool bar (see Toolbar) or the File Menu --> Save option (see Save).

This completes the modification of the Plant Mix Density test type material information to include the First Lift On CAC Plant Mix Density evaluation.
22. Systems Support

To obtain support, contact one of the following:

Randy Boysen
Specifications Engineer
406-444-0464
rboysen@mt.gov

Engineering Support Team
mdtisdapppmainteng@mt.gov
# 23. Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.45 Power Factor Chart</td>
<td>987</td>
</tr>
<tr>
<td>Add New Brick</td>
<td>671, 672</td>
</tr>
<tr>
<td>Add New Lot</td>
<td>591, 592, 604, 605, 685, 686, 739, 741</td>
</tr>
<tr>
<td>Add New Report</td>
<td>634, 636</td>
</tr>
<tr>
<td>Add New Test Run</td>
<td>707, 708</td>
</tr>
<tr>
<td>Aggregate Optimization Charts</td>
<td>987</td>
</tr>
<tr>
<td>Coarseness Factor Chart</td>
<td>987</td>
</tr>
<tr>
<td>Commercial Plant Mix</td>
<td>981, 982</td>
</tr>
<tr>
<td>Control Graphs</td>
<td>849, 854</td>
</tr>
<tr>
<td>CP Categories</td>
<td>766</td>
</tr>
<tr>
<td>Edit Material Items</td>
<td>150, 153, 157, 181, 202, 221, 249</td>
</tr>
<tr>
<td>Edit Material Versions</td>
<td>317, 319, 321, 325</td>
</tr>
<tr>
<td>Edit Test Data</td>
<td>591, 604, 634, 671, 685, 707, 739</td>
</tr>
<tr>
<td>Edit Aggregate Gradations Test Data</td>
<td>591</td>
</tr>
<tr>
<td>Edit Aggregate Surfacing Density Test Data</td>
<td>604</td>
</tr>
<tr>
<td>Edit Concrete Specs Test Data</td>
<td>615</td>
</tr>
<tr>
<td>Edit Daily Plant Mix Report Test Data</td>
<td>634</td>
</tr>
<tr>
<td>Edit Marshall Testing Test Data</td>
<td>671</td>
</tr>
<tr>
<td>Edit Plant Mix Density Test Data</td>
<td>685</td>
</tr>
<tr>
<td>Edit Ride Specification Test Data</td>
<td>707</td>
</tr>
<tr>
<td>Edit Volumetrics Test Data</td>
<td>739</td>
</tr>
<tr>
<td>Edit Test Specs</td>
<td>267, 268, 273, 278, 286, 298, 302, 305, 310</td>
</tr>
<tr>
<td>Exit</td>
<td>3, 44</td>
</tr>
<tr>
<td>Export</td>
<td>39, 859</td>
</tr>
<tr>
<td>File In Use</td>
<td>29</td>
</tr>
<tr>
<td>File Operations</td>
<td>29, 30, 31, 38, 114</td>
</tr>
<tr>
<td>First Lift Directly On Crushed Top Surfacing (CAC)</td>
<td>697, 995</td>
</tr>
<tr>
<td>Gradation Calculator</td>
<td>117</td>
</tr>
<tr>
<td>Headquarters</td>
<td>45, 921, 924, 926, 928</td>
</tr>
<tr>
<td>Help</td>
<td>3, 139, 140, 141</td>
</tr>
<tr>
<td>Length Payment Based Ride Spec</td>
<td>725</td>
</tr>
<tr>
<td>Length Payment Based Ride Spec UI Changes</td>
<td>725</td>
</tr>
<tr>
<td>Local Policy</td>
<td>935, 936, 939, 946</td>
</tr>
<tr>
<td>Lock</td>
<td>328, 351, 380</td>
</tr>
<tr>
<td>Locking Materials/Test Specs</td>
<td>328, 351, 380</td>
</tr>
<tr>
<td>Locking Test Data</td>
<td>874, 876, 881, 890, 893, 896, 900, 905</td>
</tr>
<tr>
<td>Locking Materials/Test Specs</td>
<td>328, 351, 380</td>
</tr>
<tr>
<td>Locking Test Data</td>
<td>874, 876, 881, 890, 893, 896, 900, 905</td>
</tr>
<tr>
<td>Lot Pay Adjustments</td>
<td>760</td>
</tr>
<tr>
<td>Main Form</td>
<td>3</td>
</tr>
<tr>
<td>Merge</td>
<td>553, 570, 587</td>
</tr>
<tr>
<td>Modify Materials/Test Specs</td>
<td>542, 543, 552</td>
</tr>
<tr>
<td>Modify Pay Adjustments</td>
<td>762</td>
</tr>
<tr>
<td>Open</td>
<td>3, 31, 36, 41</td>
</tr>
<tr>
<td>Overview</td>
<td>1</td>
</tr>
<tr>
<td>Pay Summary</td>
<td>51</td>
</tr>
<tr>
<td>Percent Retained Chart</td>
<td>987</td>
</tr>
<tr>
<td>Personnel</td>
<td>951, 953, 956, 961, 962, 965, 966, 970, 972, 977, 980</td>
</tr>
<tr>
<td>Plant Mix Incentive Adjustments</td>
<td>62, 696, 729, 758, 989</td>
</tr>
<tr>
<td>Plant Mix Incentive Ties</td>
<td>62, 696, 729, 758, 989</td>
</tr>
<tr>
<td>Plant Mix Summary</td>
<td>71</td>
</tr>
<tr>
<td>Print</td>
<td>23, 25, 42</td>
</tr>
<tr>
<td>Print Preview</td>
<td>22, 23, 43</td>
</tr>
<tr>
<td>Project Information</td>
<td>47</td>
</tr>
<tr>
<td>Random Asphalt Mat Sampling</td>
<td>128</td>
</tr>
<tr>
<td>Recover File</td>
<td>30, 114</td>
</tr>
<tr>
<td>Report Materials/Test Specs</td>
<td>436, 444, 495</td>
</tr>
<tr>
<td>Report Test Data</td>
<td>770, 777, 791, 801, 808, 815, 822</td>
</tr>
<tr>
<td>Report Aggregate Gradations Test Data</td>
<td>770</td>
</tr>
<tr>
<td>Report Aggregate Surfacing Density Test Data</td>
<td>777</td>
</tr>
<tr>
<td>Report Concrete Specs Test Data</td>
<td>784</td>
</tr>
</tbody>
</table>
Report Daily Plant Mix Report Test Data 791
Report Marshall Testing Test Data  801
Report Plant Mix Density Test Data  808
Report Ride Specification Test Data  815
Report Volumetrics Test Data  39, 78, 822, 826, 831, 835, 840, 849, 859, 864
Review/Lock Material Items  328
Review/Lock Material Versions  380
Review/Lock Test Specs  351
Save  3, 38, 980
Set Up Materials/Tests Specs  150, 267, 268, 317, 319, 328, 351, 380
Show Pay Adjustments  591, 601, 604, 613, 685, 694, 707, 722, 739, 753
Split  553, 555, 556, 570, 578, 584, 587
SSI Profiler Ride Data  713, 730
Creating SSI Ride Data Import File  730
Importing From SSI Ride Data File  713
Status Bar  3
Technical Support  1001
Test Forms  3, 17, 18
Tests Navigation  3, 6
Toolbar  3, 6
Transfer to Helena  47, 915, 919
Unlock  543, 909
Unlocking Materials/Tests Specs  543
Unlocking Test Data  909
View Materials/Tests Specs  383, 415, 436, 444, 495